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DropBooks Introduction

Welcome to the fascinating world of open source software that is Linux. In
this book, I introduce you to the wonders of the Linux operating system,
originally created as a labor of love by Linus Torvalds in the early 1990s. My
goal is to initiate you into the rapidly growing gang of Linux users and enthusi-
asts busily rewriting the rules for the operating system marketplace.

If you have contemplated switching to Linux but find the prospect too forbid-
ding, you can relax. If you can boil water or set your alarm clock, you too can
become a Linux user. (No kidding!)

When this book appeared in its first edition, Linux was an emerging phenom-
enon that was neither terribly well known nor understood. In this edition —
for a new generation of Linux users — so much is available that I have
steered this particular title toward what Linux is and how you can make the
best use of it on your desktop. To that end, these pages contain various
online resources, tips, and tricks — as well as more general instruction.

[ keep the amount of technobabble to a minimum and stick with plain English
as much as possible. Besides plain talk about Linux installation, boot-up, con-
figuration, and tuning, I include lots of examples, plus lots of detailed instruc-
tions to help you build and manage your very own Linux machine with a
minimum of stress or confusion.

[ also include with this book a peachy DVD-ROM that contains Fedora Core 1.

About This Book

Note: At press time, Red Hat renamed its consumer-level Linux product to the
Fedora Project. Throughout the course of this book, I have tried my best to
refer to the consumer-level product as Fedora Core, and the commercial ver-
sions you have to buy as Red Hat Enterprise Linux. You’ll probably see the
product referred to as the Fedora Project in the news, on the Web, and else-
where, but you can rest assured that the different terms, as used in this book,
are referring to the same product.
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Think of this book as a friendly, approachable guide to tackling terminology
and the Linux retinue of tools, utilities, and widgets. Although Linux isn’t ter-
i to figure out, it does pack a boatload of details, parameters, and
D ro p B O Qj ivia (administrative trivia, in Unixspeak). You need to wrestle those
details into shape while you install, configure, manage, and troubleshoot a

Linux-based computer. Some sample topics you find in this book include the
following:

v Understanding where Linux comes from and what it can do for you
v Installing the Linux operating system

» Working with a Linux system to manage files and add software

v~ Setting up Internet access and surfing the Web

v Customizing your Linux system

v Managing Linux system security and resources

Although it may seem, at first glance, that working with Linux requires years
of hands-on experience, tons of trial and error, advanced computer science
training, and intense dedication, take heart! It’s not true! If you can tell some-
body how to find your office, you can certainly build a Linux system that does
what you want. The purpose of this book isn’t to turn you into a full-blown
Linux geek (that is the ultimate state of Linux enlightenment, of course); it’s
to show you the ins and outs you need to master in order to build a smoothly
functioning Linux system and to give you the know-how and confidence to
use it.

How to Use This Book

This book tells you how to install, configure, and customize a Linux system.
Although you can do most things in Linux these days by pointing and click-
ing, you still may want to try using Linux at the command prompt — where
you type detailed instructions to load or configure software, access files, and
do other tasks. In this book, input appears in monospace type like this:

rmdir /etc/bin/devone

When you type Linux commands or other related information, be sure to
copy the information exactly as you see it in the book, including upper- and
lowercase letters, because that’s part of the magic that makes Linux behave

properly.
@‘“\NG! A failure to follow instructions exactly can have all kinds of unfortunate,
8 unseemly, or unexpected side effects. If you don’t know exactly what you're

doing at the command prompt, don’t experiment for the sake of exploration —
you may come to regret your carefree departure from my instructions!
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The margins of a book don’t give you the same amount of room as your com-
puter screen; therefore, in this book some URLs and lengthy commands at

d (S'nand prompt may appear wrapped to the next line. Remember that

puter sees these wrapped lines as a single set of instructions, or as a
single URL — so if you're typing a hunk of text, keep it on a single line. Don’t
insert a hard return if you see one of these wrapped lines. I clue you in that
it’s supposed to be all one line by breaking the line at a slash mark (to imply
“Wait — there’s more!”) and slightly indenting the overage, as in the following
silly example:

www.infocadabra.transylvania.com/nexus/plexus/lexus/
praxis/okay/this/is/a/make-
believe/URL/but/some/real/ones/
are/SERIOUSLY/T1ong.htm]

Note that as you dig your way into and through this book — and other sources
of Linux wit, wisdom, and inspiration that you’re likely to encounter — you
may find some terms used interchangeably. For example, you may see the
same piece of software called a program, a command, a utility, a script, an
application, or a tool, depending on the source, the context, and the author
of the information you're consulting. To a large extent, you can treat these
terms as interchangeable, and when an important distinction needs to be to
be made among them, I'm sure to point it out. Similarly, when you’re working
with various commands or configuration controls, you may also encounter
terms such as flag, switch, option, or parameter used more or less inter-
changeably. In this case, all these terms refer to ways in which you can con-
trol, refine, or modify basic commands or programs to make them do what
you want. Again, wherever distinctions and clarifications may be needed, I
provide them!

Three Presumptuous Assumptions

They say that making assumptions makes a fool of the person who makes
them and of the person about whom those assumptions are made. (And just
who are they, anyway? I assume that [ know, but — never mind.) Even so,
practicality demands that [ make a few assumptions about you, gentle reader:

v You can turn your computer on and off.
»* You know how to use a mouse and a keyboard.
»* You want to install, configure, and use a Linux system because you’re

curious or interested or it’s your job to do so.

You don’t need to be a master logician or a wizard in the arcane art of pro-
gramming to use this book, nor do you need a Ph.D. in computer science. You
don’t even need a complete or perfect understanding of what’s going on in
your computer’s innards.

3
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If you can boot a PC or install an application on your machine, you can install,

configure, and manage a basic Linux system. If you have an active imagina-

i the ability to solve rudimentary problems, that’s even better — you
D ro p B O $ady mastered the key ingredients necessary to making Linux work

for you. The rest is mere details, and I help you with those!

How This Book Is Organized

This book contains six major parts, arranged in an order to take you from
Linux installation and configuration through keeping a Linux system up and
running, if not purring like a cat in the sun! Most parts contain three or more
chapters or appendixes, and each chapter or appendix contains modular
sections. Whenever you need help or information, pick up this book and start
anywhere you like, or use the Table of Contents and the index to locate spe-
cific topics or key words.

Following is a breakdown of the book’s six parts and what you find in each one.

Part I: Getting Your Feet Wet

This part sets the stage and includes an overview of and introduction to the
terms, techniques, and software components that make Linux the raging soft-
ware tiger that’s so ready, willing, and able do its thing. To be a little more
specific, I start out with a Linux overview that explains what Linux is, where
it came from, and how it works. Next, I tackle the various tasks and activities
involved in preparing for and installing Linux on a PC. If you're not a diehard
Fedora Core 1 fan, I also cover what’s involved in installing Mandrake and SuSE,
but in a little less detail. After that, I tell you how to give Linux the boot —
not to get rid of it by any means, but rather, to fire up your brand-new system
to reach the heights of computing ecstasy (at least, [ hope it’s as good for you
as it usually is for me)! Finally, [ help you explore standard Linux tools and
interfaces, work with accounts, and get the skinny on various aspects of
distribution-related Linux tools.

Part 1I: Internet NOW

In this part, you explore the issues involved in connecting a Linux system to
the Internet, including configuring a modem, managing a dial-up connection
to an Internet Service Provider (or ISP), and configuring the various Internet
protocols involved to make your Internet connection work. You also go
through the details involved in configuring and using a Web browser and
setting up and using an e-mail client and newsreader.
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Part I11: Getting Up to Speed with Linux

D ro p B O Q‘K%udes a great many facilities and capabilities, so after you get past
inm

installation and configuration, you probably want to use your
system to do something. Here’s where the doing begins! In this part of the
book, you can read about the Linux file system and how to work with files,
directories, and related access rights — called permissions in Linuxspeak.
You discover how to move in, out, and around GNOME and KDE, the two
major graphical interfaces (GUIs) in Linux. In addition, I include an in-depth
exploration of the Linux command-prompt environments, also known as
shells. Part Il concludes with an overview of text editors available in Linux,
office software such as word processors and spreadsheet programs, and how
to get your computer humming with Linux multimedia tools.

Part IU: Sinking Vour Teeth into Linux

In this part of the book, you delve into the Linux file system, meeting the root
(/) directory and its subdirectories, and I show you how to keep them all in
order. You also find out how to use removable media on your system, pain-
lessly. In addition, you find out about adding software to Linux, working with
the Red Hat Package Manager (RPM), and finding new software for your
system. Finally, security issues are important on any computer available to a
network, and Linux is no exception to this rule; that’s why you can also read
about what’s involved in keeping tabs on who’s messing with your machine’s
files and resources and how to plug holes and fix potential leaks.

Part U: The Part of Tens

In the penultimate part of this book, I sum up and distill the essence of what
you now know about Linux and its inner workings. Here, you have a chance
to read answers to the most frequently asked questions about Linux, visit
some key troubleshooting tips and tricks for Linux systems, and identify and
locate some cool Linux information and resources, online and in print.

Part Ul: Appendixes

This book ends with a set of appendixes designed to sum up and further
expand on this book’s contents. Appendix A delivers a comprehensive list of
Linux commands, complete with syntax and explanations, arranged in groups
according to their function. Appendix B lists details about what’s on the Linux
For Dummies, 5th Edition, DVD. As I note in this appendix, the materials on
the DVD include the Fedora Core 1 distribution.
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Icons Used in This Book

DropBo

G’ 'nSch chapter, [ use icons to highlight particularly important or useful

information. You find the following icons in this book:

The Tip icon flags useful information that makes living with your Linux
system even less complicated than you feared that it might be.

[ sometimes use this icon to point out information you just shouldn’t pass
by — don’t overlook these gentle reminders. (The life, sanity, or page you
save could be your own.)

Be cautious when you see this icon — it warns you of things you shouldn’t
do. The bomb is meant to emphasize that the consequences of ignoring these
bits of wisdom can be severe.

This icon signals technical details that are informative and interesting, but not
critical to understanding and using Linux. Skip these if you want (but please
come back and read them later).

Where to Go from Here

This is where you pick a direction and hit the road! Linux For Dummies, 5th
Edition, is much like 71001 Nights because it almost doesn’t matter where you
start out. You look at lots of different scenes and stories as you prepare your-
self to build your own Linux system. Although each story has its own distinc-
tive characters and plot, the whole is surely something to marvel at. Don’t
worry — you can handle it. Who cares whether anybody else thinks that
you’re just goofing around? [ know that you’re getting ready to have the time
of your life.

Enjoy!
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The 5th Wave By Rich Tennant
BRITEMNANT

“Think of our relationship as aversion of
Red Hat Linux — T will not ghare a
divectory onthe love—branch of your life.”
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In this part . . .

Flis part includes an introduction to the history,
development, and capabilities of the Linux operating
system. | also cover the terms and tools that make Linux
what it is, along with detailed step-by-step instructions
about what it takes to prepare your computer for Linux
and to install Linux on your very own PC. For those inter-
ested in Linux distributions other than Red Hat Linux 10,
which is included with this book, I also cover what'’s
involved in installing two other popular distributions —
namely, Mandrake and SuSE. I even explain how to config-
ure this marvelous operating system to do what you want
it to do and how to boot your brand-spanking-new system
into a powerful and productive computing colossus. After
that, you find out what’s involved in working with stan-
dard Linux tools and interfaces, working with accounts,
and various aspects of distribution-related Linux tools.
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Chapter 1

In This Chapter

Describing Linux

Telling Linux apart from the rest of the operating system pack
Depending on GNU and the GPL
Marveling at the Linux Company (or lack thereof)

Checking out popular Linux distributions

Ford, you're turning into a penguin. Stop it!

—Arthur Dent

Welcome to the world of Linux, the operating system developed by
thousands of people around the world!

Understanding Linux requires a radical shift of thought regarding the way
that you acquire and use computer software. (Note: By radical, | mean getting
to the root of the matter rather than growing your body hair and camping out
in the administration building.) Your first step toward shifting your mind-set
is to alter your general connotation of the word free to represent freedom,
rather than free lunch. That’s right, you can sell “free” software for a fee . . .
and you’re encouraged to do so, as long as you relay the same freedom to
each recipient of the software.

Don’t scratch your head too hard; these concepts are tough to grasp initially,
especially when you consider the conditioning you've received from the mar-
keting departments of the commercial software industry. Perhaps you don’t
know that when you purchase most proprietary, shrink-wrapped software,
you don’t actually own the software; rather, you're granted permission to use
the software within the bounds dictated by the licensor.

Linux also has a license, but the motives and purpose of the license are much
different than those of most commercial software. Rather than use the license
to protect ownership of the software, the GNU General Public License (GPL)
that Linux is licensed under ensures that the software will always be open to
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anyone. No company can ever own or dictate the way in which you use or
modify Linux — though they can have their own individual copyrights and
ks on their various brands of it, like Red Hat. In essence, you already
D ro p B O X, and you can use it for anything you like, as long as you propagate
the GPL freedoms to any further recipients of the software.

Linux: Revolution or Just Another
Operating System?

Contrary to popular belief, penguins are not the salvation of modern
technology. Neither do they throw parties for the urban proletariat.

—Anonymous

Author note: Cute quote . . . obviously Anonymous has never been to a
Linux convention!

Before going any further, [ need to get some terminology out of the way.

Tux is the formal name of the mascot penguin that represents Linux. Rumor
has it that Linux’s creator, Linus Torvalds, is rather fond of these well-dressed
inhabitants of the Antarctic.

An operating system is the software that runs your computer, handling all of
the interactions between you and the hardware. Whether you're writing a
letter, calculating a budget, or managing your recipes on your computer, the
operating system provides the essential air that your computer breathes.
Furthermore, an operating system isn’t just one program,; it consists of hun-
dreds of smaller programs and utilities that allow us humans to use a com-
puter to do something useful. You then run other programs on top of the
operating system, like a word processor, to get everything done.

In recent technological history, Linux has evolved from water cooler techie
chatter to a rock-solid solution for the business enterprise. The same soft-
ware that was once dismissed as rogue is now being adopted and promoted
by industry leaders such as IBM, Hewlett-Packard, Motorola, and Intel. Each
of these computer manufacturers has, in some way, determined that Linux
provides value for their customers (as well as for their own operations). The
only viable company that has publicly denounced Linux is Microsoft. Note
that one doesn’t have to look very far to conclude that Microsoft is merely
running scared from the threat that Linux poses to its personal computer
operating system monopoly.
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Drop

its rich heritage. Although programming of the
Linux core started in 1991, the design concepts
were based on the time-tested Unix operating
system.

Unix was developed at Bell Telephone Labo-
ratories in the early 1970s. The original archi-
tects of Unix created it back when there were
few operating systems, with the desire to have
one that shared data, programs, and resources
both efficiently and securely — something that
wasn't available at this time. From there, Unix
evolved into many different versions, and its
current family tree is so complicated it looks like
a kudzu infestation!

In 1991, Linus Torvalds was a computer science
student at the University of Helsinki in Finland.
He wanted an operating system that was like
the Unix system that he’d grown fond of at the

B Kéo, where did Linux come from?
0 ugersQ1 LIndX, you need to take a peek at  university, but both Unix and the hardware it ran

on were prohibitively expensive. A Unix version
called Minix was available for free, but it didn’t
quite meet his needs. So, as a computer sci-
ence student, Torvalds studied Minix and then
set out to write a new version himself. In his
own words (recorded for posterity on the
Internet), this project was, “just a hobby, won't
be big and professional like gnu.”

Writing an operating system is no small task.
Even after six months of hard work, Torvalds had
made very little progress toward the general util-
ity of the system. He posted what he had to the
Internet, and found that many people shared his
interest and curiosity. Before long, some of the
brightest minds around the world were con-
tributing to Linus’s project by adding enhance-
ments or fixing bugs (errors in the code).

Linux has been accused of being “just another operating system.” On the sur-

face, it may appear so, but if you look deeper, you can see that this isn’t so.

The Linux project is a flagship leading the current trend toward open source
and free (as in freedom, not free beer) software within the computing industry.
A rock-solid operating system because of the model under which it was (and
continues to be) developed, Linux represents much that is good and pure in

software development.

Two fundamental distinctions separate Linux from the rest of the operating

system pack:

v Linux is licensed under the unique and ingenuous GNU General Public
License, which you can read about in the next section.

v Linux is developed and maintained by a worldwide team of volunteer
programmers, working together over the Internet.

11
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Linux is great for many reasons, including the fact that the folks who built it
from the ground up wanted it to be

DropBooks

iuser: More than one user can be logged in to a single computer at
one time.

v Multiprocess: True pre-emptive multitasking enables the operating system
core to efficiently juggle several programs running at once. This is impor-
tant for providing multiple services on one computer.

v Multiplatform: Linux currently runs on 24 platforms (hardware types),
including Intel-based PCs, Digital/Compaq Alpha, PowerPC-based Apple
Macintosh, Sun SPARC, Amiga, and StrongARM-based computers.

v Interoperable: Linux plays nice with most network protocols (languages)
and operating systems, allowing you to interact with users and computers
running Microsoft Windows, Unix, Novell, both Mac OS 9 and OS X, and
other, more niche groups.

v~ Scalable: As your computing needs grow, you can rely on Linux to grow
with you. The same Linux operating system can run on a desktop com-
puter or a very large, industrial strength server system.

v Portable: Linux is mostly written in the C programming language. Cis a
language created specifically for writing operating system-level software
and can be readily ported (translated) to run on new computer hardware.

v Flexible: You can configure the Linux operating system as a network
host, router, graphical workstation, office productivity PC, home enter-
tainment computer, file server, Web server, cluster, or just about any
other computing appliance that you can think of.

v~ Stable: The Linux kernel (the operating system itself) has achieved a
level of maturity that makes most software developers envious. It’s not
uncommon to hear reports of Linux servers running for years without
crashing.

v~ Efficient: The modular design of Linux enables you to include only
those components that you need to run your desired services. Even
older Pentium computers can utilize Linux and become useful again.

v Free!: To most people, the most intriguing aspect of Linux is the fact
that it’s often free. How (the capitalists murmur) can anyone build a
better mousetrap with no incentive of direct monetary return?

In this chapter, | intend to answer that last question for you. I also hope to
paint a picture of the open source software development model that created
Linux.
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Anatomy of an Open Source
Drop&B@asrroject

Linux isn’t a product. Linux is an organic part of a software ecosystem.

—Michael Robinson, Netrinsics

To the casual observer (and some corporate IT decision-makers), Linux
appears to be a freak mutation — a rogue creature randomly generated by
anarchy. How, after all, can something so complex and discipline-dependent
as a computer operating system be developed by a loosely knit band of vol-
unteer computer geeks from around the world?

Just as science is constantly attempting to classify and explain everything in
existence, technology commentators are still trying to understand how this
open source model can create superior software. Often, the reasons have
much to do with the usual human desire to fill a need with a solution. When a
programmer in the Linux world wants a tool, the programmer simply writes
one or bands together with other people who want a similar package to write
it together.

GNU who?

Imagine — software created out of need rather than projected profit. Even
though Unix ultimately became expensive proprietary software, the ideas and
motives for its creation were originally based on need. What people usually
refer to in the singular as the Linux operating system is actually a collection of
software tools that were created with the express purpose of solving specific
computing problems.

Linux also wouldn’t be possible without the vision of a man whom Steven
Levy (author of the book Hackers) refers to as The Last of the Great MIT
AI-LAB Hackers. This pioneer and advocate of freedom software is Richard
Stallman.

The Massachusetts Institute of Technology (MIT) has long held a reputation
for nurturing the greatest minds in the technological disciplines. In 1984,
Stallman, a gifted student and brilliant programmer at MIT, was faced with a
dilemma — sell his talent to a company for a tidy sum of money or donate his
gifts to the world. He did what we’d all do . . . right?
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Stallman set out on a journey to create a completely free operating system
that he would donate to the world. He understands and continues to live the

O{ i gacker ethic, which declares that “information wants to be free.” This

ew concept in his time. In the early days of the computing industry,
many advancements were made by freely sharing ideas and programming
code. Manufacturer-sponsored user groups brought the best minds together
to solve complicated problems. This ethic, Stallman felt, was lost when com-
panies began to hoard software as their own intellectual property with the
single purpose of profit.

As you may or may not have gathered by this point, widespread and accessi-
ble source code is paramount to successful software development. Source
code is the term for the human-readable text (as opposed to the unreadable
ones and zeros of binary code or an “executable”) that a programmer types
to communicate instructions to the computer.

Writing computer programs in binary is an extremely arduous task. Modern
computer software is usually written in a human-friendly language and then
compiled, or translated, into the computer’s native instruction set. To make
changes to this software, a programmer needs access to a program’s source
code. Most proprietary software comes only as precompiled, and the software
developer keeps the source code for those programs under lock and key.

After determining that his operating system would be built around the con-
ceptual framework of Unix, Stallman wanted the project name to distinguish
his system from Unix. So, he chose the recursive acronym GNU (pronounced
ga-new), which means GNU’s Not Unix.

To finance the GNU project, Stallman organized the Free Software Foundation
(FSF), which sold free software to help feed the programmers who worked on
its continuing development. (Remember, we're talking free as in free speech,
not free beer.) Although this organization and goal of creating a complete oper-
ating system was necessary and important, a much more important piece

of the puzzle had to be put into place to protect this new software from big
business pirates — a concern still all too relevant today as a former Linux
company tries to hijack ownership of decades of volunteer work from thou-
sands of people around the world.

The GNU General Public License (GPL) is a unique and creative software license
that uses copyright law to protect the freedom of the software user, which

is usually the opposite of how a copyright works. Generally, a copyright is

an enforceable designation of ownership and restriction from duplication by
anyone but the copyright holder. When software is licensed under the GPL,
recipients are bound by copyright law to respect the freedom of anyone else
to use the software in any way they choose. Software licensed with the GPL is
also known as copyleft software. Another way to remember the GPL is through
its ultimate result: Guaranteed Public for Life.
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Who's in charge of Linux anyway?

D ro p B O ng'%n source project evolves, various people emerge as leaders. This
ead

often known as the project’s benevolent dictator. A person who
becomes benevolent dictator has probably spent more time than anyone
else on a particular problem and often has some unique insight. Normally, the
words democratic and dictator are never paired in the same sentence, but the
open source model is a very democratic process that endorses the reign of a
benevolent dictator.

Linus Torvalds is still considered the benevolent dictator of the Linux kernel
(the operating system’s core). He ultimately determines what features are
added to the kernel and what features aren’t. The community trusts his vision
and discretion. In the event that he loses interest in the project, or the com-
munity decides that he has gone senile, a new leader will emerge from amongst
the very competent people working with him.

Einstein was a volunteer

Someone who is a volunteer or donates their time to a project isn’t necessar-
ily providing a second-rate effort or only working on weekends and holidays.

In fact, any human resource expert will tell you that people who choose to do
a job of their own free will produce the highest quality products.

The volunteers who contribute to open source projects are often leaders

in their field who depend on community collaboration to get useful work
done. The open source concept is no stranger to the scientific community:.
The impartial peer-review process that open source projects foster is critical
in validating something as being technically correct.

Those who paint the open source community as copyright violators and
thieves often misunderstand or outright ignore these vital issues. Open source
programmers are very proud of their work and are also very concerned about
their own copyrights, not wanting their work to be stolen by others — hence
licenses such as the GPL. This concern creates an atmosphere with the great-
est respect for copyright. Those who claim that they are just being “open
source” when they steal other people’s hard work are grossly misusing the
term to soothe their own consciences.

Many have also pointed out that if copyright is violated in open source, it is
easy to tell. Watch the news and notice how often large software corporations
are convicted of stealing other people’s code and incorporating it into their
own work. Tracking down such copyright violations is incredibly difficult in a
closed source scheme.

15
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G’ gxple call a Linux distribution is actually the culmination of the GNU

project’s tools, the Linux kernel, and any number of other open source (and
closed source) software projects that sprang up along the way.

Robert Young, cofounder and current chairman of Red Hat, has coined an
analogy comparing Linux to ketchup. Essentially, the operating system called
Linux, with the GNU tools, Linux kernel, and other software, is a freely avail-
able commodity that, like ketchup, different distributors can package and label
in different containers. Anyone is encouraged to package and market the stuff,
even though the ingredients are fundamentally the same.

Linux is a complex, malleable operating system, and thus it can take on many
appearances. The greatest Linux advancement in recent years has been making
it easier to install. After all, the tools that today enable the casual PC user to
install Linux originally weren’t available. Companies such as Red Hat saw this
as an opportunity to add value to an existing product, and the concept took
off like gangbusters.

To draw again on the ketchup analogy, various distributions of Linux have a
slightly different flavor or texture; your distribution preference may be spicy,
mild, thick and gooey, or runny. However, you can rest assured that any of the
following distributions have the same Linux and GNU heart and soul. Each
short description includes a Web address where you can find more informa-
tion about each project:

v Debian GNU/Linux: This distribution is one of the oldest and is a recog-
nized favorite among advanced technical circles. Historically, it’s relatively
difficult to install. The Debian team works closely with the GNU project
and is considered the most “open” of the Linux distributions. An easier
to install (and use) distribution with Debian underneath is Xandros.

www.debian.org
www . xandros.com

» Mandrake: This distribution demonstrates the power of the GPL by
allowing this competing company to stand on the shoulders of giants.
Mandrake was originally based on Red Hat Linux, something that simply
could not happen in a closed source environment, but has since become
an excellent solution in its own right.

www.mandrakelinux.com

+ Red Hat and Fedora: Red Hat claims the prize for successfully mass
marketing the Linux operating system. Red Hat has validated Linux by
packaging the GNU and Linux tools in a familiar method of distribution
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(shrink-wrapped) and has included value-added features to its product,
such as telephone support, training, and consulting services.

DropBooks;:::
p://fedora.redhat.com/
P I base all the examples in this book on Fedora Core 1, which is the free
version of Red Hat’s distribution. Fedora Core 1 is included on the DVD-

ROM that comes with this book. I show you how to install Fedora Linux
in Chapter 3. However, I try to cover Linux in general in this book.

v Slackware: Of all the more recognized surviving Linux distributions,
Slackware has been around the longest. In fact, until about a year ago,
the installation interface remained unchanged. Slackware has a very
loyal following, but isn’t well known. Like Debian in terms of spirit, the
Slackware crowd is respected in Linux circles as the weathered old-timers
who share stories of carrying around a shoebox full of diskettes.

www.Slackware.com

v SuSE: (Pronounced soo-za) This distribution hails from Germany, where
it has a very loyal following. SuSE works closely with the XFree86 project
(the free X graphical server component of all Linux distributions).
Consequently, SuSE has a terrific graphical configuration tool called SaX.

wWww.suse.com

As you can see, many paths (in the form of distributions) lead to Linux. It’s
important to note that, regardless of which distribution you choose, you're
using the same basic ingredients: the GNU tools and the Linux kernel. The
major differences that you’ll encounter among distributions are

v Installation programs: Each distribution has developed its own installa-
tion program to help you achieve a running system. Some installation
programs are designed for the casual computer user (hiding the techni-
cal details), whereas others are designed with the seasoned system
administrator in mind. Some of the simpler ones offer an “expert mode”
for those who want to have more control right from the beginning.

1 Software versions: Different distributions may use different versions of
the kernel (the core of the operating system) and other supporting soft-
ware packages. Open source projects are dynamic and release new ver-
sions regularly, as opposed to the often sluggish development cycle of
traditional commercial software.

v Package managers: Even though one Linux program should be able to
run on any distribution, tools called package managers keep track of the
software on your system and ensure that you have all the required sup-
porting software as well. Distributions are usually dependent on one par-
ticular package manager. Chapter 15 provides more information about
package managers.

17
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It would be impossible to account for every possible installation of every
Linux distribution. Okay, maybe not impossible, but you would need a forklift
i our Linux For Dummies book home from the bookstore if I did.
egntly, [ try to summarize the concepts needed to install any Linux
distribution into this one book without detailing each. As you can imagine,
this is a bit of a challenge!

I chose Fedora Core 1 as the sample distribution because Red Hat has become
arecognized Linux standard, and its Fedora Core project is specifically aimed
at home and small business users who cannot afford or have no need to pur-
chase higher-level products. Even better, if you do use Red Hat Enterprise
Linux (RHEL) in your office or organization, Fedora Core is a proving ground
for the technologies that will make their way into RHEL.

In addition to Red Hat coverage, I also include information about two other
popular distributions: in particular, Mandrake and SuSE. I certainly don’t wish
to discount Slackware and Debian because these are very powerful distribu-
tions. I just feel that they are more advanced than the others and best left for
your post-Linux For Dummies endeavors.



Chapter 2

PrOP B ing Your Computer for Linux

In This Chapter

Taking basic preinstallation steps

Using Linux and Windows on the same computer
Customizing disk partitions before installation
Knowing (and finding) your hardware information
Preparing for CD or floppy disk installation

M ost current Linux distributions automatically detect your hardware
and guide you through the installation process. In fact, some people
just dive right in and start installing. However, if you're setting up a machine
that will run both Windows and Linux (although not at the same time), don’t
leap in without at least reading the section “Preparing to Use Linux and
Microsoft Windows Together,” later in this chapter. You need to make sure
that you have the space to install Linux and that you don’t accidentally wipe
out your Windows installation.

Other people like to start with a bit more caution. You can save yourself poten-
tial headaches — or make it easier to troubleshoot technical problems — by
becoming familiar with your computer’s hardware.

You should watch out for several issues when preparing to install Linux. In
this chapter, I address the tasks that prepare you for the Linux installation
process, such as setting up your system to install Linux directly from the
DVD or CD, or with an installation floppy disk, if you end up needing one.

Installation Considerations

You got to be careful if you don’t know where you are going, because you
might not get there.

—Yogi Berra
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If you have a spare machine that’s only going to run Linux and nothing else,
you're in luck! You can skip all of the “Preparing to Use Linux and Microsoft

d Together” section. In fact, if you're feeling brave, you might want to

to Chapter 3 and start your installation. There’s troubleshooting
information in Chapter 19, as well.

If you plan to run both Linux and Microsoft Windows on the same computer —
a scenario called dual booting — DO NOT PROCEED TO CHAPTER 3 without
reading the section, “Preparing to Use Linux and Microsoft Windows Together.”
Sorry for yelling, but you can wipe out your whole Windows installation if
you don’t take some precautions!

Preparing to Use Linux and Microsoft
Windows Together

\\3

If you're planning to run Linux and Microsoft Windows on the same machine,
the odds are that you've already got Windows installed and have been using
it for some time. Because [ hate to hear screams of anguish all the way up
here in western Canada, take a moment to assess what you have and what
you need to do.

On the off chance that you actually don’t have Windows installed yet, you’ll
want to install it before you install Linux. Otherwise, during installation,
Windows will overwrite the part of your hard drive that Linux uses to store
its boot menu. This can create a bit of a mess later when you want to boot
back into Linux! Those who are installing Windows should skip down to the
section “Working with Disk Partitions,” to learn how to set up your Windows
installation so that it causes the least amount of fuss when it’s time to add
Linux.

The majority of you, however, want to dual boot because you've got one
machine and it’s already running Windows. If you have a brand new hard
drive to work from that has nothing on it already, skip down to the section I
just mentioned (“Working with Disk Partitions”). You won’t need to do any-
thing funny with the hard drive that Windows is using. However, if you need
Linux and Windows to share the same hard drive and already have Windows
installed, you have a bit of extra work to do. The rest of this section focuses
on getting you through both of these processes.
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Removable hard drives

amQIthlzﬁéultiple operating systems

is the removable rack hard drive. The installa-
tion entails placing a special carriage into one
of your computer’s hard drive bays. This setup
can be installed in most computers by an expe-
rienced individual or a qualified technician.

After this component is installed, you can place
individual hard drives into the carriage, plugging
them in and pulling them out as you might do
with a CD-ROM — although you wouldnt want
to justyank one out in the middle of doing some-
thing on your machine! Using a removable rack
hard drive setup allows you to have a separate
Windows drive and Linux drive. When you're
using Windows and want to switch to Linux, you
shut down Windows and pull the drive out. Then
you replace it with the Linux drive and boot as
though the Linux drive were always there.

If you're nervous about managing multiple oper-
ating systems and don't have room for a second
hard drive in the machine, this is a great alter-
native. You'll need to make sure that your exist-
ing hard drive can fit in the rack, as well as the
new one, and it's wise to buy more than one
loading chassis (used to slide the drive into the
rack) so you can just leave your drives in the
chassis when they're not in the machine.

For more information, see PC Hardware in a
Nutshellfrom O'Reilly & Associates.

If you're new to computer hardware, | strongly
recommend that you seek assistance or have a
technician install an additional hard drive or
removable rack setup for you. Improper handling
of computer components can damage your com-
puter. In addition, you must keep safety in mind
when working with electrical components.

Peeking at your disk space in Window's

21

2000 and Windows XP

If you need Windows and Linux to share the same hard drive, you and I need
to take a look at your disk space before we can continue. Windows 2000 and
XP operating systems use accounts to control and secure the files and fold-
ers. To get information about the computer’s disk space usage, you need to
be logged on to the system as the Administrator or with an account that has
administrative permissions. In Windows 2000/XP, you use the Computer
Management application in the Administrative Tools collection to find the
details of the computer’s hard drive usage. Follow these steps:

1. Open the Control Panel by choosing Start->Settings->Control Panel.

2. Open the Administrative Tools folder and double-click the Computer
Management icon.
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3. In the left pane of the Computer Management application, click the
Disk Management folder icon.

in a few seconds, the right pane displays the current status of the

D ro p B O O K’S;ge devices on your computer, such as the hard drive(s), CD drives,

DVD/CD drives, and so on. Figure 2-1 is an example of the Windows XP
Disk Management display, and Figure 2-2 shows the Windows 2000 Disk
Management interface.

|
Figure 2-1:
Disk Man-
agement
information
within the
Windows XP
Computer
Manage-
ment tool.
|

|
Figure 2-2:
Disk Man-
agement
information
within the
Windows
2000
Computer
Manage-
ment tool.
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Figure 2-2 reflects a computer that has one hard drive and one DVD/CD drive.
The hard drive is divided, or partitioned, into four pieces. Of these four

idc ree are in use, and one portion is free. In the Disk Management tool,

AL labeled Primary or Extended are sections of the drive that have

already been assigned to an operating system, such as Windows. In Figure
2-2, the section identified as Unallocated is not assigned to any operating
system and is free. This Unallocated portion could be used to install Linux
since this portion is more than 3GB (you want plenty of room for programs
and files, right?) and not assigned to another operating system.

Make a note of which partition is marked as Unallocated. You’ll need this
information later. Also, if you see NTFS (NT FileSystem) listed as a partition
type, make note of this as well.

Checking your disk space in Windows 98

If you need Windows and Linux to share the same hard drive, [ need you to
do some detective work before | move on. Windows 98 does not provide a
graphical tool like Computer Management. Instead it uses FDISK, which is a
command-line tool that indicates the partitions on your hard drive. To find out
the details about computer’s hard drive in Windows 98, follow these steps:

1. Open an MS-DOS prompt window by choosing Start=>Programs->
MS-DOS Prompt.

2. Enter FDISK and press Enter.

In Windows you can enter FDISK in uppercase, lowercase, or any mixed
case you like as long as you spell FDISK correctly!

Depending on the size of your hard drive, you may be prompted to dis-
play large disk information. If you don’t see the prompt, the FDISK menu
options appear similar to the ones shown in Figure 2-3.

3. If you see the large disk prompt, choose Y at this prompt and then
press Enter.

The FDISK menu options appear.
4. Display the current drive partition information.

If you have more than one hard drive in your computer, FDISK displays
a fifth menu choice to change between disks. To change to another disk,
type 5 and press Enter. The FDISK screen displays all the hard drives in
your system. Type the number of the disk you want and press Enter. The
top of the FDISK menu screen displays the number of the drive that FDISK
is working with.
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"5 MS-DOS Prompt - FDISK

[ eao = e i Al
Hicrosoft Windows %8

Fixed Disk Setup Program
(C)Copyright Microseft Corp. 1983 - 1998

FDISK Options
Current fixed disk drive: 1
Choose one of the following:
1. Create DOS partition or Logical DOS Drive

2. Set active partition
3. Delete partition or Logical DOS Drive
b

| - Display partition information
Figure 2-3:
FDISK Enter choice: [ ]
menu
0pt|0n3. Invalid entry, please enter 1-4.
— Press Esc to exit FDISK

5. To display partition information for the disk number displayed, type 4
and press Enter.

Figure 2-4 shows an example of the Display Partition Information screen
within FDISK.

The disk information shown in Figure 2-4 indicates that no free, unallo-
cated disk space is on the drive. If the disk had unpartitioned space,
FDISK would display the amount of space available.

However, in Figure 2-4, you see that a portion of the disk space is config-
ured as an extended partition EXT DOS. Extended partitions can contain
what’s called logical partitions, so it’s possible that there might be free
space available inside the extended partition that you could use to
install another operating system, like Linux, or even another type of
Windows.

"% MS-DOS Prompt - FDISK [_ O x]

e = piElel B /= Al

Display Partition Information
Current fixed disk drive: 1

Partition Status Type Uolume Label Hbytes System Usage
| | (] FR (1%

1 00§ 3004  FaT32
2 EXT DOS 3467 542
I
Total disk space is 6471 Hbytes (1 Mbyte = 1048576 bytes)

Figure 2-4:

e The Extended DOS Partition contains Logical DOS Drives.

Partition Do you want to display the logical drive information CY/HI...... 211

information
in FDISK.

— Press Esc to return to FDISE Options
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P Think of primary partitions as empty boxes that you put data into.
Extended partitions are those annoying boxes that have a collection of
ller boxes stacked next to each other inside. You only put data into
ro O smaller boxes with an extended partition. These smaller boxes are
the logical partitions.
Unfortunately, FDISK doesn’t tell us anything about what’s inside this
extended partition. You’ll have to dig deeper.
6. To view the logical partitions within the extended partition, select
the EXT DOS entry and press Enter.
Figure 2-5 is an example of a logical partition setup. In this case, all space
within the extended partition is currently assigned. If free space were
available, FDISK would list how much. If it’s 3GB or more, then installing
Linux in there will be a breeze.
& M5-DOS Prompt - FDISK
o 5 Cili @] B 2/5 Al
Display Logical DOS Drive Information
Drv VYolume Label Mbytes System Usage
D: DATh 367 FAT32 100%
|
Figure 2-5:
LOgica| driVe Total Extended DOS Partition size is 3467 Mbytes (1 MByte = 1048576 bytes)
information
in FDISK.
— Press Esc to continue
A\

If you have free space available, make note of the names of all of your parti-
tions. You'll need this information later. Also, if you see NTFS (NT FileSystem)
listed as a partition type, make note of this as well.

If all the hard drive space is assigned to Windows and no unallocated space is
available, you've got a problem. Fortunately, it's not impossible to solve!

Take a look in your Windows installation to see how much of your drive space
you're really using. You can actually buy tools that can resize (decrease) the
size of your Windows partition, and then open up a free partition to install
Linux or another operating system within. Tools such as Partition Magic pro-
vide an easy way to resize and work with the partitions on your hard drives.
You can find information about Partition Magic from the company’s Web site
at www.powerquest.com. You can read more about partitions — including the
free alternative to Partition Magic — in the next section, “Working with Disk
Partitions.”
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Working with Disk Partitions

DropBo

gMBER

a\\S

Q g:tion “Preparing to Use Linux and Microsoft Windows Together,” at

the beginning of this chapter, I discuss setting aside disk space for Linux on a
computer already running Windows. The techniques I cover here assume that
your system’s hard drive contains space that is not already assigned to
Windows or that there’s enough free space to reorganize things and give it to
Linux.

Choosing a partitioning tool

If you already have an existing operating system, such as Windows, on your
drive(s), and you want to keep them, you will need to resize those before you
install Linux. (Those who have plenty of unallocated space or a separate,
empty hard drive can skip to the section “Assessing Your Computer” later in
this chapter.)

As I said earlier, long as you either have 3GB of disk space or more available,
or your existing Windows installation can give up about 3GB of disk space,
you've got it made. If not, seriously consider a cheap hard drive for your Linux
installation.

This is unfortunately the tricky part. If Windows has all of your hard drive
space, you'll need to resize that existing Windows installation so you can
have some of your space back. Before going any further, make a backup of
anything you don’t want to lose off your Windows installation! Things can go
wrong during the various steps of this process, even when using Windows
tools on Windows.

Perhaps the easiest and safest way to adjust your existing partitions is through
the use of commercial programs, such as Partition Magic. Partition Magic
enables you to view the partition information for your hard drive or drives.
The utility also includes the ability to resize, move, and add partitions.

You can also use a free utility that comes with this book, on the included
DVD: FIPS. See the section “Resizing partitions safely with FIPS” later in this
chapter for more.

If you create an open partition using Partition Magic, after resizing your
Windows partition, make a note of the name of that partition. You'll need
it later.
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Partitioning from scratch for a dual boot

D ro p B O Qkﬁn to take a fresh hard drive and install both Windows and Linux on
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e to install Windows first. While you’re going through the installation,
you will be asked to partition your drives. Your hard drive can have three pri-
mary partitions and one extended partition. Inside that extended partition,
you can have up to 12 logical partitions.

Make sure that you leave either a whole extended partition of at least 3GB
available for Linux, or at least part of an extended partition with a minimum
of two logical partitions available inside, for a total size of at least 3GB.

Make a note of the partition you leave open. You'll need this information later.

Resizing partitions safely with FIPS

Probably the most common free disk partition modification program out there
is FIPS (First nondestructive Interactive Partition Splitting program). Most
Linux installation media contains this program, and your DVD is no exception.

On the Fedora Core 1 DVD  or the first CD — that comes with this book,
FIPSisin the /dosutils directory. In that directory, you find two subdirec-
tories for FIPS — /fipslbcand /fips20. The /fips20 directory contains
the most recent version of FIPS and its documentation.

As the name implies, FIPS enables you to modify your disk partitions without
destroying existing data or operating systems. Again, be sure to make a backup
of your existing files and important data before using FIPS!

Also, I highly recommend that you read through the documentation on the
DVD — or first CD — before attempting to use FIPS. You'll find it in the
/dosutils/fipsdocs/fips.fagqfile.

FIPS does not work on NTFS partitions. If you've used NTFS, you will need to
purchase Partition Magic to resize those partitions, or a separate hard drive
you can start from scratch on with Linux.

If possible, have the FIPS documentation in front of you before proceeding.
To set up and use FIPS, follow these steps:

1. Insert a DOS bootable floppy disk into the disk drive.
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2. On a system running DOS or in a MS-DOS/Command window in

Windows 98, type format a: /s at the command prompt and press
r. On a Windows 2000/XP system, skip the format command and
the files boot.ini, nt1dr, and ntdetect.com from the root folder
(for example, C:\) to the floppy disk. In addition, if you see the files
bootsect.dos or ntbootdd.sys on the Windows 2000/XP system,
copy those files to the floppy disk.

In the FORMAT command, the a: refers to the drive letter of your floppy
drive — insert the appropriate drive letter on your system if yours isn’t
a:. The /s copies the necessary files to the floppy to make it bootable.

. Copy the following files from the /fips20 directory to the floppy disk:

e restorrb.exe
e fips.exe
® errors.txt

If you're using Windows, you can use Windows Explorer to copy the
files to the floppy disk. For DOS or in a MS-DOS/Command window
under Windows, you can use the XCOPY or COPY command.

. Defragment your hard drive.

Before using FIPS, you must defragment your hard drive. Windows
includes a defragmentation utility, so let’s use that. The defragmentation
utility shuffles around your files so that they occupy the beginning of a
partition’s storage area. This frees up unused space at the end of the
partition so that you can shrink it. If you don’t defragment your hard
drive, shrinking the partition will destroy the data on it.

Perform the following steps to defragment your partitions:
a. Choose Start=>Run.
b. Type defrag in the Open field and click OK.
The utility dialog box opens.
c. Select your drive or drives and click OK.

Depending on the size of your hard drive, the number of files, and
how much the drive is already fragmented, defragmentation may
take a long time. A long time may translate to hours. | recommend
that you start this task in the evening and allow defragmentation to
occur overnight.

. Reboot your machine with the bootable FIPS disk you created in

Steps 1 through 3.

Make sure you reboot and run from the floppy. Do not use FIPS within
an MS-DOS/Command window in Windows.
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6. After the system reboots to DOS, type FIPS at the command prompt
and press Enter.

D ro B O O Kﬁinitial screen that you see contains information about some FIPS
ions. After reading the information, press any key to continue.

|
Figure 2-6:
Example of
the FIPS
utility.

If your system has more than one drive, the utility presents the drives
and asks you to select one.

7. Type the number that corresponds to the drive whose partitions you
want to modify.

The screen displays the partition table for the drive that you selected,
and FIPS asks for a partition number, as shown in Figure 2-6.

8. At the bottom of the screen, type the number that corresponds to
the partition that you want to split.

The screen displays information about the partition you've selected.

At the bottom of the screen, the application asks whether you want to
make a backup copy of your root and boot sectors before proceeding. If
you choose to make a backup, you can go back and undo the partition
split. Having this backup also enables you to restore your partition
architecture if you have a problem using FIPS.

9. Insert a blank formatted disk into the disk drive and type Y.

10. Use the arrow keys on the keyboard to adjust the size of the two
partitions to the values that you want and press Enter.

FIPS asks if you want to continue or edit the partition table.

File Power Seftings Devices View Help

hﬂ NOT use FIPS in a multitasking environment like Hindows, 05-2, Desgview,
NHovell Task manager or the Linux DOS ermulator: boot from a DOS boot disk first.

If you use 05/2 or a disk compressor, read the relevant sections in FIPS.DOC.
F IPS comes with ABSOLUTELY NO WARRANTY, see file COPYING for details

This is free software, and you are welcome to redistribute it

nder certain conditions; again see file COPYING for details.

Press any Key

Partition table:

H H Start H H End i Start iHumber of!
[Part. ibootableiHead Cyl. SectoriSystemiHead Cyl. Sector: Sector iSectors | MB
1 yes | 1 8 1: B6hi 63 587 631 63 20848193:16800
2 no | 8 588 1: 83hi 63 634 631 2848256: 512864 258
3 no | 8 B35 1: B5hi 63 1822 631 2568328 1564416: 763
4 no a a a: 8ah! a a a: a: :H a
Checking root sector ... OR

Ilhich Partition do you want to split (1-2,3)7 _
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11. If you're satisfied with your changes, type C.

At the bottom of the screen, the application asks if you want to write the
O kl partition information to disk.

DropBo
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12. To apply the changes and exit the application, type Y; to ignore the
changes and exit the application, type N.

Make a note of the particular partition you create. You'll need this information
later.

Running Windows and Linux together

When you install Linux on a system that has Windows already installed, you
can run only one operating system at a time. In other words, if you're using
Windows and you want to run Linux, you need to shut down Windows, allow
the computer to reboot, and then start Linux. Figure 2-7 shows the startup
environment for a system that has Linux and Windows installed.

However, with the use of additional software, you can run Linux on a Windows
system at the same time Windows is running. You can also run Windows soft-
ware within Linux itself! See Chapter 15 for more information.

GRUB uversion B.93 (638R lower ~ 26BH3ZH upper menoris)

Fedora Core (2.4.22-1.2861.nptl)
Hindous XP

|
Figure 2-7:

Dual-boot
Startup Use the T and ¢ keys to select which entry is highlighted.

Press enter to boot the selected 05, ‘e’ to edit the
screen for conmands before booting, ‘a’ to modify the kernel arguments
a system before booting, or ‘c’ for a command-line.
with Fedora
Core 1and
Windows
XP installed.

Fedora
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Assessing Your Computer
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@ @dware these days works just fine with Linux. Sometimes, if you have

the very latest whiz-bang video card or some other fancy new type of electron-
ics, there might be some trouble, so if you're an early-adopter sort of person,
you’ll want to go to your distribution’s hardware compatibility list and make
sure you're covered. Fedora Core’s list is available at http://hardware.
redhat.com/hc1/. Hardware does not need to be listed as Certified. Supported
will do just fine.

If you're new to computers or aren’t that familiar with hardware definitions
and details, you can find a lot of information on the Internet. (One good Web
site is www. tomshardware.com.)

If your hardware isn’t listed, don’t panic. You might not be able to use the
very latest features of your latest-generation video card, but you will be able
to use it as a generic SVGA at the very least. All is not lost. In fact, sometimes
older hardware is left off the lists but is still supported. Often you're better
off with slightly older hardware than with the latest and greatest. If you can’t
find your hardware listed, do a Web search on the make and model of the
hardware, plus the word linux.

Sometimes you’ll find that drivers have been released for your hardware after
this particular version of Linux came out. Make sure that you've obtained these
drivers before installing Linux, whether you download them and save them
onto a floppy disk, or they come on a floppy or CD with the hardware itself.

Also, try to have your computer manuals (especially the ones for your video
card and monitor) handy, just in case you need them in order to answer a
question asked by the installer — most people won’t have to deal with this

at all, but some will. At the very least, make sure that you know exactly what
video card you have in your machine. You might find this information on your
receipt, or you can track much of this information down by making smart use
of your existing Windows installation. I'll show you how in a moment.

If you don’t want to deal with this right now, skip to the section “Finally,
Preparing for Your Installation” later in this chapter. Then, if the installer needs
additional information from you later, you can either find what you need on
the Internet or boot back into Windows and do your detective work before
re-starting the installation.
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If you can’t find the information about what’s in your computer that easily,
you have the following options:

D ro p B O Okl@an existing operating system to document your hardware. If your

computer is already running Windows, you can collect a lot of informa-
tion from the Windows environment. Use one of the following methods,
depending on your system:

e In Windows 98, select Startr>Settings=>Control Panel=>Systemr>
Device Manager to access the dialog box shown in Figure 2-8.

¢ In Windows 2000, select Start=>Control Panel=>Systemr>Hardwarer>
Device Manager to access the list of hardware installed on your
machine, as shown in Figure 2-9.

¢ In Windows XP, select Start=>Control Panel=>Printers and Other
Hardware. Here, you can select one of the items from the dialog
box under “or Pick a Control Panel Icon,” or you can look to the
“See Also” section and select System. If you choose System, from
there it’s Hardwarem>Device Manager (Figure 2-10).

If you don’t want to deal with this right now, skip to the section “Finally,
preparing for your installation” later in this chapter. Then, if the installer
needs additional information from you later, you can either find what you
need on the Internet or boot back into Windows and do your detective
work before re-starting the installation.
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Each of the items within the Device Manager can be double-clicked to
display the corresponding details.

System Properties HE
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-7 Mouse
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The
Windows
2000 Device

Manager.

- &l Display adapters

DYDYCD-ROM drives

[+-52 IDE ATAMATAPI controllers

-6 Keyboards

Mice and other pointing devices
-3 Monitors

- B Metwork adapters

[ Ports (COM & LPT)

=-<}= Sound, video and game controllers

= ATI WDM Rage Theater Audio

- ATI WDM Rage Theater Video
ATI WDM Specialized MYD Codec
ATI WDM Specialized PCD Codec
ATIWDM TV Audio Crossbar
ATIWDHM TY Tuner

Audio Codecs

Hauppauge WinTY PYR PCI I (Encoder/Decoder)
Legacy Audio Drivers

Legacy Video Capture Devices
M-fudio Resvolution

Media Control Devices

= video Codecs

- System devices

% Universal Serial Bus controllers

v Download PC hardware detect tools. If you don’t have any diagnostic
tools and you have a relatively current version of DOS, you can download
various PC hardware detect tools, such as PC-CONFIG, from the Internet.

The PC-CONFIG tool contains several screens of information and menus
to choose hardware areas and options. This tool is shareware, and the
usage and fee information is available from the Holin Datentechnik Web
site (www.holin.com).

v Gather information by reading the screen when the computer starts.

If your system doesn’t contain any operating systems and you don’t
have any of your system’s documentation, you can resort to reading
the screen as your computer starts. On some systems, the video infor-
mation is displayed as the computer boots. You may have to reboot
several times to read the information if it goes by too fast. Also, some
systems display the PCI components and their settings as the system is
starting up. Again, you may need to reboot several times to gather all
the information.

1 Access the Basic Input/Output System (BIOS) information. Stored

in a small area of memory and retained by a battery, this is sometimes
referred to as (Complementary Metal-Oxide Semiconductor) CMOS, which
indicates the type of computer chip that can store and retain information.
The amount of information stored in the BIOS can be very little to quite
a lot. Some newer systems may display several screens of information
about the computer’s hardware.

Chapter 2: Prepping Your Computer for Linux
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To access the BIOS, you need to do so before any operating systems load.

Most manufacturers indicate the keyboard key or key sequence to get into
I0S, or Setup, on the screen when the system is starting up — for
D ro p B O O eSZple, Press Del to enter Setup.If you can’t find the keyboard
sequence, check the manufacturer’s Web site. After you've entered the

BIOS, you typically navigate around with the arrow keys, Tab key, or Enter

key. In some BIOS environments, the function keys are also used. Look
for a list of function key options on the top or bottom of the screen.

N You especially need to be cautious of labels on hardware boxes and Web
sites that include the term Win (as in Windows). These components, such as
WinModem, don’t contain all the configuration and software in the hardware —
even worse, there might be nothing on the packaging that suggests this limi-
tation. These components are designed to use the Windows operating system
to handle some of the load. Only a very slight chance exists that you can find
a Linux driver for Win hardware. If you do find one, copy it to a floppy before
installing Linux. If you can’t find a driver and you need to use a modem, put
down a little cash and get a modem that is supported properly. For more infor-
mation about WinModems, see Chapter 7.

£, Device Manager
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Finally, Preparing for Your Installation

Yes, this is a lot of prep work, but it’s worth it. Now you can finally look at the
actual pre-installation routines. The first thing you need to do is figure out
which method you’re going to use to install Linux. This isn’t actually as hard
as it sounds. You have three choices:
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v DVD or CD: If your computer can boot from a DVD or CD, and your Linux
distribution installation CD or DVD is bootable, you can start the instal-
ign directly from the CD or DVD. Most current Linux distributions come
ro p O O ogootable CDs or DVDs, and most current computers are capable of
booting from CD and DVD. The distribution included with this book comes

on a bootable DVD, and if you use the coupon to get the CDs, the first CD
is also bootable.

1 Floppy: You can also start the installation from a floppy disk if you cannot
boot from the DVD or CD. After booting from a floppy disk, the installer
program then uses the DVD or CD to continue the installation.

1 Network Source: This method enables you to install Linux over a network.
In this procedure, you start your computer, establish a network connec-
tion to where the Linux installation files reside, and then complete the
installation by accessing the files across the network.

This chapter concentrates on preparing to install Linux from the DVD (with
notes for the CD users as well) or with an installation floppy disk. Once you
have decided which one of these you want to use, the second large decision
you need to make is where on your target hard drive you want Linux to reside.
If you have a brand new, empty hard drive, that’s your best choice. Make a
note of which drive it is before proceeding. As I covered earlier in this chap-
ter, you can also install within disk partitions on a drive you're already using
for Windows. Be sure to have your notes handy on which partition(s) you’ll
be giving to Linux before proceeding to Chapter 3.

Laptop considerations

The current distributions of Linux do very well
on relatively new notebooks and laptops (see
www.linux-Taptop.net for an excellent
research site for how Linux gets along with var-
ious makes and models). If your laptop is a
common brand, you shouldn’t encounter any
problems installing Linux. However, laptops
often contain WinModems (as mentioned else-
where in this chapter, hardware labeled with
the Win prefix is for Windows, not Linux).

If you plan on purchasing a laptop for Linux,
check outthe modem and other hardware, such

as network cards, to make sure they're not Win
branded. If the built-in or default hardware for
the laptop is Win labeled or you discover while
researching the machine that it contains a Win
product even if it isn't properly labeled, you
might be able to switch the offending hardware
fora PC (or PCMCIA) card. Most current laptops
contain at least one PC Card slot so that you can
slip in a PC card modem, network card, or
combo modem-network card. As long as you
stick with a common brand of PC card, it should
be able to work well with Linux.
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Now, before you go any further, there’s one more thing I want you to do: locate
your Linux distribution’s documentation. These manuals can help you get

j llation roadblocks and contain lots of useful information for after the
ropBooks::

Finding this documentation depends on how you got your distribution:

v Many boxed sets come with printed manuals.

v Downloaded materials (and the boxed sets) might come with the docu-
mentation on your distribution CDs or DVD. Unfortunately, this is not the
case with the media included with this book.

You can also (usually) find both help files and the full manuals in Web form on
the distribution’s Web site, and you might even be able to purchase manuals
separately if you’d like to have them in hardcopy.

What about situations where the documentation doesn’t cover your problem?
Check out one of the many Linux reference Web sites, especially:

v General sites and publications: www.1inux.com, www.everything
Tinux.org, www.linuxgazette.com, www.linuxjournal.com,
www.linuxtoday.com, www.Tinuxworld.com, www.lwn.net, www.
linuxcare.com, www.slashdot.org, waw.freshmeat.net, and
www.linuxdoc.org.

v Security sites: www. Tinuxsecurity.com, security.ucdavis.edu/
sysadmin/Tinux.html, and www.portalux.com/system/security.

v Kernel and software sites: www. 1 inuxhq.comand www. linuxapps.com.

Enabling Booting from
a CD- or DUD-ROM

A really nice installation option is that you can install Linux from the CD- or
DVD-ROM. Many systems these days come set up to boot from a CD or DVD
if there’s one in the drive, but yours may not already be configured for this.
Just pop in the installation DVD (or CD) and try it! If booting from DVD (or CD)
doesn’t work when you try it:

1. Determine if your Linux installation CD or DVD is bootable.

Almost all modern Linux distribution CDs and DVDs — including the DVD
that comes with this book (and the first CD from the CD set you can order
as a replacement using the included coupon) — can be used to boot into
the installation routine.
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However, if you've chosen a distribution not covered in this book, your
DVD or CD may require a boot disk. The distribution’s documentation

D r O O #htell you whether this is possible or not. Follow the documentation’s
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i uctions on how to make a boot disk.
2. Determine if your system is capable of booting from a DVD or CD.

If you've ever booted your system from a CD or DVD, you’ll have no
problem booting from the Linux installation CD. You’ll find this informa-
tion in your BIOS, in the section that lets you tell the machine which stor-
age devices (drives) to check at boot time. If CD-ROM or DVD-ROM isn’t
listed in the options, proceed to the section “Preparing to Boot from the
Floppy Installation Disk.”

If you have to make changes in your BIOS, make sure to save them when you
exit! It’s easy to forget and end up wondering why the machine isn’t doing what
you told it to do.

Preparing to Boot from the
Floppy Installation Disk

\\J

If you're having trouble booting from the DVD or CD, you can start the instal-
lation from a floppy disk. When you purchase a boxed set, a floppy disk comes
with it. Downloading the CDs or DVD  or getting them through a source such
as this book  doesn’t give you a physical floppy disk, but you can make your
own anyway!

Usually, the Linux DVD or installation CD contains a directory of DOS utilities
called dosutils. Within this directory is a program you can use to create an
installation floppy, called rawrite.exe. You'll find the documentation for
rawrite in the same location.

You can use Windows Explorer or the DOS dir command to investigate the
contents of the /dosutils directory.

In addition, the DVD that comes with this book also contains disk image files,
which contain a kind of snapshot of the installation boot disk. With Fedora
Core 1, these image files are kept in the /images directory.

To make a boot disk on a Windows system using Fedora Core 1 and the DVD
(or CD) that came with this book, follow these steps:

1. Insert the DVD that comes with this book into the DVD drive, and
make a note of the drive letter that corresponds to your DVD drive.

If you are using the CD set, insert the first CD.

37
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2. Accessing a command prompt depends on your Windows version:

¢ [n Windows 98, open an MS-DOS window by choosing Start=>

D {0) p B 00 kS Programst>MS-DOS Prompt.

a\\J

¢ In Windows 2000 and XP, open a command prompt window by
choosing Start=>Programs>Accessoriess>Command Prompt.

3. Change to the drive that corresponds to your DVD or CD drive by
typing the drive letter followed by a colon at the command prompt
and pressing Enter.

The prompt in the MS-DOS/Command window changes to reflect the
CD’s or DVD'’s drive letter.

4. To change to the /dosutils directory, type cd dosutils at the
command prompt and press Enter.

5. To create a boot disk in floppy drive A:, type
rawrite -f ..\images\bootdisk.img -d a

The - f parameter specifies the location and name of the image file. The
-d option indicates the floppy drive letter.

The following instruction phrase is echoed in the MS-DOS window:
Please insert a formatted diskette into drive A and press -ENTER- :

6. Insert a blank, formatted, 1.44MB floppy disk into the floppy drive
and press Enter.

When the process is complete, the MS-DOS command prompt returns to
reflect the /dosutils directory, and the flashing underscore cursor
appears.

After you've created the installation boot disk, you need to configure, or
verify, that your computer is set to boot from the floppy drive. The easiest
way to do this is to insert a floppy disk into your main floppy drive, make
sure no other drives have media in them (such as a DVD in your DVD-ROM
drive), and then reboot your computer. If your computer boots from the
floppy, you're set.

If for some reason your machine seems to be ignoring the floppy drive as it
boots, check in your system’s BIOS as we discussed earlier in this chapter.
Make sure that the floppy is listed first. Then, save your changes before exit-
ing the BIOS; otherwise, the items you set don’t take effect.
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In This Chapter

Checking out some neat features and installation improvements

Installing Linux as a personal desktop by using the graphical interface

Do, or do not. There is no “try.”

—Yoda, The Empire Strikes Back

Linux has clawed its way out of the geek-only realm and into the average-
user light. No longer are arcane glyphs and complex sorcerer’s spells
required to install Linux. For this reason, the graphical installation of Linux

is now quite easy to perform and will be familiar to users coming from another
graphical operating system, such as Microsoft Windows. This chapter provides
the details.

If you're installing SuSE or Mandrake Linux, proceed to Chapter 4. There’s
plenty for you to learn in this chapter, but you can start by looking at the
specifics for your particular distribution first.

Things to Consider before
You Begin Installation

You can install Fedora Core by

v Booting with the Fedora Core DVD-ROM.

v Booting with the Fedora Core installation CD, which is CD number 1 if
you ordered the CD set.

v Booting with an installation floppy disk and having the remainder of the
installation files read from the DVD-ROM or CD.
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To begin the installation from the DVD-ROM or CD-ROM, you must first change
your system to start, or boot, from a DVD-ROM or CD-ROM. In Chapter 2, I
OO gw to configure a computer to boot from these devices.

If you want or need to make the installation floppy disk and have access to a
Windows system, perform the steps to create the installation floppy covered
in Chapter 2. If for some reason the installation floppy (or the CD- or DVD-
ROM'’s installation routine) won’t work on your system, you may need to
download a new version of just the installation portion.

You can get the updated install images from the “Security & Errata” page
(http://www.redhat.com/apps/support/errata/). Click through the link for
Fedora Core 1 and search through for the words “boot,” “image,” and “ana-
conda.” If there’s a new boot disk image, that’s how you'’ll find it. The site

explains what you need to do from there.

What’s this “image” thing? An image is a file that has to be precisely placed
into storage media (like a floppy disk or a writable CD- or DVD-ROM). You
can’t just copy it. I cover the RAWRITE utility in Chapter 2.

The instructions in this chapter tell you how to follow the installation for
Fedora Core 1.1 concentrate on Fedora Core 1 and its installation for two
main reasons:

v Fedora Core 1 is included on the DVD with this book, and the CDs you
can order with your coupon.

v Covering the installation of every Linux distribution in existence would
make this book into a set of encyclopedias.

[ cover the Personal Desktop installation because it requires little or no hard
drive preparation and doesn’t use umpteen partitions like other installations
do. In addition, the Personal Desktop installation option installs the X Window
System (graphical interface) and applications that are commonly used on
desktop and laptop systems. Server or service-type applications, such as the
Apache Web server and FTP server, aren’t installed with the Personal Desktop
option. However, you can add these to your Personal Desktop package selec-
tion before actually beginning your installation.

Please note that if you're installing Red Hat Enterprise Linux, a different ver-
sion of Fedora Core, or a different distribution of Linux, your screens will look
different from what is shown in this book. Each Linux distribution installation
covers the same basic tasks, but each action may be presented in a different
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order. For example, one distribution may present account creation before net-
working configuration, and another may have these two topics reversed.

ou reach the About to Install (GUI install) screen, you can back out
of the installation without changing anything on your system. None of the
configuration options you make before the About to Install screen are saved
to your disks. After you continue beyond the About to Install screen, data is
written to disk, and your system is changed.

N If you have really new hardware and an older version of Linux, the installation
software and process may not be “happy” with the newer hardware. If you have
installation troubles and suspect that this may be the cause, | recommend
checking out the Linux distribution’s Web site for newer installation floppy
disk images. The Linux community is usually very quick to address new hard-
ware for the different distributions and versions of Linux. However, if you are
attempting to install a version of Linux that is more than a couple of years old
on new hardware, you may be out of luck finding updated installation floppy
disk images.

The Installation Process

In this chapter, I follow the graphical installation. If you can’t use the graphi-
cal installation for some reason (if Linux doesn’t support your video card, for
example), follow the text-based installation instead. The steps are the same,
it’s just not as pretty. You can find more detailed coverage of the text install
in Red Hat’s manuals, which are available on their Web site, and I will include
the occasional image of the text installer as well.

Dealing with damaged CDs

If your media check fails, what you do next
depends on where you got the DVD or CDs. If
the DVD came with this book, contact Wiley
Customer Care at 800-762-2974 to get them
replaced. Do not contact Red Hat's technical
support to have the DVD replaced in this case.

On the other hand, if you burned your own CDs
or DVD, there may be one of two different prob-
lems. Try burning the media again at a slower
speed. If these media also fail the media check,
download the images again. Or, they may have
been corrupted during the file transfer, though
it's unlikely.
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To install Fedora Core 1, follow these steps:

| u want to boot and install from the Red Hat DVD-ROM, place the
ro p O O that comes with this book in your DVD-ROM drive and reboot
your system.
Otherwise, place the installation floppy disk (see Chapter 2 for details)

in your floppy drive, put the DVD in your DVD-ROM drive, and reboot
\\3 your system.

If you are using the CDs, boot with the first CD in the CD-ROM drive.

Whether you start the installation from the floppy disk, CD-ROM, or

the DVD-ROM, the first installation screen appears. The screen contains
several options, as shown in Figure 3-1, which are each described in the
following list:

e Install or upgrade in graphical mode. The first option in the
graphical interface is for installing Fedora Core for the first time
or for upgrading an existing version of Linux. This installation
probes to detect your system’s hardware. The graphical interface
is designed to work with a mouse to select options. If you don’t
have a mouse, you can use the keyboard to navigate around the
screens. In most places, the Tab key or the arrow keys advance
you to the next option; the space bar toggles options off and on;
and the Enter key accepts the choices and moves to the next
screen. In most screens, if you want to change a previous setting,
a Back button is available to navigate to earlier selection screens.
The graphical installation screens also include help in the left panel.
The content changes to reflect information about the current con-
figuration screen.

¢ Install or upgrade in text mode. The second option enables you to
install or upgrade Fedora Core using a text menu interface. This
interface presents the options in text menus, and you use the
arrow keys or Tab key to move the selection area. In some areas,
the spacebar is used to turn options off and on. To install by using
the text interface, type Tinux text at the boot: prompt and press
Enter.

Use the function keys. The last item listed points out the
function keys displayed at the bottom of the initial installation
screen.

The F1 function key presents the initial installation screen,
which allows you to install or upgrade via graphical mode, install
or upgrade via text mode, or use the function keys labeled F2
through F5.
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The F2 function key includes options for disabling hardware detec-
tion during installation (you must know the details of your hardware
before proceeding); testing the installation media before proceeding
(good option to use if you downloaded the Fedora Core distribution
from Red Hat’s Fedora Project Web site (http://fedora.redhat.com)
and burned the software to CDs or a DVD); enabling rescue mode
(this is also the function of the F5 key); using a driver disk, CD, or
DVD that isn’t included with the Linux installation media; and
updating your existing Linux installation.

The F3 function key allows you to set the video options. If you have
experienced problems installing Fedora Core 1 with the graphical
interface, you may want to try a lower resolution. Type 1inux
Towres at the boot: prompt to use a lower graphic resolution to
install Linux. The Tinux Towres nofb command allows you to
turn off frame buffering, which can cause problems with some
video cards.

The F4 function key, labeled Kernel, enables you to enter parameters
when you install Linux. For example, some help files will tell you to
do something like “turn off autoprobing for your PCI hardware bus.”
Here’s where you find out what you need to type.

The F5 function key enables you to boot into rescue mode when the
Linux system doesn’t start properly. Rescue mode includes many
useful utilities to restore your system to a functional state. To start
rescue mode, type 1inux rescue at the boot: prompt and press
Enter.

Fedora

Fedora Core 1

I
Figure 31 - To install or upgrade in graphical mode, press the <ENTER> key.
The |n|t|a| — To install or upgrade in text mode, type: linux text <ENTER>.
Fedora COre - Use the function keys listed below for more informatiom.
installation

screen. |aiEi
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If you don’t choose any options and just press Enter, the graphical instal-
lation process starts. The default installation mode for Red Hat Linux is
hical. Other Linux distributions, such as SuSE and Mandrake, also
graphical installation options. Even though the installation screens
in other distributions are different from Fedora Core, they all follow the
same basic steps.

. Press Enter to start the graphical installation.

Many lines of information scroll past as the installation begins. During
this time, a mini version of Linux is loading. If you downloaded the full
version of Fedora Core and burned it onto CDs or a DVD yourself, the
CD Found (mediacheck) screen appears. This allows you to check the
integrity of the media that you are using to install Linux. If this is the case,
I recommend taking the time to perform this test on all of the CDs or the
DVD. It’s best to know now if one of them is damaged or incomplete.

The DVD that accompanies this book is a full edition of Fedora Core 1,
so it’s the same one that you can purchase or download. Just as with the
boxed sets, the media check for this edition is not run by default. You
can perform the same function by pressing F2 in the initial installation
screen and typing 1inux mediacheck at the prompt.

. What you do here depends on whether or not you want to test your

media:

e [f you see the CD Found window or manually start the media check,
press the Tab key until the OK button is enabled. Test each of the
CDs or the DVD in turn. If any of them receives a Fail notice, see
the “Dealing with damaged CDs” sidebar. After you're finished test-
ing, tab to the Continue button and press Enter to proceed to the
next installation step.

e If you do not want to check your DVD or CDs, press the Tab key
until the Skip button is enabled. Press the Enter key to advance to
the next installation step.

In either case, after you're ready to move on, the CD Found image disap-
pears and additional text scrolls across the screen. The last few lines
load the graphic engine, a gray screen with a small X in the middle
appears, and then a screen with a large Red Hat logo appears.

After a moment, the Welcome to Fedora Core screen appears, indicating
where you can read or obtain the Red Hat manuals. The information rec-
ommends that you read the installation documentation before you
install Linux for the first time, and so do I!

. After you’ve finished with the material on the Welcome to Red Hat

Linux screen, click Next.

The Welcome screen automatically disappears and is replaced by the
Language Selection screen, as shown in Figure 3-2. Linux supports many
different languages.
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Figure 3-2:
The
Language
Selection

. ‘What language would you like to use during the installation
K soucion | @ rmrmsrmscssn

Choose the language you would
like to use during this installati Chinese( ted) (& 32 =

Chinese(Traditional) (¥ 1)
Czech (Cestina)
Danish (Dansk)
Dutch (Nederlands)
French (Frangais)
German (Deutsch)
Icelandic ([slenska)
Italian (Italiano)
Japanese (H435)
Korean (2H=01)
Nonwegian (Norsk)
Portuguese (Portugués)
Portuguese(Brazilian) (Portugués (Brasil))
Russian (Pycckuii)
Slovenian (Slovenian)
anish (Fsnafinl) =

screen.

‘@ Hide Llelp‘ ‘@gaease Notes |
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5. Use the mouse or the T or | keys to select your language and click Next.

The Keyboard Configuration screen appears, as shown in Figure 3-3.

Different languages arrange the keys differently on keyboards; you may
want to choose the matching language for your keyboard (the default is
U.S. English).

. Choose your keyboard configuration and click Next.

The Mouse Configuration screen appears, as shown in Figure 3-4. Notice
this screen also includes a Back button, which enables you to go back
to the previous configuration installation screen if you need to make
changes.

. Configure your mouse.

By this stage of the installation, you’re probably already using a mouse
to make your selections. The Mouse Configuration screen enables you

to choose the model and features of your mouse. If you're unfamiliar with
mouse hardware, the important distinction to understand is between the
serial, PS/2, and USB mice. A serial mouse has a wide rectangular con-
nector with pins in the end that plugs into the computer. A PS/2 mouse
has a round connector, and a USB mouse has a small rectangular con-
nector, much smaller than the connector that hooks up your monitor to
your computer.

If you're using a two-button mouse, you also have the option to emulate
three buttons. If this feature is enabled, you can emulate the middle
button by pressing both mouse buttons at the same time.
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OSConﬁguration

Choose the layout type for the
keyboard (for example, U.S.
English) that you would like to use
for the system.

ropBog

|
Figure 3-3:
The
Keyboard

Keyboard

@ Select the appropriate keyboard for the system.

Russian (Microsoft)
Russian (rul)
Russian (ru2)
Russian (win)
Slovakian

Slovenian

Spanish

Speakup

Speakup (laptop)
Swedish

Swiss French

Swiss French (latinl)
Swiss German
Swiss German (latinl)
Turkish

Ukrainian

United Kingdom

Configura-
. U.S. Intemational
tion screen.
‘al-ﬂda Lle!p‘ ‘gaease Nutes|
I
Online Help Mouse Ci
[ -
Mouse Conﬁgu ration & Select the appropriate mouse for the system.
-
Choose the correct mouse type ‘Mwel |
for your system. 2 Button Mouse (senal)
2 Button Mouse (USB)
Do you have a PS/2, USB, Bus ||~ 3 Button Mouse (PS/2) il
or serial mouse? (Hint: If the 3 Button Mouse (serial)
cennecior yous molse plugs 3 Button Mouse (USB)
into is mund,' itisaPS/2 ur_a. Wheel Mouse (PS/2) Z
Bus mouse; if rectangular, itis )
a USB mouse; if trapezoidal, it
is a serial mouse.) L] P el i
b Kensington
Try to find an exact match. If an b Logitech
exact match cannot be found, b Microsoft [+]
I choose one which is el
) compatible with yours. =
Flg“re 3-4: Otherwise, choose the [devfyS0 (COM1 under DOS)
appropriate Generic mouse fdev/ttyS1 (COM2 under DOS)
The Mouse type. fdev/ityS2 (COM3 under DOS)
Conﬁgura_ . ' ‘dev/ttyS3 (COM4 under DOS) k
tlon screen If you have a serial mouse, pick | [ Emulate 3 buttons
i . R % o
‘ml—ﬂdeﬂelp‘ ‘@5&\&;5& Nutes| < Back
I

8. After making any adjustments to your mouse settings, click Next.

The Monitor Configuration screen appears, as shown in Figure 3-5,
with your monitor type highlighted.
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Monitor C
In most cases, the monitor can be automatically detected. If the
detected settings are not correct for the monitor, select the right
settings.

Onifle Help

'tSonﬁguration

The installation program was
not able to properly detect your
monitor. You can either
proceed with the currect
selection or select a monitor 4 MAG TX1795
that best matches the model MAG DX17F
attached to this system. MAG DX17T
MAG DX500AV
You may also enter the MAG DX500T
roiare sl I —
5ync»hlon|za||un ranges for your S BT
monltgr. These values can be L -
found in the documentation for
[T your display. Be careful when LIS e

entering these values; if you MAG InnoVision DX17F

[*

>

DropBoc

MAG DX1495
MAG DX1595
MAG DX15F
MAG DX15T

E 4
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Figure 3-5: enter values that fall outside the MAG InnoVision DX21F
. capabilities of your equipment, MAG InnoVision LX1450
The Monitor you can cause damage to your MAG Innovision MX15F -
Conﬁgura- g:fvpla;i'- Eﬂlx_v'f:%;ler ﬂlumb'efs in Horizontal Sync: [30.0-70.0 | khz
tion screen ese fields if the values in your (B orycq syne: [s001200 bz
] [Goimere]
|

9. If the monitor configuration information is correct for your hardware,
click Next; if the information isn’t correct, scroll through the list and
click the triangle next to the vendor’s name to expand and collapse
the choices. In the expanded list, choose the brand and model of your
monitor (or the one that matches your hardware), and then click Next.

If you can’t find your monitor at all, you have three choices. You can
simply choose Unprobed Monitor and keep your monitor’s documenta-
tion handy to answer questions about the hardware. You can also choose
either Generic LCD Display (for laptops) or Generic CRT Display (for
desktop monitors), and then select the resolution the monitor is capable
of. Again, it’s best to have your monitor’s documentation handy if at all
possible. If you don’t have the physical papers, you can usually find what
you need on the manufacturer’s Web site or by doing a Web search on

NG/ the make and model.

It is vital that you make sure not to push your video hardware harder
than it’s made to go. You can actually damage your hardware this way.
If you're not sure, err on the side of a lower resolution or refresh rate.

10. After making any adjustments to your monitor settings, click Next.

The Installation Type screen appears, as shown in Figure 3-6.



58

DropBoo

Part I: Getting Your Feet Wet

‘ Fedora’

Choose the type of installation
that will best meet your needs.

An installation will destroy any
previously saved information on
the selected partitions.

For more information concerning
the differences among these
installation classes, refer to the
product documentation.

®

o

o]

Type

Personal Desktop

Perfect for personal computers or laptops, select this installation type to
install a graphical desktop environment and create a system kleal for
home o desktop use.

Workstation
This option instals a graphical desktop enviranment with tools for
and system

Server

Select this installation type i you would ke to set up file sharing, print
sharing, and Web services. Additional services can also be enabled,
and yau can choose whether or nat ta installa graphical environment

Custom

|
Figure 3-6:
The Installa-
tion Type

Select this installation ty e to gain complete control over the installation
process, including software package selection and partitioning.

&8 & .

screen.
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Four options are available under Installation Type:

¢ Personal Desktop: This option performs an installation for personal
desktop or laptop use and installs a graphical interface. If your
system already contains a copy of Linux, the default for the Personal
Desktop installation is to remove any existing Linux-related parti-
tions and use all the remaining free, unpartitioned disk space. If
you choose this default, any existing non-Linux partitions, such as
DOS/Windows, remain untouched. After installation, you can boot
to Linux and your other existing operating system or systems.

Workstation: This option installs the graphical interface (X Window
System) and the desktop manager(s) of your choice, much like the
Personal Desktop installation, but also includes tools for software
developers and system administrators.

Server: This option is designed for a basic Linux-based server for
file and print sharing and Web services. You can also enable other
services and choose to install a graphical environment. When you
select this option, the default disk-partitioning scheme is to remove
ALL existing partitions on ALL your hard drives. This means that
all partitions and operating systems of any type, Linux and others,
are removed, and all drives are erased.

Custom: This option enables the most flexibility to retain your
existing operating systems and configuration options. This option
enables you to choose the packages or applications/roles you want
to install, the size of your disk partitions, and how you want the
system to boot.
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I cover the Personal Desktop installation in this book for demonstration
urposes, but you may select any of the other options that pertain

<
< p
D r O O pactly to your system. If you choose another option, keep in mind that

|
Figure 3-7:
The Disk
Partitioning
Setup
screen.
|

Synstructions I include here may vary from your installation experience.

11. Click the Personal Desktop installation option to select it; then

click Next.

The Disk Partitioning Setup screen appears, as shown in Figure 3-7.
You're given the option to accept an automatic partitioning strategy,

or you can define your own partition(s) manually. Your hard drive must
contain at least one Linux partition to continue with the installation. |
choose to cover automatic partitioning in this book. If you really, really
want to partition manually, see the nearby sidebar “Defining partitions
manually.”

12. Choose Automatically Partition; then click Next.

The Automatic Partitioning screen appears, as shown in Figure 3-8. You
can choose to remove all Linux partitions on your system, remove all
partitions on your system, or keep all existing partitions and use free
space. You also have the option of marking a particular hard drive to
work with. As suggested in Chapter 2, be sure you know which hard
drive you want to work with! As a hint, the first hard drive in your com-
puter is hda, the second is hdb, and the third is hdc. If you have SCSI
drives, you will see sda, sdb, and sdc instead.

If you're really nervous, check the Review check box so you can double-
check the partition assignments before the installer changes anything.

Fedora”

O

Disk Partitioning
Setup

One of the largest obstacles for
a new user during a Linux
installation is partitioning. This
process is made easier by Automatic Partitioning sets partitions based on the selected
providing automatic
partitioning.

By selecting automatic create partitions in an interactive environment. You can set the
partitioning, you will not have to
use partitioning tools to assign (® Automatically partition

mount points, create partitions, (O Manually partition with Disk Druid
or allocate space for your
installation.

e Help

Disk Partitioning Setup

installation type. You also can customize the partitions once
they have been created.

The manual disk partitioning tool, Disk Druid, allows you to

file system types, mount points, partition sizes, and more.

To partition manually, choose

the Disk Druid partitioning tool. || |

Use the Back button to choose

a different installation, or

‘@H’\de L%elp‘ ‘@5e\ease Nores|
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Automatic Partitioning
|

’Z
Partitioning
Automatic partitioning allows Before automatic partitioning can be set up by the

you to have some control installation program, you must choose how to use
concerning what data is the space on your hard drives.
removed (if any) from your
system. I want to have automatic partitioning:

(@ Remove all Linux partitions on this system
To remove only Linux partitions Pl e
(partitions created from a & (O Keep all partitions and use existing free space
previous Linux installation), =
select Remove all Linux Select the drive(s) to use for this installation:

PartgE QI ey, sda 4095 MB VMware, VMware Vitual S
I
To remove all partitions on your
Figure 3-8: hard drive(s) (this includes

partitions created by other

The operating systems such as [[] Review (and modify if needed) the partitions created

. Windows 95/98/NT/2000),
AUtoma-tIC select Remove all partitions
Partmonmg on this system.
screen. : =
|m Hide Liew| ‘ﬂejease Notes ‘ 4 Back (B> Next
I
QMING/

V.
S Be careful — you lose all data in existing partitions when you choose to

remove partitions.

13. Choose the Remove All Linux Partitions on This System option; then
click Next.

A Warning dialog box appears asking if you want to remove the parti-
tion(s). Click Yes. The Boot Loader Configuration installation screen
appears, as shown in Figure 3-9.

The first option allows you to change the boot loader from the default of
GRUB to LILO, or choose no boot loader. Keep the default.

Fedora’

Online Help 1 Boot Loader Configuration
=
[ | The GRUB boot loader will be installed on /dev/sda. |Change boot loader
Boot Loader
Conﬁgu ration ‘You can configure the boot loader to boot other operating
systems. It will allow you to select an operating system to
boot from the list. To add additional operating systems,
By default, the GRUB boot which are not automatically detected, click ‘Add." To
loader will be installed on the || | change the operating system booted by defauit, select
system. If you do not want to ~| 'Default' by the desired operating system.
install GRUB as your boot
loader, select Change boot |DEFE"" |Lat'EJ Dees Add
loader. Fedora Core (dev/sda2 Edt
You can also choose which 0S Delee
I q
(if you have more than one)
Fi ure 3_9. should bont'hy default. Select A boot loader password prevents users from changing
g " Default beside the preferred options passed to the kemel. For greater system
The Boot boot partition to choose your security, it is recommended that you set a password.
default bootable OS. You will [ Use a boot loader password | Change p d
Loader not be able to move forward in [}
Confi the installation unless you Ol ot R
ontigura- choose a default boot image. QLS 2T RACEL OO
tion screen. ,
You may add, edit, and delete
I the boot loader entries by [+l
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The second option allows you to boot to other operating systems than
Linux. If you have other operating systems installed on non-Linux parti-

D ro B O O ipRs, such as Windows, you can choose to boot to them.
p third option enables you to configure a boot loader password for

|
Figure 3-10:
The
Network
Configura-
tion screen.
|

added security.

The last option allows you to select advanced boot loader options.

14. After making any selections to the boot loader configuration settings,

click Next.

The Network Configuration screen appears, as shown in Figure 3-10.

Online Help Network Configuration

(% Network Devices

Network Configuration

Active on Boot | Device |IP/Netmask Edit
Any network devices you have e DK
on the system will be
automatically detected by the
installation program and shown ||~ |
in the Network Devices list. 1+ 0
To configure the network b pame
device, first select the device Set the hostname:
and then click Edit. In the Edit ® automatically via DHCP
D0 e ) manually ‘ | (ex. "host.domain.com")

choose to have the IP and
Bletmasiintormancy Miscellaneous Settings
configured by DHCP or you h 1
can enter it manually. You can 2 |
also choose to make the device 1
active at boot time. 1

}

If you do not have DHCP client
access or are unsure as to what L3
this information is, please =

‘@ Hide Llelp‘ ‘gewease Notes |

15. If you’re using Dynamic Host Configuration Protocol (DHCP) on your
network to set the computer’s hostname, choose the Automatically Via

DHCP option. If you aren’t using DHCP to define the hostname,
choose the Manually option and enter a hostname.

First, make sure the ethO checkbox is checked so your machine will acti-
vate its networking when it boots. Then, if you're using DHCP, this setup
allows another service or system to set all the networking parameters
for your computer so it can communicate properly on a network or on
the Internet. If you're connected to a high-speed Internet service, such
as DSL, your computer is probably configured to use DHCP for all the
settings except the hostname, which gives an identity to your machine.
If your computer is part of a company network, the DHCP services may
provide the hostname in addition to the rest of the parameters. Check
with the network administrator or IT department for the appropriate
information for your network.
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To set the hostname of your Linux system, make sure the Automatically
via DHCP option is not selected and then configure the following:

DropBook

Type a name for your machine in the field to the right of the
Manually label. I recommend that you use only alphanumeric
characters for the name of your machine. Sometimes, using
other characters may interfere with an application and make it
difficult to access your machine from a network.

If you're not using DHCP for the other network settings, click on
the Edit button to the right of the Network Devices list. In the Edit
Interface ethO window, remove the check next to Configure using
DHCP. Enter values for the IP Address and netmask settings and
click OK. After you enter these two values, the remaining fields
under the Miscellaneous Settings label are enabled. If you don’t
know what your IP address or netmask are supposed to be, ask
your administrator.

Enter values in the Gateway and DNS fields that are valid for your
network. If your network has more than one DNS server, you can
enter up to three DNS server addresses.

I cover DHCP and other [P-related information in more detail in Chapter 7.

16. After you’'ve made all your selections and entered your data, click Next.

The Firewall Configuration screen appears, as shown in Figure 3-11.

Online Help

Firewall

% A firewall can help prevent unauthorized access to your computer from the

|
Figure 3-11:
The Firewall
Configura-
tion screen.
|

Firewall Configuration | .

A firewall sits between your
computer and the network, and
determines which resources on
your computer remote users on
the network are able to access.
A properly configured firewall
can greatly increase the out-of-
the-box security of your system.

Choase the appropriate
security level for your system.

outside world. Would you like to enable a firewall?
) No firewall
(@ Enable firewall

‘What services should be allowed to pass through the firewall?

I www (HTTP)
O Fre

[ ssH

[ Telnet

[ mail (SMTP)

Other ports

If you would like to allow all traffic from a device, select it below.

High Security - By choosing
High Security, your system will
not accept connections that are
not explicitly defined by you. By
default, only the following
connections are allowed:

* DNS replies

‘m Hide Help ‘ |Eielea;e Notes

[«

[ etho
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17.

18

Online Help

Additional Language

Firewalls protect your system from unauthorized access and discovery.
When you're connected to the Internet with a high-speed connection, your

k puter appears as one of the hundreds of thousands of other systems

e Internet. For starters, you may want to choose the Medium level.
If you're on a corporate or private network, check with the network
administrator or IT department for information on the appropriate fire-
wall setting. (Your Internet connection hardware may include a firewall.
Contact your Internet connection hardware provider for information
about its firewall features.)

After you’ve made all your selections and entered your data, click Next.

The Additional Language Support screen appears, as shown in Figure 3-12.
Your Linux system can support multiple languages at the same time. If
you add languages, be sure to set which you want for your default.

Select the languages for your Linux installation and click the Next
button to continue.

The Time Zone Selection screen appears, as shown in Figure 3-13. If you
don’t find the exact name of the city you're in, choose another city in
your same time zone that supports the same options, such as daylight
savings time. You can also click the UTC (Universal Time, Coordinated)
Offset tab at the top of the screen and select your offset from UTC time
and whether you use daylight savings time. If your computer uses UTC,
you can also choose this option.

Additional Language Suppart

Select the default language for the system: | English (USA) ¥

[+

|
Figure 3-12:
The
Additional
Language
Support
screen.
|

Su ppo rt Select additional languages to install on the system:
= = Select All
(=] Selec

Select a language to use as the [ English (Great Britain)
default Iangs.lage. The default [ English (Hong Kong) Select Default Only
language will be the language [] English (India)
used on the system once [ English (ireland)
ins(allatior! is complete. If you [] English (New Zealand)
choose to |r!s!a|| ulhgll [ English (Philippines) w
languages, it is possible to [ Englsh (Singapore)
change the default language L |

< ] [] English (South Africa)
after the installation.

English (USA)

The installation program can [ English (zimbabwe)
install and support several [ Estonian
languages. To use more than [ Faroese (Faroe Islands)
one language on your system, [ Finnish
choose specific languages to [ French (Belgium)
be installed, or select all = | French (Canada) &
languages To hal\lfe all available [ French (France)
languages installed on the [ French Luxemburg) L
system. fol | L . [~]

‘@ Hide Help ‘ |@ﬂe\ea5e Notes
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Time Zone Selection

D ro p B O ( k& Selection Please select the nearest city in your timezane:

Set your time zone by selecting
your computer's physical
location.

On the interactive map, click on
a specific city (marked by a
yellow dot) and a red X will
appear indicating your
selection. You can also scroll
through the available list and
choose atime zone.

—— You can also scroll through the
Figure 3-13; | cplmamicionerns | | o e B
The T|me (i ‘AmencalNassau ‘k
You can also selectthe
Zone System Clock uses UTC ‘Amenca/N\p\qon Eastem Time - Ontario & Quebec - places that did ri Y
1 option.(UTC, also known as [ 72 I [2]
SE|ECt|0n G‘;;T, will allow your systemto | [ System clock uses UTC
screen. i e -
‘ﬁHAde Lielp‘ [ @ Release Nutes|
19. Choose the time zone in which your Linux system resides and
click Next.
The Set Root Password screen appears, as shown in Figure 3-14.
20. In the Root Password screen, type the root account password into
the Root Password field and then type the same password in the
Confirm field.
\P . . .

) You don’t see the password when you type it — just an asterisk for
each character. This prevents unauthorized individuals from seeing the
password.

After the values in the two fields agree, the phrase Root Passwords Do
Not Match, which appears below the Confirm field, is replaced with the
QWING/ message Root Password Accepted.
?
S Don’t forget your root password! You'll need it to do to do any adminis-

tration task on your Linux box.
21. After you’ve entered your root password twice, click Next.

The installation system pauses and displays a progress dialog box for a
few seconds while it reads in the package (software programs) options.
When this is complete, the Package Defaults screen appears. You can
choose to install the current default list of packages or choose to cus-
tomize the set of packages (as shown in Figure 3-15).
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|
Figure 3-14:
The

Set Root
Password
screen.
|

|
Figure 3-15:
The
Package
Defaults
screen.
|

Fedora

Use the root account only for
administration. Once the
llation has been c
create a non-root account for your
general use and su - to gain root
access when you need to fix
something quickly. These basic
rules will minimize the chances of
atypo or incorrect command
doing damage to your system.

il

$assword
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Set Root Password

O Enter the root (administrator) password for the system.

Root Password: ||

Confirm: |

Online Help

‘@ Hide ﬂelp‘ ‘@ﬂe\ease Notes |

Package Defaults

The default installation environment includes our recommended
package selection, including

Desktop shell (GNOME)
Office suite (OpenOffice)
‘Web browser (Mozilla)

Email (Evolution)

Instant messaging

Sound and video applications.
‘Games

After installation, additional software can be added or removed
using the redhat-config-packages’ tool.

If you are familiar with Fedora Core, you may have specific
packages you would like to install or aveid installing. Check the
box below to customize your installation.

(@ Install default software packages
() Customize software packages to be installed

< Back P> Next |

22. Choose the Install Default Software Packages option or the Customize
Software Packages to Be Installed option.
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In this example, I want to install the KDE desktop in addition to the default
GNOME desktop. Choosing the Customize option and then clicking the
button changes the screen to display the contents of the package

D ro p B O O l@tgories, as shown in Figure 3-16.

|
Figure 3-16:
The
Package
Group
Selection
screen.
|

23.

24.

Online Help Package Group Selection

bosiops g

Package Group
Selection

Choose KDE Desktop Environment in the Desktops category. If you plan
to have your Linux computer access other computers on your network,
select System Tools in the System category. If you plan on developing
software in your Linux environment, select the appropriate options in
the Development category. You can even scroll to the bottom to the
Miscellaneous section and choose Everything if you want!

Remember, you can always go back and add other packages after you
have installed Linux.

If you want to select individual packages in a group, click the Details
link to the right of each package group name. In the Details for window,
place a check mark to the left of each item in the package group name
to select individual items within a group.

Don'’t feel obligated to do this. This is probably a task you want to save
for when you’re feeling more comfortable with Linux. When you have
completed any selections you decide to make, click the OK button.

When you have selected all the packages that you want to install,
click Next.

The About to Install screen appears.

X Window System

&

[34/39]

Install this group of packages to use the base graphical (X)
user interface.

Details ||~

Select the package (application)
groups that you want to install. To
select a package group, click on
the check box beside it.

Once a package group has been
selected, click on Details to view
which packages will be installed
by default and to add or remove
optional packages from that
group.

‘@ Hide Help ‘ ‘ (9 Release Notes

GNOME Deskiop Environment [39/42]  Details

e GNOME is a powerful, graphical user interface which
'c includes a panel, desktop, system icons, and a graphical
file manager.

[] KDE Desktop Environment [o/186]
- KDE is a powerful, graphical user interface which includes
4% 2 panel, desktop, system icons, and a graphical file

" manager.

Applications
Editors [2/51 Details

Sometimes called text editors, these are pregrams that
@ allow you to create and edit files. These include Emacs and
[[] Engineering and Scientific

Vi
[0/7]

This group includes packages for performing mathematical
and scientific computations and plotting, as well as unit
conversion.

Total install size: 1,883M

-
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|
Figure 3-17:
One version
of the
Required
Install
Media
dialog box.
|

WING/
&

25.

When you're ready to commit to the installation, click Next in the
About to Install screen.

Required Install Media dialog box appears, as shown in Figure 3-17.

Required Install Media

@ The software you have selected to install will require the

following CDs:

Fedora Core 0.94 CD #1
Fedora Core 0.94 CD #2

Please have these ready before proceeding with the
installation. If you need to abort the installation and reboot
please select "Reboot”.

| Reboot ‘E____gontinue

26.

27.

If you want to stop your installation of Linux, this is the last place where
you can stop without changing anything on your hard drive(s). To stop
the installation, press Ctrl+Alt+Del, and your system reboots.

After you read this and ready the media — not much of a chore if
you’re installing from one DVD! — click Continue.

The Installing Packages screen appears. As the system is installing, you
see progress bars for each individual package being installed and total
installation progress.

After the packages and software are installed, the Boot Diskette Creation
screen appears. This enables you to create a disk that you can use to start
your system for troubleshooting booting problems. These days, almost
all modern Linux distributions allow you to use the installation DVD as a
rescue disk, so boot disks aren’t as important as they once were. Still, the
phrase “better safe than sorry” is a cliché for a reason. If it makes you
more comfortable, make a boot disk.

If you started the Linux installation from the floppy installation disk,
remove the floppy disk from the drive, insert a blank 1.44MB floppy
disk into your drive, and click Next in the Boot Diskette Creation screen
to create the boot disk. If you don’t want to create a boot disk, select
the No, I Do Not Want to Create a Boot Disk option and click Next.

After a boot disk is created, you reach the final installation screen.
Congratulations, you've made it through the first Linux gauntlet! Give
yourself a good pat on the back, remove the DVD from the DVD tray, and
click Exit to reboot your machine. Then, proceed directly to the next
section, “Your First Boot.”
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Defining partitions manually
Books

fine partitions manually,
you'll be using Red Hat's Disk Druid.

Disk Druid enables you to delete existing parti-
tions and add new partitions. If you don’t know
how to use Disk Druid, | recommend that you
not proceed any further. Click Back to return to
the Automatic Partitioning screen and choose
to review the automatic setup Disk Druid sug-
gests instead of starting from scratch.

If you choose to Review, there’s some things
you'll want to know. For example, the mount
point, or starting point in the Linux directory hier-
archy, for this example is /boot. For Linux native
partitions, you need to define the mount point,
size, and hard drive. For a Linux swap partition,

you need to define the size and hard drive. An
ext3, or Linux native, partition is used for the
operating system and user files. The swap par-
tition may come into play when you are running
Linux and getting low on free memory. When
you install Linux, you have to have at least one
swap partition and one native partition. After
you've finished making all your changes, click
Next to continue the installation.

If you're installing Linux by using the text inter-
face, the Disk Druid text interface is similar to the
graphical interface, except that you use the Tab
key and arrow keys to navigate to various por-
tions of the screen. To find out more about Disk
Druid, consult the Fedora Core documentation.

VYour First Boot

The first time your Fedora Core system boots, you’ll have the first chance to
see the boot menu. Select the Linux entry and press Enter. Your machine
should start to boot. If you run into trouble, see Chapter 5, “Booting and
Stopping Linux.” This first boot is special so [ cover it separately here.

After your machine boots up, you see the first boot Welcome screen, as

shown in Figure 3-18.

1. Click Next to proceed to the setup routine.

The Date and Time screen appears, as shown in Figure 3-19.

2. Verify that the date and time are accurate. If they are not, adjust

them now.

If you're on a computer network that is currently connected to the
Internet, you might want to check the Enable Network Time Protocol
check box to let your system use the Internet to make sure it has the
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right time. After you've checked this box (sometimes this can take a
while to set itself up, but after that you're fine), choose one of the

D ro p B O O kgers from the Server drop-down list box.

| 2 Welcome

User Account

There are a few more steps to take before your system is ready to use. The Setup
Sound Card Agent will now guide you through some basic configuration. Please dick the "Next"
Red Hat Network button in the lower right corer to continue,

Additional CDs
Finish Setup

|
Figure 3-18:
The Fedora
Core
Firstboot
Welcome
screen.
|

} o ant e Date and Time

User Account
Please set the date and time for the system.
Sound Card

Red Hat Network B | (Time
Additional €Ds 4 Ocwober » 4 2003 ¥

Finish Setup

Current Time :  22:43:45

Sun Mon Tue Wed Thu

I
I
BB

Hour:

5 6 74 8 9 10 11
12 13 14 15 16 17 18 Minute :
19 20 21 2 23 24 B

2% 27 28 29 30 31 Second :

I I
i IN
(I 33 B i

Network Time Protocol -
Your computer can synchronize its clock with a remote time server using

I the Nework Time Protocol.
Figure 3_19: [[] Enable Network Time Protocol
The Fedora S| [+]
Core
Firstboot
Date and

Time screen.
|
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|
Figure 3-20:
The User
Account
first boot
screen.
|

3. After you’ve finished adjusting the date, click Next to proceed.

kl" he User Account screen appears, as shown in Figure 3-20.

S

User Account

create a parsor
provide the requ:

. Type the name you want for your personal account into the Username

text box.

For example, [ would enter dee.

. Type your name into the Full Name text box.

For example, I would enter Dee-Ann LeBTanc.

. Enter your account password both in the Password and Confirm

Password text boxes.

This is the password for your personal account and has nothing to do
with your root account. Feel free to use a different password. In fact, it’s
a good idea to do so.

. Click the Forward button to proceed.

If your machine has a sound card, the Sound Card screen appears.
If not, skip to Step 9.

. Click Play Test Sound to make sure your sound card is set up properly.

You will (hopefully) hear a sound from the right speaker, then the left,
and then both. After the sound plays, a dialog opens asking if you heard
the sound properly. If you heard nothing, click No, and you’ll be informed
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that the card could not be autodetected. This is something to fix later. If
you heard the sound, click Yes. If the sound doesn’t work, refer to http://
.t1dp.org/HOWTO/Sound-HOWTO/ for assistance.

¥’k Forward to proceed.

The Additional CDs screen appears. If you have any of these CDs that it
lists and want to add software from them, feel free to do so now. If you
don’t have them but you want them, you could download them and burn
them onto a CD later if you have the proper hardware. See Chapter 15
for more on multimedia.

When you’re finished with the additional CDs, click Forward to
continue.

That’s it! Click Finish Setup. You've just survived the second Linux
gauntlet! Your machine now brings you to a graphical login prompt.
Skip to Chapter 5 for instructions on how to proceed.
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P (il?sliglling Other Distributions

In This Chapter

Touring the Linux distribution countryside

Demystifying Mandrake
Getting to know SuSE

Fe Linux distribution refers to the “packaging” that wraps up the free oper-
ating system everyone has come to know as Linux. At the core of all dis-
tributions are the same general components: the Linux kernel and the GNU
utilities. Just as many other commodity products are packaged and delivered
differently to accommodate various recipients and applications, Linux is also
packaged differently to provide for a variety of target uses.

After our earlier discussions, you should understand that Linux is more than
just some newfangled computer program. Linux is a fully equipped workshop
of software tools and building materials that can be used to construct any of
a wide spectrum of computing solutions. Developing the killer Linux distribu-
tion has been the Holy Grail of the Linux community. This ultimate Linux distri-
bution would provide all the support and capability that the preschooler, the
rocket scientist, the housewife, and the crotchety old computer science pro-
fessor would need to harness the power available with GNU/Linux. Although
the competition to create the perfect distribution continues, you don’t need
to do much research to determine which distribution is right for your needs.

In this chapter, [ survey two more of the most popular and easiest-to-install
distributions. Although I don’t have the space to cover every installation in
detail,  hope to point out some of the shiny chrome — or notable, character-
istics that these distributions have to offer.
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Distribution Geography
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@ &n 200 different Linux distributions are now available. Furthermore, a

dozen or so new distributions are created each year and rapidly fade, either
from a lack of publicity or perhaps because the innovative features they pro-
vide simply aren’t popular enough to draw a loyal following.

Although all distributions provide the same software and can ultimately pro-
duce the same configurations, seeing how various countries tend to gravitate
toward one distribution over another is interesting. For example, SuSE is from
Germany and has a large contingent of supporters in Europe; TurboLinux is
popular in Japan; Red Flag Linux is a favorite in China; Conectiva goes over
well in Spanish-speaking countries; and Red Hat, with its new Fedora Core,
maintains a high profile in the United States.

Regardless of your choice and curiosity, most Linux distributions have
matured to the point where you can be confident that your installation
will be successful.

Finding various distributions

Every major distribution has its own Web site. After you're there, hunt around
for a download link. Of course, most companies that distribute Linux would
rather have you purchase a boxed set of their products.

Pay for free software, you say? Preposterous! Buying free software is not such
a bad deal, though, when you think about it. When you purchase a distribu-
tion’s boxed set (when one is available, you can’t do this with Fedora Core),
you receive a tremendous value. You not only get some nicely bound books
to scribble in and dog-ear (as well as some telephone or online support), but
you also help support companies to develop better service and support for
your free software.

Okay, okay! Both purchasing your Linux distribution and downloading it for
free (in most cases) are legitimate options, both ethically and legally. How
often does life come that easily these days? But if you don’t have the band-
width to do all of this downloading, or just get queasy at the thought of burn-
ing your own CDs and DVDs, there are some places you can turn in order to
pick up the media on the on the cheap without giving yourself a headache.

The site www. Tinuxiso.org offers a ton of distributions for downloading,

for example. Armed with your DVD-ROM or CD-ROM burner and a high-speed
Internet connection, you can download and burn your own CD Linux distribu-
tions all day long, for both yourself and for sharing with friends (again, legally).
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However, [ want to emphasize that a high-speed Internet connection is neces-
sary because a CD image is typically in the 650MB range. So just imagine

D r O p B O Gma DVD image would be! A DVD contains around seven CDs’ worth of
yon!

A\

However, if you haven’t tangled with broadband yet, don’t despair. You can still
get your evaluation distribution on CD or DVD, and you can even purchase
CDs and DVDs on the cheap off of eBay (and legally too). Just ask a Linux geek:
Linux geeks are plentiful these days and can usually hook you up with a CD
or two — they’re just happy that another computer user has seen the light.

If you don’t know any Linux geeks, you may want to look up a local Linux
Users Group (LUG). You can find a list of LUGs worldwide, listed by geographic
region, on the GLUE (Groups of Linux Users Everywhere) Web site: www.ssc.
com:8080/glue/groups. These folks are always happy to help the techno-
logically challenged. These user groups also regularly sponsor events, called
demo days or install-fests, where you can bring your computer and get all the
help you need. These events are usually lots of fun for computer enthusiasts —
hot and cold running caffeine and enough know-how to do just about anything
with a computer.

Putting Linux distributions in perspective

Just so you know that I'm not using any special smoke and mirrors, here’s a
description of the system [ used to evaluate these distributions:

v~ Intel Pentium Il 450MHz processor (not exactly a fighter jet these days —
not even a passenger jet)

v 258MB RAM

v 6GB IDE hard drive

v ATI 128RT video adapter
v PS2 mouse and keyboard

In both systems [ surveyed (Mandrake and SuSE), I elected to use the entire
hard disk setup and chose to install the recommended software rather than
get fancy with software selections. Essentially, | was after the fewest possible
keystrokes, mouse clicks, and brain cycles to get Linux up and running on my
system.

Both Linux distributions proved exceedingly simple to install. In the past,
Linux installation was fraught with partition pains and cryptic decisions, but
those days appear to be gone.
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Mandrake
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v Web site: www.mandrakelinux.com

v Version surveyed: Mandrake 9.2

The Mandrake distribution pioneered the art of easy installation. With
Mandrake, you finally get a distribution that can resize your existing
Windows partition for dual booting without any effort on your part. That’s
right! You no longer need to do any of those preinstallation partition-resizing
stunts; Mandrake does all of it for you automagically.

Mandrake, created in 1998 with the goal of creating an easy and intuitive instal-
lation for everyone, specializes in ease of use for both server and homej/office
installations. To accomplish this objective, the creators of Mandrake focused
on the goal of making an easy transition from your Microsoft Windows or Mac
skills to Linux. Having a system that resembles what you're used to working
with greatly shortens your Linux learning curve.

If you like strong user communities, Mandrake has many dedicated supporters.
Check out the Mandrake User’s Club (www.mandrakelinux.com/en/club). For
a minimal fee, you can have access to all kinds of cool extras and opportunities.

Installing Mandrake

The installation screen lets you know the status of your installation at all times
(see Figure 4-1 for an example). You’re shown which tasks have been success-
fully completed and which tasks are yet to be performed via a progress list
on the left side of the screen.

The time it takes to perform the installation depends on the number of pack-
ages you choose to install. You have three options for partitioning:

v Use existing partition.

v Erase entire disk.

v Use custom disk partitioning.
I chose the Erase Entire Disk option. I then used the package selection defaults

and added the rest of the Workstation options, including all the fun packages:
games and multimedia stuff. The package installation ran for about 20 minutes,
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and the total installation took about half an hour. Just don’t forget to go
through the various items offered in the Summary page before finishing your

i therwise, half of your system won’t be configured. Also take
ro p O Gn rtunity to test your X configuration before completing the install.

|
Figure 4-1:
The
Mandrake
installation
screen.
|

As with most current popular distributions, during the installation you're kept
amused by advertising for support services, helpful Web sites, and tips and
tricks for making the most of your Linux computer. You're asked to accept a
license agreement, essentially just reiterating the terms of the GPL, and you
see a reminder to be aware of the license variations that may apply to other
software included with the distribution.

(.*Mandrukel.lmx 9.2 - Installation

Please choose a language to use.

I Africa
~ America

English (American)
English (British)
Espafiol

Esperanto
Francais
Portugués do Brasil

b Asia
> Europe
b OceaniaPacific

- Dep ‘ Bivcice

Recognizing some special
Mandrake features

One unique option (after Mandrake has asked you for the root password and
other user information) is whether you want the computer to log on automat-
ically to one specific user when it boots. If you're the only person who uses
this computer and you have no need to provide user authorization, this fea-
ture is handy — though not necessarily a good idea since it would let anyone
access all of your personal information. Note that even though you don’t have
to supply a username or password to see your desktop, you're still bound by
the security settings in your user profile. The program’s not bypassing any
type of security; it’s simply automating the login process for you.
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The last item on the installation checklist is handy, as long as you have a
decent Internet connection. The installer connects, if you choose to let it,
orized Mandrake download mirror site and fetches all appropriate
teSYy o your existing version of Mandrake. Considering the time lag in any
publishing event between the time the product is packaged and the time you
install it, this feature can be quite important to maintaining a secure system
with the latest software updates.

The first time you boot, you’re prompted to register your contact information,
which may be automatically passed to Mandrake so the company can keep
you up to date with security information, and more. The first login also takes
a few moments to establish the initial settings of your desktop, so please be
patient.

Here are some random notes about Mandrake:

v Membership in the Mandrake club gives you access to more than 50,000
applications, plus the ability to download the latest version of Mandrake
for free before people can even buy it.

v The shrink-wrapped sets cost $39 and more.
v MandrakeUpdate provides easy updates through the Internet.

v Versions exist for computers that are based on these architectures:
Pentium (i586 and higher), Alpha AXP, 1A64, PPC, and Sparc.

v Tagline: The Linux Experts
»* Web site: www.suse.com

1 Version surveyed: 8.2 Live Evaluation

The SuSE (“SO0-za™) company and Linux distribution were founded in

1992. The distribution is named after a German acronym for Soffware und
Systementwicklung (Software and System Development). One SuSE claim to
fame is its international support (most major distributions provide a level of
support for users around the globe, but some have better language integra-
tion for particular groups than others; SuSE understandably excels in the
German and otherwise European space), including distributions in these
seven languages:
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v Brazilian Portuguese

DropBooks:

v French

v German

v Italian

1 Portuguese
v Spanish

As with other widely used distributions, SuSE has service and support offices
and staff members around the world to help businesses and industries sup-
port their Linux solutions.

Installing SuSE

Of all the latest and greatest distributions claiming to be better than all the
rest, SUSE has made the most dramatic leap in providing a truly simple Linux
evaluation system. You can download the live evaluation version from the
Web site (www.suse.com/us/private/download/suse_1inux) and burn it
to a CD. After you boot from this CD, you're prompted with the typical instal-
lation questions: which types of keyboard and mouse you have and which
type of video hardware, for example.

Notice that one important and necessary setup step is omitted: how you
want to partition and format your hard disk. Omitting such an important step
seems goofy, don’t you think? Well, the folks at SuSE didn’t forget to include
this step; rather, it comes in an ingenious feature to keep you from nuking
your existing operating system while trying to see what this Linux thing is all
about. Intrigued?

If you pay close attention when the CD is initially loading into memory, you
may see a message regarding file system detection. Here’s the scoop: The CD
isn’t really installing Linux to your hard drive. If you recall, the title of this
distribution states Evaluation in its wording. SuSE has drastically reduced the
time gap between wanting to use Linux and being able to interact with a usable
system, by booting a virtual system that utilizes your computer’s memory, any
available existing file system volumes, and the directories and files already
on the CD.
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Another distribution designed to change nothing on your hard drive is
Knoppix (www. knoppix.org).

oks

Using the SuSE evaluation version

If you have an operating system on your computer, the SuSE evaluation ver-
sion detects what your file system is and borrows some space to write sev-
eral files of its own. The information kept in these files includes usernames,
passwords, and hardware information about your computer. By establishing
a virtual system, you don’t have to make any critical decisions about parti-
tioning and disk formatting that could ultimately trash your existing system.

After you perform this virtual installation, you can simply drop the SuSE 8.2
Evaluation CD in the caddy and boot from it whenever you want to run Linux.
Note that you wouldn’t want to use this evaluation CD for any serious work
with Linux. You would instead want to make a full and permanent installation
to your hard drive. You notice quickly that your SuSE Linux evaluation tends
to run slowly because accessing a CD-ROM drive takes much longer than
accessing the average hard drive. Mouse clicks and keystrokes tend to be
sluggish. Just remember that it’s intended for only evaluation purposes. The
upside is that the distribution is a remarkable one and likely provides the
quickest way to see a full Linux graphical workstation in action with the least
amount of computer knowledge required.

SuSE has created a powerful, central tool for installation and configuration:
called YaSTst2 (a descendant of YaST, which is an acronym for Yet Another
Setup Tool). Following a few prompts and mouse clicks, the SuSE evaluation
CD installs in fewer than 15 minutes (see Figure 4-2).

After the evaluation system is booted and running, you see several menu
options, including the SuSE tour, a browser link to the SuSE home page, a link
to free installation support, and a couple other links that provide additional
information for the curious.

Without creating its own file system to store information, SuSE needs a place
to store your settings and user accounts. It creates the following four files on
the existing file system to maintain the variable information you change in
your SuSE evaluation:

v suselive.800: Data for the SuSE Version 8.2 evaluation CD

v suselive.swp: Swap file

v suselive.usr: Users’ home directories

v suselive.txt: Descriptions of these files
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Figure 4-2:
SuSE's
YaST2 gets
you set up

in a jiffy.
|

Welcome to YaST2 - the SuSE Linux
installation and system administration program.
Language
Selection
Select your language:
TraTTsT Y|
Installation Deutsch |
Settings English (GB)
Espariol
Francgais
Perform EAMNU LED |
Installation itallano |§|
Help Abort Installation

To remove SuSE from your system, you simply need to delete these files from
the root of your current file system. For Windows, they’re in your C:\ direc-
tory, and for an existing Linux installation, they’re at the root mount point (/).
These files take up about 120MB of disk space, not exactly small potatoes.

Here are some additional notes about SuSE:

v You can still do a permanent SuSE installation to your hard drive, but you
need to visit the SuSE Web site (www. suse.com) or a mirror to download
the appropriate files and instructions for making a complete installation.
The partitioning options are similar to those available with Red Hat
Linux.

v Several boxed sets are available from SuSE and the company’s retail
vendors. Prices for these sets start at $39.95 (U.S.).

About SuSE 9.0 Professional

If you want to stick with the defaults, the initial SuSE 9.0 Professional installa-
tion is a very simple operation. You answer a few quick questions, glance over
a summary screen to make sure that everything will be set as you would like
it, and then start the install. Then, after most of the packages are placed on
your computer, you fine-tune it all.

/1
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P\\- s,(/ lhlS two- pal‘t practice is more and more common in modern Linux distribu-
E\G &
tions because it means that first installation segment has a better chance of

ithout any problems, making it easier for experienced users to then
ro GJ ﬁepair if the second portion of the installation and setup process fails.
Not only does this version have a simple installation process, but with SuSE
9.0 Professional, you receive more than 2,000 applications on both CD and

DVD, saving you from having to spend an inordinate time tracking down and
downloading additional programs.
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In This Chapter

Understanding what happens when you turn on your Linux machine
Identifying and isolating boot problems
Shutting down safely

I like work; it fascinates me. I can sit back and look at it for hours.

—Jerome K. Jerome

f you came here from Chapter 3 or 4, you likely just survived the first

gauntlet of the Linux world: installing the operating system. I hope that
booting for the first time worked well. If it did and you decide that most of
this chapter isn’t for you, at least skip to the last section in this chapter,
“Don’t Just Turn Off the Machine!” Otherwise, if you're interested in learning
about what your machine does as it boots, read on.

If your Linux installation didn’t boot properly, don’t panic. Much of this chapter
is designed to help you deal with any problems you ran into. Before you curse
Linux, remember that installing an operating system is no small task and that,
because many technical variables are associated with such an installation,
many computer manufacturers insist on performing the task at the factory.

In this chapter, [ unravel the mystery of booting a Linux system by taking you
through the boot process step-by-step. Although you may encounter all sorts
of potential problems during the boot, identifying the culprit is often the most
important component of the solution. Seeking an answer to the source of a
boot error is much like solving a crime. Discovering the first of many clues
always led Mr. Holmes to an elementary solution.
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So grab your giant magnifying glass and turn your hat around so that you can
start sleuthing.

DropBooks
Giving Linux the Boot

Let’s face it: As enjoyable as the experience of staring at a dormant computer
is, the real fun starts when you turn the computer on. As with any electronic
device, opening the electron floodgate is the first step to fun. A computer,
however, has much more stuff to do than your toaster oven, for example.
Rather than act as a simple heating element, your computer has to check all
those gizmos that you (or the manufacturer) plugged into your computer’s
motherboard. After the initial power-up, the computer performs some simple
hardware tests to determine whether those various components are working

properly.

Checking all your hardware is just the beginning. Between the time you turn
the computer on and the moment the glowing phosphor on your monitor
prompts you for a login name, the computer is building itself an empire. If
you listen and watch carefully, your computer and monitor show signs of the
boot process through bleeps, buzzes, whirring motors, clicks, messages on
the monitor, and blinking lights. In this section, I help you identify each stage
in the boot process.

Although you have heard the cliché “Rome wasn’t built in a day,” the boot
process goes fairly quickly. This is pretty amazing, considering that the archi-
tecture of an operating system makes Rome’s look like a stack of cardboard
boxes and that each time you power up your computer, it must build its whole
operating system in memory. (Remember that an operating system is software
that resides between your programs and the computer hardware.) Electrons
move at the speed of light, of course, which gives the computer an advantage
over the Romans — but that’s enough jibber-jabber.

Making certain that this operating-system software is installed and running
correctly is the purpose of the boot process. This process can be broken into
four main steps, which I discuss in the following sections.

Step 1: Power-On Self-Test (POST)

The POST process really has nothing to do with the operating system. Your
computer performs this step whether you're running Linux or another oper-
ating system. Inside your computer is a chip containing a program that carries
out the POST process. The program
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v Checks your computer to ensure that fundamental components are
functioning properly.

D ro p B O Ok(gnts and tests memory.

v Verifies that no resource conflicts exist for the current adapters and
settings, kind of like a traffic cop.

v Performs certain basic tests to verify whether each system component
is working properly. (The set of rules that determine how these compo-
nents communicate is called the BIOS, or Basic Input-Output System.)

Some symptoms of a failed POST include

v An unusual series of long and short beeps.
v Nothing displayed on the monitor.
+ No apparent activity other than the fan on the power supply.

v A puff of smoke or the pungent smell of burning electrical components
seeping out the vent of your computer case.

v An error message, displayed on the monitor, indicating a hardware failure.

If you encounter any of these problems, you have hardware problems that
need to be resolved before you can proceed. Chances are, if your computer
was running properly before you began your Linux installation, your computer
should be getting through the POST just fine. If not, it’s time to question your
nephew Mortimer, who was last seen lurking around your computer with a
screwdriver.

Step 2: The BIOS passes the
baton to the boot loader

After the BIOS gives the okey-dokey with a successful POST, the BIOS locates
the first hard drive in your system and reads the first sector of that disk. On
that first chunk of disk is a small program called a boot loader. The boot loader
doesn’t know much about anything, except how to load your operating system.

Two boot loader programs understand how to load a Linux operating system:
LILO (LInux LOader) and GRUB (GRand Unified Boot loader). LILO has been
a tried-and-true boot loader for as long as Linux has been a gleam in a geek’s
eyeball. GRUB is a newer and much more sophisticated boot loader program
than LILO. The current version of Fedora Core allows you to choose your boot
loader, but uses GRUB by default.
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I recommend that you stick with whatever your chosen distribution uses by
default. This boot loader has the best support with the distribution’s built-in

ks

One common symptom of a missing or corrupt boot loader is a message saying
that the operating system could not be found. To get the boot loader working
again, reinstall the boot loader to the master boot record of your first drive. |
explain later in this chapter how to reload and install the boot loader. You may
also see this message if the disk geometry has changed in the BIOS from the
time you installed the operating system. If, for some reason, you change the
heads, tracks, and sectors setting, the BIOS may not be able to find the first
sector on the first drive.

Step 3: The boot loader (GRUB or LILO)
loads the system kernel into memory

A boot loader is a program that understands how to load a system kernel into
memory. A kernel is the software at the heart of any operating system and
communicates directly with the hardware. For example, when you choose to
save a file in your word processor application, your word processor is making
arequest to the kernel to perform the saving of the file to disk. The loaded
kernel acts as the maestro, orchestrating all the components of your computer
and delegating resources in a logical and cooperative manner. The boot loader
is the red carpet on which the maestro enters.

This list shows some symptoms of a missing, incorrect, or corrupt system
kernel:

v The system freezes after the boot loader continues.

1 A few dots appear across the top of the monitor and then the system
freezes.

1 A few messages appear on the screen, and the final message reads
kernel panic.

v The system reboots automatically after the kernel starts loading.

You know when the kernel is loading because several screens full of kernel
messages scroll up your monitor. Note that a kernel error results in a wide vari-
ety of symptoms because the loading of the kernel is the first introduction of
Linux to your hardware. With a seemingly infinite combination of computer
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components, making certain that they’re compatible can be a challenge —
especially with really old or really new hardware. Kernel support for this type
OI k are may be minimal or nonexistent.

The remedy for an apparent missing kernel is to correctly tell the boot loader
where to find the kernel. Although this task can be relatively easy to do with
GRUB, it requires a crowbar and a rescue disk with LILO. Although a descrip-
tion of this task is beyond the scope of this book, you can check out Chap-
ter 2 for other sources of Linux information.

One key step in installing Linux on your computer is the configuration of a
boot loader. If your installation is successful, you never need to give another
thought to this component. It just runs silently each time you turn on your
machine. However, some situations require that you interact with the boot
loader program. You may want to start Linux in a mode other than the default,
for example, or perhaps you need to pass special information regarding a
new adapter you just installed.

The way you invoke the boot loader depends on your Linux distribution. The
text displayed on your monitor following the power-on typically provides you
with instructions. If you loaded the GRUB boot loader, you can get to an inter-
active prompt by pressing A.

The GRUB manual is available online at www.gnu.org/manual/grub-0.92/
grub.html.

Step 4: Control is handed over to init

Up to this point in the boot process, only the components that run behind
the scenes have been loaded. A program named init is the common ances-
tor to all other programs that run while the system is operating. The init
program is responsible for starting all services and programs. You can see
these processes starting as they scroll up the screen with [OK] or [FATLED]
on the right side of the monitor. If you see these lines, you know that your
kernel has loaded.

The only problems you may encounter with init are services that fail to load,
as is indicated by the [FAILED] status. Many of these services don’t keep
you from logging in and using your system. Services usually fail because of
misconfigurations or unsupported hardware drivers.

77
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Troubleshooting the Boot
D ro p B O G‘Kg’gency boot disk you create for your system and a rescue disk are

subtly different. A boot disk still requires the capability to access your Linux
installation on your hard disk, whereas the rescue disk does not. The rescue
boot simulates your hard disk in what is called a RAM disk, holding the files
entirely in memory. The benefit of this disk is that you can perform necessary
system surgery without requiring utilities that are part of the installed system,;
everything you need is part of the rescue disk.

The DVD — or the first CD — in your Fedora Core distribution doubles as a
rescue disk. To enter rescue mode:
1. When the disk first loads, type linux rescue at the boot prompt prompt.
This action begins booting the system into maintenance mode.
2. Select your language and press Enter.
3. Select your keyboard type and press Enter.

The rescue system does its thing for a while, perhaps a minute or two
on a slow system.

4. When asked if you want to start the network interfaces, answer No
unless you know there is something you need to download.

5. At the Rescue screen, select one of the three options offered, and
“then press Enter.

Your three options are

¢ Continue: The rescue interface will track down your installed Fedora
Core system for you. Make a note of where it says it will mount the
files so you know which directory contains them.

e Read-Only: The same as Continue, but you will not be able to make
any changes to your hard drive installation.

e Skip: Don’t bother trying to locate the filesystem, just give me a
prompt!

[ will assume that you chose Continue.

6. In the next screen, make a note of the command that the rescue inter-
face gives you to help your file navigation easier, and then press
Enter.

You now have access to the rescue interface. This is a command-line
setup, so if you haven’t delved into Linux at the command line yet, it’s
time to do so! Appendix A has a handy reference of commands you can
use for a variety of purposes if you want a good starting place.
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If you're having problems with your boot loader, the GRUB configuration file
is /etc/grub.conf. Remember, the GRUB manual is available online at www. gnu.

Or ual/grub-0.92/grub.html.

Does the process above sound a bit too painful? As useful as rescue mode is,
it doesn’t take away your need for a boot disk. With a boot disk, if your boot
loader gets messed up, you can boot with the special floppy instead. How
handy is that?

You had the opportunity to create one during installation. If you have already
created a custom boot disk, you're set. Label it clearly and keep it some-
where convenient in case you have problems with the machine. If you're the
conservative type, you may also want to keep another version off-site, maybe
at home.

If you haven’t already created a boot disk, many distributions have special
programs or tools available to make custom boot disks for you! The Red Hat
tool — and hence, the Fedora Core tool — is mkbootdisk. See your documen-
tation for details.

You shouldn’t limit the boot disks you keep on hand to Linux — things can go
wrong with Windows and other operating systems too. Each operating system
has a method of creating boot disks. Be sure to make one and keep it handy,
especially if you start dual- or triple-booting.

In fact, you have the opportunity to create a custom boot disk when you per-
form the installation. If you've already created a custom boot disk, you're set.
Label it clearly and keep it somewhere convenient in case you have problems
with the machine. If you're the really conservative type, you may also want to
keep another version off-site, maybe at home.

Many distributions have special programs or tools available to make custom
boot disks for you! Fedora Core has mkbootdisk, Mandrake has mkbootdisk
and drakfloppy (graphical), and SuSE has yast.

Also, a lot of modern Linux distributions allow you to boot with the CD-ROM
and choose rescue as your boot option without necessarily needing a custom
disk. If you haven’t yet made a custom boot disk, refer to Chapter 2 for
instructions.

The emergency boot disk that you create for your system and a rescue disk are
subtly different. A boot diskette still requires the capability to access your
Linux installation on your hard disk whereas the rescue disk does not. The
rescue boot simulates a root file system in what is called a RAM disk or entirely
in RAM memory. The benefit of this is that you can perform necessary system
surgery without requiring shared libraries or utilities that are part of the
installed system; everything that you need is part of the rescue disk.
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“My system never booted properly”

D ro p B O Qlkﬁve just installed your system and it isn’t booting properly, | suggest
t
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try reinstalling Linux from your DVD or CDs. If that doesn’t work, try
booting from the special boot floppy you created during installation. Your
computer’s hard drives may be misconfigured, a common problem with
hand-me-down computers that have obviously been Frankensteined, or
pieced together. (Symptoms include unnatural bolts jutting from the side of
the case or entrails dangling from empty drive bays.). If your computer still
doesn’t work, you have a hardware incompatibility or configuration issue,
and helping you debug it is beyond the scope of this book. | recommend that
you find a friend or neighbor who understands PC hardware and can help you
diagnose your hardware’s health. Another valuable resource is your local Linux
Users Group. In most cities, active groups often gather for install-fests, where
you can take your computer for some friendly and expert advice.

“I could swear 1| saw an error
while it was booting”

Some boot problems appear as the kernel initializes the system. Lots of infor-
mation scrolls by as the Linux computer boots, which makes it hard for you
to catch specific pieces (especially if your machine is really fast). Fortunately,
most Linux distributions keep a log in the form of a text file. This log contains
a record of what happened during the boot process. Table 5-1 lists where you
can find this information in several popular Linux distributions.

Table 5-1 Log File Locations in Linux Distributions
Distribution Log File Locations

Mandrake /var/log/boot.log, /var/log/dmesg, /var/log/messages
Fedora Core /var/log/boot.log, /var/log/dmesg, /var/log/messages
SuSE /var/log/boot.msg, /var/log/messages

Type dmesg at a command prompt and press Enter to get your boot informa-
tion to come back up at any time. You can also use dmesg | less to ensure that
it doesn’t just scroll past you again. (Note that this command is two commands
in one.) If you run dmesg by itself, it scrolls through the initialization messages,
probably off the screen. The 1ess command is another command that displays
one screen full of messages at a time. The vertical bar that glues these com-
mands together is a pipe. See Chapter 11 for more information.
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&n you’re not tapping anything into the keyboard or clicking any
buttons, Linux is still running along in the background and doing lots of
housekeeping chores. Some of these chores may involve swapping cache
and memory data to and from the fixed disk. When you deprive your com-
puter of its power, it may not be able to complete its transaction.

You may need to recondition yourself from the bad habits of older versions
of Windows (for example, shutting down the computer when you're done). A
Linux computer doesn’t need to be turned off after use; rather, you just log out
and perhaps turn off your monitor. The next time you want to use the com-
puter, you simply log in rather than go through the arduous boot process.

At times, however, you may want to turn off your Linux machine. Perhaps you
need to add new hardware, the power company is turning off the power to
your house, or you're going on vacation for a few weeks and just want to save
on your electric bill. Regardless of the reason, you must shut down Linux in
an orderly manner.

You can use one of these methods to shut down Linux properly:

v If you're in the GUI, log out of your account using the main menu’s Log
Out option, and then click the display manager option that says,
strangely enough, Shut Down.

v If you have a command prompt open, enter the halt command at the
shell prompt (#) followed by the root password, and Linux shuts itself
down and tells you when it’s all right to turn off the machine.

v If you have a command prompt open, enter the reboot command, and
Linux goes through the motions of shutting itself down and then immedi-
ately reboots the machine.

v If you have a command prompt open, entering shutdown -r now is the
most traditionally accepted method. The shutdown command optionally
allows you to send messages to logged-in users and determine how long
until the shutdown takes place. Another method is the poweroff com-
mand, which is just an alias to the previously mentioned halt command.

If you do accidentally cut the power to your Linux box, take heart; all is not
lost. Chances are that you can reboot your computer and pick up where you
left off. However, you may have to pay for your error by waiting during a quick
file system check while the machine makes sure that nothing was damaged.
This process is similar to the one in Windows, where, if you power off incor-
rectly, the operating system performs a Scandisk operation.
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In This Chapter

Checking out the faces of Linux
When to use and not use root
Setting up to print

Configuration tools & la carte

A bus station is where a bus stops.
A train station is where a train stops.
On my desk, I have a workstation. . . .

—Steven Wright

One of the great things about Linux is that you can customize the environ-
ment to fit your needs and your style. You can choose to use a “standard,
out-of-the-box” look, or you can be unique. Whichever way you decide to go,
you can always go back to the original settings or choose a different look.

A base, or typical, Linux installation provides you with an elegant and capable
system that can certainly give you all the necessary elements you need for
work or for fun. However, you may want to explore the various configuration
options and tools to mold Linux to your personal preferences and needs.

In this chapter, | provide an overview of common configuration options —
from system-level configuration to customizing individual user environments.
Modular design, one of the great strengths of Linux, enables you to customize
your system in any way you want and for any computing need. Along the way,
I point into the dark corners of the file system, where the configuration files
lurk. I also introduce you to helpful configuration tools so that you don’t have
to get your hands dirty with these often cryptic files.
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Before I delve into the innards of Linux configuration, I take a brief tour of the
various Linux interfaces. Whatever Linux configuration you choose or what-

kagjr applications you use, you find that you can do almost anything, no

at Linux “looks like.” After I have spent some time discussing the
faces of Linux, I cover user accounts and the root account a bit. You see why
you should create a user account for yourself and for others who use your
Linux system.

The Interfaces

WING/
&

Linux has two interface types: the command-line interface and the graphical
user interface (GUI). If you use other computer systems, such as Windows or
the Macintosh, you’re already familiar with a GUI interface. Most Linux distri-
butions include different versions of the GUI, and you can configure all aspects
of the graphical interface.

If you have been using computers for many years, you may also be familiar
with a command-line interface. The initial release and early development of
Linux was all command-line-oriented; GUI interfaces only recently became
popular and powerful on Linux. One important deciding factor when choos-
ing between a command-line interface and a GUI is speed. If you plan to com-
pile programs or perform other processor-intensive tasks that tend to slow
down your machine, running the GUI will add to the speed problem, especially
if you don’t have a fast computer. However, if you have a new computer with
a gigahertz or two of power, tons of memory, and a nice, big hard drive, speed
won'’t be a problem.

Remember that even with gobs of power and speed, the more applications or
services you run at the same time, the more the overall speed of any one of
the running applications is reduced.

Readability can also be a big issue when choosing between the GUI and

the command prompt. If you have a hard time reading text in those small
command-prompt windows from within the GUI, you can make the windows
and the font bigger, or you can work directly with the command prompt out-
side the GUL. In this case, you may or may not want to close the GUIL.

The two biggest GUI contenders for Linux are GNOME and KDE. Because
Fedora Core 1 comes with this book and this distribution is backed by Red
Hat — which has its own versions of GNOME and KDE, called Bluecurve — I
cover these versions. Every Linux distribution customizes the interface to
some degree. I'm as explicit as possible in pointing out when you’re looking
at something that’s specific to Red Hat (Bluecurve GNOME) and when it’s not
(just GNOME).
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The command line

D ro p B O Q&S{ command-line interface provides a quick and fast way of entering
o d
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s and executing actions. Even if you are mostly a “GUI person,” after
you get the hang of using the command line, you discover that it’s faster to
perform some tasks at the command line than with a mouse in the GUI envi-
ronment. However, if you prefer to use a GUI interface as your working environ-
ment, you can easily open a terminal window, which is a command-prompt
window, to perform your command-driven tasks.

When you installed Fedora Core 1, it gave you a graphical login by default.
Other versions may give you the option of choosing a graphical or command-
line login. If you don’t have a graphical login, when you start up, your screen
is mostly black with a few lines of text displaying the Linux distribution, the
name of your machine, and a blinking line. To log in to Linux at a command
prompt, follow these steps:

1. Type your account name and press Enter.
The system responds with a password prompt.

2. Enter your password at the prompt and press Enter to send the
password to the operating system.

For security purposes, the password isn’t displayed on the screen. After you
have successfully logged in to Linux, the command prompt points to your
default location, which is your home directory.

Most Linux distributions have quite a flexible command-line interface and
allow you to use the arrow keys to move the cursor and the Backspace and
Delete keys to remove text. One difference between the Linux command line
and other interface command lines, such as in Windows, is that Linux com-
mands are case sensitive. The Linux command line also has an autocompletion
feature for commands. If you know the first few characters of a command, type
part of the command and press Tab to complete the rest of the command auto-
matically. If you hear a beep when you press Tab, more than one command is
available that starts with the same sequence of characters. To see the list of
matching commands, press Tab again. To autocomplete the command you
want, type a few more characters and press Tab again.

The trick to using the Tab key for autocompletion is to type just enough of
the command so that the typed characters are unique to the command.

Most Linux distributions also keep a running history of the most recently
used commands. To access the history list, press the up-arrow key on your
keyboard. As you continue to press the up-arrow key, you step through the
most recently entered commands in reverse chronological order. If you
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have moved too far back in the command history, use the down-arrow key to
reverse direction in the history list. When the command you want is displayed

D r O p B O Ot kg‘nmand prompt, press Enter to execute the command.

You can modify the Linux command prompt and the entire command-line inter-
face. In Chapter 11, I cover some techniques for customizing the command
interface and other aspects of the command-line environment.

GNOME basics

The Bluecurve GNOME interface, which is shown in Figure 6-1, is the GNU
Network Object Model Environment. [ know — the full name doesn’t tell you
much, does it? This is a full desktop environment, which means that it gives
you everything you need for the GUI all-in-one package. You may find it odd
to even talk about this subject if you're used to Windows or Macintosh sys-
tems because for them, it has always been that way. Things are different
under Linux. You can stitch together a Frankensteinian mismatch of many
different GUI pieces, if you want.

| o

dee's Home

Start Here

|
Figure 6-1:
The default
Bluecurve
GNOME
desktop

in Fedora
Core 1.
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To find out more about GNOME, visit the main GNOME site, at www.gnome.org.

D ro qk S:S find that GNOME has an intuitive layout. Take a tour through the
n d see what’s available in this environment. Keep in mind that the
tools you have on the menus may depend on the type of installation you

chose; if what you have is different from what you see in descriptions or the
figures, don’t panic.

The GNOME desktop environment is essentially broken into three separate
parts:

v The menus
v The Panel at the bottom of the screen

v The icons along the top of the background on what’s known as the
desktop

The menus

The GNOME menus are normally accessible through the button that looks
like a big footprint in the lower-left corner of the Panel, but Fedora Core uses
a button with a red fedora (hat) in Bluecurve — this is the Red Hat symbol.
Either way, this button is called the Main Menu button. The main menu that
opens after you click the Main Menu button is shown in Figure 6-2.

@ Accessories ¥
{i& Games ¥
@ Graphics El
é\ Internet o
;';% Office o
%‘ Preferences o
ﬁ Programming El
,:f'_ Sound & Video
{_,,_,,1 System Settings ¥
% System Tools

‘@ Help

— _Q‘ Home Folder
Figure 6-2: |5 Nework Servers
The {3} Run Application...
Bluecurve |[€] search for Files...
GNOME |[= open Recent ¥
main menu Lock Screen
in Fedora Log Out

Core 1. ‘A%
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The contents of this and many of the submenus are slightly different, depend-
ini on exactly which programs you installed. Often, the submenus have their

), ' O gnenus within that offer even more programs.

I describe in Table 6-1 the contents of the submenus on the main menu.

Table 6-1 Bluecurve GNOME Main Menu Contents,
Listed in the Order That They Appear
Menu Choice What You Find

Accessories

Small, specific-function GNOME and X programs. Contains a
calculator, character map, dictionary, file roller, Pilot/Handspring
tool, and text editor.

Games A collection of games.

Graphics A variety of graphics programs, including The GIMP.

Internet A few Internet tools, such as Evolution (e-mail and calendar
program), Gaim (instant messenger), and Mozilla (Web browser).

Office The OpenOffice.org suite of applications (word processing,
drawing, and more).

Preferences Access to programs to control the look and feel of the GNOME

and Linux graphical interface.

Programming

Applications and tools used in programming. This menu appears
only when Linux is installed with one of the programming-related
packages selected.

Sound & Video

Programs, such as a CD player and sound recorder, for working
with your computer’s multimedia hardware.

System Settings

Many tools for working with your computer’s hardware, such as
display settings and packages to view and configure the soft-
ware packages installed on your system.

System Tools

Many tools for managing, monitoring, and updating your
system, such as the Internet Configuration Wizard, Red Hat
Network, and a System Logs viewer.

Help The Help Browser, for exploring the electronic documentation
included in the Linux distribution.
Home Folder The Nautilus file manager, defaulting to your home folder’s

contents.

Run Application

The dialog box you can use to run a specific program without
opening a virtual terminal.
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Figure 6-3:
The Run
Application
dialog box
with Show
List of
Known
Applications
selected.
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Menu Choice What You Find

for Files  The Search Tool window, for locating files in the file system.

Opeﬁecent

A selection of the last files you opened from the file manager.

The capability to set your machine so that no one can use your
GNOME login without entering your password. This feature is a
good one if you need to walk away from the computer for a
while (but don’t want to log out of your account) and other
people are around.

Lock Screen

The capability to exit the GNOME session, shut down, or reboot

Log Out
the machine — if you know the password of the root account.

The Run Program tool

After you choose the Run Program option on the main menu, the Run Program
dialog box appears, as shown in Figure 6-3. To run a program using this dialog
box, select the application from the Known Applications list and click the Run

button.

x|

Run Application

ﬂ Luserinfo
[1 Run in terminal

Show list of known applications

Run with file...

F1 About Myself
Accesswbiliw
%Addmemuw Applications

[ AisteRiot Solitaire
Q. e
Change personal information

| & Help |

I I- [

‘ 3% Cancel || @R_um |

The Lock Screen tool

If you're not the root user and you choose the Lock Screen option on the
main menu, your screen fades to black or your screen saver appears. Then, if
anyone moves the mouse or uses your keyboard, a dialog box appears with
your login name in it and a password field. You can access this GUI session
again by entering your password. Note that if you're logged in as the root
user, the Lock Screen option doesn’t work.

Notice that I say GUI session and not machine. Folks who know how to sidestep
out of GNOME (something I discuss in Chapter 12) can start a virtual terminal
session and do whatever they want. Don’t think of this feature as something
that completely secures your machine.
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The The Log Out tool
r you choose the Log Out option on the main menu, the screen darkens

D ro B O t and the Are You Sure You Want to Log Out? dialog box opens. To
ox, follow these steps:

1. If you want GNOME to remember which items you have open and
return you to its current state after you log back in, make sure that
you select the Save Current Setup check box.

2. Click Log Out, Shut Down, or Restart the Computer to set the appro-
priate action into motion, or click Cancel if you don’t want to do any
of them.

These options do the following:
¢ Log Out: Closes GNOME and returns to the command prompt.

e Shut Down: Shuts the machine down and then off. You must be able
to enter the root password (the password for the root user) to use
this option.

¢ Restart the Computer: Shuts down the machine and then brings
it back up. You can use this option only if you know the root
password.

3. Click OK to go through with your choice or Cancel if you change
your mind.

The Panel

Along the bottom of your GNOME desktop is a long bar with icons on it. It’s
the Panel. Because this bar is neatly divided into sections, take a look at
what’s in each section from left to right. On the far left side of the Panel is
the GNOME Main Menu button (refer to Figure 6-1), which opens the appro-
priately named main menu.

As you continue your journey to the right, you run into the standard set of
Bluecurve GNOME tools (refer to Figure 6-1). You can reach all these items
through the main menu, but they’re placed on the Panel so that you can find
them quickly and easily:

v Mozilla: The Worldplanet-with-a-mouse icon. It launches the Mozilla Web
browser if you're using Red Hat Linux; if not, it’s a red dinosaur.

v Evolution: Just to the right of the Mozilla button; launches an e-mail and
calendar program.

v OpenOffice.org Writer: Resembles two pieces of paper and opens
the OpenOffice.org Writer word processing program.
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v OpenOffice.org Impress: Opens the OpenOffice.org Impress presenta-
tion creation program.

D ro p B O Ok(@nOfﬁce.org Calc: Opens the OpenOffice.org spreadsheet program.

v Print Manager: The next button opens the Print Manager, which allows
you to check and see which documents are waiting to go to the printer.

v Workspace Switcher applet: Allows you to work in four different desktop
environments during a single login session. Each desktop environment
has the same menus, Panel, and background, but you can run different
programs in each of the environments. It’s an easy way to remain orga-
nized while you’re working in multiple programs.

What you see in the segment to the right of the icons depends on the programs
you have open. Every program you have open has a task box dedicated to it
in this portion of the Panel, called the status, or task, section. For an example
of what you may see, take a look at Figure 6-4.
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You can change a program’s status in three different ways by using the boxes
indicated in Figure 6-4:

D ro p B O Ok& text in a task box is shaded so that it’s harder to see than the others,

the program is minimized. You can open the window by clicking the box.

v~ If the text in a task box isn’t shaded, but the program’s window is hidden
by another program, you can click the box of the hidden program to bring
this program to the front.

v~ If the text in a task box isn’t shaded and the corresponding window is the
program you’re using, you can minimize the program by double-clicking
the unshaded task box.

To the right of the task section is the area where applets show up. You can
add small programs to the Panel for a variety of reasons, which I describe
how to do in Chapter 12. Notice that the clock applet appears in the applets
section by default.

The Panel menu

You can change the look and feel of the Panel, such as adding or deleting
applets, by choosing options from the Panel menu. To open the Panel menu,
right-click any free space on the Panel. For a list of what this menu’s items
offer, see Table 6-2.

Table 6-2 GNOME Panel Menu Contents

Menu Choice What You Find

Add to Panel The applets, menus, and other objects you can add to your
main panel

Delete This Panel The capability to delete a secondary panel but not the main

icon panel

Properties The options for setting this panel’s behavior

New Panel The options for creating new panels that sit on different
parts of the screen

Help The Help browser for GNOME

About Panels A dialog box with some basic Panel information

About GNOME A dialog box with some basic GNOME information

For detailed information about using the Panel menu items, see Chapter 12.
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The Add to Panel menu

The Add to Panel menu is accessible from the Panel menu (right-click any
D ro B O e on the Panel). I show you how to add and remove applets in
2. In Table 6-3,  describe the tiny wonders you may find on the Add

to Panel menu.

Table 6-3

GNOME Add to Panel Menu Contents

Menu Choice What You Find

Accessories

Items such as Clock and Weather Report

Actions

Items for various ways of logging out of your account

Amusements

Games and other fun stuff that can reside on the Panel

Internet

Both the Inbox Monitor and Modem Lights utilities

Multimedia

Simple sound utilities

Utility

Miscellaneous applets that don't fit easily on the other menus, such
as Keyboard Layout Switcher and Window List

Launcher

A feature that enables you to create a shortcut to an application

Launcher
from Menu

An option that enables you to create a shortcut to a menu

Main Menu

The ability to add the main Footprint (or Red Hat fedora) icon to the
Panel

Menu Bar

The same as Main Menu but in a different format

Drawer

An extension to the Panel to provide growth in a different direction
from the main menu

Playing with desktop icons

What you see on your desktop (the main GNOME screen) may be quite differ-
ent from distribution to distribution. In the case of the Fedora Core 1 setup,

a horizontal row of icons lines the top of the screen. The first icon (refer to
Figure 6-1), the Home icon, opens the Nautilus browser with your home direc-
tory’s contents displayed. The next icon is a GNOME shortcut that opens the
Start Here window, whereas the Trash icon opens ~/.Trash. A trashcan is a
welcome sight to users who accidentally delete files in Linux and need to

recover them!

93
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\g
) To use the trashcan, drag into it any files you want to delete. Later, if you're

sure that you want to be rid of them, you can empty the trash in one of

Drop&doks'

v Open the trashcan by double-clicking the icon. Then choose to delete
the entire contents of the trashcan by choosing File>Empty Trash

v Open the trashcan by double-clicking the icon. Then items by right-
clicking the item (or items), choosing Delete from Trash from the pop-up
menu, and clicking the Delete button.

v Another way to remove items from the trashcan is to delete them manu-
ally from ~/.Trash.

KDE basics

KDE, the K Desktop Environment — in Bluecurve style — is shown in Figure 6-5.
Notice that the main menu button for KDE (in the lower left corner) is a big K.

|
Figure 6-5:
The
Bluecurve K
Desktop
Environment
(KDE).

adceclBgapl 0000 g %
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|
Figure 6-6:
The KDE
main menu.
|

To find out more about KDE, visit the main KDE Web site, at www. kde.org.

appearance

As you can see from Figure 6-5, Bluecurve KDE looks pretty familiar, and that’s
by design. Red Hat is trying to make it easier on folks who swap from one GUI
to another. However, if you're using the non-Bluecurve versions, they still look
somewhat similar. An item that should be familiar is the Workplace Switcher’s
set of four boxes (numbered 1 through 4) on the Panel. Almost all Linux GUIs,
including GNOME, allow you to have multiple GUI screens — even if the boxes
look a bit different.

Suppose that you have lots of clutter on your desktop and want to open even
more programs, or maybe you like to have just one item on the desktop at

a time. You can have more than one desktop! The boxes for the additional
screens are numbered 1 through 4 by default. The highlighted box is the one
you’re in. If you click 2, for example, you suddenly have a totally new desk-
top. If you have a bunch of programs in 1, they’re still there after you go to 2.
You just have the equivalent of four screens in one!

The KDE menus

The KDE menus are available through the Main Menu button, which looks like
a big K (or, in Red Hat, a fedora) in the left corner of the Panel. The contents
of the main menu are shown in Figure 6-6. Depending on what applications and
options you choose when installing Linux, the contents of the main menu vary.

Because of the variety and number of icons, I briefly cover the contents of
the submenus of the main menu in Table 6-4.

ey
Q_ﬂ Games
b Graphics
ﬁ] Internet
@ Office

@ Preferences
ﬁ Programming
@ Sound & Videa
@ System Settings
38 System Tools
@ Control Center
€ Find Files

T Help

@ Home

Q Run Command...
@ Lock Screen

Logout "dee"...

-

* v oW ¥ oW ¥ v ow W
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Table 6-4

KDE Main Menu Contents

hoice

What You Find

Accessories

A collection of typical desktop applications

Games An assortment of text and graphical games

Graphics Various applications for working with graphics

Internet Web browsers and other Internet applications

Office The OpenOffice.org collection of word processor, spreadsheet,
and other office-oriented applications

Preferences Tools for configuring the KDE environment

Programming

This menu contains applications and tools used in program-
ming. This menu appears only when Linux is installed with one
of the programming-related packages selected

Sound & Video

Programs, such as an audio player and sound recorder, for
working with your computer’'s multimedia hardware

System Settings

Many tools for working with your computer’s hardware, such as
display settings and packages to view and configure the soft-
ware packages installed on your system

System Tools

Applications for working with the Linux system

Control Center

A group of small applications to configure the Linux system

Find Files A shortcut to a search-file application
Help Access to the online Linux and KDE documentation
Home A shortcut to the home directory of the account that's logged on

when KDE started

Run Command

The ability to launch applications by selecting or typing the
name of the application

Lock Screen

The ability to lock the KDE environment to prevent unauthorized
access to the graphical environment

Logout

The ability to close the KDE session, shut down, or reboot the
machine — if you know the root password

Accounts Great and Small

Linux is a multiuser operating system. It allows everyone to have his own
account and allows more than one user to log on at the same time. Even if
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you’re the only person to use this system, you need an account of your own
that isn’t the root user’s. Multiple accounts are especially fun for experiment-

D o p B 0O O'lkgiifferent user setups.

WING/

Avoiding root

The root user, also known as the superuser or just root, has access to anything
and everything on the machine. No matter how you set things up, you can’t
keep the root account out of any area. The root user also has access to all
commands and devices. Many Linux beginners figure that they may as well
always use the root account because it’s so convenient.

However, for good reasons, you shouldn’t use the root account for
everyday use:

»* You don’t always need root-level access.

v Root-level access is as much a curse as it is a blessing. If you mess up as
a user, you mess up only the stuff in your account. If you mess up as the
root user, you can wipe out everything — all the files on the entire Linux
system!

Don’t think that can happen to you? Many experienced Linux administra-
tors tell horror stories about the day they made a fatal typo or weren’t
paying attention to what they were doing when they were logged in as root.

v If you send e-mail or news posts as root for anything other than serious
administrative business, people think that you don’t know what you're
doing or are showing off.

v Root comes with too much temptation. The superuser can read other
people’s e-mail messages and files, which introduces a few tiny ethical
issues. Many Linux distributions give you a nasty red background when
you’re in the root account so that you don’t forget.

Creating user accounts

Fedora Core 1 and most other modern Linux distributions enable you to
create one or more user accounts during the installation and setup process,
so you may have already added some accounts. You can do this task at any
time, however, after your Linux machine is up and running.

The GUI way

Most Linux distributions include a graphical interface application for creating
and managing user accounts. As an example, I go to the main menu and choose
System Settings=>Users and Groups. Because I'm on my regular user account,
I'm asked to enter the root password before I'm allowed in, which is good for
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en the Red Hat User Manager window opens, as shown in
igure 6-7. When the application opens, the user accounts already in your

Fi
i tem appear. Figure 6-7 shows an example of the initial Red Hat User
ro p O Swindow contents for a Fedora Core 1 system.
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Most graphical Linux account-management programs work in this same

manner.

To create a new user account, follow these steps:

1. Click the Add User button.

The Create New User dialog box opens, as shown in Figure 6-8.

The defaults for the fields, such as Login Shell and Home Directory,
should work just fine for typical users. You may want to fill in the Full
to complete the account information.

1. In the Password field, enter the password, and in the Confirm
Password field, reenter the same password.

2. Click OK to close the Create New User window, and then click the X in
the upper-right corner of the Red Hat User Manager window to close

. Enter a name for your new user in the User Name field.

In Linux, the case of the user account is important, so note the case as

eed to have an initial password set. To assign the new account

ow these steps:

SOMBER 2
&
you type the information.
Name field
New accounts n
a password, foll
@‘(«“BE” the application.
&

Passwords

are case sensitive!
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See the Mandrake and SuSE configuration sections later in this chapter for

where to find things in these distributions.

To create a user account at the command line in any distribution, issue the
useradd command. Although not all Linux distributions have the same
useradd functionality, they all have the command. The generic version of
useradd works very simply. Here are the steps:

1. Type su - root and enter your password with prompted.

Doing this lets you temporarily access the root account.

2. To create an account, type useradd accountname, where accountname

is the name of the new account.

For example, to create an account for a user called named test, you type

useradd test.

Now you need to create a password for this account; otherwise, you can’t
log in to it! Follow these steps:

1. Type passwd accountname, where accountname is the name of the

account that needs the new password.

To create a password for a user named test, for example, you type
passwd test. You then see the following text:

Changing password for user test

New password:
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2. Type the password for this user.

bers and letters, such as 5A2g1AG, and tell the account user to
ge the password to something else when first logging in.

l{ this isn’t one of your own accounts, you should use a set of random
OK

Good passwords consist of the following:
e A combination of numbers, letters, and even punctuation marks
e Uppercase and lowercase characters
e No dictionary words
e Six or more characters

e No family or pet names, friends’ names, birthdays, anniversaries,
or other items that someone can easily guess about you

3. Press Enter.

You see both the following lines or just the last one:

BAD PASSWORD: it is based on a dictionary word
Retype new password:

If you get warnings about the password, pay attention to them! A pass-
word is the first line of defense against people snooping around in your
files or, even worse, messing with your machine.

. If you see only that last line, retype the password and press Enter,

and you’re done!

When the password has been set properly, you see the following line on
the screen:

passwd: all authentication tokens updated successfully.

You have to type the password twice for confirmation. If you mistype
one instance, you see

Sorry, passwords do not match.
Enter new password:

Just try again until you get a working password, and the new user account
is ready to go! While you’re logged in as root, you can run the passwd
username command again at any time, to change the password for this
user’s account later. A user can also change her own account by typing
passwd at the command prompt.

5. Type exit to leave the temporary root login.
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Printing
D ro p B O @*k@s probably one of the most common tasks performed while working

|
Figure 6-9:
The opening
window

of the Red
Hat Printer
Configura-
tion tool.
|

on a computer. Unless you live in a paperless environment, you most likely
need to print something (such as a letter, a picture from your digital camera,
or an invoice) from time to time. Therefore, you need to set up your Linux
system to print. Because printing is such a common task, people often wonder
why they have to set up printing. The reason is that many different makes and
models of printers are available and many ways exist in which your computer
can communicate with a printer. Fortunately, most Linux distributions include
tools to step you through the printer configuration process. All you really
need to know is the make and model of your printer and how it’s connected.

In this section, I describe how to set up a printer with the Red Hat graphical
tool. Follow these steps:

1. To access the printing setup tool , open the Main Menu and then
choose System Settings~Printing.

The Red Hat Printer Configuration window appears, as shown in
Figure 6-9. If you're not logged in as root, you're prompted to enter
the root password.

2. To begin setting up your printer, click the New button.

The Add a New Print Queue window appears. Click the Forward button
to advance to the next step.

3. In the Queue Name window, type the name you want to assign to this
particular printer.

If you have multiple printers, add something in the Short description
text box to help you tell them apart later. When finished, click the
Forward button to advance to the next step. The Queue Type window
appears (as shown in Figure 6-10).

Action Test  Help

& = B @

© New Edit Delete Default Apply

IO,ueue name « |Defau\t |Descripn’on
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4. In the Queue Type window, select the type of queue you need.

The queue type corresponds to how the printer is connected. If the
printer is directly attached to your Linux system, choose the Local
Printer option. If the printer is attached to another computer, select
the appropriate operating system, such as Networked Windows (SMB).
If the printer is directly connected to the network, choose Networked
CUPS (IPP). Depending on what you select, you may have to fill in
further information. For example, if you chose CUPS, like I did, you
have to enter in the Server text box the IP address assigned to your
networked printer.

5. After you have entered the information, click the Forward button.

The Printer Model dialog appears, as shown in Figure 6-11.

6. In the next window (Printer Model), click the Generic (click to select

manufacturer) button to choose your printer’s manufacturer.

The selection of models below changes, according to your manufac-
turer’s list.

7. Select your printer model and then click the Forward button.

The Finish and Create New Print Queue dialog appears.

Choosing the correct make and model of your printer is important
because Linux loads and associates a specific print driver that corre-
sponds to the information you supplied. If the wrong printer make and
model are specified, the wrong print driver (the software the operating
system uses to talk to the printer) is used. The result of this mismatch is
usually garbled characters and symbols when you attempt to print to
your printer.

8. In the Finish and Create the New Print Queue window, click Finish to

enable your new printer.

You're offered the opportunity to print a test page. Click Yes. If this page
doesn’t print properly, make sure that you set the proper make and
model for your printer. Some manufacturers make the model numbers
similar, and it’s easy to get them confused.
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9. If the test page comes out great, click Yes when you’re asked whether
it looks okay. If it doesn’t come out at all or it looks garbled, click No.

If your answer was is No, you're shown a copy of all of the data that
went to the log file when you tried to print. Scroll down to the last few
lines to find hints to what your problem is. This situation happened to
me once, and it turned out to be a problem with my networking, not a
problem with my printer!

10. The main Red Hat Printer Configuration window appears, and your
new printer is listed in the tool.

Click the X in the upper-right corner to put away the printer tool. From
now on, whenever you want to deal with your printer or print jobs, you
can use the Print Manager icon on the panel.

See the configuration sections, “Mandrake tools” and “SuSE tools,” later in
this chapter, for where to find things in these distributions.

Zen and the Art of Linux Configuration

Anyone can use Linux, but to become a true Linux master requires an inti-
mate knowledge of your system’s internal mechanics. This task may seem
daunting when you consider that Linux is the sum of many different software
subsystems, each written by different programmers with different back-
grounds and beliefs regarding problem solving. Fortunately, software devel-
opers try to comply with a few universal truths.

One of these truths is that mere mortals must be able to configure a program.
You can define a computer program as a series of instructions that directs the
computer to perform a specified task. You can’t change any instructions that
are hard-coded into the program (unless, of course, you make the required
changes to the source code and recompile the program). As you can imagine,
the slightest variance in program use requires the handiwork of a skilled
programmer.

Chapter 6: Dip in Those Toes ’ 03
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File types
D ro p B O @kSux subsystems are composed of at least the following types of files:

v Executable file: This is most likely a binary file that speaks only the
language of the computer, like an . exe file in Windows.

1 Configuration file: A simple text file you can view and alter with your
favorite text editor.

Executable files read directives from the configuration files to know how to
behave. Because the executable must understand the directives in the config-
uration files, you must RTFM (Read The Fine Manual) before doing any heavy
lifting in a configuration file.

Providing details on the configuration files themselves is beyond the scope of
this book. Instead, I cover some handy tools that you probably prefer to use
over a text editor any day.

Configuration tools

Linux comes with a number of configuration tools at both the command line
and within the GUI environment. In the following sections, I take a look at
what comes with the three major distributions covered in this book. If you
want to know more, see your distribution’s documentation.

Red Hat and Fedora Core tools

The Fedora Core distribution of Linux contains many configuration tools in
the graphical and command-line environments. At the command line, Red Hat
has made sure that all of their specialized tool names, for convenience, start
with the text redhat-config. For example, redhat-config-network lets
you work with your network settings (see Figure 6-12).

You can make use of the Red Hat package management program (rpm) to find
which configuration tools you have installed by typing the following line at
the command line:

rpm -ga | grep redhat-config

Not all these tools have a command-line component. Some try to open GUI
windows after you type their names, and if they can’t do so, they don’t work.
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In the graphical environment, you can find a good portion of the GUI configu-
ration tools by going to Main Menur>System Settings. The graphical tools typ-
ically present the same options as the command-line tools but with a GUI
interface. The rest are available by choosing Main Menu=>System Tools.

For most configuration tools, both command line and GUI, you need to know
the root password for security reasons.

You also find additional tools if you look through the menus. Lots of fun wid-
gets are available in Linux. Explore!

Mandrake tools

Mandrake includes many tools (such as the Mandrake Control Center,
HardDrake, and PrinterDrake) to help configure the hardware. HardDrake is
used to set up the hard drives and partitions, and PrinterDrake is designed

to configure the printing environment. To find these, choose Main Menur>
Configuration. You can open up either the entire Mandrake Control Center (as
shown in Figure 6-13) or an individual tool by looking through the menus.

SuSE tools

YaST2 (Yet Another Setup Tool) is the name of the main configuration tool for
SuSE Linux, as shown in Figure 6-14. YaST2 includes tools to configure and
work with the mouse, keyboard, video card, monitor, and desktop. The desk-
top, in this case, refers to the look and feel of the graphical interface you have
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chosen to work with on SuSE Linux. SaX2 is another configuration tool found
on SuSE systems, used for configuring the underlying GUI, such as for the

D o p B 0O O'Jkgf colors to show.

To find either of these tools, select the SUSE Main Menu (to the right of the
KDE or GNOME Main Menu icon). You can either select the entire YaST2
Control Center (or SaX) from here or choose the YaST2 Modules submenu to
look for only one configuration component.
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Mandrake Control Center is Mandrake Linux's main configuration tool. It
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In this part . . .

n this part, you make the necessary mental and physi-

cal connections to hook up your Linux machine to the
Internet, including configuring telephone dialup to an
Internet Service Provider (ISP). You also learn how to
work with the all-essential protocol that makes the
Internet possible — namely, TCP/IP, otherwise known as
the Transmission Control Protocol/Internet Protocol pro-
tocol suite. (Say THAT three times in a hurry!) Next, you
set up your Web browser, e-mail client, and newsreader
software so that you can surf the Web, send and receive
e-mail, and access newsgroups. Armed with the facilities
you install in this part, you enable yourself to extend and
customize your Linux system to your heart’s content. You
also learn how to travel on the electronic highways and
byways of the Internet to get things done!
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In This Chapter

Understanding common Internet connection methods

Setting up your Internet connection
Connecting to your Internet Service Provider (ISP)
Understanding enough TCP/IP to be dangerous

ou may already be connected to the Internet if you're on a machine that’s

connected to a LAN and configured the networking during installation.
To test this, open up a Web browser and try to go to an outside Web site (like
www.redhat.com). If it works, you're up! No need for this chapter. Otherwise,
read on.

In this chapter, I slash a trail through the networking jungle and help you link
your Linux machine to the rest of the world. However you choose to connect,
configuring your Linux computer to connect to the Internet has never been
easier. Red Hat provides you with a graphical tool to help you configure your
Internet connection in a snap. In this chapter, I explain how to configure your
modem, and after you're connected, | show you how to mingle with the Linux
community by using a few cool tools.

But, first, a little background.

Internet Connectivity 101

Every Internet surfer is on a quest to find open lanes on the information super-
highway. Telephone, cable, and satellite television companies are now jockey-
ing for a strategic position to fill your future Internet-connection needs. In the
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following list, I briefly examine a few popular Linux-friendly options that may
be available to you:

DropBook

(@e modems: Many cable television companies have expanded their
product lines to include Internet access over their cable infrastructure.
When you subscribe to a cable Internet service, the installation technician
provides you with a special device, called a cable modem, along with a
standard network adapter. The technician then installs the network
adapter into your computer and connects the cable modem. If cable
Internet connectivity is available in your area, it provides the best cost-
to-bandwidth ratio now available. In other words, whereas the service is
likely to cost you more than a dial-up connection, a cable connection
can reach speeds 50 times faster than a 56 Kbps modem dial-up account
and typically costs only about twice as much.

You may have to configure your Linux machine to work with cable
Internet service on your own. Most cable companies don’t yet provide
technical support for Linux. The following Web page provides a docu-
ment that fills you in on all the details:

www. Tinuxdoc.org/HOWTO/Cable-Modem/index.html

+~ Integrated Services Digital Network (ISDN): Not too long ago, ISDN was

one of the only residential high-speed options. It appeared when 28 Kbps
was about all that you could milk from the copper strands that connected
your telephone to the telephone company. ISDN is still available and
promises a steady 128 Kbps — as long as you’re within 3.4 miles of the
telephone company’s central office. You need two special devices to use
ISDN: a terminal adapter (an ISDN modem) and a network adapter. The
Red Hat Network Configuration tool includes support for ISDN setups.

v~ Digital Subscriber Line (DSL): DSL works much like ISDN in that it carries

data to your telephone jack in a digital format. DSL is popular because it
provides a faster connection with lower installation and service costs
than ISDN, and it utilizes the existing copper telephone wiring provided
by your telephone company. (DSL costs about the same as a cable modem
connection.) A DSL connection requires additional communication hard-
ware, which your Internet Service Provider (ISP) should provide. The Red
Hat Network Configuration tool includes support for DSL.

Note that several variants of DSL exist:
¢ IDSL (over an IDSN line)
e Symmetric Digital Subscriber Line (SDSL)
e Asymmetric Digital Subscriber Line (ADSL)
¢ Generic DSL (XDSL)
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Typical residential connection service ranges from 128 Kbps to 1.0 Mbps.
For an overview of DSL, visit the following Web page:

D ro p BOO kgw Tinuxdoc.org/HOWTO/DSL-HOWTO/index.html

v Dial-up modems: The dial-up modem is still widely used. It translates
the digital signal from the computer into an analog signal required for
transmission from the wall jack to the telephone company. Because the
modem utilizes existing voice telephone service, you don’t need any spe-
cial setup beyond subscribing to an ISP. Red Hat includes support for
modem setup.

Because most people who aren’t hooked up through a network are con-
nected via either DSL or dial-up modems, [ had to decide which one to cover.
Throughout the rest of this chapter, I guide you step-by-step through setting
up your Linux workstation to connect to the Internet by using a dial-up modem.
Like any good guide through a deep, dark forest, I point out the slippery parts
of the trail as I go. If you're using DSL, the process is similar.

Creating Your Internet-0-Matic

Sara, could you connect me with Goober down at the fillin’ station?
—Andy Griffith

If only it were that simple. Fortunately, the good folks at Red Hat have
provided a few tools that reduce the complexity of networking with Linux.
It’s not that networking has changed, but rather that many of its details have
been abstracted so that you just have to click here and press a key there. Not
long ago, configuring dial-up networking on a Linux machine was nothing short
of debugging a defective Rube Goldberg contraption.

Then came broadband

Before I focus on dial-up modem configuration, a few words regarding the
broadband options (DSL and cable) are in order. The word broadband has

a technical definition, but I just use it to mean high-speed Internet access.
Although a high-speed dial-up modem can typically transmit information at
speeds only up to 56 kilobits (thousand bits) per second, broadband connec-
tions can reach 50 times that speed. Nowadays, the Web contains lots of
images and multimedia elements, and enjoying these features through a dial-
up line and a 56 kbps modem is similar to drinking a cold glass of water with
an eyedropper when you're dying of thirst.
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Drop

are of devices posing as modems

BrstQJO:Sn some frustration — and

your computer from the rounded end of your
ball-peen hammer. Many Linux newbies have
become irritated by not being able to communi-
cate with their internal modems. “After all,” the
newbie reasons, “the same hardware worked
when | was running Microsoft Windows."”

Well, here's the story: Several years ago, hard-
ware manufacturers developed a device, called
a software modem, in an effort to reduce hard-
ware costs. The idea was to trim some respon-
sibility from the modem and relegate these
tasks to the CPU through the operating system.
The result was an inexpensive interface card
that routed signals to proprietary software that
operated only under Microsoft Windows. In
short, these so-called modems, also known as
WinModems, aren’t really modems, but, rather,
are telephone cable interfaces to Windows.

The following list shows methods you can use
to determine whether you have a software
modem:

v The model number has a HCF-, HSP-, or
HSF- in front of it.

v The packaging refers to the device as a
WinModem or designates that it works with
only Windows.

v Windows recognizes your modem, but
Linux doesn't.

In short, if you determine that you have a soft-
ware modem, Linux simply doesn’t work with it.
For the adventurous out there, the LinModem
project (1inmodems.org) has successfully
written Linux drivers to work with a few of these
software modems. | encourage you to hecome
involved in this type of project, if you're so
moved. These explorers drive the wonderful
world of freedom software, which Linux is a
prominent part of.

The bummer in all this is that, although you
probably saved a few bucks by buying a
machine with a software modem, you most
likely need a real modem to use with Linux
(unless you have a LinModem).

| strongly advise searching the Linux modem-
compatibility list to determine whether your
modem is a good buddy with Linux. You can use
the money you ultimately save in headache
medicine to buy a real modem.

Don’t let high-speed providers discourage you from using Linux with their
services. Just because they don’t support Linux directly doesn’t mean that
the technology doesn’t work with Linux. TCP/IP (the set of traffic rules for

the Internet) was developed for the Unix operating system, from which Linux
descends. The irony is that most broadband support provided by ISPs is for
Windows, which was never intended for use on a network, much less TCP/IP.
The protocol-to-network support for Windows was added to the software
much later.

If you have the luxury of dual-booting to Windows, your ISP can help you
install your broadband connection, and then you can tinker with getting
Linux connected as you have the time and inclination. I point you to some
sites that can help you configure your broadband connection in the section
“Internet Connectivity 101,” earlier in this chapter.
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Connecting the hardware

D ro B O Q&Kﬁu get too comfortable in your chair, you must physically check
oIn€ t€ms that may require you to do some low-level maneuvers (such as
crawling under your desk):

v External modem: If you have an external modem (one that’s independent
of your computer case), you need to verify that

e A cable is securely connected from the modem to the serial port
on the computer.

¢ The modem is powered on. (External modems have their own
power supply.)

¢ One end of a telephone cable is plugged into the wall jack and the
opposite end is plugged into the modem.

v Internal modem: If you have an internal modem, you need to verify that

e The modem is not a software modem. See the sidebar, “Beware of
devices posing as modems,” if you're not sure what a software
modem is or whether you have one.

¢ One end of a telephone cable is plugged into the wall jack and the
opposite end is plugged into the phone plug on the back of your
computer.

Okay, now you can climb back into your chair.

If you determine that your modem is, in fact, a software modem, [ recommend
that you get an external modem. You don’t have to touch your existing inter-
nal modem (Linux conveniently ignores it); just plug the external modem into
an available serial port and step through the external modem checklist in this
section. If you're still unsure of the identity of your internal modem, go ahead
with the configuration and cross your fingers. If it works, great! If not, no harm
done, and you can start shopping for a good external modem.

\\3

Selecting an Internet Service
Provider (ISP)

Because of the recent meteoric rise in the popularity of Linux, many ISPs are
training their support staff in the ways of Linux. If you already have a dial-
up service, give one of them a call to let them know of your Linux pursuits.
Chances are, that person already has information pertinent to Linux sub-
scribers and can provide you with that information. If you're shopping for a
new ISP, read on for some practical selection advice.

113
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@“\NG! Some ISPs provide their own proprietary software that you must install on
5 your PC to connect to the Internet. The software they provide is likely to run
indows. Several free dial-up services don’t work with Linux because
\ t. The proprietary software meddles with the operating system to
ensure that banner advertising isn’t hidden or that you stay dialed in for only
a specified duration.

If you're shopping around for an ISP, consider these questions:

1 Can you get local dial-up numbers across the country and around the
world? If you travel often and need Internet access from different cities,
this service is a handy money saver.

v Does it provide technical support for Linux? If you're planning on
running Linux, this consideration is an important one.

1 Can you get a recommendation? Ask a friend. An ISP’s best friend is an
endorsement from a satisfied customer.

+ Will you have trouble dialing in? Although a subscriber-to-line ratio of
7-to-1 (an average of seven or fewer subscribers per line) or better isn’t
an entirely accurate measure, it should help you avoid frequent busy
signals. Hey, it doesn’t hurt to ask.

Information you need from your ISP

Most reputable ISPs provide you with a customer information sheet after you
sign up for its services. This sheet should include the following information
at the minimum:

v Local telephone dial-in numbers

v User login name

v User login password

v E-mail address

v E-mail outbound host or Simple Mail Transport Protocol (SMTP) server

v E-mail inbound host or Post Office Protocol (POP) server

v News host

With this information, you can establish an Internet connection by using your
Linux system.
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Configuring your dial-up service

D ro p B O QK ven't already done so, start your computer and log in to your GUI
eSktop-

You shouldn’t be logged in as the root user, but you do need to know
the root password.

With your ISP information in hand and a glowing monitor in front of you,
follow these steps to configure your dial-up connection to the Internet:

1. From the GUI desktop, click the Main Menu button on the Panel and
then choose System Settings~>Network.

In default GNOME and KDE setups, the Main Menu button in the lower-
left corner is a footprint in GNOME or a big K in KDE. If you installed
Fedora Core 1, the Main Menu button is the Red Hat fedora icon in both
GNOME and KDE.

2. Enter your root password in the dialog box, if necessary.

If you're logged in as a regular user (not root), you're prompted to enter
the root password.

The Network Configuration dialog box should open (refer to Figure 6-12,
in Chapter 6). The entries listed in the dialog box depend on whether
you have an existing network adapter that was established during your
installation. The remaining steps assume that you don’t now show a
modem entry.

3. In the Network Configuration dialog box, click the New button.
The Select Device Type dialog box appears, as shown in Figure 7-1.

4. Select Modem Connection from the Device Type list box and then
click the Forward button.

Take a moment to make a mental note of the other options listed. This
area is also where you perform your configuration for an ISDN, xDSL, or
Ethernet network connection. Each network option requires distinct
configuration parameters, which your ISP should supply.

After you click Forward, the tool probes for your modem. If your modem
could not be found, the Select Modem dialog may appear, as shown in
Figure 7-2. If you do encounter this dialog, make your selections and
then choose Forward again.

If you know your modem is on COM1 or COM2 in Windows, translating
this to Linux isn’t hard: You just need to subtract 1. So, it’s ttySO for
COM1 and ttyS1 for COM2.
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The Select
Modem
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5. Enter your ISP information and then click Forward.

In the Select Provider dialog, shown in Figure 7-3, the default list of coun-
tries that your ISP might be from is pretty limited. Unless you live in one
of these regions, you can safely ignore this list. When you select one of
these countries, the dialing entries are completed for you. If you don’t
pick one of these countries, enter the information your ISP provides. Be
sure to add any dialing prefix you may require in order to obtain an out-
side line. (For example, if you have a PBX system with a 9 prefix, be sure
to enter the 9.) Click the Forward button when you're done.
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After you click Forward, the IP Settings dialog box appears as shown in
Figure 7-4.

D ro B O O Kﬁle IP Settings dialog box, indicate whether your modem needs to
in its IP addressing information from the ISP or whether you
need to tell it what its IP data is, and then click Forward to continue.

Your ISP should have given you which of these you require. If you have
to enter the data manually, do so now. After you click Forward, the Create
Dialup Connection dialog box appears.

[~ b Add new Device Type % i [=1[=][x]

Select Provider

Internet Provider ficEs e
_ —TE |Preﬁ1 | ‘Agea code: ! |Enane number: |
Czech Republic |
Germany
I fimm Slovenia Provider name: | |
. & Efg United Kingdom |-
Flgure 7-3: # | T-Online Account Setup |
The Select Login name: [ T —|
. PrOVId.er Password: | |
dialog box in | |
the Network
configura-
tion tool. :
| 8 Cancel | | <@ Back | | > Forward |
|
[+ Add new Device Type BENE

IP Settings

Encapsulation mode:

(@ Automatically obtain IP address settings

PPP Setings
Automatically obtain DNS information from provider
I () Statically set IP addresses:
Figure 7-4: Manual [P Address Settings
The |P Address: |
Settings Subnet mask: ‘ |
dialog box in Default gateway address ‘ |
the Network
configura-
tion tool.

| % Cancel | | <fl Back | | > Eorward ‘
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. Click the Apply button to confirm your selection.
At this point, your modem and dial-up connection is complete. You
D ro B O O k ably received much more information from your ISP than what you
entered (username, password, and connection telephone number).
Settings such as e-mail and news servers are applied in the various
applications to which they pertain, such as Mozilla.

Look at the Network Configuration dialog box again. It should now list a
device named ppp0 (PPP stands for Point-to-Point Protocol) along with an
Inactive status.

8. To connect to the Internet, simply highlight the ppp0 entry you just
created and click the Activate button.

With any luck, your modem springs to life with some beeps and then
buzzes along with a dialog box indicating that a connection is being
made. After a successful connection, the Network Configuration dialog
box appears again; this time, the Status column of the ppp0 device reads
Active. Congratulations; you're now connected to the Internet!

Whew, you made it. If all went well, you're connected with the worldwide
Linux party! To disconnect, simply click the Deactivate button in the Network
Configuration dialog box. Your settings remain; the next time you want to con-
nect, just open this dialog box and click Activate. If all is not well, skip to the
next section to find out how to get help.

Now that all the dirty work of configuration is complete, you can add a simple
Dialer applet to your GNOME desktop applet panel to use as a shortcut:

1. From the GUI desktop, click the Main Menu button and select System
Settings.

2. Right-click the Network option and choose the Add This Launcher
to Panel menu option.

This step puts another icon on your applet bar to allow you to conve-
niently activate your network connection.

As long as we'’re on the subject of applets, another handy applet to include
on your applet bar is the Modem Lights applet:
1. Right-click the applet bar and choose Internet->Modem Lights.

This option places a small rendering of your modem activity on the
applet bar.

2. To activate your connection, click the left dotted button in the Modem
Light applet.

A dialog box appears, asking whether you want to connect.
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3. Click the Yes button, and your modem springs to life.

he modem applet displays a green (rather than black) dot when you're

T
D ro B O O k:Sected, and send/receive statistics appear as you start surfing the
net. When you're ready to disconnect, use the same button.

It’s all fun and games until
something doesn’t work

In a perfect world, the dial-up configuration steps in the preceding section
would work 100 percent of the time. Red Hat has truly hidden all the mystery
that has traditionally surrounded dial-up networking. Unfortunately, in many
situations (mostly related to modems and hardware), a simplified configuration
doesn’t work. If you cannot connect to the Internet after you have followed
these steps, | recommend that you access a copy of the Modem-HOWTO from
the Linux Documentation Project (www.t1dp.org). This written treatment is
updated often and includes a wealth of information and reference resources
for configuring your modem on a Linux computer.

Turning to TCP/IP

It’s a good thing.
—Martha Stewart

You can make it all the way to the Internet without one single mention of
Internet Protocol (IP) numbers. This ease in configuration demonstrates the
progress that renders Linux easier to use. However, TCP/IP is still humming
away in the background, carrying digital information for you in all its com-
plex and robust glory.

Transmission Control Protocol/Internet Protocol (TCP/IP) is a set of rules for
moving information from one point in a network to another. These TCP/IP
delivery rules are similar to the methods that a parcel service, such as UPS,
uses to move packages. Each package contains a label with a destination,
return address, and content that is important to the sender or receiver. Using
this address, the package carrier can make a decision about how to route the
package. Each routing decision shuttles the package closer to its intended
destination until it arrives. The network component that provides this rout-
ing information is known as, strangely enough, a router.



1 20 Part ll: Internet NOW

Every computer on a TCP/IP network requires a distinct [P number. You can
use one of two methods — static or dynamic — to assign this number to your

DropBooks
p v~ Static: You assign a static IP number when you configure the machine,
and the number remains the same until you change it. Servers and other
computers that are required to continually service the network usually
have static I[P numbers. (Seasoned networking professionals usually
administer static IPs.)

v Dynamic: Typically, dial-up Internet users or workstations that aren’t
continuously logged in to the network use dynamic IP numbers. If your
computer is configured to obtain an IP number dynamically, the computer
requests an IP number from another network host computer configured
as a DHCP server. The Dynamic Host Configuration Protocol (DHCP)
server has authority for a range of IP numbers that it can assign as needed
to trusted computers. The DHCP server also provides other handy ser-
vices, such as dishing out DNS, gateway, and routing information that
you're otherwise required to know and stitching all this information into
those cryptic and sometimes elusive configuration files.

You can be thankful that the dial-up networking tools provided with your Red
Hat distribution, along with services your ISP provides, perform these geeky
functions for you transparently.

The IP number looks like this to your computer (remember that the com-
puter stores information in the form of ones and zeroes):

11010001100101001111010101100100
Ouch — do your eyes hurt? Is this any better?
11010001.10010100.11110101.01100100
Hardly. What about this?
209.148.245.100
The last example is a decimal representation of the first binary number exam-
ple. It’s known as an IP number, and every computer on the Internet requires

a unique one.

The IP number is the mailing address for your information packages. Granted,
the casual cybestrian doesn’t keep a list of friends’ [P numbers. Instead, you
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use more familiar names. The Internet uses an ingenious method, called the
Domain Name System (DNS), to resolve names into IP numbers.

IQ Q registrar is a company that provides the authority for the popular,

top-level domains of .com, .org, and .net. By registering a unique domain
with one of these designated organizations, you can become the authority for
your own network domain. Linux also comes with a free software package,
called BIND, that provides the tools you need to become part of the Domain
Name System.

Putting 1P to work on your network

The ping command is akin to a submarine using sonar to detect other
objects in the ocean. Sonar sends out a ping signal, which reflects off a hard
surface. By measuring the amount of time between sending the ping and the
ping’s return, the submarine’s engineer can determine whether an object is
out there and how far from the submarine that object is.

The ping command in Linux provides information similar to what sonar pro-
vides. If you consider the Internet to be your ocean, you can determine, by
pinging, what other network computers exist and also how long it takes for
your ping to return.

Another fun command is traceroute, which allows you to see all the routing
points your package touches on its way to a destination. Simply type the
command traceroute hostname. The hostname can be either a valid DNS
name or [P address of a computer on the network. After a few moments, you
receive a list of all computers between you and the designated hostname.

The ping and traceroute utilities determine whether your network connec-
tion is working. Whereas ping reveals whether another network host is now
available, traceroute provides a trail to that host. For example, if your Web
browser can’t seem to find a particular site, you can jump out to a shell
prompt and run a traceroute command to the site to determine where the
hold-up is.

Latency, or the amount of time it takes for a signal to travel, on the Internet
has little to do with physical distance. Rather, factors such as network traffic,
bandwidth, and network hardware all contribute to a slow latency. These fac-
tors determine whether a ping to your neighbor’s computer takes longer
than pinging a host at the South Pole.
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Checking whether an address

DropBogks with ping

To use the ping command in Linux, you must have an object in mind that
you want to ping, which is usually another host computer that’s connected
to the network. You can ping an IP number of another host or a hostname if
your DNS is working correctly.

For example, you can ping the Yahoo! site. Jump to a command prompt and
type the following command:

ping www.yahoo.com

Press Ctrl+C to break the ping; otherwise, your machine continues to ping
the target.

The ping line, as shown in Figure 7-5, provides information about what the
ping is doing. If the host is unreachable, a message indicates so. If the host is
located, you receive a line that provides some useful data — namely, the last
item on the line: time=. This number is the time, in milliseconds (ms), that it
takes for the signal from your computer to get to the destination computer
and return. Lower numbers are better. For an Ethernet, a ping time of 1 ms to
3 ms is an acceptable response time from another machine on the same local
net (that is, the gateway). For dial-up connections, expect somewhere around
150 ms. When you start seeing ping times climbing to 900 ms or higher, some
serious network traffic likely sits between you and your target host.

The ping command lets you know immediately whether a network is between
you and the host that manages the Yahoo! Web site. Although these widely
varying times may indicate a network problem, ping doesn’t provide much
more information than that. To flush out more of the problem, you can use
the traceroute command.

Tracking the path of your
packets with traceroute

The traceroute utility enables you to map the route that your IP packets are
taking from your computer to their intended destination. Just because you may
not be able to visit your favorite Web site doesn’t mean that the Web site is
down. It may simply mean that a link along your route is down. A significant
router or conduit going down (basically, crashing) is like traffic congestion on
your morning commute because of a pile-up.
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To use traceroute, you need to know of a destination. Try Yahoo.com!
again. Open the main menu and then choose System Tools=>Traceroute

r O p B O 612 'gre 7-6). Type yahoo.com in the Hostname field and press Enter.

(] evan@localhost:~ - M X
File Edit View Terminal Go Help
[evan@localhost evan]$ ping yahoo.com [=]

PING yahoo.com (66.218.71.198) from 192.168.1.101 : 56(84) bytes of data.

54 bytes from wl.rc.vip.scd.yahoo.com (66.218.71.198): ilcmp_seq=1 tt1=247 time=60.2 ms
54 bytes from wl.rc.vip.scd.yahoo.com (66.218.71.198): ilcmp_seq=2 tt1=247 time=68. 3 ms
64 bytes from wl.rc.vip.scd.yahoo.com (66.218.71.198): icmp_seq=3 ttl=247 time=103 ms
54 bytes frem wl.rc.vip.scd.yahoo.com (66.218.71.198): icmp_seg=4 tt1=247 time=144 ms
54 bytes from wl.rc.vip.scd.yahoo.com (66.218.71.198): icmp_seg=5 ttl=247 time=123 ms
54 bytes from wl.rc.vip.scd.yahoo.com (66.218.71.198): icmp_seg=6 ttl=247 time=81.7 ms
54 bytes from wl.rc.vip.scd.yahoo.com (66.218.71.198): icmp_seg=7 ttl=247 time=225 ms
64 bytes from wl.rc.vip.scd.yahoo.com (66.218.71.198): ilcmp_seq=8 ttl=247 time=63.7 ms
54 bytes from wl.rc.vip.scd.yahoo.com (66.218.71.198): icmp_seg=9 tt1=247 time=165 ms
64 bytes from wl.rc.vip.scd.yahoo.com (66.218.71.198): icmp_seg=10 ttl=247 time=81.2 ms

-—- yahoo.com ping statistics --- [
10 packets transmitted, 10 received, 0% loss, time 9024ms
I | rtt min/avg/max/mdev = 60.291/111. 797/225.992/50.873 ms
- [evan@localhost evan]$
Figure 7-5: 0
Sample
results of
the ping
command.
[+]
I =
Hostnarme gyahnncnm
Hostname | Lussl Rcvl Sntl Lasll Bestl Avngurst|
192.166.0.1 0% 11 1l 1 1 1 fz
10.36.0.1 0% 11 1l 12 9 26 140
srpd-0.austi<c-rirl austin.rr.com 0% 11 1l 1 i 16 38
srp0-0.aust<rdc-riré austin.rr.com 0% 11 1l 9 9 25 64
srpd-0.austi<rdc-rird texas.rr.com 0% 10 10 12 i 18 31
popZ-hou-PE-1.atdn.net 0% 10 10 39 15 26 41
hhb1-hou-P0-3.atdn.net 10% G 10 52 15 23 52
hh1-dal-PE-0.atdn.net 0% 10 10 26 23 38 132
—— popz-dal-Pl-0.atdn.net 0% 10 10 54 20 32 54
iari-so-2-1-0.Dallas.cw.net 0% 10 10 an 21 30 o4
T A | agri-loophack.Dallas.cw.net 0% 10 10 46 24 33 48
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Resu|ts | deri-loopback. Washington.cw.net 20% g 10 37 a7 6B 105
f h | bhr1-pos-10-0.5terling1dc2.cw.net 0% 10 10 79 56 63 111
Ofthe || | csinz-vezan stignt exodus net 0% 10 10 80 S 71 &7
trace- | 216.35.210122 0% 10 10 58 a7 68 94 |
| w rc.vip.dex yahoo.com 0% 10 10 61 56 64 79|
route
utility. ||
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DropBocks

Each line of your traceroute results represents a hop. This command helps
illustrate the concept [ explain earlier in this chapter, of packets being routed,
d off to carriers along the way to move your package closer to its

n. Each hop is a physical machine that reads your packet address
and forwards it. You also notice a latency time associated with each hop. You
can identify heavy network congestion, or a weak router along the way, by
identifying the relatively larger numbers in the list.

Sometimes, especially when you’re troubleshooting, the reason that you can’t
access your intended Web site, you perform a traceroute that times out
somewhere along the way. This situation usually indicates that a “traffic acci-
dent” has occurred somewhere along the information superhighway. Give it a
few minutes and try again. TCP/IP is an amazingly robust networking protocol
that was designed to reroute packets efficiently in the event of a failed network
segment.

If, as you get close to your own network, your traceroute command abruptly
stops and doesn’t tell you anything, a firewall may be in the way, blocking that
information from being shared.



Chapter 8

DIrOpBOOk§urfing the Web and
Managing E-Mail

In This Chapter
Configuring Mozilla
Setting file associations
Test driving the Mozilla Web surfing features
Subscribing to newsgroups
Installing and configuring Evolution

Checking and sending e-mail

Give a man a fish and you feed him for a day; teach him to use the Net, and
he won'’t bother you for weeks.

—Anonymous

A ssuming that your Internet connection is configured (which I discuss in
Chapter 7), you can now get on with doing something interesting on the
Internet. In this chapter, [ introduce you to a few useful communication utili-
ties that provide you with the tools of the Internet trade.

Many people attribute the explosive growth of the Internet to the graphical
Web browser. The Internet has been around for much longer than the inven-
tion of the browser. It’s just that most of the work done on the Internet was in
plain old text, which held little attraction for those of us who are more spa-
tially oriented (that is, we preferred picture books as young children).

Several graphical Web browsers are available for Linux. The most popular of
these browsers is Mozilla, which does far more than just display Web pages.
You can also use Mozilla to manage your e-mail and newsgroup subscrip-
tions. Mozilla is also the browser included with Fedora Core 1, which is on
the CDs that come with this book.

A multitude of e-mail programs is available for Linux users. Fedora Core 1 has
included Ximian Evolution as the default in its distribution, and you may
agree that Evolution is a worthwhile choice.
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Configuring Mozilla

DropBoaok

\\J

|
Figure 8-1:
The Mozilla
Preferences
window.
|

$tart surfing right now, if you want. However, you may want to take a
moment to customize Mozilla with preferences, such as a home Web site, font
sizes, colors, and many other options.

Mozilla provides an entire menu of Help documents. To access the online Help
options, click the Help menu on the menu bar at the top of the Mozilla screen.

The following steps introduce you to the Preferences dialog box, where all
the Mozilla configuration parameters are stored:

1. Start Mozilla by clicking the planet or dinosaur icon on your Panel.

Mozilla starts after a moment. Be patient; Mozilla is a large program, and
it usually takes a few seconds to load from the disk into memory.

2. Choose Edit~>Preferences.

The Preferences window appears, as shown in Figure 8-1.

Notice that many configuration options are available. Throughout the rest of
this chapter, I guide you through configuring a few of the essential settings. I
encourage you to explore the many options available along the way:.

Use the left pane of the Preferences window to access the various preferences
categories. You can expand any of the major categories by clicking the small
plus sign (+) next to them, and contract them again by clicking the small minus
sign (-). Each of the categories also has its own menu, so don’t forget to look at
those too. If you get tired of reading through menus, just click OK or Cancel at
any time to close the Preferences dialog box and get back to surfing.

Navigator
- Display on | Navigator Starup .

() Blank page

(@) Home page

() Last page visited

- Home Page
Composer
Clicking the Home button fakes you 1o this page or grou

Offline & Disk Space
Seleet the buttens you want to see in the toolbars

Bookmarks Search
[]&e Prim
Home
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Appearance preferences

D ro p B O Q& t§ the Appearance option — Figure 8-2 — allows you to determine
o want Mozilla to start when it loads. Navigator (the browser part) is
selected by default. If you use Mozilla primarily for e-mail, you may want to
select the Composer check box instead. Keep in mind that you can still get to

your browser and newsgroups by using the Window menu. Selecting your
startup preference is a matter of speed and convenience.

Preferences

,

Category

Fonts When Mozilla starts up, open

-~ Themes Navigator
" Languages/Content
= Navigator
History [ Mail & Newsgroups
" Languages —
Helper Applications - Show toolbars as —  Eaa
Smart Browsing
~Internet Search
~Tabbed Browsing () Pictures only
" Downloads
* Composer
Mail & Newsgroups
Privacy & Security

| (| Adianced
Offline & Disk Space Show Web Site Icons

[] Composer

@ Pictures and text

(O Text only

Show Tooltips

Figure 8-2: [] Resize large images to fitin the browser window
The Mozilla
Appearance
Preferences
window.
|

oK |[ Cancel |[ Hebp

The other check box items in the Appearance option window enable you to
determine the cosmetics of your toolbar, such as whether to display ToolTips
(those little pop-up help texts) or show Web site icons. The option categories
in the Category pane on the left are shown in this list:

v Fonts: Enables you to set your preferred typeface. For desktop resolu-
tions of 1024 x 768 and higher, [ recommend jacking up your font sizes
immediately. (Otherwise, become very familiar with the key combina-
tions Ctrl-+ to make all the fonts in the browser bigger, and Ctrl-- to make
them smaller. Use the + and — on your number pad and not your main
keyboard.)

v Colors: Sets your text colors and whether you want to override explicit
Web page settings. This setting is an important one for color-blind people.

v Themes: Allows you to put a custom paint job on your Mozilla installation.

v Languages/Content: Allows you to set the sidebar preferences of your
browser to a particular locale’s language.
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Navigator preferences

D ro p B O Q;Klggator category enables you to select the behavior of your browser
e f

irst started. You can choose to not show anything, show a specified
home Web page (entered into the Location text box), or show the last Web
site you visited during your last session. Note that the Location text box also
holds the Web site you're transported to whenever you click the Home
button on the browser. The following options allow you to personalize your
browser with some additional personal preferences:

v History: The History text box enables you to designate how many days
you want your browser to remember where you have been. You can click
the Clear History button to clear the history manually at any time.

v Languages: No, this option doesn’t automatically translate the content
of a Web page into the preferred language. Rather, some Web page
authors provide their Web pages in more than one language. If it’s an
option, this one merely lets you decide language preference.

v Helper Applications: In this table, you designate applications to inter-
cept special file types. An example is a . pdf file, which requires the
Adobe Acrobat Reader in order to view it. You can specify the applica-
tion and optional arguments that need to be passed to the program.

v+ Smart Browsing: With this option, you can set the characteristics of the
What’s Related tab, which is on the Sidebar (located in the left pane of
the browser window). The What’s Related tab provides a drop-down
menu listing sites that may be related to the displayed Web site.

v~ Internet Search: Search engines have become an integral part of Web
browsing. To accommodate this, Mozilla can integrate your favorite
search engine right into your browser. You can click the drop-down
button under Default Search Engine and choose your preference.

1~ Tabbed Browsing: This option reflects the latest craze in Web browser
capabilities. It allows you to have multiple surfing destinations, all in one
window, and change between them by clicking tabs.

1+ Downloads: Mozilla provides you with a helpful download manager that
lets you watch the progress of multiple files, all in a single window. You
can even see the last items you downloaded.

E-mail and newsgroup preferences

The Composer category (Figure 8-3) allows you to set preferences for the
editor when you compose e-mail messages, and the Mail & Newsgroups cate-
gory (Figure 8-4) is where you provide your cosmetic e-mail preferences —
although if you're using Fedora Core 1 from the DVD or CDs that come with
this book, see the Evolution section to find out how to make use of that e-mail
client as well.
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Figure 8-3:
The Mozilla
Composer
Preferences
window.
|

|
Figure 8-4:
The Mozilla
Mail &
Newsgroups
Preferences
window.
|

Category

E Bppearance

Fogts.
lol
emes
L Content
El Navigator

History
Languages
Helper Applications
Smart Browsing
Internet Search
Tabbed Browsing
Downloads

New Page Settings
Toolbars
Mail & Newsgroups
[ Privacy & Security
[ Advanced
Offiine & Disk Space

Preferences
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- Recent Pages Menu

Masimurn number of pages listed: 10|

[ When Saving or Publishing Pages
() Retain original source formatting
(@ Reformat HTML source
Save images and other associated files when saving pages

[] Always show Publish dialog when publishing pages

Table Editing

Maintain table layout when inserting or deleting cells

- Cascading Style Sheets (CSS) Editing

Use CSS styles instead of HTML elements and attributes

ok |[ Cancel

Help

Previous versions of Mozilla enabled you to configure your e-mail servers and
identity, but this feature has moved to an e-mail subsystem. I cover this topic
later in this chapter, in the section “Evolving into E-Mail.”

The following list shows a few optional pinstripes and chrome for your e-mail

preferences:

+* Windows: You can choose how to format the windows created for work-
ing with your mail.

1 Message Display: You can choose the font type and fixed or variable
width, along with how you want to display those emoticons, such as ©.

]
Category
=l Appearance
Fonts
Calors
Themes
Languages/Content
= Navigator
“History
Languages
“Helper Applications
Smart Browsing
Internet Search
-Tabbed Browsing
Downloads
El Composer
New Page Settings
Toolbars
Windows
Message Display
~Motifications
Composition
~Send Format
Addressing
Labels
-Return Receipts
Privacy & Security

Preferences

Mail & Newsgroups

General Settings
Confirm when moving folders to the Trash

| Remember the last selected message

~ Mail Start Page -

When Mail launches, show the Start Page in the message area

Location: | chrome ale/start.html

Select the buttons you want to see in the toolbar

[]File []Stop
Next Junk
[] Print

Restore Default

=]

ok || Cancel

Help
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v Notifications: Do you want sounds to play when a new message arrives?
If so, which ones?

D ro B O O position: Do you want to attach forwarded messages or cut-n’-
e inline?

+* Send Format: You can determine whether you want to send messages in
plain text, HTML, or both.

1 Addressing: When you address a new e-mail message, Mozilla searches
your local address book or a common directory server (if you're on a
network and share a common contact directory).

v Labels: You can label messages with colors. This feature is a nifty way to
identify them.

v Return Receipts: You can request a return receipt to tell you if someone
has opened your mail or not, and also set how return receipts are han-
dled when someone requests one from you.

Other preferences

Other preferences you may want to check out before you start using Mozilla
include

v Privacy & Security: Network security has become a very big issue for
everybody connected to the Internet. Although the typically nontechnical
media often sensationalizes this issue, security should still be a considera-
tion for all users of the Internet. Every time you send an e-mail or click a
Web site, you're exchanging information across a network. Although you
don’t need to lose sleep over it, you should be conscious of every request
you make on the Internet. Even though completely securing your informa-
tion is impossible, you can feel reasonably safe that your exchanged
Internet information is safe because of the default options that Mozilla has
provided. See the Popup Windows section (Figure 8-5) for how to keep
these annoyances from cluttering your screen.

1 Advanced: This category provides options that affect the entire Mozilla
user environment. Options include whether you want to enable Java
applets or XSLT Web pages. This area is also where you can flush your
cache and establish your proxy settings:

e Cache: Visiting a Web site entails establishing a network connec-
tion with the site and downloading the Web document and
included images for viewing on your browser. The browser caches
(stores) this information on your local hard drive. By doing so,
your browser doesn’t have to retrieve the same information from
the Internet again and again for sites you frequent. This option
enables you to set limits on this local storage space. You can also
manually clear your cache here.
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Figure 8-5:
The Mozilla
Popup
Windows
Preferences
window.
|

¢ Proxies: If you're part of a Local Area Network (LAN) that has a
connection to the Internet, you likely connect to a proxy server.

Your system administrator provides you with this information. You
ro p O O S can safely ignore this option if you're using a dial-up account.

i Preferences %

Catel =
ER00y; Popup Windows
Message Display |~

Notifications

Composition

Send Format

Addressing

Labels

Return Receipts
I Privacy & Security ‘

Cookies

Images

Forms — | Note: Blocking all popups may prevent important features of some web sites from
working, such as login windows for banks and shopping sites. For details of how
to allow specific sites to use popups while blacking all others, click Help. Even if
blocked, sites may use other methods to show popups.

Popup Windows

[] Block unrequested popup windows

When a popup window has been blocked:

[ Play a sound:

H Seledt... H Preview

Display an icon in the Navigator status bar

Passwords
Master Passwards
SSL
Certificates
Validation

El Advanced
Scripts & Plugins
Keyboard Navigation
Cache
Proxies
HTTP Networking
Software Installation
Mouse Wheel

Offline & Disk Space |

oK | [ Cancel |[ Help

Them Dad-Gum Browser Plug-Ins

Do you ever get irritated at those Web sites that insist that you download a
plug-in, or additional piece of software, just to view the site? The difference
between a plug-in and an external program is this: A plug-in displays the
results in the browser, and an external program runs outside the browser.
Although these plug-ins are annoying if you're just looking for some basic
information, they can provide some pretty cool stuff, such as streaming video
and music through your Web browser.

Plug-ins provide browser capability extensions, which are programs that
interface with the browser to provide nonstandard features, such as sound
and video. The digital age is still in its infancy, so the industry hasn’t yet
adopted these multimedia formats as standard. In turn, the developers

have chosen not to build support into the Mozilla browser. Rather, the
plug-in architecture enables software developers to innovate without requir-
ing the supporting browser to know what to do with newly emerging media
formats.
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Each plug-in may require manual setup steps, and Linux doesn’t support all
available plug-ins for Mozilla — yet. (Apple QuickTime is one good example,
ou should see Chapter 15 for ways to get around this glitch.) Your
D ro p B O d‘ ' Sstallation includes some plug-ins. To view which plug-ins are

installed, choose Help>About Plug-ins.

The general rule for plug-in installation is to move the required file, which
usually has a . so file extension, into the plugin directory, located below the
Mozilla installation. A likely place for the default Fedora Core 1 installation is
/usr/Tib/mozilla-1.4.1/plugins.

To associate a file with a program or plug-in, choose Edit~>Preferences to
open the Preferences window, and in the Navigator category, click Helper
Applications. The File Types pane appears, as shown in Figure 8-6.

This window provides you with a simple way to associate a particular file
type with a specific program or plug-in. For example, a file with a . ram exten-
sion denotes a file in Real Media format that probably contains an audio or
video presentation. A special plug-in (program) from Real Media is required
in order to play this file. This window enables you to match up the file type
with the required program.

Luckily, Mozilla comes preconfigured for many common multimedia file
types. Any new plug-ins you’re required to download come with instructions
for configuring them for Linux and Mozilla.

] Preferences E3
Cate = 3
SRS Helper Applications
E Appearance [+
- Fonts Specify how to handle files of each file type
i Colors il .
~Themes fEbTES
Languages/Content New Type...
= Navigator Edit...
 History
- Languages Remove

| _telber Applicaiions |

Smart Browsing @
Internet Search
Tabbed Browsing
Downloads

E Composer
New Page Settings

Toolbars File Type Details
I E Mail & Newsgroups Desaiption:
 Windows [ | Extension(s):
H . 1:Message Djsplay. When encountered
Flgure 8 6' Notifications ‘
Composition
The Helper - Send Format - Plug-in Finder Service -
1 1 © Addressin
App|lcatI0nS {abals 1 [] Aways use the Netscape Plug-in Finder Service (PFS) to get plug-ins.
window in " Retum Receipts If this option is not checked, the PFS is used only when a plug-in location is not
= Privacy & Security || specified by the web page that requires the plug-in.
. -
Mozilla. - -

ok | [ Cancel |[ Hew
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Shifting Mozilla into Gear
D ro p B O Ofkjs fine-tune your graphical Internet vehicle, you can take it for a road

test. In this section, [ cover some righteous maneuvers with your Mozilla
browser.

Steering the monster

Mozilla is your viewing window into the wonderful World Wide Web. Mozilla’s
primary purpose is to fetch Web pages on your command, download all their
graphics and related files into your computer’s memory, and, finally, render
the page for your interactive viewing pleasure.

If you're used to using Internet Explorer or Netscape, using Mozilla should be
a snap. It has all the familiar navigation tools, such as an address bar; Back,
Forward, Reload, and Stop buttons; and a feature that stores links to your
favorite Web sites (bookmarks).

Mozilla, like Netscape, also has a Sidebar feature — press F9 to add and
remove it — which you can use to find sites related to the one you're visiting,
search for a word or phrase on the Internet, access bookmarked Web pages,
or access a Web page you recently visited (via the History option). The pane
at the bottom of the Mozilla browser window contains a few buttons that
allow you quick access to Navigator, Mail & Newsgroups, Composer, and
Address Book, and so does the Window menu.

Perusing newsgroups

Although e-mail is usually directed at an individual, you can think of news-
groups as public-message bulletin boards where people with similar interests
come together to discuss a topic. Newsgroups are also great places to find
technical support.

With the newsgroup server information that your ISP provided, follow these
steps to access the world’s largest cork board:

1. Choose Window=>Mail & Newsgroups.

The message center window appears with your Inbox selected by
default. The first time you open this menu option, you immediately see
the Account Wizard shown in Figure 8-7. However, from now on you have
to choose Edit=>Mail & Newsgroups Account Settings before you'’ll be
able to return to this dialog box.
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DropBoc

|
Figure 8-7:
The Mozilla
Account
Wizard.

Account Wizard

New Account Setup

7/

I to receive messages, you first need to set up a Mail or
Newsgroup account.
This Wizard will collect the information necessary to set up a Mail or
Newsgroup account. If you do not know the infermation requested,
please contact your System Administrator or Internet Service Provider.

Select the type of account you would like to set up:

(0 Newsgroup account

< Back H Next > || Cancel

2. Select the Newsgroup Account radio button and click Next.

3. Continue your newsgroup server configuration by answering the
remaining questions presented to you via dialog boxes.

Note that your ISP probably provided this information when you signed
up for service. When the configuration is complete, you return to the
Inbox window.

4. Right-click the newsgroup server that’s highlighted and choose
Subscribe.

When you add your Newsgroup servers in the Preferences dialog box,
you indicate a default news server. As your default server, it’s automati-
cally highlighted.

The first time you do this, you're in for a wait as an index of all the news-
groups downloads to your browser. Tens of thousands of newsgroup titles
are out there, so even though the browser is downloading only the news-
group names, the process takes some time. The status bar at the bottom of
the dialog box indicates progress.

After all the newsgroup titles have loaded into your browser, you can scroll
through the list for topics of interest. To subscribe to a newsgroup, highlight
the group name and click the Subscribe button to the right.

Subscribe to the newsgroup comp.os.linux.announce to see how this
process works. Don’t worry; by subscribing, you aren’t flooded with e-mails
and don’t announce to the world that you’re a member of this group. Rather,
the subscription is merely telling your browser to remember this group for
you. Follow these steps to subscribe to a newsgroup:



1. In the Newsgroup text box, type the name of the newsgroup you want
to subscribe to.

D ro B O O xample, if you want to subscribe to the Linux announcements news-
p, type comp.os.linux.announce. The group is then highlighted.

s

2. Click the Subscribe button.

A check mark is placed next to the selected newsgroup you want to sub-
scribe to.

3. Click OK.

You’re now back at the Message Center and see an extra item, listed
under your news server, labeled comp.os.Tinux.announce.

4. Double-click the item for your newsgroup in the Message Center.

The Mail & Newsgroups window pops up with a message stating that it’s
loading headers for this group. If it’s a busy newsgroup, you may be
prompted for the number of message headers you want to download.

After the message headers are loaded, you can scroll through the messages
and read or contribute to this newsgroup. Seeing what your peers are doing
around the world is educational!

You need to be aware of the written and unwritten rules for newsgroup eti-
quette, which vary wildly from group to group. I recommend that you read
the Frequently Asked Question (FAQ) page for the newsgroup and lurk for a
while before posting questions and comments.

Evolving into E-Mail

Although you can utilize Mozilla for e-mail, the default mail client in Fedora
Core 1 (the distribution included with this book) is Ximian Evolution. If this
product doesn’t come with your distribution, you can find it at www.ximian.
com, although these days it comes with nearly all versions of Linux.

Setting up Evolution

The first time you open Evolution, the program walks you through the setup
process, so be sure to have the following information on hand:
v Your assigned e-mail address, in the format username@example.org.
v The type of mail server used for incoming mail: for example, POP.

v The name of the mail server used for incoming mail, in the format
servername.example.org.

Chapter 8: Surfing the Web and Managing E-Mail
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v The type of mail server used for outgoing mail: for example, SMTP.

The name of the mail server used for outgoing mail, in the format
D ro B O O SS/ername .example.org. This name may be the same as for the
ming mail server.

v Any special type of authentication required, for both mail coming in and
going out. This authentication is typically just passwords for coming in,
and may be nothing for going out.

After you start Evolution for the first time, follow these steps:

1. Click Forward to proceed past the Welcome screen.
The Identity dialog box (Figure 8-8) opens.

2. Change the Full Name field, if you want, and then change the E-Mail
Address field if it doesn’t match the address your ISP gave you. Then
click Forward to proceed.

The Receiving Mail dialog box opens, as shown in Figure 8-9.
3. Select in the Server Type list box the type of e-mail server your ISP uses.

Leave it as None if you don’t want to receive e-mail on this machine.
Depending on which item you choose, the dialog box changes to ask for
the appropriate information. I assume that you’re using a POP mail
server to receive mail.

4. Enter the full name of the POP mail server in the Host text box.

The name may be something like pop.example.com.

Identity o

Please enter your name and email address below. The
"optional" fields below do not need to be filled in, unless
you wish to include this information in email you send.

Required Information

Full name | Jane Doe |

Email address: | ‘

Optional Information

Reply-To: ‘ ‘

Organization: ‘ ‘

|
Figure 8-8:
The Ximian
Evolution
Identity
dialog box.

| € Cancel | | <@ Back | | B Forward
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Figure 8-9:
The Ximian
Evolution
Receiving
Mail dialog

Evolution Setup Assistant - NEE

le<eiving Mail

Please enter information about your incoming mail
server below. If you are not sure, ask your system
administrator or Internet Service Provider.

Server Type: | POP s
Description: For connecting to and downloading mail from POP servers.
Configuration

Host pop.example.com

Usemame: |jane

Use secure connection (SSL):

Authentication

Authentication type: | Password s | | Check for supported types

[ Remember this password

Note: you will not be prompted for a password until you connect for the first ime

box.
|

| 8 Cancel ‘ | <@ Back ‘ ‘ > Forward

5. Enter your login name for checking mail in the Username text box.

If your e-mail address is jane@example.com, your username is pat.

6. If you were told to use SSL for security, check the Use Secure

Connection (SSL) check box.

If you don’t know what kinds of authentication your mail server uses,
click the Check for Supported Types button.

7. Select the appropriate authentication option.

Typically, it’s Password.

8. If you aren’t concerned about someone else using your login session

10.

11.

when you turn your back, check the Remember This Password check
box. Otherwise, do not.

. Click Forward to proceed to the second Receiving Mail dialog box
(Figure 8-10).

Set how often you want to check for new mail automatically, if you
want to do so.

If you don’t have a permanent connection to the Internet, you may
prefer to check mail manually.

If you check mail from multiple machines, you may want to check the
Leave Messages on Server check box so that you can access the same
messages from all your machines.

Click Forward to proceed to the Sending E-Mail dialog box, shown in
Figure 8-11.
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v Evolution Setup Assistant [= (=]

D ro p B Oc | #2r=ing Mail

Please select among the following options
Checking for New Mail

[] Automatically check for new mail every |10 @ minute(s)

Message storage
[[] Leave messages on server

["] Disable support for all POP3 extensions

Figure 8-10:
The second
Ximian
Evolution
Receiving
Mail dialog
box.

| # Cancel H <d Back H }Emwaid|

12. Change the Server Type entry if yours isn’t SMTP.
I assume that you're sending e-mail with SMTP.
13. Enter the full name of the SMTP mail server in the Host text box.

The name may be something like smtp.exampTle.com.

Sending Mail

Please enter information about the way you will
send mail. If you are not sure, ask your system
administrator or Internet Service Provider.

Ser e

Description: For delivering mail by connecting to a remote mailhub using SMTP.

Server Configuration

ﬂ05t|
Use secure connection (SSL):
— ["] Server requires authentication
Figure 8-11: Authentication
. g -
The lelan Authentication Type: | PLAIN ‘ ‘ Check for supported types ‘
EVOlUtion Username |Jane ‘
Sending ] Remember this password
Mail dialog
box.

| % Cancel | | <f Back | | kEorward|
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Figure 8-12:
The Ximian
Evolution
Account
Manage-
ment dialog
box.
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14. If you were told to use SSL for security for outgoing mail, check the

16.

17.

18.

19.
20.

Account Management /

Use Secure Connection (SSL) check box.

u were told to use additional authentication for sending mail,
k the This Server Requires Authentication check box.

Typically, nothing is required here. You have to fill out the appropriate
information if you do activate this section.

Click Forward to proceed to the Account Management section, shown
in Figure 8-12.

If the account you just set up wasn’t your default e-mail account, dese-
lect the Make This My Default account check box.

You need to add another account later.
Click Forward to proceed to the Time Zone dialog box.

This dialog should easily remind you of the Time Zone selection portion
of the Fedora Core 1 installation routine.

Click your continent to zoom in, and then click the closest city to
where you live, time-zone-wise.

Your time zone is selected. You can also click the drop-down list box and
choose your time zone manually.

Click Forward to proceed to the Done dialog box.
Click Apply.

That’s it! Ximian Evolution finally opens, as shown in Figure 8-13.

Evolution Setup Assistant BEE

You are almost done with the mail configuration process.
The identity, incoming mail server and outgoing mail
transport method which you provided will be grouped
together to make an Evolution mail account. Please enter
a name for this account in the space below. This name
will be used for display purposes only.

Account Information

Type the name by which you would like to refer to this account.
For example: "Work" or "Personal”

WL e @example. ned

Make this my default account

¥ Cancel ‘ | < Back ‘ | B> Forward ‘
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Sending and checking e-mail

The following steps outline how to create a new e-mail message and send it to

the President of the United States:

1. Click Inbox.

The Inbox window appears, as shown in Figure 8-14.

2. Click the New Message button.

A Compose a Message window appears, which contains a work area to
create your e-mail message.

3. Complete the message, as shown in Figure 8-15.

4. When you finish typing your message, click the Send button.

Watch for MIBS (Men In Black Suits) to show up at your door and haul
you away for interrogation. Just kidding! This e-mail address gets mil-
lions of messages.

Within a few minutes, you have mail in your inbox waiting to be read.
No, the President of the United States isn’t constantly reading and reply-
ing to everyone’s e-mail. A program called an auto-responder is running
on the computer that has responsibility for the President’s e-mail. When
a message is received, the auto-responder returns a form letter to the
e-mail address of the sender. Your message is queued up, and the
Presidential staff eventually reads it (or so I'm told).
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5. Click the Send/Receive button.

Your e-mail goes out. Wait a minute or so and then click the button
again. You should have a message waiting for you from the President of

the United States.

Take some time to really explore Evolution. As you can see just from the fig-
ures in this chapter, there’s much to see in this program.

Figure 8-15:
An e-mail
message

to the

President of

the United
States.

b4 EOI](ET[IE&;;I‘I;I:I‘I“I‘&XDE)’ = !'I:I| x
File Edit Format View Insert Security

i send DA B @ Ep O DA

From: | e e ——— '|Signamre" None ““

|president@whitehouse.gov

Subject |Concerned about taxpayers’ money!

Linux is created en the fundamental principles that make America
great: freedom and innovation. As a tax paving citizen I request that
all government computers run Linux instead of that expensive winders
stuff.

Yours,

Me
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In This Chapter

Getting the message out instantly
Browsing with other Web browsers
Mail, mail, and more mail
Exchanging files quickly with FTP

In case you haven't heard, the Internet is not a superhighway.

—Bill Washburn, Internet World magazine

Fe Internet is a vast network of computers that spans the globe. Many dif-
ferent types of computers and operating systems work together to allow
you access to information across the Internet. Linux, along with its related
Unix operating system, has long supported and worked with the Internet.
Practically all the different services available on the Internet are available
from your Linux desktop.

When Fedora Core 1 is installed using the Personal Desktop option, several
Web browsers, mail programs, and instant messaging tools are installed in
your Linux system. In this chapter, [ introduce you to some tools you can use
to access different services on the Internet, such as accessing Web sites,
using e-mail, investigating newsgroups, and utilizing FTP.

Your Linux system has other tools in addition to the applications | mention
here, and I suggest that you take the time to explore these tools. You may find
that an application I don’t cover works better for you. Also, if you don’t like
any of the Internet-related tools in your Linux system, you can always find
lots more on the Internet and install them on your Linux system. But those
are topics for Chapters 17 and 19.

Instant Messaging

Instant messaging between people is like using a telephone — except that you
type your conversation rather than speak it. In addition, you can simultaneously
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hold multiple instant messaging conversations without the need for additional
connections to the Internet. America Online (AOL) provides one popular instant

ide variety of computer operating systems, including Linux, support

D r O p B O @ksg service, named AOL Instant Messenger, or AIM. Others are ICQ and

W

|
Figure 9-1:
The Gaim
IM client.
|

these various services. Kit and Gaim are two instant messaging software pack-
ages that are installed by default on your Fedora Core 1 system when you select
the Personal Desktop installation option. Because Gaim supports more than just
a single instant message (IM), I cover this one in detail. Kit supports only AIM.

In other distributions, if you select the GNOME desktop during installation,

Gaim is installed. If you select KDE during installation, Kit is installed in the

system. If you select both GNOME and KDE, Gaim and Kit are both installed.
In Fedora Core, however, both are installed by default, although Gaim is the
main selection.

Gaim

You can launch Gaim by choosing Main Menur>Internet=>Instant Messenger
to open the application shown in Figure 9-1. After the application starts, you
need to enter your current IM account, or screen name, or create a new
screen name. Gaim supports AIM, ICQ, MSN, and even more services.

Screen Name;

<New User>| |v|

Password:

8 X @

Accounts  Preferences  Sign On

For a quick start, if you’re now an AIM user, enter your screen name and pass-
word and click the Sign On button. Make sure that your Internet connection
is already established before you use the AIM service.

If you use types of messaging services other than AlM, or if other users want
to use this same instance of Gaim, you need to use the Account Editor to set
things up (unless you give them their own login, which is the best solution):
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1. Click the Accounts button in the Gaim main window.

A window contalnlng the current accounts is displayed, as shown in

DropBooks-

|
Figure 9-2:
The Gaim
Accounts
window.
|

|
Figure 9-3:
The Gaim
Account
Editor Add
Account
window.
|

v [ Accounts : BEE

IScreenname |0n|ine |Auto-|cgin |Prowcc\

| & Add H & Modify || 8 Delete || X Close |

[»] Add- Account B

2. To add an IM screen name or account type, click the Add button.

The Add Account window appears, as shown in Figure 9-3.

Login Options
Protocol:

Screenname: {

Password:
Alias: | |
Remember password

[ Auto-login

User Options

[] New mail notifications
Buddy icon file | |ﬂrowse |

[- Show more options

| # Cancel || ke Save

3. Select the IM service type in the Protocol drop-down list.

You have the option to choose AIM/ICQ (these use the same network, so
if you want to add either one of these types of accounts, select this one),
TOC (another aspect of AIM you need if you want to use AIM chats),
Yahoo!, MSN, IRC, Jabber, Napster, Zephyr, and Gadu-Gadu.

4. Enter your IM name in the Screenname text box.

5. Enter your IM password in the Password text box.

145
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6. If you want to use a nickname with your IM name, enter that in the
Alias text box.

D ro B O O K&l’re the only person using this account (and this is Linux, after
if other people want to use IM, give them their own login
accounts and let them set up Gaim for themselves!), select the
Remember Password check box.

If other people have access to this account, don’t check this box.
Otherwise, someone may accidentally or intentionally, have a bit of fun
with your IM at your expense.

8. If you want Gaim to automatically log you in to this account when you
start the program, check the Auto-Login check box.

More settings exist, but these are the basics. Continue on and click the
triangle next to Show more Options to see more. If you don’t want Gaim
to automatically log you in, follow the remaining steps to manually con-
nect Gaim to IM.

9. Click the OK button to return to the Account Editor window.

10. If you want to create another IM account, return to Step 2. You can log
in to multiple IM accounts at the same time with Gaim.

11. After all your accounts are created and you’re back in the Account
Editor window, select the Online check box for each one you want to
connect with.

Gaim attempts to connect to each of your specified accounts.

Troubleshooting Your IM Connections

If you have been using AIM or MSN with other operating systems, after your
Linux system has successfully connected to the IM service, you see your
buddy lists and any buddies now connected. If you haven’t ever used AIM or
MSN, you can now set up buddy lists. Buddy lists contain the usernames of
people you want to communicate with through the instant messaging service.
Your buddy list lets you know when your “buddies” are online and available
to receive an instant message.

If you're using ICQ, your buddy list isn’t stored on the Internet for you. This
list is stored on your machine and not in a central location online.

Sometimes, your Linux system is unable to properly connect to the IM ser-
vice. When this happens, an error message pops up on your screen and indi-
cates a failure to connect. You may be unable to connect to the IM service for
several reasons:
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v You may have entered the wrong password for your IM account or
chosen the incorrect IM account name.

D ro B O Omr computer may not be connected to the Internet. Try opening
illa or another Web browser to see whether you can get to a Web
site, which tells you whether you're connected to the Internet.

v If you can open a Web site but can’t get IM to work, the IM system may
be unavailable. This problem occurs at times because of maintenance of
the IM service or an excessive amount of traffic on the Internet or on the
IM service.

v If you attempt to access the IM service from your computer at work,
your company or organization may block the IM service for security or
productivity reasons. If using IM at your work is permitted, check with
your network administrator to see whether he can help you out.

v Often, companies use firewalls between the company’s network and
the Internet to keep out unwanted traffic on the company’s network.
If the firewall is configured to block IM traffic, you cannot use IM across
the Internet.

Other Browsers to Consider

There are three kinds of death in this world. There’s heart death, there’s
brain death, and there’s being off the network.

—Guy Almes

In Chapter 8, you can explore a Web browser named Mozilla that includes lots
of features to access Web sites, work with e-mail, and perform other services.
In addition to Mozilla, other graphical Web browsers are available for Linux.
Another popular Web browser, Konqueror, is also included with Fedora Core 1
on the DVD that comes with this book, and on the CDs you can order. In addi-
tion to browsing the Web, you can use Konqueror to manage your e-mail and
newsgroup subscriptions. There’s also Firebird, a version of Mozilla that is
Web-only and therefore a bit less cumbersome.

Konqueror

Some Linux systems, including Fedora Core 1, come with a Web browser
named Konqueror. You can launch Konqueror by choosing Main Menu>
Internet>More Internet Applications>Konqueror Web Browser to see the
tool shown in Figure 9-4.
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E\ Fedora Project, sponsored by Red Hat - Konqueror,
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To set up the Konqueror preferences, choose Settings>Configure Konqueror.
The Settings window, which is shown in Figure 9-5, contains many options,
some of which are similar to Mozilla preferences. You can explore each config-
uration area by clicking the area icons in the left pane of the Settings window.

<} Settings - KDE Control Module *
?\F : You can e how Kongq beh, as afile ger here
=
Beha.vlor . Misc Options
% ["] Open directories in separate windows
Appearance ["] Show network operations in a single window
[[] Show file tips
e |
Previews
Q Home URL: |
File Associations —Ask Confirmation For
E% Move to trash
— Behavior Delete
Figure 9-5: L) G
The Java & JavaScript ~Minimize Memory Usage
Konqueror W L | ©Newr
Settings =4 @ For |ocal browsing only (recommended)
window. |V oK ” _ Hx gaw‘
|
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E-Mail Client: KMail
D ro p B O Qk@) browsers provide e-mail support so that you can read and send

e-mail to other people. In addition, several e-mail applications, or e-mail
clients, that deal with only e-mail are available. As an example, [ look at the
e-mail application named KMail, which is part of KDE.

KMail is a simple e-mail program that is available in many distributions

of Linux, including Fedora Core 1. (If KMail isn’t installed by default, see
Chapter 17 for information on how to add software to Linux.) You can launch
KMail by choosing Main Menu=Internet=>More Internet Applications=>KMail
from the main menu.

The first time you launch KMail, you must set up your e-mail environment:

1. Choose Settings->Configure KMail.

The Configure window appears as shown in Figure 9-6. It allows you to
set your name, your e-mail signature, the storage location for your
e-mail, and the name and port number of the Simple Mail Transfer
Protocol (SMTP) server. If you don’t know the settings for your SMTP
server, check with your ISP, or if you're at work, check with your net-
work administrator.

Configure - KMail

& Manage Identities
R | Identity Name | Email Address

Default (Default) Dee-Ann LeBlanc <=

New...
T _doan._|
.'@ Modify...
e
Rename
: BT
L
Composer
(1]
()
Security

Fﬁs
|
Figure 9-6:
The
Configure —
KMail dialog

]l o o
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|
Figure 9-7:
The KDE
Mail Client
application
window
with Tip of
the Day
dialog box
open.
|
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2. After you make all desired settings, click OK.

D B I You return to the KDE Mail Client window.

Mail Client application window contains a series of labeled buttons
across the top of the window (as shown in Figure 9-7). To create a new mes-
sage, select the New Message button, and the Composer window appears.
Enter the e-mail address of the recipient of your message, a subject line, and
the main body of the message in the window. When you have completed your
message, click the Send button to send the message on its merry way.

KMail =101
File Edit View Go Folder Message Tools Settings Help
imEodoxne § @V e H
‘Fc\dev ~ |Unread
=-Local Folders
--Q\nhnx
- (1 outbox
~Bsentma

¥ vrash
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1 mailing standards
rewrite header "Subject"

replace "\s*\[mailing list name\]\s*"

05 e which are described
with

ation about new

KMail include

Show tips on startup ‘ &) Previous g

b

Before sending a message, you can also attach a file, such as a picture, by
using the Attach File button. The Attach File button displays a miniature file
system navigator so that you can browse to and locate the file you want to
attach to your e-mail. You can also spell check your message before delivery
by choosing Edit=>Spelling in the Composer window.

3 Next

|:Q Close :|
< The ‘Delete’ Action

cably deletes messages. Use ‘Move 1o
Trash' 1o put messages into the trashean.

+ PGRIMIME (RFC 3156) support for GnuPG users,

+ SIMIME support

+ Optional MIME tree vi

now ievor

iewar, allowing direct access 10l

| Initializing...

Transferring Files with FTP

One of the first types of services designed for networks were file services.
People needed a way to get files to and from file servers quickly and reliably.
File Transfer Protocol (FTP) was designed to provide this type of service. FTP
has been around for ages and is still one of the best ways to get files to and
from systems in a network. In addition, most current Web browsers support
FTP for downloading, so you no longer need to memorize commands to
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transfer files if you never need to upload. Sometimes, as you point your browser
to a Web site and download an update to a software package, you're receiving

j way of FTP. Applications, such as gFTP, provide a nice graphical inter-
ro p O ilitate FTP file transfers without needing to use your browser.

|
Figure 9-8:
A Web
browser
software
FTP
interface.
|

Using a Web browser for FTP

To access a FTP service with a Web browser, open up your Web browser and,
in the Address field, type ftp:// followed by the address of the FTP location.
For example, if ftp.redhat.comis the name of an FTP service, type ftp://ftp.
redhat.com in the Address field of your Web browser.

Figure 9-8 shows the Mozilla Web browser software FTP interface. In the
browser view of FTP, you click directories to navigate up and down the file
structure. If you click a file, you're given the option to open the file or down-
load and save it in your file folders.
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7| 4hHome | WhBookmarks 2 Red Hat Neworte (14 suppon (1§ shep G Producs (4 Training

Index of ftp://ftp.redhat.com/pub/redhat/linux

Up to higher level directory
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D& 07/13/2002 12:00:00 &M
D@ 07/13/2002 12:00:00 &M
D& 07/13/2002 12:00:00 &AM
3.0.3 07/13/2002 12:00:00 AM
Dﬂ 07/13/2002 12:00:00 AM
Dﬂ 07/13/2002 12:00:00 44
Dﬂ 07/13/2002 12:00:00 AM
L”f' Eh ~Z E3 | one T ‘ ‘#iﬂ

Checking out gFTP

Fedora Core 1 includes a graphical FTP application named gFTP.
To access the application, follow these steps:

1. On the Panel, click the Main Menu button at the left to open the
Main Menu.
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2. Choose Internet->More Internet Applications-~>gFTP.

The gFTP application window appears, as shown in Figure 9-9.

D ro p B O O 5 Sle Host field in the upper-left corner, type the address or URL of

the FTP server.
For example, type ftp://ftp.redhat.com.

4. In the User field at the top center, type the name of an account to
access the FTP server.

If an account isn’t necessary, enter anonymous for the account name.

5. In the Pass field at in the top upper-right corner, type the password
for the account.

If you're using anonymous to access the FTP service, enter your e-mail
account for the password.

6. To connect, click the two-computer button in the upper-left corner of
the screen.

In the bottom area of the display, you see messages and status indica-
tors as the connection to the FTP server is processed.

After the connection is established, the left pane displays the file system on
your Linux computer. The right pane displays the file system on the FTP
server to which you just connected. You can navigate around both systems
and upload and download files by using the right and left arrows that are
located between the two panes.

Host [#]Port [ [+]user | []Pass: | [Fre "‘
/home/dee | v ‘ ‘ H i ‘
[Local] [All Files] Not connected”
L}|Filename Size |User E L}|Filename Size|User
3 .gaim 4,096 dee ‘
(3 .gconf 4,096 dee
3 .geonfd 4,096 dee
3 .dfp 4,096 dee
3 .gimp-1.2 4,096 dee
3 .gnome 4,096 dee
(3 .gnome2 4,096 dee
(3 .anome2_private 4,096 dee
[e] Z ] [2] | iz [2]
I || Filename Progress
Figure 9-9:
The gFTP

gFTP 2.0.14, Copyright (C) 1998-2002 Brian Masney <masneyb@gfip.org>. If you have any questions, comments,
H 1 or suggestions about this program, please feel free to email them to me. You can always find out the latest news,
a ppllcatlon about gFTP from my website at http:/fwww.aftp.ora/
W|nd0W gFTP comes with ABSOLUTELY NO WARRANTY for details, see the COPYING file. This is free sofware, and you
*  |are welcome to redistribute it under certain conditions; for details, see the COPYING file
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In this part . . .

n this part of the book, I expand my coverage of Linux

beyond what’s part and parcel of the operating system
to include its many other facilities and capabilities. These
components are critical to making Linux the raging mon-
ster of productivity that a well-constructed, properly con-
figured system can represent.

Here you read about the Linux file system and how to
manage its constituent files and directories, as well as how
to control which users or groups are permitted to access
these vital system resources. Next, you can read about
using the Linux command-prompt environment, known as
the shell, along with some key capabilities that should be
part of any savvy Linux user’s standard repertoire. After
that, you explore two common graphical user interface
(GUI) tools for Linux: GNOME (the GNU Network Object
Model Environment) and KDE (the K Desktop Environment).
With a GUI to use, you also review how to spiff up the look
and feelof your Linux desktop. Finally, I explore a variety of
text editors, the increasingly popular OpenOffice suite, and
take a whirlwind tour of Multimedia Wow.
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In This Chapter

Encountering Linux file types
Managing Linux file permissions
Maneuvering through the file system
Working with file system contents

Referring to multiple files at once using wildcards

There is no need to do any housework at all. After the first four years, the
dirt doesn’t get any worse.

—~Quentin Crisp

Flere’s no avoiding it. At some point, you have to work with the files and
directories in your system. Fortunately, after you get familiar with the
rules and commands, you feel more comfortable (even if you find yourself
being reminded from time to time of working in good old MS-DOS). Because
many people find that working at the command line is easier when dealing
with files, in this chapter I cover both the typed commands and the graphical
tools you have at your disposal.

Comprehending File Types

You find lots of different file types out there in the Linux world. By types, 'm
not referring to extensions, such as .exe or .doc. Linux sees everything
within its file system — even directories — as “files.” As a result, assigning a
type to a file is merely a Linux machine’s way of keeping track of what’s what.
In the following sections, I show you how to see what’s in your file system,
describe each of the file types used in Linux, and explain how to figure out
which type you’re looking at.
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Listing directory contents

D ro p B O Q:K;ﬁ? most basic skills any computer user needs is the ability to see
a

ere in her file system. In Linux, you use the 1s (short for lisf) com-
mand to do this. If you use this command by itself with no options — special
extras that let you control the behavior of a command — all the command
tells you is which files and directories are in the specified directory.

Suppose that you're at the base of the Fedora Core directory tree (which is
referred to as the root, or /). The 1s command lists the contents of the cur-
rent directory by default. So, if you type 1s at the command prompt in the
root directory, you see the following output, which lists all subdirectories
inside the root:

pin dev home 1ib misc  opt root tmp var
boot etc initrd lost+found mnt proc sbin usr

But this is only the tip of the iceberg for the 1s command. The 1s command
has a bunch of options you can mix and match to get the results you need. |
list the most interesting of these options in Table 10-1. Remember: Linux is
case sensitive; when an item is shown in uppercase, it must be used in upper-
case, and vice versa.

Table 10-1 Is Options

Option Purpose

-a Displays all files, including hidden files (files whose names
start with a period)

-C Displays the last time the file was changed

@hycolor Color codes items by type

-1 Displays a long format file listing

-R Displays the contents of the directories in this directory

-S Lists the files by size

-t Lists the files according to how long ago they

were changed

-u Lists the files according to how long ago they
were accessed

In this table, -a and -1 are by far the most commonly used options. If you're
in a brand-new home directory and type 1s, you see nothing. However, if you
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type 1s -a, you may see something like this because of the hidden files
(those starting with periods):

DrOpBOO.kS.bashMgout .bash_profile .bashrc

Q\QN- S Tl"}o

What are the first two entries? The first entry — the single dot — always refers
to “right here.” It points to the directory you're in now. (Don’t worry if this stuff
doesn’t make any sense to you at the moment. As you work with other com-
mands and get more familiar with Linux, it makes sense.) The second part of
the line (the two dots) refers to the parent directory, or the directory one level
up from where you are now. For almost all user home directories (for example,
/home/dee), the parent is /home. I discuss file system structure in more detail
in “Working with the File System,” later in this chapter.

If youtype 1s -1 in this same brand-new home directory, you get nothing,
just like you did when you typed 1s.

Type one of the most commonly used combinations and you get much more
information. If you type 1s -1a, for example, you see something similar to
the following:

drwx------ 2 dee dee 4096 Jul 29 07:48 .

drwxr-xr-x 5 root root 4096 Jul 27 11:57 ..

-rw-r--r-- 1 dee dee 24 Jul 27 06:50 .bash_logout
-rw-r--r-- 1 dee dee 230 Jul 27 06:50 .bash_profile
-rw-r--r-- 1 dee dee 124 Jul 27 06:50 .bashrc

You may find some parts of this format easier to understand, at a glance, than
others. The first item in each listing (the part with the letters and dashes —
for example, the drwx ------ in the first line) is the permission set assigned
to the item. Briefly, permissions define who can read the file, change it, or run
it if it’s a program. You can read more about permissions in “Haggling with
Permissions,” later in this chapter. The second item in the first line (in this
case, 2), is the number of links to the item.

A link is a fake file listing that points to another file, making a kind of short-
cut. You use two kinds of links in Linux and Unix:

v~ Soft link: This link is like a Windows shortcut in that the link points back
to the original file, and anything you do to the link happens to the original
file. Erase the original file, and the link remains, but it becomes unusable.
The link is broken without the original file.

v Hard link: This link doesn’t have a counterpart in the Windows world. A
hard link isn’t just a shortcut; it’s another instance of the file itself. The
data in this file is saved in only one place, but you can edit either the
original or the link, and the edit is saved for both instances of the file.
Erase the original, and the file still exists as long as the link is there. It’s
like two doors to the same room!

157
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The third item (dee) is the file’s owner, and the fourth (dee) is the group —
depending on which version of Linux you're using, both these items may or
e identical. You can find out more about both of these in “Haggling
gissions,” later in this chapter. The fifth item is the file’s size in
bytes. All directories show up as 4,096 bytes. Everything else has its own
size. You can tell an empty file from the size of 0 bytes.

The sixth, seventh, and eighth entries are all related to the last time the file
was changed: the month (Jul), the date (29), and the time in 24-hour format
(07 :48). Finally, the ninth item is the filename (for example, bash Togout, in
the third row).

Getting information about specific files

You can zoom in and focus on specific files too. As you may guess, one tool
used for this purpose is the 1s command. Typing 1s f7/ename gives you the
short listing, where filename is the name of the file you're interested in. The
short listing isn’t all that useful unless you're just checking to see whether the
file exists. What’s more useful is typing 1s -1 f7ilename, which gives you a
single line in the 1s -1 format, which I examine in the preceding section.

When you type any form of 1s directory, you actually see the contents of
the directory instead of the directory and its permissions (unless you add
the -d flag to the mix). For example, typing 1s -1d directory gives you the
long format listing for just the directory itself.

The first letter in any long format file listing (the result of a 1s -1 command)
tells you which type of file you're dealing with. In Table 10-2, I list the types
you’re likely to run into.

Table 10-2 Linux File Types
Label Type Description
- Regular file The item is an everyday file, such as a

text file or program.

b Block device The item is a driver (control program)
for a storage medium, such as a hard
drive or CD-ROM drive.

C Character device The item is a driver (control program)
for a piece of hardware that transmits
data, such as a modem.
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Label Type Description

D ro B O O kS Directory The item is a container for files, also
referred to as a folder in some operat-

ing systems’ lingo.

1 Link The item is a soft link.

Linux has additional commands that can give you something a bit easier to
understand than a raw listing of information. The first of these commands is
simply named fi1e, which directly tells you which kind of file you're dealing
with. For example, if you type file /home, you see the following result:

/home: directory

The file command even traces links for you! You can use it with links in two
different ways:

v If you use just the file command and a filename or directory, the com-
mand tells you about the exact item you listed. For example, if you type
file /usr/src/1inux, you may (depending on your Linux distribution,
if you have particular packages installed, and other issues) see the fol-
lowing line:

/usr/src/linux: symbolic link to /usr/src/linux-2.4.18
v When you use the -L flag (often the same thing as an option) with file,
it traces a link back to the original and gives you an answer based on the

original. For example, if you type file -L /usr/src/linux, you see
the following line:

/usr/src/Tinux: directory

Working with the File System

It was an accident, Phyllis.
Oh, you know, so was Chernobyl.
—From the movie Quick Change
You need to know how to move within the directory structure, how to find out
where you are, and how to add and remove things. I suggest logging in to a user

account to experiment with what you read about throughout the rest of this
chapter. Don’t use root. You don’t want to delete or move something vital!
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Moving through the file system
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he first of these lets you see exactly where you are. You may think
that you wouldn’t need a command like this one. After all, shouldn’t your
location be obvious? Many Linux distributions, however, have the habit of
giving you a prompt like the following:

[dee@myhost deel$

This prompt tells you that your login name is dee, and that the machine
you’re on is myhost. The directory you're in, however, is /home/dee, not just
dee. Linux uses this format mostly because the full location can get pretty
huge: A prompt showing the full path can take up half the line or more. To see
exactly where you are, type pwd.

You move through the file system with the cd (change directory) command. If
you’re in the /home/dee directory and you want to go to the temporary
directory (/tmp), you type cd /tmp.

Another thing that you need to be aware of — and that can save you lots of
typing — is that you can type file system locations in two different ways:

v~ Type the whole thing. If you're in /home/dee and you want to switch to
the subdirectory files, you can type cd /home/dee/files. You have
another way to do it, though.

v Type a relative location. If you know where you are and where you want
to go relative to where you are, you can use the relative location rather
than type the whole thing. For example, to switch to the files subdirec-
tory of /home/dee from inside /home/dee, you can just type cd files.
The cd command understands that you're already in /home/dee, so it
looks for the files directory inside it.

Maybe you’re logged in as root and checking up on a few different user direc-
tories. You're in /home/dee and you want to go to /home/ralph. You can
either type cd /home/ralphor cd ../ralph. Remember that the .. always
refers to the directory that contains the one you're in. Using . . /ralph tells
the cd command to back up one directory (into /home) and then move for-
ward into ralph.

Just want to change to your own home directory? Type cd ~ and you get
there immediately! In fact, you can just type cd with nothing else if you want.
If you want to change to your own text subdirectory (maybe it’s /home/
ralph/text), you could type cd ~/text.
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Creating files and directories
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ely are

v Create your own files: If you're using the Linux machine for serious
work, you probably will want to create files for a variety of reasons.
You may have a personal journal to keep or want to make a tip sheet
for yourself with the things you find out about Linux during your
experimentation.

1 Create directories: Eventually, those files add up! Directories are there
for organizational purposes. Make the most of them.

Making new files

In Linux, you have essentially three ways of creating new files. One is the
wonderfully straightforward touch command, and I get into the details here.
The others are a bit more complex and involve things you get into as you
continue with your explorations or with this book.

You can create a new, empty file at any time by using the touch command.
Because the file contains nothing (it just has a name), all you're really doing
is making an entry in a directory. But this technique does have its uses. You
use touch in the format touch f7/7ename, where filename is the name of
the file you want to create. You can either be inside the directory in which
you want to create the file, in which case you just type touch f7lename, or
use the techniques I discuss in the preceding section. If you're in /home/mike
and want to create the file today in your journal subdirectory (/home/mike/
journal), you type touch journal/today. Or, if you're in /home/mike/
Journal and want to create the file note in /home/mike, you type touch

. WANOEN

When you get to the “Haggling with Permissions” section of this chapter
and start experimenting with file permissions, use the touch command to
make expendable files that you can mess with without causing yourself
problems later.

The other methods of creating files depend on which kind of files you want to
make. If you want to create a text file, you can use one of many text editors
available for Linux. A text editor is a small program that lets you work with
raw text with no formatting, such as Notepad in Windows. In Chapter 13, I
cover one of the text editors that comes by default with all Linux distribu-
tions and point you to additional ones.

Finally, the nontext files are items like word processing documents that have
lots of formatting codes, image files (such as GIFs) that are chock-full of for-
matting stuff and have no readable text, and more. You create these files by
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using the appropriate program for them. To make a word processing file, you
use a word processing program, such as WordPerfect or OpenOffice.org (see

oks®

Making new directories

As you add more and more files to your home directory and elsewhere, you
realize that you need to organize them before you get completely buried and
can’t find anything quickly. Directories are the perfect tools for filling this
need. You create new directories in Linux with the mkdir command. Again,
you can use it in more than one way. If you're in /home/mi ke and want to
create the directory /home/mike/pictures, you can type mkdir pictures.
If you need to create a temporary directory outside your home directory with
files to share with others, you type mkdir /tmp/pictures. This is a perfect
use for those hard and soft links, since you’ll want to keep a copy of those
files in your own home directory. The contents of your /tmp directory are
removed pretty regularly!

Moving, renaming, and deleting
files and directories

One of the facts of life is that things change. Suppose that you create a file
named text one day. Then, the next day, you have a pile of text files and need
to make a new directory for them. You make the new directory and then move
the files into it. Or, suppose that you make a filename too generic and you can’t
tell the difference between text and texth at a quick glance. You need to
rename them. Fortunately, Linux has commands to do all these things easily.

Moving and renaming

You need to be careful if you're using the root account. Renaming, moving, or
deleting system files can wreak total havoc! This is just one more reason that
[ constantly beg people not to use root at all unless they have to.

You use the mv command for both moving and renaming files. To move a file
from one location to another, you type mv originallocation newlocation,
where originallocation is the directory in which the file starts, and newlocation
is where you want to move the file. Suppose that you want to move the file
/home/mike/text into the directory /home/mike/textfiles. When you're
inside /home/mike, you typemv text textfiles.This command is the
same as typing mv /home/mike/text /home/mike/textfiles or even mv
/home/mike/text /home/mike/textfiles/text.If you make the destina-
tion the name of an existing directory, the mv command assumes that you
want to put the file into that directory with the same name.
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Renaming files is remarkably similar. If you want to rename /home/mike/
text as /home/mike/grocerylist,youtypemv text grocerylist from

Gkéome/mke.

You can even move and rename at the same time. You can move /home/mike/
text into /home/mike/textfiles while renaming it grocerylist, all from
inside /home/mike by typing mv text textfiles/grocerylist.

Getting rid of the junk

In any operating system, cleaning out your files occasionally is a good idea. If
you don’t, you're on the road to having no drive space left, which is definitely
no fun. Linux has two different commands for deleting. One is rm (short for
remove). If you use this command by itself, it deletes files. For example, if you
type rm ~/test.tif,the test.tif file may just be deleted without ques-
tion, or you may see the following line, depending on how your distribution
has the rm command set up:

rm: remove 'test.tif'?

Press N or Enter to cancel the operation. Otherwise, press Y to delete the file.
Linux contains a number of options, as shown in Table 10-3, that you can use
to make the rm command behave according to your preferences. The default
preferences may differ between your root account and your user accounts.

Table 10-3 Options for rm

Option Description

-d Removes a directory, even if it's not empty

=1 Removes items without asking for confirmation

-1 Asks for confirmation before removing anything

-r Continues into subdirectories and removes items there too
-V Prints status information during the removal process

You can use these options individually or in combinations. If you use the -d
option, you can use rm to remove a directory as well as a file. For example, if
you want to delete /home/mike/textfiles,youtype rm -d textfiles
from inside /home/mike. This command removes both the directory and its
contents, but you may be prompted for each item, depending on how your
distribution has rm set up. You can override either behavior (prompting or no
prompting) with the proper flags. If you type rm -df textfiles, youdon’t
have to answer any questions; if you type rm -if textfiles, youdo.
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Suppose that you have a series of subdirectories you want to get rid of.
Maybe you have /home/sally/files, and the files directory has the sub-

Gi‘ {es /text, /images, /programs, and more. You can type rm -r

/home/sally to get rid of all of them. Once again, though, you're
prompted frequently during this removal process. To eliminate the constant
prompting, type rm -rf files.

The command rm -rf is perhaps the most dangerous thing you can type on
a Linux or Unix system, especially if you're logged in as root (rm -rf *isthe
worst possible command because it’s a great way to accidentally delete your
entire file system). Be quadruply sure that you're typing this command in the
right place if you're logged in as root and that you really want to get rid of
everything in the subdirectories. Many people have typed rm -rf in the root
directory accidentally, only to feel sick as they listen to the drive churn and
churn as it deletes everything. You can press Ctrl+C to cancel out of this com-
mand, but you can’t get back the already deleted files.

Another way you can get rid of directories is to use the rmdir command. This
program deletes only empty directories. Many people prefer to use a combina-
tion of rm to delete the files, and then rmdir to remove the directories, just to
ensure that they aren’t making a colossal mess of things. You use rmdir in the
format rmdir directory.Suppose that you have a temporary directory,
/tmp/mikesfiles, that you want to remove. After typing rm -r or rm -rfin
that directory for each of the files, you type cd .. to back up to /tmp (you
can’t delete a directory if you're now in it) and then type rmdir mikesfiles.

Haggling with Permissions

Take a look at some long format file listings on your machine by typing Is -1
within a directory. If you find yourself scratching your head, don’t worry. The
“Comprehending File Types” section, earlier in this chapter, gives you a feel-
ing for the first letter on each line, but nine more characters are attached to
that item before you get to the next column. This group of nine is the set of
permissions (also called a permission set) for the file or directory. Linux, Unix,
and even Mac OS X use permissions as a way of providing file and directory
security by giving you the means to specify exactly who can look at your
files, who can change them, and even who can run your programs. You need
this capability when you have a bunch of different users on the same
machine, networked to the world.

Checking out the triads

Each permission set consists of three triads. Each of the triads has the same
basic structure but controls a different aspect of who can use what. Consider
the long format listing for /home/dee in the following code:



total 20

4096 Jul 29

WX~ —---- 2 dee dee
r-x root root 4096 Jul 27
rop OO > ol Sl dee dee 24 Jul 27

|
Figure 10-1:
Breakdown
of the nine
permission
characters.
|

“rwW-r--r-- dee dee

5
1
-rw-r--r-- 1 dee dee
1
-rw-rw-r-- 1 dee dee

230 Jul 27
124 Jul 27
0 Jul 29
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.bash_Tlogout
.bash_profile
.bashrc
Isfile

The first character in the permission set refers to the type of file. For a direc-
tory, the character is shown as a d, as you see here for the first two items in
the preceding list; files are designated with a dash (-) instead. Each file or
directory’s permission set is a group of nine characters — that is, the nine
characters that follow the first character (for a total of ten). But this group of
nine is really three groups of three, as shown in Figure 10-1.

R W E R w E R w E
Users Groups Others
Legend:
R=Read
W=Write
E=Execute

The three triads are read as follows:

* The first triad consists of the second, third, and fourth characters in the
long format file listing. This triad sets the permissions for the user, or
owner, of the file. (Owners are discussed in the “Beware of owners” sec-

tion, later in this chapter.)

v The second triad consists of the fifth, sixth, and seventh characters in
the long format file listing. This triad sets the permissions for the group
that is assigned to the file. (Groups are discussed in the “Hanging out in
groups” section, later in this chapter.)

v The third triad consists of the eighth, ninth, and tenth characters in the
long format file listing. This triad sets the permissions for other, or
everyone who isn’t the file’s owner or a member of the owning group.
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Although each triad is often different from the others, the internal structure
of each one is made up in the same way. Focus specifically on how to read
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v The first character is either an r or a dash. The r stands for read permis-
sion. If r is set, the triad allows the entity it stands for (user, group, or
other) to view the directory or file’s contents.

v The second character is either a w or a dash. The w stands for write per-
mission. If w is set, the triad allows the entity it stands for to add or edit
items to, or in, this directory or file.

v The third character is either an x or a dash. The x stands for execute
permission. If x is set, the triad allows the entity it stands for to run pro-
grams contained in this directory or to run the particular program in
this file.

In all cases, if the dash sits in place of r, w, or x, the triad doesn’t allow the
entity the read, write, or execute permission.

The following sections describe owners and groups in more detail.

Beware of owners

You may have noticed by now that I talk a great deal about owners (users)
and groups in Linux. Every file and directory has both of these components: a
user from the /etc/passwd file that’s assigned as its owner and a group from
/etc/group assigned as the group.

Although an everyday user probably doesn’t need to change file ownerships
often, the root user does so regularly. If you add the file comments, for exam-
ple, to /home/tom while you're logged on as the superuser (another term for
the administrator, who is the person who owns the root account), root owns
that file. The user tom can’t do anything with it unless you have set the last
triad’s permissions to allow the other folks (those who aren’t the file’s owner
or in the specified group) to read and write to the file. But this method is a
pretty sloppy way of doing things because the whole idea of permissions is to
reduce access, not to give everyone access. Instead, remember to change the
file’s owner to the user tom. You do this with the chown (change owner) com-
mand. For example, by typing chown tom comments, root changes the own-
ership over to tom. Then tom can work with this file and even change its
permissions to something he prefers.

Hanging out in groups

Groups are more interesting to work with than owners. You use groups to
allow the root user to assign to multiple users the ability to share certain file
system areas. For example, in many versions of Linux, all users are added to a
group named users. Then, rather than a long format file listing such as the
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one shown in “Reading a long format file listing” section, later in this chapter,
you may see the following:

drwx==---- 2 dee users 4096 Jul 29 07:48 .

drwxr-xr-x 5 root root 4096 Jul 27 11:57 ..
-rw-r--r-- 1 dee wusers 24 Jul 27 06:50 .bash_Tlogout
-rw-r--r-- 1 dee wusers 230 Jul 27 06:50 .bash_profile
-rw-r--r-- 1 dee users 124 Jul 27 06:50 .bashrc
-rw-rw-r-- 1 dee users 0 Jul 29 07:48 1sfile

In distributions such as Red Hat Enterprise Linux and Fedora Core, both the
user and group are the same by default (you would have owner dee and
group dee, for example). This isn’t always the case, however, as you see from
the preceding code listing, which has owner dee and group users. Various
Linux distributions have their own philosophies about this issue.

As the root user, you can create new groups or add users to groups:

v To create a group, you use groupadd groupname, specifying the name
of the group you want to create (for example, groupadd Tabteam).

v To add a user to an existing group, you use usermod -G group user,
specifying the name of the group to which to add the user and the user
you want to add to this group (for example, you type usermod -G
labteam dee).

Changing permissions

Permissions and ownerships are assigned to all files during the installation
process. From there, every directory and file you create has permissions
assigned to it automatically (what these default permissions are depends
on your Linux distribution’s default settings). But you may not like the per-
missions that are already in place. Maybe you want to change them to
make your data more secure or even more accessible. In the listing in the
preceding section, for example, I don’t see the need for everyone on the
system to be able to view the contents of 1sfile. So, I can use the chmod
(change mode) command to deal with this issue in the format chmod new
permissions filename, where newpermissions indicates that you want
to change the existing permissions for whatever file you specify as file-
name. For example, for 1sfile, you type chmod newpermissions 1sfile
at the command prompt.

You can express the newpermissions component in two different ways: by
the letters or by the numbers, as described in the following sections.
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v u for user
v g for group
v o for other, or everyone

v a for all (or ugo has the same effect)

The second group consists of the familiar characters that Linux uses for the
permission triad: r, w, and x. (See “Checking out the triads,” earlier in this
chapter.) Next, you have the operators, which are characters that tell chmod
what to do with the permissions relative to the triad you're referring to:

v + to add a permission
v - to remove a permission

v = to set the permissions to the exact value

Now that you have all the pieces, you can begin putting them together. Start
with the example chmod newpermissions 1sfile. Your goal here is to
allow no users — outside of yourself or your group members — to view the
contents of 1sfiTe. From this clue, you know that you're referring to the
third triad (the o triad). The permission used to determine whether people
can view the contents of a file or directory is the r position, and the operator
used to take away this permission is the dash (-). So, you type chmod o-r
1sfile. The deed is done: None of the users in the o (other) group can view
the contents of 1sfile. It really is that easy!

You can change multiple triads at the same time in a couple of different ways.
For example, if you want to change 1sfile so that only the owner (dee) can
read its contents, you type chmod go-r 1sfile to change both the group
and other settings simultaneously. Getting even more complex, if you want to
make sure that only the file’s owner can read, write, or run that file, you type
chmod go-rwx Isfile.

Technically, you can even type the full set of permissions, if you want. If you
want both the owner and group to be able to read 1sfi1e, but only the
owner to be able to write to it, you can type chmod rw-r----- I1sfile.

Permissions by numbers

Another method that Linux users commonly use to change permissions is
numbers. Because this format is used all over the place in Linux documenta-
tion, from books to courses to manual pages and online references, I truly
thought that [ should include the information for you here — even though it’s
a bit technical.
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To put it simply, permission numbers allow you to deal with just a raw octal
number — octal is a numbering system in base 8, meaning that you only use

ers 0 to 7 instead of 0 to 9, which is the more familiar base 10
ro p O Y he nice thing is you don’t need to know any more than that about
octal in order to use this method.
Look at the following permission set:
“PW-rw-r--
In the following list, the preceding line of code is broken into its three triads:

v Triad 1: rw-

v Triad 2: rw-

v Triad 3: r--
In each position in each triad, the important thing to notice is whether a
letter or a dash is there. The numeric values for each possible item are

v Every r is worth 4

v Every w is worth 2

v Every x is worth 1

v Every - is worth 0

Each triad keeps its own total. All you need to do is add the values. So, in the
case of the sample permission set, you have the results shown in Table 10-4:

Table 10-4 Results of Sample Permission Set
Triad Conversion to Numbers

rw- 4+2+0=6

rw- 4+2+0=6

r-- 4+0+0=4

The numeric permission set is basically set so that the value for the first triad
is the first number, the second value is the second number, and the third
triad is the third number. The permission set rw-rw-r-- works out to 664.

If you know exactly what you want to change your permissions to, you use
the format chmod newpermissions file with numbers for the permissions.
For example, to change the 1sfile’s permission to rw------- , you type
chmod 600 Tsfile.
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Reading a long format file listing

D ro p B O Q K mat file listing (1s -1) is quite easy to read after you get a handle
edc

n of the elements within it. [ go through the following example — line
by line — in the following sections:

total 20
@iPy====== 2 dee dee 4096 Jul 29 07:48 .
drwxr-xr-x 5 root root 4096 Jul 27 11:57 ..
-rw-r--r-- 1 dee dee 24 Jul 27 06:50 .bash_logout
-rw-r--r-- 1 dee dee 230 Jul 27 06:50 .bash_profile
-rw-r--r-- 1 dee dee 124 Jul 27 06:50 .bashrc
-rw-rw-r-- 1 dee dee 0 Jul 29 07:48 1sfile

Line One
total 20

The first line specifies how many blocks (a unit of file system usage) the files
in this directory use.

You can find out how large the blocks are on a particular partition by typing
dumpe2fs -h partition, where partition isthe device information for
that part of the drive. To get the list of partitions on your system, you type
df. For an example, you can type dumpe2fs -h /dev/hdal for the first parti-
tion on your first IDE hard drive.

Line Two
drwx------ 2 dee dee 4096 Jul 29 07:48 .

The first letter here is a d, so it immediately tells you that this entry is a direc-
tory. Now, move to the permissions. Only the first triad has anything turned
on here, so the owner (that’s dee) is allowed to view the contents of the direc-
tory (thanks to the r), save files to that directory (thanks to the w), and run
programs in the directory (thanks to the x). No one in the group (including
dee), can do any of these tasks in /home/dee. After this entry is the number of
links to the item, which in this case is 2. Then, you have the user who owns
this item, dee, and the group that owns this item, also dee. Next is the item
size (directories often show 4,096 bytes, but can be larger if the directories
contain a huge amount of data). Then comes the creation or last change date
and time. Last, you see the item name. In this case, it’s a period, which stands
for the current directory, so the first entry tells you about /home/dee itself.

Line Three
drwxr-xr-x 5 root root 4096 Jul 27 11:57 ..

Once again, the first letter is a d, so you're looking at a directory. As for the
permissions, the first triad refers to the root user, who has all three (rwx)
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enabled, so root can do anything she wants to do in /home. The second triad
is r-x, so anyone in the group (also root, in this case) can read the contents

@ and execute programs in there. The third triad is identical to the

o the same rules apply to everyone else. This item has five links,
and it’s owned by the user root and the group root. After the size and creation/
modification date and time comes the name of the item. The . . stands for the
directory above this one, so the second entry tells you about /home.

Okay, the root user can do anything she wants within the Linux file system. If
you’re using a Red Hat Linux-related distribution such as Fedora Core, every
user has her own group with the same name as the user account; other distri-
butions, such as SuSE, have all users assigned to the group user.

Lines Four, Five, and Six

-rw-r--r-- 1 dee dee 24 Jul 27 06:50 .bash_logout
-rw-r--r-- 1 dee dee 230 Jul 27 06:50 .bash_profile
-rw-r--r-- 1 dee dee 124 Jul 27 06:50 .bashrc

Now you get to the files, which you can recognize by the dash (-) as the first
character. Files are always listed after directories when you use 1s -1. The
permissions for all these items are the same. Their first triad is rw-, which
means that the owner (dee) can view the file’s contents and edit them. The
second and third triads for these three are r--. Anyone in the dee group can
view the contents of these files, and everyone on the entire system can too.
Each file has only one link, is a different size (in bytes) and was created at the
same time — in this case, when the account itself was created. The names for
these files are .bash_Tlogout, .bash_profile,and .bashrc.

Line Seven
-rw-rw-r-- 1 dee dee 0 Jul 29 07:48 1sfile

This last item is also a file. You can tell because the first character is a dash.
Because its first two triads are identical (rw-), the owner (dee) and members of
the group (dee) can both view the file’s contents and change them. Every-one
else, however, can only read the contents because the last triad is r--. Only one
link exists, and this item is owned by the user and group dee. It’s empty too,
indicated by the file size — 0 bytes. After the creation or last modification date
and time, you see the file’'s name: 1sfile.

Wildcards, or Legal Cheating

Working at the command prompt involves lots of typing. This fact becomes
painfully obvious if you want to deal with a bunch of files and have to type
their names one by one. Fortunately, you don’t have to do that. You have
wildcards at your disposal.



] 72 Parti: Getting Up to Speed with Linux

Wildcards are characters that represent one or more characters. Table 10-5
lists the wildcards you have available when working with files and directories.

DropBoaks

Table 10-5 Wildcards for File and Directory Manipulation

Character Name of Character Purpose

? Question mark Stands for a single missing character
* Asterisk Stands for a group of characters

[ Square brackets Allows you to specify a range or

group of characters

Suppose that you have a directory with the following short file listing:

afile cfile filelfile file2file fileafile
bfile filel file2 file3 filebfile

Table 10-6 shows you how you can use wildcards to access those files:

Table 10-6 Using Wildcards to Access Files

If You Type.. .. Then You Get

1s ?file afile, bfile, cfile.

Is file? filel, file2,and file3.

1s file* filelfile, file2file, fileafile, filel, file2,

file3,and filebfile.

1s *file afile,cfile, filelfile, file2file, fileafile,
bfile,and filebfile.

1s file[1-3] filel, file2,and file3.

1s filel[1-3]1* filel, file2,file3, filelfile,and file2file.

1s filel[l,al* filel, filelfile,and fileafile.

P You may also find filename and command completion useful. The bash shell
(the default Linux shell; see Chapter 11) has a feature that finishes a filename
for you. If you're working at the command prompt and typing a long filename,
press the Tab key and bash does the rest. You can also complete commands
by pressing the Tab key. You have to type enough letters, however, to make
the item unique so that nothing else can come up during the completion.
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G $yping stuff at the command prompt? If you prefer, the GUI contains a
bunch of file managers for you to use. A file manager is a program, such as
Windows Explorer, that enables you to dig through and manipulate your files
and directories with your mouse rather than at the command prompt. In this
section, I take you on a tour of the file managers that, by default, come with
popular Linux distributions.

In both GNOME and KDE, the file managers can do more than just work with
your files. Have some fun and experiment with the programs covered in this
section!

Sailin’ with Nautilus

In the GNOME desktop environment (and anywhere in Fedora Core 1), the
default file manager is Nautilus. You can find this program by double-clicking
the Home icon on your desktop. Figure 10-2 shows an example of what you
can see with Nautilus open in a default Fedora Core 1 GNOME setup.

The workings of this file manager should seem similar to those you're used to
in other operating systems. If you like to have the full file system tree avail-
able to you in a pane on the left, you can change the default setup by follow-
ing these steps:

1. Choose the Information drop-down list box.

The list box expands, displaying your options.

~ BEE
File Edit View Go Bookmarks Help
4, b .AD P * z
Back Forward Up Stop Reload Home
Location: |/home/dee €, 100% &

Information » X @ ﬁ B @
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2. Select Tree.

tionality you find in Microsoft Windows Explorer.

l(l\lautilus now gives you the same two-panel layout with click-and-drag

The default Nautilus setup varies according to which Linux distribution
you’re using. In some distributions, this tree panel is set up by default.

Browsing your files

Moving through the file system is pretty easy in Nautilus after you have the
tree open — the tree lets you do a lot of drag and drop stuff. The main thing
you need to keep in mind is that your directories are on the left (if you have
activated the side pane and have both activated and selected the Tree tab),
and your files are on the right. You can do the following file management
tasks in Nautilus:

+ Open a directory on the left: To open a directory within the left panel,
locate it in the list and click the right-facing arrow next to it. The arrow
pivots to point down, and if subdirectories exist, they’re now listed
beneath the current directory.

»* Open a directory on the right: To open a directory within the right
panel, locate it in the window and double-click it. Linux automatically
displays the files in this directory:.

v View a directory’s contents: To view the files in a directory, click the
directory’s folder icon or the name in the left panel, and its contents
appear in the right panel.

v Look at files and run programs: To view a file’s contents or run a pro-
gram, double-click the item in the listing.

Are you getting too much information about each file or not enough?
Experiment with the View As Dropdown list box in the upper-right side of the
Nautilus window; the options include View As Icons (the default), View As
List, or View As. The first two items pull up a view on the right that gives you
a different amount of information about the files and directories. The third
item opens the View As Other dialog box, which allows you to set the default
viewing behavior for the current folder or to alter which programs are
opened for which file types.

Copying and moving files

You can copy and move items using two different methods in Nautilus
(assuming that you have added the side pane and activated the tree view).
The first is by using the usual drag-and-drop method you’re probably familiar
with from Windows or the Mac OS — but only within the right pane — and
the other is by using the program’s menus. To move a file by using the drag-
and-drop method, first click the file you want to move in the listing on the
right. Then drag it to the folder you want to drop it into within the left pane.
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You do the same to copy, except that you click the item and then hold down
the Ctrl key while you drag and drop.

D rO p B O Oks files and directories

To use Nautilus to delete either a file or a directory from the file system,
follow these steps:

1. Browse to the file or directory’s location.

2. Select the file or directory.

Click the item to highlight its name, whether it’s in the left (if you have
activated it and the tree view) or right pane.

3. Click the Delete button.
The file or folder vanishes from view. Keep in mind that if the folder con-
tains other files or folders, they go right along with it.

These deleted items are not fully deleted yet. Deleting from the command line
is a one-step operation, but deleting by using Nautilus puts the files in the
Trash folder, which you can open by double-clicking the Trash icon on your
desktop. You can delete the contents of the Trash at any time by following
these steps:
1. Right-click the Trash icon.
This action opens a shortcut menu with options listed.
2. Choose Empty Trash from the shortcut menu.
A confirmation dialog box opens.

3. Click Empty in the confirmation dialog box to delete the contents of
the Trash folder.

Linux permanently removes the items in the Trash folder.

Viewing and changing permissions
If you have experimented with the different file views, you already know that
neither the Icon view nor the List view shows you a file’s permissions. To view
and change a file or directory’s permissions, you need to follow these steps:

1. Browse to the file or directory’s location.

You need the file or directory to appear in the right pane, so click the
folder in the left pane (if you have activated it and the tree view) that
contains the item.

2. Select the file or directory.
Click the item in the right pane to highlight its name.
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4. Click the Permissions tab.

3. Right-click the file and choose Properties from the shortcut menu

that appears.

Properties dialog box opens with the Statistics tab open.

The Permissions portion of the Properties dialog box appears, as shown
in Figure 10-3.

. Set the new permissions and ownerships.

As you can see, Nautilus offers some pretty handy tools for setting the
permissions exactly the way you want them without having to remem-
ber their structure or which numbers go with which letters. You can also
change owner and group information here.

. Close the dialog box.

When you have everything set the way you want it, click the Close
button to close the dialog box and put the changes into effect.

Journal txt Properiies

|
Figure 10-3:
The Per-
missions

tab of the
GNOME
Nautilus file
manager’s
Properties

— T
Basic |Emblems | Permissions -

Number view: 664

Last changed: unknown

File owner: dee - Dee-Ann LeBlanc

File group:

Owner: Read Write [] Execute
Group: Read Write  [] Execute
Others: Read [ ]| Write [ | Execute

Text view: -TW-rw-r--

dialog box.

Rulin’ with Konqueror

In KDE, the default file manager is Konqueror. You can find this program in
Fedora (as I discuss in Chapter 9) by choosing Main MenuInternet->

More Internet Applications>Konqueror Web Browser. After it’s open, click
the button with the house to go to your Home directory. Figure 10-4 shows an
example of what you can see with Konqueror open.

\‘\gN\BEI? In default GNOME and KDE setups, the Main Menu button in the lower-left
> corner is a footprint (in GNOME) or a big K (in KDE). If you installed Fedora

Core 1, the Main Menu button is the Red Hat fedora icon in both GNOME and
KDE. In other KDE-setup distributions, Konqueror is your default file manager.
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The workings of this file manager should seem similar to those from other
operating systems. After you click Window=>Show Navigation Panel to open
the directory tree on the left, you have the two-panel setup you’re probably
already used to from Windows Explorer or the Mac OS. From here, you can
move about and utilize the usual drag-and-drop features.

Browsing your files

Konqueror allows you to move through your file system with ease. The main
thing you need to keep in mind is that your directories are on the left (if you
have opened the directory tree on the left), and your files and subdirectories
are on the right. File management tasks you can do in Konqueror are
described in this list:

v Open a directory using the left pane: To open a directory using the left
pane, locate it in the list and click the plus-sign (+) symbol next to it. The
graphic changes to a minus-sign (-); and if the directory has subdirecto-
ries, they’re now listed beneath the current directory.

1 Open a directory using the right pane: To open a directory using the
right pane, locate it in the window and click it. Linux automatically dis-
plays the files in this directory.

v View a directory’s contents: To view the files in a directory using the
left side, click the directory’s folder icon or the name.

v Look at files and run programs: To view a file’s contents or run a pro-
gram, click the item in the listing. If the system is unsure of which pro-
gram should be used to open a file, it offers you the Open With dialog
box so that you can select the appropriate application.

177



] 78 Ppartint: Getting Up to Speed with Linux

Drop@

\\J

If you double-click a file to open it and get an unexpected and useless result,

click the back (left-pointing) arrow and then right-click the file you want to
hortcut menu appears. Click Open With and from the pop-up sub-
oose the program you want to use to view this file.

Changing file views

Are you getting too much information about each file or not enough?
Konqueror has a collection of settings that lets you tweak how file informa-
tion is presented. The Icon View and Tree View buttons appear to the right of
the first row of icons when you’re viewing a directory’s contents. These but-
tons have the following set of functions:

v To move between a general Icon view to a more detailed file listing, click
the Icon View and Tree View buttons.

v To select which layout of icons you want in Icon view, click and hold the
Icon View button until the drop-down menu with Icon View and
Multicolumn View appears. Then click the option you want to use.

v To select which combination of details you want in Tree view, click and
hold the Tree View button until the drop-down menu with Tree View,
Info List View, Detailed List View, and Text View appears. Then click the
option you want to use.

Take some time to experiment with these sets of options to see which one
you like the best. The last layout you choose remains as your default until
you close Konqueror.

The Settings menu contains a number of entries that allow you to customize
Konqueror so that it remembers your preferences.

Copying files

In some versions of KDE and Konqueror, you can open a file just by single-
clicking it. You may think that it’s hard to drag and drop when just clicking an
item opens it. You can, however, still use this feature! Just make sure not to
click and release the item you want to move. You have to click it and hold the
mouse button down as you drag the item.

For copying and pasting without using drag and drop, follow these steps:
1. Right-click the item and choose Copy from the shortcut menu that
appears.
Your computer copies the item to its memory.
2. Navigate to where you want to put the copy.

3. Right-click in the destination directory and choose Paste from the
shortcut menu that appears.
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Your computer copies the file to this location.

D ro B O CXK‘ nd deleting files
v file or directory is suspiciously similar to copying one:

1. Right-click the item and choose Cut from the shortcut menu
that appears.

Your computer copies the item to its memory and grays out the
icon to indicate that it’s on its way out.

2. Navigate to where you want to put the file or directory.

3. Right-click in the destination directory and choose Paste from the
shortcut menu that appears.

Your computer moves the file or directory to this location.
Fortunately, deleting files and directories is pretty easy in Konqueror. You
just browse to the item you want to delete, right-click it, and choose either

Move to Trash or Delete from the shortcut menu! Or, you can even use the
Delete key.

You can delete the contents of the Trash at any time by following these steps:

1. Right-click the Trash icon.
This action opens a shortcut menu of options.
2. Choose Empty Trash from the shortcut menu.
A confirmation dialog box opens.
3. Click Empty to delete the contents of the Trash folder.

Linux permanently removes the items in the Trash folder.

Viewing and changing permissions
You work with permissions in Konqueror almost exactly the same way you do
in Nautilus. To view permissions, change to any of the Tree View listing for-
mats. To modify a file’s permissions in this file manager, follow these steps:

1. Browse to the file or directory’s location.

2. Right-click the file or directory and choose Properties from the short-
cut menu that appears.

The Properties dialog box appears.

3. Click the Permissions tab.
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The Permissions tab of the Properties dialog box opens, as shown in

Figure 10-5.
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4. Set the new permissions and ownerships.

As you can see, Konqueror offers you some handy tools for setting the
permissions exactly the way you want them without having to remem-
ber the structure or which numbers go with which letters. You can also
change owner and group information here.

5. Click OK to close the dialog box.
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In This Chapter

Understanding the user shell environment

Customizing the bash environment
Working with commands

Tinkering with variables

Using redirection and pipes

Using yet more wildcards

Using a variety of commands

Whom computers would destroy, they must first drive mad.

—Anonymous

M any computing old-timers speak fondly of the command line. Others
who developed their skills by pointing and clicking refer to the com-
mand line as some antiquated tool used by crusty old-timers. The truth is
that most skilled computing professionals recognize the merits of both the
graphical user interface (GUI) and the command-line interface (CLI). You
must understand that the command line provides a powerful lever for operat-
ing your computer. If you ever watch over the shoulder of a skilled Linux
geek, you notice that, after logging in, he doesn’t take long to start tapping
out seemingly cryptic instructions on a command line.

In this chapter, I explore the Linux program that provides the CLI, which is
called the bash shell. Although many shells are available for Linux, bash is
the most common, and for good reason. Basically, the creators of bash rolled
all the good features of all the other shells into one terrific program.

Each shell has its own way of handling commands and its own additional set of
tools. I start by explaining what a shell really is, and when you understand that,
you're ready to get down and dirty with bash. I cover specifically what you can
do with some of the best features of the bash shell. Then, I continue with work-
ing at the command prompt and get into bash shell interior decorating.
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P Shells come equipped to perform certain functions. Most of these features
have evolved over time to assist the command-line jockey with a myriad of
D . ¢sihough [ only scratch the surface here, you're encouraged to read
ro Gx age for bash because it’s likely one of the more complete and read-
able man pages in existence. You can read all about how to use man pages (the
online Help system in Linux) in the “Help!” section, later in this chapter.

Playing the Shell Game

You need a way to tell the computer what you want it to do. In Linux, one of
the ways to communicate with the computer is through something called the
shell. A shell isn’t a graphical thing; it’s the sum total of the commands and
syntax you have available to you to do your work.

The shell environment is rather dull and boring by graphical desktop stan-
dards. When you start the shell, all you see is a short prompt, such as a $, fol-
lowed by a blinking cursor awaiting your keyboard entry. In just a moment, I
show you a couple of methods for accessing the shell.

The default shell used in Linux is the bash shell. This work environment is
based on the original Unix shell, which is called the Bourne shell and is also
referred to as sh. The term bash stands for the Bourne again shell. The bash
shell comes with most Linux distributions.

If you installed your Linux distribution to log in to a graphical desktop, such
as GNOME or the KDE environment, you're likely not looking at a shell
prompt. Rather, you interact with your computer via a mouse. You can start a
bash session from within the GUI desktop in a couple ways.

The quickest method to activate a bash session is to click the computer mon-
itor icon on the GNOME panel, located at the bottom of your screen, or in
Fedora Core, choose Main Menu=>System Tools=>Terminal. If successful, you
should be looking at a screen similar to the one shown in Figure 11-1.

The prompt may include some helpful information. For example, if you're
logged in as evan on the machine deepthink in Fedora Core 1, your prompt
looks similar to this:

[evan@deepthink evanl$

Before surveying a few of the shell capabilities, | need to tell you about
another method for starting a shell session. First of all, notice that your shell
prompt is merely inside a window that is part of your GUI desktop. Suppose
you want to start a shell session in a character-only or text environment.
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To switch to a text environment, press Ctrl+Alt+F2. Don’t be alarmed when
your familiar graphical desktop disappears. It’s still running in the back-
ground, and you can get back to where you left off in a moment. But first, a
few words about the boring text screen you're looking at now (I hope).

You're looking at a virtual terminal, one of several available with your default
installation. You probably see something like this:

deepthink Togin:

Go ahead and type your username and password, which you're prompted for.
You see a message indicating your last login date followed by the bash prompt:

[evan@deepthink evanl$

Notice the similarity between this prompt and the open window you left behind
in the GUI desktop. Both prompts are an indication that you have a bash ses-
sion open. Note that, although it’s accurate to say they’re both the results of
using the bash shell, they're distinct and separate instances of the same pro-
gram. In other words, the environment you're working with here is exclusive

of the bash environment you still have open in the GUI terminal window.
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shells is that you're continually moving in and
out of them. Each time you log in, you open a
shell instance — a specific shell with its own
settings. If you're logged in twice on two differ-
ent virtual terminals, therefore, you have two

shells going. If you change the settings in one
of the shells, those settings don't apply to the
other. However, if you make the changes per-
manent, any new shells you open may have the
new settings.

Are you wondering where your GUI desktop has gone? Just to settle your
nerves a bit, do some jumping around. The GUI desktop is located at virtual
terminal (VT) number 7 by default. You now have VT-2 open. Position your
piano-playing fingers and strike the chord Ctrl+Alt+F7. Within a second or
two, your screen should flash and return you to your graphical desktop, and
your terminal window with the bash prompt should still be patiently awaiting
your command. Neat huh? And guess what? The bash session you left open
on VT-1 is still there; you never logged out. Go back again by pressing Ctrl+
Alt+F2. Voila! — right where you left it. Feel free to jump back and forth a few
times, and try some other VTs, (F1 through F6). Whoopee! This virtual termi-
nal stuff rocks.

Okay, when you have grown weary and bored with this little trick, exit or log
out from all the VTs you may have opened and return to the graphical desk-
top and your bash prompt. Then you can explore what all the fuss is about
with this shell doohickey.

Understanding bash Command
Syntax and Structure

Many people happily skip through their Linux use without understanding the
fundamentals of commands in the bash shell. Note that this approach makes
you lose out on some cool capabilities available in bash. The more you know
about how this shell’s “language” works, the more interesting things you can
do with it.

The basics of using bash at the command prompt often involve typing a com-
mand and any of its flags and values. For example, you enter the 1s -T1a ~
command to see a long-format listing of all files in your home directory, includ-
ing those that start with a dot (), which are typically configuration files and
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directories. That other mysterious squiggle character is technically called a
tilde. The tilde is a bash shortcut character that points to a user’s home direc-

D r O p B O Gk’sthis example, | merely list the contents of my home directory.

You can break a command into three distinct components:

v The command name
v The options or flags

v The arguments
Consider this example.

Start with a simple command. The du command lists the contents of the direc-
tory you're now in, and its subdirectories, and how much hard drive space each
item takes up, with a total at the end. Try typing just the du command by itself:

du

That’s neat, but it probably raises more questions than it answers. The
output gives you a long listing of data, but of what? Are those numbers in
bytes, kilobytes, or messages from outer space? To clarify, try adding a
simple option to your command:

1s -h

You're still issuing the same command, but now you’re providing additional
direction on what you want displayed. The -h option tells du to show you the
information in terms that humans can read more easily. Now Ms, Ks, and Gs
appear next to the numbers so that you can see how big these numbers actu-
ally are. But, wait — there’s more. What if you just want to know the total
amount of disk space this directory and its subdirectories are taking up? That
calls for the -s flag:

du -s

What if you want the total for a different directory? Or just one of your subdi-
rectories? In my case, I keep a Music subdirectory for the items I have copied
from my CDs into Oggs (see Chapter 15). I can type the following command to
see how much hard drive space that directory takes up in a human-readable
way rather than have to count zeroes:

du -sh ~/Music

In this example, du is the command name, -sh indicates the flags (options),
and ~/Music is an argument. The -sh flags can be accompanied by many
more flags that provide various options applicable to the command.
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Are you wondering where to find all the available options and arguments of a
particular command? Most commands offer man pages, which are discussed
i elp!” section, later in this chapter. Another good place to turn is the
D ro p B O Gw tion, available with many commands. Note that —he1p displays a
terse list of options, but it’s nice and quick if you already know about an

option but just can’t remember exactly which one it is. Try it by entering the
following command:

du -help

Cool, huh?

Starting Programs from the Shell

The most obvious, and perhaps not so apparent, use of the shell is to start
other programs. Most utilities you use in Linux are separate and distinct exe-
cutable programs. Users need a method to start these programs. In the GUI,
you can associate an icon with a particular program, and the graphical envi-
ronment contains the intelligence to start the program. Note that programs
often require information drawn from environment variables, which are a part
of the shell environment. (I discuss environment variables in more detail later
in this chapter.) For this reason, the GUI often calls the intended program via
the bash shell. So you see, even the GUI finds the shell a necessity — although
the GUI does its best to hide this detail from users.

For example, after you have a terminal window open, type the following com-
mand at the prompt:

mahjongg

After a few seconds, the Mahjongg game is displayed. You can start any pro-
gram at a command prompt that you can click from the GNOME menu if you
know what the underlying program name is. Note that if you're in a virtual
terminal (press Alt+F1), you may see an error message. Some programs
require a graphical environment in which to run, which a character-based ter-
minal obviously doesn’t have.

Putting Wildcard Expansion to Good Use

Computing life would be tedious if you had to repeat the same command on

multiple files. After all, aren’t repetitive tasks what the computer was designed
to do? Wildcard expansion refers to the ability of one command to be executed
against many files. The asterisk (*) and the question mark (?) are two wildcard
characters that are used to match any filename, or a portion of a filename. For
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example, you can use the following command to see a long directory listing
that includes only files that end with a . doc filename extension:

DropBooks:

The files listed may include resume.doc, cover_letter.doc, and
to_editor.doc, for example. (Refer to Chapter 10 for more on wildcards.)

‘x&N\BEB If you're used to using Microsoft Windows, be aware that, in Linux, no special
Y meaning is assigned to file extensions, such as .doc, .exe, and . txt. For
example, in a Linux filename, the dot character in a . doc extension is treated
like any other character in the filename. However, the . extension convention
is rather handy and widely used to easily identify file types; just remember
that, unlike the Windows file system, the Linux file system doesn’t require
anyone to follow this convention.

Working with Long Commands

As you become used to the command line, you should learn some shortcuts
to ease your typing chores. In this section, I show you some features of the
bash shell designed to make your life on the command line as pleasant as
possible. These features include command-line completion, editing, and using
the history of previously entered commands.

Asking Linux to complete a
command or filename for you

Considering that you do much more typing on the command line in Linux
than you may normally do in a GUI environment, a feature that provides
typing shortcuts wherever possible is great. Command completion is a func-
tion of the shell that completes filename and system commands.

The capability of the Linux file system to deal with practically unlimited sizes
of filenames means that many filenames can become huge. Typing these long
filenames can become cumbersome. Fortunately, with command completion,
typing a command or a long filename is short work.

You may want to use command completion in two situations: to enter a com-
mand or to complete a filename.

Completing a command

Suppose that you want to type a command, but you can remember only that
it begins with the letters up and is supposed to return the length of time that



188 Partii: Getting Up to Speed with Linux

has passed since the system was rebooted. Type up at the command prompt
and then press Tab:

D rO p BOO[kaneepthink evanl$ up[TAB]

One of two things happens:

v If only one matching command is in the search path (directory locations
for searching for programs), your command line is completed with that
command, and the system waits for you to press Enter to execute the
command.

v If you hear a beep, it means that more than one command begins with
up. Simply press Tab a second time, and all the possibilities are dis-
played. Locate the command on the list and continue typing it until the
first letters are unique, at which point you can press the Tab key to com-
plete the command.

Completing a filename

Command-line completion isn’t only for commands; if you're typing a file-
name on your command line, you only need to type the first few characters
and then press Tab. The shell usually searches the current working directory
for filenames that match what you have typed and subsequently completes
the filename on the command line. This feature behaves the same way as the
command-completion feature in that, if more than one file contains the letters
you type, you hear a beep and need to press Tab again to see a list of choices.

It takes a little getting used to, but after you have control of the Tab key and
the shell command-line completion feature, you may wonder how you ever
got along without it.

Accessing your command history

It’s nice of the shell to remember what you have done, for better or worse.
Having the shell keep track of the commands you enter makes it easy to
return to those gawd-awfully long commands you pecked at a while ago —
even days ago! Let me give you an example. Suppose that yesterday you man-
aged to issue a command to find all the core dump files in your system (core
dump files are massive files containing debugging data that only an expert
programmer or your computer can understand) and delete them. The com-
mand looked something like this:

find / -name core -exec rm {} \;
To re-execute the command, all you need to do is fish it out of your shell his-

tory and rerun it. The simplest way to read through your command history line
by line is to press the up-arrow key repeatedly until you locate the command
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you want to re-execute. Then just press the Enter key to run the command
again. That’s all there is to it!

D ro p B O O)k&iccess your command history in two ways:

v Press the up-arrow key: This technique is the easiest way to access the
history. As soon as you press the up-arrow key, you see all your previous
commands light up on the command line. When you find what you're
looking for, just press Enter and you’re cookin’.

v Enter the history command: The history command lists your last 20
commands (by default) when you enter it at the prompt.

Creating aliases for commands

Pretend for a moment that you're one of those crusty old DOS users who
enjoys wielding commands, such as dir to display a directory listing. You
can use the alias feature of bash to create new commands that resemble the
commands you're used to. For example, to create an alias that generates a
long directory listing similar to what you have become accustomed to with
dir, you can enter this line:

[evan@deepthink evan]$ alias dir="Ts -1°"
Then, whenever you type dir, you see a long directory listing.

You can also use the alias feature to create shortcuts to very long commands
you use frequently. To see which aliases Red Hat is kind enough to provide by
default, simply type the alias command. The list includes a few prepackaged
aliases along with the dir alias you just created.

Note that the next time you log out or create an additional shell instance,
your newly created aliases disappear. | show you later how you can put these
aliases and other shell commands into a bash startup file that runs each time
you begin a new bash session. (See “Altering the Shell Environment,” later in
this chapter.)

Working with Variables

Variables in the bash shell are words or strings of text that computers use to
represent a piece of data. An example of using a variable is setting the vari-
able fruit to contain the text apple. A number of variables contain informa-
tion about your account and environment settings.



190 Part i Getting Up to Speed with Linux

Uaviables versus environment variables

D ro p B O Q—Ki}%thing I need to make clear is that the bash shell has two classes of
aria :

\\J

v Variables: A variable can be referenced in a program or shell session,
but it’s visible and available to only that session or program.

v+ Environment variables: An environment variable can also be referenced
by the shell or program. However, it has the added behavior of having
its value copied to any other program or shell that is created from its
environment.

You can usually tell at a glance the difference between a variable and an envi-
ronment variable in bash. The normal convention is to name local variables
in all lowercase or in mixed-case characters. An environment variable, how-
ever, is usually always in all uppercase letters.

Checking out commonly used
environment variables

The bash shell has many environment variables. You may be amazed at the
range of items these variables store. The handy thing is that, if something is
stored in a variable, you can change it to suit your needs! In Table 11-1, I list
the environment variables you're most likely to want to work with.

Table 11-1 Commonly Used bash Environment Variables
Environment Variable Purpose Value
HISTSIZE Determines the Number of commands

number of previously
typed commands that
are stored.

HOME Sets the location of The path to your home
your home directory.  directory

MATLCHECK Sets how often the Number of seconds to wait
bash shell checks for between checks
new mail in your mail-
box. If mail has arrived,
you see a message
similarto You have
new mail the next
time you do something
atthe command prompt.
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Environment Variable Purpose Value

! Sets the directories Colon-separated directories
DrOpBOO that bash looks in,

and the order to look
in them to find a pro-
gram name you type
atthe command prompt.

PS1 Sets your command Command and formatting
prompt. characters used to form
the prompt

Most environment variables are established for you by the system adminis-
trator or perhaps by the shell itself. These variables are mostly read by pro-
grams to gather information, and you don’t need to change their values.
However, you may want to alter the value of some environment variables. For
example, in Table 11-1, the first entry, HISTSIZE, determines the number of
lines of command-line history that are kept on file. You may remember the
discussion, earlier in this chapter, of re-executing a command from yesterday
(refer to the section “Accessing your command history” earlier in this chap-
ter). By setting a higher number for HISTSIZE, you can save an even longer
list of previously executed commands.

Storing and retrieving variables’ values

To assign a value to a variable, you just use the variable name followed by an
equals sign (=) followed by the value to store:

MyVariable=MyValue

To retrieve the value being represented by that variable, you need to precede
the variable name with a dollar sign ($). Look at a variable, created by the
shell, that determines what your prompt looks like. This variable is named
PS1. First, you view the value being held by PS1:

echo $PS1
You likely see something like the following line:
[\u@\h \WI\$

Each of the characters preceded by a backslash represents a special instruc-
tion to the shell to return specific information when the shell prompt is refer-
enced. See Table 11-2 for examples of special slash-characters you can use in
customizing your prompt.

191
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Table 11-2 Pieces of the PS1 Puzzle

D r O p B O G@nent Result
! Prints the position of the command in your history list.
\#

Prints the number of commands you have used during the
current shell session.

\$ Prints a $ for user accounts or a # for the superuser.
\d Prints the date in the following format: day month date.
\h Prints the name of the machine you're logged in to.

\n Moves down to the next line.

\s Prints bash for the bash shell.

\t Prints the time in 24-hour format.

\u Prints your username.

\w Prints the lowest current directory level.

\W Prints the entire current directory.

Okay, on with the example; to change your shell prompt to something more
amusing, enter the following line:

PS1="Hello \u, what can I do for you? => '

Note the single quotes. (I get to those later in this chapter.) Inmediately after
pressing the Enter key, you see that your prompt has changed into something
more inviting. Don’t worry if you would rather have the original prompt: You
can either reassign to the original prompt the value stored in PS1 or simply
log out and log in again, and you’re back to familiar territory.

Are you wondering which other variables your system has in store for you?
You can view all environment variables at one time by typing env. Note that
you may not have any reason to access variables on the command line as a
casual use of Linux. However, after you get more proficient, you may want to
journey into the shell programming capabilities of bash, in which case variable
storage is quite handy, just as it is in any computer programming language.

What’s with those single quotes? You have to be careful of some details when
changing environment variables. If you're just assigning something to a
number, you could just use, for example, HISTSIZE=250. However, if you
want to use something with spaces in it, you need to use quotes. Which kind
of quotes you use depends on what else you want to do.
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If you want to display exactly what you have specified, use single quotes
to create a literal text string. For example, type the following line at a

Ooksd prompt:

echo "Hello, my name is $USER'

Kinda goofy, huh? Take a look at a different kind of string that the shell inter-
prets differently: an interpolated string. An interpolated value is one in which the
shell interprets special characters before processing the value. Rather than use
single quotes, this time you use the same example with double quotes:

echo "Hello, my name is $USER"

Notice what the output is this time. Rather than display the exact text you
provided, the shell replaces the variable name, designated with a dollar sign,
with the actual value stored in that variable.

Why did I use single quotes in the PS1 example? The items with the back-
slashes (\) are interpreted one way or another. However, if you use double
quotes with PS1 they are interpreted only once, so that item that lists what
directory you're in changes only the first time. With a single quote, the vari-
ables are interpreted every time you do something.

If you're going to play around with environment variables, | recommend
that you start by using the methods I discuss in this section. After you have
decided that you're comfortable with any changes you have made, you can
make your changes permanent by opening the ~/.bash_profile file and
adding the same text there. The next time you log in, the changes go into
effect. I talk more about making changes permanent in an upcoming section.

Don’t be too discouraged if you don’t understand all this variable stuff right
now. As you become more proficient with Linux, you should explore shell
scripting. Shell scripting is the art of creating computer programs with just
the shell. Most Linux and Unix administrators speak shell script language like
you and I speak our native tongues.

Using Redirection and Pipes

Redirection and pipes facilitate the flow of information. A pipe is exactly what
it sounds like: It directs the output of one program to the input of another
program. A pipeline may consist of several utilities that are plumbed together
by pipes. At either end of this pipeline is, optionally, a redirection.
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Almost all Linux utilities that require input and output have been plumbed
with the following common interfaces: stdin (standard in), stdout (standard
) stderr (standard error). By having a common method to feed input
D ro p B O G Sram or read data from the output of a program, you can glue utilities

together into sophisticated solutions.

Redirecting command output

[ discuss redirecting command output here because it’s by far the most
common form of information detouring. One example of output redirection
involves telling a command to send its results to a file rather than to the
screen, as you probably have been used to seeing. Start in some familiar terri-
tory by typing 1s -1a ~ and then pressing Enter, to produce something like
the following:

total 20

drwx------ 2 sue users 4096 Oct 30 07:48 .

drwxr-xr-x 5 root root 4096 Oct 30 11:57 ..
SAf=Fes=== 1 sue wusers 24 Oct 30 06:50 .bash_logout
SrW-r----- 1 sue wusers 230 Oct 30 06:50 .bash_profile
=PH=F===== 1 sue wusers 124 Oct 30 06:50 .bashrc

-rw-rw-r-- 1 sue users 0 Jan 2 07:48 wishlist

Want to send this information to a file instead? You can use the > redirection
operator to tell bash to send the data into a file instead of onto your screen.
Enter the following command to send the information to a file named Tisting:

Is -1la ~ > listing

Notice that nothing displays on the screen, as you normally would expect.
That’s because the shell has rerouted the output to a file named 1isting. To
verify that the directory listing is there, enter the following command:

cat listing
The cat command displays the contents of the listing file.

Note that if you type 1s -1a ~ > 1isting again, the data is overwritten,
meaning that the file’s contents are wiped out and replaced with the new
output. You can avoid this situation by using >> as your redirection operator,
which tells bash to add the command’s output to the end of the specified file.
Ifyoutype Is -Ta ~ >> Tisting in the same directory after making no
changes, the contents of 11sting are as follows:



Chapter 11: Working without the GUI

total 20
Wx====== sue users 4096 0ct 30 07:48 .
r-x 5 root root 4096 Oct 30 11:57 ..
rop OO - 1 sue users 24 Oct 30 06:50 .bash_logout
SPW-r----- sue users 230 Oct 30 06:50 .bash_profile
=[Pl=r===== sue users 124 Oct 30 06:50 .bashrc
“PW-rw-r-- 1 sue users 0 Jan 2 07:48 wishlist
total 20
drwx------ 2 sue users 4096 Oct 30 07:48 .
drwxr-xr-x 5 root root 4096 Oct 30 11:57 ..
SrW- oo 1 sue wusers 24 0Oct 30 06:50 .bash_logout
S 1 sue wusers 230 Oct 30 06:50 .bash_profile
= F===== 1 sue wusers 124 Oct 30 06:50 .bashrc

\\J

-rw-rw-r-- 1 sue users 0 Jan 2 07:48 wishlist

Laying pipes

Another bash shell feature enables you to connect commands so that the
output of one becomes the input for the next one. This feature is referred to
as a pipe. Suppose that you want to look over the details of all files in the
/etc directory in long-listing format. If you type 1s -1a /etc todo so, a
massive listing appears, and much of the information scrolls right past you.
Although you can back up a bit by pressing Shift+PageUp, you may not be
able to see everything.

To see all the information, you can do one of two things:

v Send the data to a file with redirection by typing something like 1s -1a
/etc > ~/etclisting and then review the contents of ~/etclisting
with your favorite editor.

v Pipe the output to the more command. This command ensures that text
doesn’t show more than one screen at a time. It waits until you press the
spacebar before showing you the next screen. Many Linux users find
this command quite useful.

To pipe the output to more, type 1s -1a directory_path | more, where
directory_path is the directory for which you want to list the contents. The
| symbol (which on the keyboard looks more like two vertical bars stacked
on top of each other rather than just one solid line) tells bash that you want
to use a pipe.

The more utility is a pager. There’s another utility that behaves like more, but
has additional features and ability. Guess what it’s called? It’s called 1ess.
The Tess utility allows you to scroll information both forward and backward
and search for keywords. So, Tess can be used in place of more. At least in
this example, 1ess is better than more.

195
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Altering the Shell Environment

DropBoak

\NG/
é*%“

&hange several configuration files to alter your bash environment.
Each of the following files is text and can be edited with any available editor.
You can simply alter or add the settings your want in each of these files:

v /etc/profile: The system-wide settings. When any user logs in to a
bash session, this file is read first.

v .bash_profile: The user-specific login settings, run after the /etc/
profile file is evaluated.

v .bashrc: The subshell configuration file that is read each time a sub-
shell instance is created. A subshell is called every time a new program
is executed. This file merely provides another level of shell configuration
for this event.

v .bash_Togout: The file that’s evaluated when a user logs out of a bash
session. This file is handy for deleting temporary work files or other
housekeeping you may want to perform after closing up shop for the day.

Note that these last three files are kept in a user’s home directory and are
hidden, which the dot at the beginning of the filename indicates.

If you experiment heavily with these files, create a separate user account so
that you can do whatever you want without messing up your own login. This
advice especially goes for /etc/profile. You can damage everyone’s logins
with this one! To create a separate /etc/profile, you can make a backup by
typing cp /etc/profile /etc/profile.original. Then, edit /etc/
profile knowing you can always delete it with the rm command and use the
mv command to rename /etc/profile.original to /etc/profile.

Vour Handy Command Toolkit

Now that you may have a little more respect for that command prompt and
what it can do, you're ready to take a look at a few commonly used tools.

“Im lost”

Want to know whom you logged in as last? Or, perhaps you have chanced
upon a terminal with no user nearby. A few key commands can give you infor-
mation about who and where you are:

v whoami: By typing whoami on the command line, you can find out to
whom the current shell belongs.



Chapter 11: Working without the GUI ’ 9 7

v who: The who command is related to the whoami command, but it dis-
plays not only who owns the session, but also the controlling terminal
D r B Ksﬂdate logged in along with every other user logged in to the system.
O p O O e: You can find out more about the system you’re running by using
the uname command. Try adding the -a option on the end for informa-
tion regarding your current kernel version and when it was compiled.

v pwd: Knowing whom you're logged in as is only part of the mystery —
knowing where you are is the other vital clue. As you find out in Chapter
10, much of navigating Linux is in working with files and directories.
Unless you're an astral traveler, you can likely be in only one place at any
time. In the Linux file system, this place is known as the current working
directory. To determine your current working directory, type pwd.

“Help!”

The man page system is the electronic manual for Linux (man is short for
manual), designed to provide users with a convenient reference to all the
detailed command information. This information includes command prompt
options, file formats, and program function usage.

The syntax for drawing a man page is man <command name>.

Don’t know the command you're looking for or need basic information about
using the man page system? Just type man man to get started.

Tracking memory and disk space

Other useful information for inquiring minds is how much memory and disk
space is being used. The df command returns a list of all your mounted parti-
tions and how much space is used and available of each one. As with many
commands, you can see a terse listing of helpful options by including the
—help option on the end of the command. Use the df —help command to
determine which command option you need to use to display the information
in a much more familiar byte-size, rather than block-size, number (it’s -h).

That’s all fine and good, but perhaps you're running out of disk space and
you want to find some files to delete, or at least know where all your space is
being used. The du command stands for disk usage. The command by itself
simply returns the number of blocks allocated in the current working direc-
tory. If you include an argument of a directory path, du returns that directory
and all subsequent directories, listing the number of blocks used in each one.

[ don’t want to overwhelm you right now, but if you type the command top,
you can see a second-by-second update of how your system is allocating
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resources, such as memory, and to which processes. Enjoy it as long as you
like, and just press Q to exit when you're done.

DropBooks

Clearing the screen

The clear and reset commands are handy to know about when you’re
working in a shell. The cTear command simply wipes the bash screen clean.
Don’t worry; it’s not deleting any files or changing and settings — it’s just
tidying up so that you can start dumping new stuff to the screen again.

The reset command is a little more interesting. Suppose that you try listing a
binary file to the screen with the cat command. After the computer finishes
puking the result of executing the cat command on a binary file, you may get
lucky and still be able to read your prompt. More likely, your prompt has been
rendered into box characters of no special meaning, and typing on the keyboard
gives you more of the same. To get back to normal, just type reset and press
Enter. Note that it doesn’t look like you're typing the word reset, but rest
assured that the computer understands the series of characters and, after a
couple seconds, should restore your shell environment to your native language.

What'’s cookin’?

A few more status commands can help you keep tabs on your system:

v ps: While top is useful for watching what’s happening, the ps command
lets you take a snapshot of what’s happening on the system. This com-
mand returns statistics on all of your processes, or even every process on
your system.

» kill: One handy use of virtual terminals and the ability to start a shell ses-
sion is the ability to sneak up from behind and kill a process that is misbe-
having. (It sounds much harsher than it really is.) The ki11 command is
usually executed (no pun intended) with the following parameters:

kill -signal process_id

The -signal is a number that indicates the message you want to send to
the process. Not all messages are designed to destroy the process: Some
graciously request that the process stop what it’s doing and return the
resources to the kernel. The deadly signal is -9, the equivalent of vapor-
izing the process from the system regardless of the process’s intentions.

v» killall: The killall command, related to the ki11 command, allows
you to Kill a process based on the name of the command that’s running
the process. For example, I at one time routinely jumped to a virtual termi-
nal and entered kiTlall netscape because some bugs in the software
seemed to allow the Netscape program to run amok. This problem hasn’t
occurred lately, though, with all the work being poured into Mozilla.
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DrOpBO&lﬁin' Gooey with the GUIs

In This Chapter
Adding applets to the Panel

Adding programs to the desktop

Downloading and setting up themes

Configuring the X Window System

\\J

Fe X Window System (or X) opens a world of possibilities. X is, in general,
a set of applications that work together to provide a graphical interface.
Some applications draw windows, some manage the look and feel of the inter-
face, and others handle other aspects of the graphical world for you. In the
Linux world, you can configure all these aspects, which is where many people
start to get overwhelmed.

In Chapter 6, | introduce the two major players in the Linux GUI market:
GNOME and KDE. In this chapter, you get a chance to alter the GUI's behavior
to suit your own needs. For example, if you have a hard time reading text in
those small command-prompt windows in the GUI, you can make both the
windows and their fonts larger. A wealth of other things can be changed too,
so read on and take a look.

If something goes terribly wrong in the GUI and you need to exit in a hurry,
press Ctrl+Alt+Backspace. This key combination does one of two things. If
you boot into the GUJ, it collapses your GUI session and takes you to the GUI
login prompt. However, if you boot to the command line, this key combina-
tion collapses the GUI immediately, taking you to the command line.

However, press Ctrl+Alt+Backspace only in an emergency. This key combina-
tion doesn’t cleanly stop the programs involved. You’'ll end up with all kinds
of bits and pieces of programs, files, and more on your system.
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Changing GNOME’s Look and Feel
D ro p B O O k@'vge is inevitable, except from a vending machine.

— Anonymous

The GNOME desktop environment has an amazing set of features for you to
explore, including lots of ways to change the GUI’s look and feel. Some of
these customization features are nice and practical, and others are just plain
fun. I tried to group the types of changes into related topics so that you can
peruse them easily.

How do ya like them applets?

Applets — a collection of miniprograms that do anything from display the
time to show system status — are available out there in the great big world of
computer programming. A number of people got it in their heads to write
some of these applets specifically for use in the GNOME desktop environment
in Linux. So these applets are included with your GNOME installation. Some
of these miniprograms are more useful than others. Then again, everybody
needs a bit of entertainment too, right?

If you're using Red Hat Enterprise Linux or Fedora Core, GNOME is your
default environment.

Adding an applet icon to the Panel

You can have fun sifting through to see what kinds of applets are available to
you. To look through your options and perhaps add an applet to the Panel
(remember that the Panel is the bar along the bottom of your screen), follow
these steps:

1. Right-click any free space on the Panel and choose Add to Panel.

The Add to Panel submenu opens.

2. Browse the following submenus: Accessories, Amusements, Internet,
Multimedia, and Utility.

Each of these submenus contains a collection of applets you can add to
your panel.

3. To install an applet, click it on the submenu.

The applet is now on your Panel.

Configuring an applet

After you have an applet placed and running, you may be able to play with
configuration options. Some of these options enable you to change what
information is displayed. Others have a variety of look-and-feel settings.
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To check for which configuration and other options are available for your

applet, follow these steps:
D ro p B O O k@t-click the applet and examine the shortcut menu that appears.
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This shortcut menu is different from applet to applet. The bottom por-
tion is always the same: Remove from Panel and Move. Common entries
for the top portion are Help and About. The rest of the items are either
configuration options (see Step 2) or special applet features, such as the
ability to copy the date from the Clock applet.

2. Choose Preferences from the shortcut menu.

Not every applet has a Preferences dialog box. If this one does, the
dialog box opens when you choose this option, and whichever configu-
ration features this applet has are displayed.

3. Alter the selections in the Preferences dialog box to customize this
applet’s behavior.

Now you get to have some fun. Make changes so that you can see
what this applet can do. Each applet has its own set of features, so |
cannot do a general walkthrough here. Just remember that you can
always go back and change the settings or remove the applet from
your panel later.

4. Click Close to put your changes into effect and close the dialog box.

An option available for all applets is to choose Move from the bottom of the
shortcut menu. This action allows you to move the applet to another spot on
the Panel.

Ditching an applet

You only have room for so many applets. And, if you're like me, you probably
don’t want to have every bit of free space cluttered with icons. To remove an
applet from the Panel, simply right-click the applet you want to remove and
choose Remove from Panel from the shortcut menu that appears. With nary a
whimper, the applet vanishes from the Panel.

Don’t forget the programs

You may be looking at your panel and wondering whether you can make any
changes to the programs listed there, like you can with applets. The good
news is that you can change the programs on the bar! They fit in the same
empty spaces that applets do. You can also add a program to the desktop, if
you want.
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Adding a program to the Panel

If you have a program you end up using often, you can add it to your panel by

D o p B o0 these steps:

1. Click the Main Menu button and browse to the program you want to
add to the bar.

Don’t open the program. Just point to the menu item with your mouse
pointer.

2. Right-click the program and choose Add This Launcher to Panel.

An icon for this program appears on your Panel.

After you have your program on the Panel, you can run the program just by
clicking its icon.

Removing a program from the Panel

If you want to remove one of the programs on the Panel, just right-click the
icon you want to remove and choose Remove from Panel from the shortcut
menu that appears. The icon vanishes from the Panel. That’s it!

Adding a program to the desktop

The panel has only so much room. Maybe you would rather have your pro-
gram shortcuts lined up on the desktop as you do in Windows. To add a pro-
gram to the desktop, follow these steps:

1. Click the Main Menu button to open the GNOME main menu.

2. Browse to the submenu containing the program you want to add to
the desktop.

For example, if you want to add The GIMP, you open the Graphics
submenu.

3. Select the program you want to add to the desktop.

Don’t open the program — just move your mouse pointer to it. For
example, to add The GIMP, you move your mouse to the words The GIMP
so that they’re highlighted.

4. Click the program name and drag it to the desktop.

Be sure to drag this item to the side (not up through the menu). A little
piece-of-paper graphic follows your mouse pointer until you release the
mouse button. After you do so, your new shortcut is added to the desktop.
A\
If you're not happy with where a desktop icon is placed, click it and then drag
it to a new location.
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Removing a program from the desktop
oﬁt rid of an icon you have on your desktop, right-click the icon and
S|

D ro p B O él ove to Trash from the shortcut menu that appears.
Customizing KDE

Don’t worry, you KDE users: You have plenty of options too. You can cus-
tomize your KDE setup in lots of ways, from the fun to the practical, so that
you truly enjoy using it. As with GNOME, in fact, you can choose from far
more features than I have room to cover in this chapter, so if you enjoy fid-
dling with the look and feel of your GUI, do some exploring on your own!

Applets keep fallin’ on my head

Applets are miniprograms that do all sorts of things. An applet may display
the time, show system status, or even offer a little frivolous fun. All kinds of
applets are available out in the great big world of computer programming. A
number of applets are included with your default KDE installation, though
some of them are more useful than others.

Adding an applet icon to the Panel

An interesting combination of applets is available in KDE, and you can easily
add and remove these little gems from your KDE Panel as suits your needs.
To add an applet to the Panel (remember that the Panel is the bar along the
bottom of your screen) in KDE, follow these steps:

1. Right-click a blank spot on the Panel.
The Panel’s menu opens.
2. Choose Add=>Applet.
You find yourself looking at the Applet submenu’s contents.
3. Select the applet you want to add to the Panel.
If the applet has any configuration options available, a Preferences

dialog box opens after you have completed this step.

On a particularly crowded panel bar, you may have to use the right and left
arrow bars at the Panel’s ends to see the applet. You may need to delete from
the Panel, in fact, any items you don’t use, to ensure that everything can
show up (see the section “Removing an applet,” later in this chapter).
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See those vertical bars between various Panel entries? Hover your mouse
pointer over them, and the pointer changes into a two-headed arrow. You can

D r O dme vertical bars left and right to expand and contract various parts of
1.

Configuring an applet

Some applets have options that let you customize how they behave. Others
are more boring and just do the same old thing no matter what you would
prefer. To check which configuration and other options are available for your
applet, follow these steps:

a\\S

1. Right-click the applet and examine the shortcut menu that appears.

This shortcut menu is different from applet to applet. In fact, there doesn’t
seem to be any real consistency in the menu options! (And not every
applet even has a shortcut menu.) Look for entries such as Preferences,
Settings, and the word Configure.

2. Select the appropriate item from the shortcut menu.

If you see a Configure or Preferences dialog box, make your changes and
click Apply to see how that affects your applet without closing the
dialog box. You may see more than one configuration dialog box or sub-
menu, as is the case for the KNewsTicker applet.

3. Alter the selections in the dialog box to customize this applet’s behavior.

Experiment as much as you want. Just remember that you can always go
back and change the settings or remove the applet from your panel later.

4. Close the dialog box.

In a Preferences dialog box, click OK to close the window. Settings dialog
boxes typically have a button, aptly named Defaults, that enables you to
restore your defaults.

Removing an applet
You have room for only so many applets. And, if you're like me, you probably
don’t want to have every bit of free space cluttered with icons. To remove an
applet from the Panel, follow these steps:

1. Right-click the Panel on an empty spot.

2. Choose Remove~>Applet.

The series of submenus opens, and you finally are looking at a list of the
applets you now have on your Panel.

3. Choose the applet you want to remove from the Panel.

The applet is no longer on your panel.
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Cluttering the desktop with icons

D ro p B O Q%SNS you to alter which applets and programs appear on your Panel,
n 0

A\

ur desktop. Managing these shortcuts is a simple operation after
you understand how it works.

Adding a program to the desktop

The Panel has only so much room. Maybe you would rather have your pro-
gram shortcuts lined up on the desktop as you do in Windows. To add one of
these shortcuts, follow these steps:

1. Click the Main Menu button to open the KDE main menu.

2. Open the submenu containing the program for which you want to
make a shortcut.

For example, if you want to add The GIMP, you open the Graphics
submenu.

3. Select the program for which you want to make a shortcut.

Don’t open the program. For example, to add The GIMP, you move your
mouse to the program and then click and hold the mouse button.

4. Drag the program to the desktop.

A little piece-of-paper graphic follows your mouse pointer until you
release the mouse button, at which point you're asked whether you
want to add the shortcut to the desktop but not remove it from the
menu (Copy Here); add the shortcut to the desktop and remove it from
the menu (Move Here); or make an obvious shortcut that looks more like
a Windows shortcut (Link Here). After you make your selection, your
new shortcut is added to the desktop.

If you're not happy with where a desktop icon is placed, click it and then drag
it to a new location.

Removing a program from the desktop

If you want to remove one of the programs from the desktop, just right-click
the icon you want to remove and choose Delete. The icon vanishes from the
Panel or desktop. That’s it!

Prettying Up Your Desktop

You may be familiar with the ability to install desktop themes under
Microsoft Windows. A theme in the desktop world refers to color schemes,
images, and sounds applied to all portions of the desktop — window borders,
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fonts, icons, sound effects, and more — as part of a single, centralized entity.
Many people are happy to find out that themes are available in the Linux

DropBoo

ks

Downloading themes

Alarge number of themes is available on the Internet for both GNOME and
KDE. To find and grab these themes for your own use, follow these steps:

1.

Point your Web browser to http://themes.freshmeat.net.

You’re taken to the Themes Web site, where any number of GUI cus-
tomization items is offered.

. If the Section drop-down list box isn’t already selected, select it and

choose Themes.

You're taken to the Themes section of the site.

. For GNOME themes, click GTK; for KDE themes, click KDE.

This action brings you to the appropriate section, to ensure that you
choose themes that work with your system.

. For GNOME, select the GTK 2.X area; for KDE, select KDE 3.X.

Now you’re in the section for the latest versions of GNOME or KDE.

. Browse and choose the theme you want to try.

You can use the Sort Order drop-down list box to change the order in
which the items are displayed. Keep your eye out for the requirements
that go with the theme. Some themes require additional “engines” (soft-
ware that runs behind the scenes), and you want to avoid them if you're
uncomfortable with finding and adding software at this point. You're safe
if it mentions Metacity — that’s part of the Fedora Core GNOME GUI.

. After you have chosen your theme, click its name to go to the theme-

specific page.

There, you can find any comments someone has about the theme.

. Scroll down if necessary and click the link under Tar/GZ.

Your browser asks for specifics on where you want to place the file. If
you want to use this theme only for yourself, place it in your home direc-
tory or a subdirectory within your home. If you want to share the theme
with others, place it in a directory that everyone can reach — make one,
and set its permissions appropriately.

In the next two sections, I cover how to set this new theme as your current
theme.
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Figure 12-1:
The KDE
Control
Center with
the default
theme
selected.
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Setting your theme in KDE

D ro p B O Q(kn WQux distributions are installed with a collection of themes already
s

empbted. In Fedora Core (the distribution that comes with this book), you

can tour the available themes in KDE and select one by following these steps:

. Open the main menu.

In default GNOME and KDE setups, the Main Menu button in the lower-
left corner is a footprint in GNOME or a big K in KDE. If you installed Red
Hat Linux, the Main Menu button is the Red Hat fedora icon in both
GNOME and KDE.

The appropriate menu opens.
. Choose Control Center~>Appearance & Themes=>Theme Manager.

This action opens the KDE Control Center, shown in Figure 12-1. If you
didn’t download a theme because you want to use one of those already
included, skip to Step 7.

3. Choose Main Menu~>System Tools~> Terminal.

A command-line terminal window opens.

4. Use the cd command to go to the directory where you stored

the theme.

5. Type gunzip themefile to uncompress the theme.

This step leaves you with a file of the same name, with . tar at the end.

i@l Sywiem Administarion Theme
*-4 3 Web Erowsing
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6. Type tar xvf themefile to unpackage the theme.
This step brings you down to a single file with . ktheme at the end.
D ro p B O O A Sle Control Center, click Add.
The Add Theme dialog box appears.

8. Browse to the . ktheme file and select it, clicking OK to add it to the
Control Center’s menu.

If your theme is fully compatible with your version of KDE, the theme is
added to the list of choices.

9. Click the theme you want to sample.

Look in the Preview pane, toward the top of the window — not all
themes can be previewed. If the theme can be previewed, the Preview
pane’s contents change to represent what the various components of
your screen look like if you use this theme. Notice how the window
shown in Figure 12-2 is different from the window shown in Figure 12-1.

10. Continue previewing themes until you find one you like.
You're still not committing at this point, so don’t worry.

11. Click the Apply button to see how this theme looks when you apply it
to your desktop.

This process may take some time, depending on the speed of your com-
puter. The changes you see may be minor, or your desktop may look
incredibly different. If you want to go back, you need to click your pre-
ceding theme (Default if you never chose one) and click Apply again.

12. Click the X in the upper-right corner to close the Control Center.

Index | Seareh | Halp

-« Appearance & Themes

e

o
|
Figure 12-2:
The KDE
Control

Center with -
a different
theme
oo [ |

selected.

|« R [« ]||_ Defauts Apply Reset
I (el £%
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Setting your theme in GNOME

D ro p B O QK‘ WQux distributions are installed with a collection of themes already
s

ed. In Red Hat Linux (the distribution that comes with this book),

you can tour the available themes in GNOME and select one by following
these steps:

1. Click the Main Menu button.

The appropriate main menu opens.

2. Choose Preferences=>Theme.

This action opens the GNOME Theme Preferences dialog box, shown in
Figure 12-3.

. If you downloaded a theme, add it to the Theme Preferences dialog box.

Double-click your user’s Home directory icon on your desktop to open
the file manager, and then browse to where you stored the theme. Select
the theme file (yes, while it still has the .tar.gz extension) and drag it
into the left (Installer) pane of the Theme Preferences dialog box. If your
theme is fully compatible, the installer dialog box opens. Click Install,
and your new theme is added to the list of choices.

The Theme Preferences dialog box allows you to install the theme even
if it isn’t compatible with your GUI! This is bad since said theme doesn’t
work. Once you have added the theme, if it doesn’t show up in the
themes list in Step 4, the theme isn’t compatible.

Theme Preferences %]

i@ Install Theme...
xThemE Details
@iave Theme...

[#]

Bluecurve
Red Hat Linux default theme

N

Crux
Smooth gradients with teal highlights

= Grand Canyon

i Dusty orange appearance

High Contrast
. Black-on-white text and icons

[+

This theme does not suggest any particular font or background.




210 partin: Getting Up to Speed with Linux

4. If you installed a new theme, click Details to open the Theme Details
dialog box, click the theme you want to sample, and click Close to

D r O B O O K rn to the main dialog box.
p $u like this theme and want to keep it in your list, click Save Theme.

You’re asked to give the theme a name, and then it shows up in the
Theme Preferences dialog.

5. Click the theme you want to sample.

Your desktop items change to match the theme. What a handy way to
preview!

6. Continue previewing themes until you find one you like.

You're still not committing at this point, so don’t worry. You're not com-
mitted until you close the dialog box, and even then you can always
come back and change it later.

7. Click Close when you’re finished, and the Theme Preferences dialog
box closes.

Tweaking the GUI's Innards

Behind GNOME and KDE lurks the X Window System, or “X.” X provides the
skeletal GUI structure and functionality. GNOME and KDE make use of this
skeleton to provide you with a pleasant GUI environment. Whenever you con-
figure hardware or other basic GUI features like resolution, you actually work
with X, and not GNOME or KDE. In this section, I introduce you to the critical
components of X and point you to some useful X configuration tools.

The /etc/X11/XF86Conf1ig file contains your X configuration. Although this
file is just a normal text file, the format is complicated and confusing. Rather
than make you work with this file by hand, the various Linux distributions
provide a number of tools. The following table can help you identify which
tool or tools you can use to change your X configuration for a few different
Linux distributions:

Linux Distribution Tool

Red Hat Xconfigurator and redhat-config-xfree86
SuSE sax and sax?

Mandrake drakx

The X Window System searches for the XF86Conf1i g file in several places,
reading the first one it finds. The filename XF86Conf1ig-4 takes precedence
over XF86Config in the distributions where it occurs, so if you find both, go
with XF86Config-4.
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Additional X configuration tools come with every Linux distribution. They’re not
quite as easy to use as those just listed, but if you need them, here they are:

D ro p B O Ok&Setup: A popular, graphical X Window System setup tool. It uses a

simple GUI, so it can run on any VGA setup and has a useful graphical
interface for configuring X. Note that VGA is just an older graphics stan-
dard and has fewer capabilities than the SVGA cards that are common in
most personal computers today.

v xf86config: A text-based X configuration tool.

If you really enjoy experimenting with GUIs and fiddling with them, you can
do a number of things. Go to www. Tinuxdoc.org and read the various X
Window System and XFree86-related HOWTO files. Some are quite technical,
but some are a bit more friendly, and you may be surprised by just how much
you can tweak the Linux GUI You can also find www.gnome.org and

www . kde.org, and dozens of other useful sites out there.

A\
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In This Chapter

Viewing the contents of text files

Manipulating text files in vi
Manipulating text files in gedit

Fom text editors to word processors, Linux offers a wide variety of
options for working with words. In this chapter, I take a look at different
ways to view the contents of a text file, using some simple text editors in
both the non-GUI and GUI environments. In Chapter 14, I take a look at office
suites for those who would rather do word processing!

Viewing the Contents of a Text File

Almost all configuration files in Linux are text files. In addition, many pseudo-
programs (called shell scripts), all HTML documentation, and many other
items in your system are text files. Fortunately, if you just want to see what’s
in a text file and don’t want to do anything to its contents, you don’t have to
use an editor or word processor. You can use three commands to view text
files: cat, Tess, and more. [ would bet that you will grow to love them.

Yes, that first command is cat, and it’s taken from the word concatenate,
which means “to bring together end to end” — you can use the cat command
on multiple text files to have their text joined, one file’s contents directly after
another’s. Typically, you use this command in the Linux world in the format
cat filename, where the contents of the file 77 ]ename are displayed on the
screen. For example, if you create the short text file greetings and then type
cat greetings, you see the following:

$ cat greetings

These are the contents of the greetings file.
Meow!

$

Of course, if the file contains more than a screen’s worth of information, cat
spews it all out at one time like a big hairball, and all but the last screen of
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text scrolls off the screen. It’s a good thing that you have some other choices.
The one you're likely to choose is 1ess, which displays the contents of a file

Gfl&gen at a time. Then you press the spacebar to continue to the next

u can also use the arrow keys to move up and down one line at a
time, if you want.

An alternative to 1ess is more. The main difference between the two is that
with more, you can move only forward through the file, and see only a
screen’s worth of information at a time. You can’t back up.

To use either 1ess or more, the format is similar to the format used with the
cat command: less filename or more filename.

Getting Prehistoric with vi

A\

People tend to have a love-hate relationship with the vi editor. Some think of
vi as a wonderful, efficient, fast-moving tool (usually, those who know how to
use it); others find it cryptic and confusing. Whether you love it or hate it,
you can’t get around the fact that if something is wrong with your Linux com-
puter, vi may be the only editor you have access to. The entire program is
small enough to fit on a single floppy disk — a rare thing these days! I suggest
that you take the time to get familiar with vi and then try out other editors
and decide which one you like best.

Many text editors are available in the Linux world. You probably already have
vi, pico, emacs, and mcedit on your system, which you use from the com-
mand prompt. If you prefer the GUI, you can use gedit (GNOME default),
xedit, and kedit (KDE default). Each of these editors has a different set of
features and a different look and feel. Drastic differences exist among the var-
ious non-GUI editors.

Opening files

Because vi is a text-based text editor, opening a file is straightforward. You
just type vi filename (replacing filename with the name of the particular
file you want to see), and the file opens. If the file’s content already exists,
you can see it in the file. Otherwise, you get a blank screen, as shown in
Figure 13-1.

Looking for menus? You don’t see any. The vi editor has help information,
but no menus. Instead, it has modes. vi has three basic modes:
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Figure 13-1:
The initial vi
screen

ina KDE
terminal
window,
displaying
an empty
file.

v+ Command mode: vi assumes that everything you type is a vi command.

Insert mode: vi interprets everything you type in this mode as text that

gg in the file.

v ex mode: If you have ever used the old ex editor, you can use those old
ex commands in this mode. You can recognize ex commands in various
resources when you see something that starts with a colon (:).

If you have a file open in vi, you can get help information by pressing F1. To
close the help screen, type :q (that’s a colon and the letter ¢) and press Enter,
which takes you back to vi in Command mode.

Entering text

To type text in vi, you need to enter Insert mode. To enter Insert mode,
follow these steps:
1. Press Esc to enter Command mode from any mode you may now be in.

The layout of this screen should look similar to the one shown in
Figure 13-1.

2. Press i to enter Insert mode from Command mode.
Notice that the screen changes slightly from mode to mode, but it
mostly looks similar to the image shown in Figure 13-1.

From here, you simply type text until you're finished.

Session Edit View Bookmarks Settings Help

|y

"newfile" [New File] A1l B
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Editing text

D ro p B O Q!gﬁa number of ways you can edit text in the vi editor. You can do it

shioned way by entering Insert mode and manipulating the text by
using the Delete key, Insert key, and more from your keyboard. However, v i

does have some fancier options available. To use any of these options, follow

these steps:

1. Press Esc to enter Command mode from any mode you may now be in.

The layout of this screen looks familiar (refer to Figure 13-1).

2. Use the arrow keys to properly position the cursor for the option

to work.
WMBER
@Y—
&

Table 13-1 explains proper cursor positioning.

3. Press the key or sequence of keys that tells vi what you want to do.

Table 13-1 shows one group of commands you may want to use.

Table 13-1

Commonly Used vi Editing Commands

Keystroke(s)

Initial Cursor Position

Result

A

One space before the place
you want to add

vi enters Insert mode directly after
text the cursor’s position.

Directly where you want
the text to appear

vi places in the document a copy
of the previously copied text.

#0

Anywhere directly above
where you want the new
line to appear

vi adds a blank line or lines below
the cursor’s position and then enters
Insert mode with the cursor within
that blank line.

#r_

Directly on top of the
(first) character you want
to replace

vi replaces the current character
if it's just used as r_ (where _ is the
character to replace the item with)
or replaces # of characters, includ-
ing the current one, with _.

#l

Directly on top of the (first)
character you want to copy

vi copies the specified characters
into the buffer.

#yy

Anywhere within the (first)
line you want to copy

vi copies the specified lines(s) into
the buffer.

Anywhere in the file

vi undoes what you last did.
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P The number sign (#) indicates the optional ability to include a number so
that the command works on more than one line, word, or character. If you

D ¥ igslude a number, vi assumes a 1. Whenever you see an underscore

ro G need to specify a character for the command to work on. For an
example, to replace the current character and the next five after it with
dashes, you would type 5r-.

Keep in mind that when an option puts you into Insert mode, you need to
return to Command mode before you can use editing commands again.

Deleting text

The vi editor has a large collection of commands that are useful for deleting
text. You can use the Backspace or Delete keys, of course, but many other
options are available too. To use the vi deletion features, follow these steps:

1. Press Esc to enter Command mode from any mode you may now be in.

The layout of this screen looks similar to the one shown earlier, in
Figure 13-1.

2. Use the arrow keys to properly position the cursor for the option
to work.

See Table 13-2 for an explanation of proper cursor positioning.
3. Press the key or sequence of keys that executes what you want to do.

Table 13-2 shows some commands you may want to use.

Table 13-2 Commonly Used vi Deletion Commands

Keystroke(s) Initial Cursor Position

#dd Anywhere within the (first) line you want to delete

#dw Anywhere within the (first) word you want to delete

p Anywhere within the line on which you want to paste in the lines
that you “yanked” with #y

#x Directly on top of the (first) character you want to delete

#y Anywhere within the line on which you want to “yank” (copy) the

specified number of lines into the vi “clipboard” (called a buffer),
and then delete them (where # is the same number both times)

\\J
A # indicates that if you include a number, the command works on more than
one item.
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Don’t forget that when an option puts you into Insert mode, you need to
return to Command mode before you can use deletion commands again.

oks
Saving files

Just about every text and document editor has at least two different ways of
saving a file. The first way involves saving and closing the document. In vi,
you save and close the document by following these steps:

1. Press Esc to enter Command mode from any mode you may now be in.

The layout of this screen looks similar to the screen shown earlier, in
Figure 13-1.

2. Type ZZ to save and close the file.
The file closes, and you return to the command prompt.
The second method of saving a file involves saving without closing. To save a
file and keep working on it in vi, follow these steps:
1. Press Esc to enter Command mode from any mode you may now be in.

The layout of this screen looks similar to the one shown earlier, in
Figure 13-1.

2. Type : (a colon) to enter Ex mode.
The bottom of the screen changes slightly, looking similar to Figure 13-1.
3. Press w and then Enter.

The w stands for write (or save). You're now back in the file in
Command mode.

\\3

Do you want to close the file without saving changes? In the preceding steps,
follow the first two steps, and when you get to Step 3, type q! rather than w.

Going with gedit

You're not stuck with just command-prompt-based text editors in Linux. Lots
of graphical options are available. In this section, I cover gedit because it is
the default GUI text editor for Fedora Core 1.

\\3
Remember that if you don’t automatically boot into the GUI, you can enter it
at any time from the command prompt by typing startx.
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Starting gedit

D ro p B O @Kigedi t from within GNOME, follow these steps:

1. Click the Main Menu button.

“&N\BER In default GNOME and KDE setups, the Main Menu button in the lower-
& left corner is a footprint in GNOME or a big K in KDE. If you installed
Fedora Core 1, the Main Menu button is the Red Hat fedora icon in both
GNOME and KDE.

2. Choose Accessoriesc>Text Editor.

The program opens, as shown in Figure 13-2.

B3 untitled 1 - gedit

Fle Edit View Search Tools Documents Help

BE.LU6 % e >2D0D 08 %

© New Open Save Print Undo Redo Cut Copy Paste Find Replace

" Untitled 1 %

|
Figure 13-2:
The gedit
window is
open, with a
blank file.
e L

Ln1, Col. 1 INS _/I

Entering and editing text

gedit is strictly a text editor, in that you use it to generate raw text, whereas
a word processor creates marked-up text that can be opened only by pro-
grams that can read that word processor’s file formatting. If you want to add
bold, italics, underlines, or any other special features to your gedit docu-
ment, you want to read the next chapter.

To enter text in gedit, just click within the big white space and start typing.
You have access to the standard collection of editing tools, such as cut,
paste, and copy. Select the text you want to work with, and then click the
appropriate button on the gedit toolbar.
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The really interesting thing about this particular text editor is its plug-ins. To
enable this feature, you need to follow these steps:

DropBO0KS: sarectrencesnsecr.

This action opens the Preferences dialog box.
2. Locate the Plug-Ins section in the left panel.
Plug-Ins is the last entry.
3. Click the Manager item under Plug-Ins.
The Plug-Ins portion of the dialog box opens.

4. Click each item in the Plug-Ins list box and read its descriptions in the
section underneath it.

5. Click in the check box for each plug-in you want to use.
The plug-in is activated if a check is in the check box.

6. If the Configure Plug-In button becomes active for a plug-in you have
selected, click the button to open the tool’s plug-in configuration
dialog box.

This dialog will be different depending on which plug-in you are using.

7. When you’re finished with each individual plug-in configuration, click
OK to return to the Preferences dialog box.

8. When you're finished selecting plug-ins, click Close to close the
Preferences dialog box.

You can now access the plug-ins from your gedit menus. Each one is placed
in its appropriate location: for example, ASCII Table on the View menu.

Saving your work

As with most programs, you have two choices for saving your work. You can
save your work and keep going or save it and then close the program. To just
save the file and keep going, follow these steps:

1. Click the Save button.

This button looks like a floppy disk. If you haven’t ever saved this file,
clicking it opens the Save As dialog box.

2. Browse through the directories in the left pane until you’re in the
directory where you want to save the file.

Double-click the name of a directory to enter it, or click the . . in the left
pane’s listing to move up a level in the directory tree.
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3. Type the file’s name in the Selection text box.
. Click OK to save the file.

D ro p B O O dialog box closes.

To close gedi t, follow these steps:

1. Choose File=>Quit.

If you haven’t saved this file since the last time you changed it, the
Question dialog box appears.

2. If you see the dialog box, click Save to save your work or click Don’t
Save to abandon it.

The program closes, unless you have more than one file open, in which
case you see the Question dialog box for each file you have altered but
not saved.
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Chapter 14

DmpBOWé?d Processing and More
with OpenOffice.org

In This Chapter
Installing the OpenOffice.org suite
Word processing with OpenOffice.org Writer
“Spreadsheeting” with OpenOffice.org Calc
Presenting with OpenOffice.org Impress
Drawing with OpenOffice.org Draw
Formulating with OpenOffice.org Math

Words fly, writing remains.

— Spanish proverb, from Dictionary of Proverbs, by Delfin Carbonell Basset

Flese days, just about everyone who has a computer has at least one office
suite at their fingertips. If they’re Microsoft Windows users, this suite is
probably Microsoft Office, although it may be another worthy contender, such
as Corel WordPerfect Office. Undoubtedly, everyone has told you that the
biggest problem with Linux is a lack of software: “It has no good office suites,”
for example.

[ have good news for you. They’re wrong. A number of office suites are avail-
able (see the “Tip” below) but what I cover here is the one that has gobbled
up market share like nobody’s business: OpenOffice.org. This suite comes with
Calc (a spreadsheet), Draw (diagrams and figures), Impress (for presentations),
Math (a word processor for writing mathematical formulas), and Writer (for
word processing).

After you figure out how to use one of the programs in this suite, you may be
happy to find that the others are designed in the same fashion. Menus and fea-
tures work across each of the programs. You can even save files in Microsoft
Office format, if you need to share them with people using it — and you can
edit the ones people send you too.
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That’s enough about OpenOffice.org. Let’s actually use it!

ice suites available for Linux users are the OpenOffice.org relative
D ro p (www.sun.com/staroffice), Anywhere Office (www.vista
source com/products), KOffice (www.koffice.org), and GNOME Office
(http://www.gnome.org/gnome-office/).

Installing OpenOffice.Org

Many distributions install this office suite by default, but that doesn’t mean
that it’s already on your system. Before you start the huge download unnec-
essarily, see whether you already have OpenOffice.org installed:

v In Fedora Core 1: Look at your Panel. If the OpenOffice.org Writer,
Impress, and Calc icons discussed in Chapter 6 are not there, you don’t
have OpenOffice.org installed.

+ In Mandrake Linux 9.2: Choose Main Menu=Officem>Wordprocessors
and see whether any OpenOffice.org items are listed. If not, you don’t
have it installed.

v In SuSE Linux Professional 9.0: Choose Main Menu=Office and see
whether Office Suite is listed. If not, OpenOffice.org isn’t installed.

If you don’t have OpenOffice.org installed, you can do so by using your distri-
bution’s package-management tools (see Chapter 17). If you can’t stand the
thought of not having the latest version, you can first start up any of the
OpenOffice.org applications (OpenOffice.org Writer, for example) and choose
Help=>About OpenOffice.org to see which version you have. Then, point your
Web browser to www.openoffice.org. The latest version is mentioned on
the front page. If this version isn’t what you have and you want the latest one,
read the following section to find out how to proceed.

Getting the software

To acquire OpenOffice.org from the Web, follow these steps:

1. Open your favorite Web browser.
The default browser in Fedora Core is Mozilla.
2. Go to the URL www.openoffice.org.
It’s the home page for the OpenOffice.org project.
3. Click Downloads to open the OpenOffice.org downloads page.

Note that this Web site changes frequently, so don’t be surprised if its
organization has changed since the time I wrote this section.
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4.

DropBooks:

Click the Software and Information link to jump to the New Software
Items section.

the OpenOffice.org version selection.

This action takes you to the OpenOffice.org version Download Sites
section.

6. Locate the subsection labeled The Application.

7. Click Linux.

10.

This action opens the location selector. (Did you notice that you can get
this office suite for other operating systems too? — even Windows!)

. Look within the table for your particular country.

The Linux section is the center column.

. Click one of the download server choices offered for your country or

the nearest country.

If you have problems with this server, try another one within your coun-
try or a nearby country. Try to stay at least on the same continent.

When the Downloading dialog box opens, select where you want the
file to go and then click Save.

[ typically create in my home directory a directory named Downloads
and put all my new software in there. After you click Save, the Download
Manager dialog box opens. It tells you how much of the file you have
downloaded, how much more you have to go, and how long this down-
load should take. OpenOffice.org is a huge file. Even if you’re on broad-
band, it takes more than ten minutes to download. In the meantime, feel
free to browse elsewhere on the Web or read further into this book.

After the download is complete, proceed to the following section.

Installing the software

After you have OpenOffice.org downloaded, you need to unpack the software
and run the automated installation program, as outlined in the following steps:

1.

Open the File Roller program.

Choose Main Menu=Accessories=File Roller.

. Click Open Archive, and then browse to the directory containing the

software you just downloaded.

The Open Archive dialog box opens. Browse as you would in any other
GUI file manager.

. Select the file you want to uncompress, and then click OK to access

the package’s contents.
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DropBooks

4.

10.

11.
12.

13.

14.

For example, if the file’s name is
000_1.0.3_LinuxIntel_install.tar.gz, click that file.

Open Archive dialog box closes, and you can now see what'’s inside.

Click Extract, and then browse to the directory where you want to
unpack the contents.

The Extract dialog box opens.

. Click OK to extract the file’s contents.

Because this package is so large, the decompression may take a few
minutes.

. Close File Roller.

Click the X in the upper-right corner of the window.

. Open the Run Program dialog box and choose Main Menu=>Run

Program.

The Run Program dialog box appears.

. Click Append File, and then browse to the directory containing what

was in the downloaded file.

The Choose a File dialog box appears. If you downloaded the file to the
Downloads directory, browse to that location; otherwise, browse to where
you extracted the file. Then, browse within the extracted directory to the
install subdirectory, which was created when you unpacked the file.

. Select Setup and then click OK.

The Choose a File dialog box closes.

Check the Run in Terminal check box in the Run Program dialog box,
and then click Run to begin the installation.

After a moment, a terminal window opens, showing you what the installer
is doing. A progress dialog box also appears. After the setup program
finishes loading, you see the OpenOffice.org installation program initial
screen.

Click Next to proceed to information about OpenOffice.org.

After you have read this information, click Next to proceed to the
license agreement.

After you have read the agreement, click Accept to proceed to the
Enter User Data dialog box.

You can enter as much or as little information as you want.

After you have finished filling out the form to your satisfaction, click
Next to proceed to the Select Installation Type dialog box.
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15.
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16.

17.

18.

19.

Select Standard Installation and click Next to proceed to the Select
Installation Directory dialog box.

can, of course, choose another installation type, if you’d want like.
overing the Standard installation herein these steps.

Change the directory in the Installation Directory text box (or by
browsing), if you want.

Click Next to be asked whether you want to create the new directory.
Then click Yes to create the directory.

This action opens the Start Copying dialog box.
Click Install to begin putting all the proper files into place.

You may get asked about Java and JavaScript. If you're not sure what
they are or whether you want them, just leave them as unsupported. If
you know that you have them, use the Browse button to select them and
then click OK to proceed. Then, the installation starts.

When the Installation Completed dialog box appears, click Complete.

That’s it for the installation!

Word Processing with
OpenOffice.Org Writer

Word processors are almost required equipment these days. Kids use them
to write letters to their grandparents. Grandparents use them to write letters
to their grandkids. Whether you’re working on the great American novel or a
school book report, OpenOffice.org Writer has all the best features you find
in the other word processing packages you have used in the past.

Starting it up

To start OpenOffice.org Calc in the distributions [ cover in this chapter, do
the following:

v In Fedora Core 1: Choose Main Menu=Officem>OpenOffice.org Writer.

Or, you can click the OpenOffice.org Writer button on your panel.

v+ In Mandrake Linux 9.2: Choose Main Menu=>Officer>Wordprocessor=>

OpenOffice.org Writer.

v In SuSE Linux 9.0: Choose Main Menu Officer>Word processor.
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When you first open OpenOffice.org Writer, you see the Address Data Source
AutoPilot dialog box. Click Cancel for now. A Paragraph Styles (choose

© Stylelist) dialog box opens too. Click the X in the upper-right corner
D ro p B O @ his box. You then see, at some point as you're taking these tours, a
Registration dialog box. You now have the option of registering your software.
Select the option that suits you and your mood — after all, perhaps you do
plan to register but would rather not do so right at this very moment.

After you have closed the dialog boxes, you have a clean screen to work with
while getting used to the program.

Taking a tour of OpenOffice.org Writer

Before you proceed, take a look at the GUI layout shown in Figure 14-1.

v] Untitled1 - OpenOffice.org 1.1.0
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Main toolbar

Along the left side of the window is the main toolbar. Each icon in this series
represents a different functionality. If a button is extensible (it has a little green
arrow on it), you can click to open a tiny dialog box containing the options
therein. Each icon is described in Table 14-1; for an example of what you see
when you click and hold the mouse button down over an extensible button,

see Figure 14-2. If you determine that you want to remove this toolbar, choose
View=>Toolbars>Main Toolbar.
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You can close the small dialog by clicking the X in its upper right corner.

oks

File Edit View Inset Format Tools Window Help X

Table 14-1 The OpenOffice.org Writer Main Toolbar,

from Top to Bottom

Button What You Can Do Extensible?

Insert Place an element (a table, another document, or ~ Yes
a picture, for example) at the cursor’s current
location.

Insert Fields Place a text element (current date, subject, or Yes
author’s name, for example) at the cursor's
current location.

Insert Objects Place an object (a chart, a mathematical formula, Yes
or an applet, for example) at the cursor’s current
location.

Show Draw Access the many OpenOffice.org drawing utilities.  Yes

Functions

Form Build forms with their respective special features  Yes

(text boxes, radio buttons, and more) .

(continued)
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Table 14-1 (continued)

I ) r O p B O O g What You Can Do Extensible?
it AutoText Adjust the various settings for commonly used Yes

phrases to recall at the click of a button.

Direct Cursor Add or remove special functionality that automat-  No

On/Off ically formats text and objects according to
where you click on the page (clicking in the
middle centers the item, for example).

Spellcheck Run the spell checker on your entire document No
or the selected text

AutoSpellcheck  Activate or turn off the automatic spell checker No

On/Off feature.

Find On/Off Open or close the Find and Replace dialog box. No

Data Sources Open or close the Data Sources dialog box, which  No
lets you access databases previously specified by
using the dialog box accessed through Tools=>
Data Sources.

Nonprinting Show all spaces, returns at the ends of para- No

Characters graphs, and other characters that you don't

On/Off normally see in your documents.

Graphics On/Off  Show embedded images, or just show place- No
holders so that you can see where they are
without seeing the images.

Online Layout Tell OpenOffice.org Writer to show your docu- No

ment as a Web page.

Menu bar

Along the top of the window is the Menu bar, something you should be used
to if you typically work in Microsoft Windows. OpenOffice.org Writer has all

the features you would expect from a modern word processor. It has too many

menu options to cover in depth, so I give you instead a (nonexhaustive) sum-
mary of what you find on each major menu:

v~ File: The usual Open, Save, Save As, Print, and Print Preview commands,
along with a set of wizards (under the term AutoPilot) plus the ability to
send documents through e-mail, create templates, and create Web pages

v Edit: The usual Select All and Find commands, along with change tracking,
document merging, and document comparing
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v View: The usual Zoom functions and toolbars, along with the abilities to
show or hide formatting characters, to see what the document would look
D r O B O OKiSas a Web page, and to access your database information
p rt: The usual page breaks and special characters, along with indexes,
tables, bookmarks, headers, footers, and cross-references

v Format: The usual character, paragraph, and page settings, along with
styles, autoformatting capabilities, and columns

v Tools: The usual spell-checking and thesaurus entries, in addition to
hyphenation, autocorrection, an image gallery, and a bibliography
database

These menus have more features than what is listed here. Go through and
take a look; you may find a new favorite feature in there somewhere.

Function bar

Directly below the menu bar in a default setup is the Function bar, which you
can remove at any time by using the View menu. This series of icons allows you
single-click access to the most commonly used File and Edit features, among
others. Table 14-2 lays out, from left to right, what you find on the default
Function bar. The extensible items can all be expanded to show a further set

of options.
Table 14-2 The OpenOffice.org Writer Function Bar,
from Left to Right
Button or Item What You Can Do Extensible?

URL Entry drop-  After you type a full URL, including the opening No
down list box http://, openanew window with the Web
page’s contents displayed.

Stop Loading Tell OpenOffice.org to stop attempting to load the  No
specified Web page.
Edit File Edit the displayed Web page. No
New Open new documents of various types. Yes
Open File Open an existing file for reading or editing. No
Save Document  Save the current document. If you have not No
saved this document before, the Save As dialog
will open.

Export Directly Opens a Save As dialog with PDF selected as No
as PDF the file type.

(continued)
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Table 14-2 (continued)
O @or Item What You Can Do Extensible?
rintFile Directly  Send a file to the default printer. No

Cut Remove the selected text from the document No
and save it in memory.

Copy Make a copy of the selected documenttextand  No
save it in memory.

Paste Place the text from memory into the document No
atthe cursor's current location.

Undo Undo the last change you made to the document.  Yes

Redo Undo the last undone change to the document.  Yes

Navigator On/Off  Open or close the Navigator window, which No
allows you to jump to specific features within
your document.

Stylist On/Off Open or close the Paragraph Styles window, No
which allows you to select the particular style
to apply to selected text.

Hyperlink Dialog ~ Open or close a dialog box that you can use to No
build complex hyperlinks.

Gallery Open or close a dialog box that provides access No
to divider bars, bullet types, and more.

Object bar

The Object bar is directly below the Function bar in a default OpenOffice.org

setup. As usual, you can remove the Object bar at any time by using the View
menu. This series of icons allows you to click buttons and expand drop-down

list boxes that represent standard word processor functions, such as styles,
fonts, font sizes, and formatting instructions. Most features on this bar are
identical to what you see in most modern word processors. The button for
paragraph background formatting is the only one that’s particularly unusual.

This toolbar actually changes depending on what you're doing. If your cursor

is within a table, for example, then the Object bar contains useful buttons for
working with tables.
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Ruler
'Rtly below the Object bar in a default OpenOffice.org setup is the ruler.
S:

Di
D ro B O @ n word processors offer this item, which marks out the margins and
example, of your document in the measuring system of your choice.
To change which system you want to use, right-click the ruler to open the
Measurements pop-up dialog box.

VYour document

Oh, yeah — that big, blocked-off white space takes up most of the window.
That’s where you work on your documents! Just click in there and start typing.
You can also access a Formatting pop-up menu by right-clicking in the docu-
ment section.

OpenOffice.org Writer supports the following file formats (and more): its own
“text” format (.SXW), Microsoft Word 95, 6.0, 97, 2000, and XP (.DOC), Rich Text
Format (.RTF), Text (.TXT), and Web Page (HTML).

Spreadsheets with OpenOffice.Org Calc

Some people like to balance their checkbooks by hand. When I first graduated
from a university, I decided that it was time to get hold of my finances, and a
spreadsheet was the way to do it. These days, [ use spreadsheets to keep track
of my “time card” when I'm doing consulting or contract work, to help me
manage project teams and other tasks. I'm sure that you have your favorite
uses for spreadsheets. Let’s take a look at OpenOffice.org Calc so that you
can get to work.

Starting it up

To start OpenOffice.org Calc in the distributions I cover in this chapter, do
the following:

v+ In Fedora Core 1: Choose Main Menu>Officer>OpenOffice.org Calc.
Or, you can click the OpenOffice.org Calc button in the lower panel.

v In Mandrake Linux 9.2: Choose Main Menu= Officer>Spreadsheetsw>
OpenOffice.org Calc.

v In SuSE Linux 9.0: Choose Main Menuw Officer>Spreadsheet.
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Taking a tour of OpenOffice.org Calc

D ro p B O Q what you see here should look familiar, between looking through
e

|
Figure 14-3:
The
OpenOffice.
org Calc
layout.
|

ce.org Writer and other spreadsheet programs you have used. Take
a look at the GUI layout shown in Figure 14-3.

[l el =]

~
3|5

|
=

~

5

|
i

rn

|
&

{
5,

] |ri]Sheetl
Default 100% STD Sum=0

()
=
o
o
i
s

Main toolbar

Along the left side of the window is the main toolbar, which you can remove at
any time by choosing View=>Toolbars=>Main Toolbar. Each icon in this series
represents a different functionality. If a button is extensible (it has a little green
arrow on it), you can click and hold the mouse button on it to see the options
contained within. Each icon is described in Table 14-3.

Table 14-3 The OpenOffice.org Calc Main Toolbar,
from Top to Bottom
Button What You Can Do Extensible?
Insert Place an element (a table, another document, or  Yes
a picture, for example) at the cursor’s current
location.
Insert Cells Place a cell (or column or row) at the cursor’s Yes

current location.
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Button What You Can Do Extensible?
D ro B O O k bject Place an object (a chart, a mathematical formula, Yes

or an applet, for example) at the cursor’s current
location.

Show Draw Access the many OpenOffice.org drawing Yes

Functions utilities.

Show Form Build forms with their respective special fea- Yes

Functions tures (text boxes, radio buttons, and more).

AutoFormat Quickly format a collection of cells in one of a No
variety of ways.

Choose Themes  Quickly assign a color-coordinated look to a No
sheet.

Spellcheck Run the spell checker on your entire document No
or the selected text.

AutoSpellcheck  Activate or turn off the automatic spell check No

On/Off feature.

Find On/Off Open or close the Find and Replace dialog box. No

Data Sources Open or close the Data Sources dialog box, No

which brings up the same dialog box as the
Toolsc>Data Sources menu selections.

AutoFilter On/Off  Quickly sort a selected set of cells in a variety . No
of ways

Sort Ascending  Quickly sort a selected set of cells from ascend-  No
ing to descending order.

Sort Descending Quickly sort a selected set of cells from descend-  No
ing to ascending order.

Insert Group Select a set of rows or columns that you can No
compress or expand when needed.
Ungroup Remove the group settings. No
Menu bar

Along the top of the window is the Menu bar, a standard in the GUI world no
matter which operating system you’re using. OpenOffice.org Calc has all the
features you would expect from a modern spreadsheet system. It has too
many menu options to cover in depth, so, instead, here’s a (nonexhaustive)
summary of what you find on each menu:
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v File: The usual Open, Save, Save As, Print, and Print Preview commands,
along with a set of wizards (under the term AutoPilot) plus the ability to
D r O B O OKS documents through e-mail, create templates, and create Web pages
p #: The usual Select All and Find commands, along with change tracking,
headers and footers, and plug-in loading
v View: The usual Zoom functions and toolbars, along with the abilities

to show or hide column and row headers and to access your database
information

v Insert: The usual page breaks and special characters, along with cells,
rows, functions, and external data

1 Format: The usual cell and row formatting, cell merging, and page set-
tings, along with conditional formatting

v Tools: The usual spell-checking and thesaurus entries, in addition to
hyphenation, autocorrection features, an image gallery, and a bibliogra-
phy database

v Data: The usual data selection, sorting, and grouping routines in one easy
place for quick access

These menus have more features than what is listed here. Go through and take
a look; you may find a new favorite feature in there somewhere.

Function bar

Directly below the Menu bar in a default setup is the Function bar, which you
can remove at any time by using the View menu. This series of icons allows
you single-click access to the most commonly used File and Edit features,
among others. Table 14-4 lays out, from left to right, what you find on the
default Function bar. The extensible items can all be expanded to show a fur-
ther set of options.

Table 14-4 The OpenOffice.org Calc Function Bar, from Left to Right

Button or Item What You Can Do Extensible?

URL Entry drop-  After you type a full URL, including the opening No
down list box http://, open anew window with the Web
page’s contents displayed.

Stop Loading Tell OpenOffice.org to stop attempting to load No
the specified Web page.

Edit File Edit the displayed Web page. No

New Open new documents of various types. Yes

Open File Open an existing file for reading or editing. No
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Button or Item What You Can Do Extensible?
D ro B O O k/gocument Save the current document, either with Save As  No

if you have never saved it or to save over the last
saved version if you have.

Export Directly Open a Save As dialog with PDF selected asthe  No

as PDF file type.

Print File Directly ~ Send the file to the default printer. No

Cut Remove the selected text out of the document No
and save itin memory.

Copy Make a copy of the selected document textand  No
save it in memory.

Paste Place the text from memory into the document No
atthe cursor's current location.

Undo Undo the last change you made to the document.  Yes

Redo Undo the last undone change to the document.  Yes

Navigator On/Off  Open or close the Navigator window, which No
allows you to jump to specific features within
your document.

Stylist On/Off Open or close the Paragraph styles window, No

which allows you to select the particular style to
apply to selected text.

Hyperlink Dialog ~ Open or close a dialog box you can use to build  No

complex hyperlinks.

Gallery Open or close a dialog box, which provides No

access to divider bars, bullet types, and more.

Object bar

The Object bar is directly below the Function bar in a default OpenOffice.org
setup. As usual, you can remove the Object bar at any time by using the View
menu. This series of icons allows you to click buttons and expand drop-down
list boxes that represent standard spreadsheet functions, such as styles, fonts,
font sizes, and number formatting instructions. Most features on this bar are
identical to what you see in most modern spreadsheets.

Formula bar

Directly below the Object bar in a default OpenOffice.org Calc setup is the
Formula bar. All modern spreadsheets offer this item, which allows you to
enter and edit cell values and contains a few often-used features, such as a
single-click Sum button.
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VYour document
Hepe’s where you work on your spreadsheet! Just pick a cell and start typing.
D ro p B O % Iso access a Formatting pop-up menu by right-clicking in the docu-
n tion.

OpenOffice.org Calc supports the following file formats (and more): its own
spreadsheet format (.SXC); Data Interchange Format (.DIF); dBASE (.DBF);
Microsoft Excel 95, 5.0, 97, 2000, and XP (.DOC); text-based comma-separated
values (.CSV), and Web Page (HTML).

Presentations with OpenOffice.Org
Impress

Most people would rather eat glass than speak in front of a group of people.
Still, if you have to, you may as well have some cool presentation software
to back you up. This program is what I use when I speak at conferences. (I
use it even when my clients want me to send in my presentation in Microsoft
PowerPoint format. Shh! Don’t tell — they don’t know the difference!) Give
OpenOffice.org Impress a chance to impress you.

Starting it up

To start OpenOffice.org Impress in the distributions I cover in this chapter,
do the following:

v In Fedora Core 1, select: Choose Main Menu= Office>OpenOffice.org
Impress. Or, you can click the OpenOffice.org Impress button on your
lower panel.

1+ In Mandrake Linux 9.2, go to: Choose Main Menu=>Officer>Presentations=>
OpenOffice.org Impress.

v+ In SuSE Linux 9.0, go to: Choose Main Menu=Officer>Presentation.

Taking a tour of OpenOffice.org Impress

Before you proceed, take a look at the GUI layout shown in Figure 14-4. The
little Presentation dialog box may look like clutter to some, but [ personally
find it helpful as I'm creating and editing presentations. If you don’t need it,
just click the X in the upper-right corner of the dialog box. You can bring it

back at any time through View=>Toolbars=>Presentation.
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Along the left side of the window is the main toolbar, which you can remove
at any time by choosing Viewr>Toolbars=>Main Toolbar. Each icon in this series
represents a different functionality. If a button is extensible (has a little green
arrow on it), you can click and hold the mouse button on it to see the options
contained within. Each icon is described in Table 14-5. As you can see, this
main toolbar is significantly different from the other OpenOffice.org programs.

Table 14-5 The OpenOffice.org Impress Main Toolbar,
from Top to Bottom

Button What You Can Do Extensible?

Select Set the mouse pointer to select a particular No
element or section of a slide.

Zoom Use a set of options that let you zoom in and out ~ Yes
on the slide.

Text Use a variety of methods for enteringtextona  Yes
slide.

Rectangle Easily draw various forms of rectangles. Yes

Ellipse Easily draw various forms of ellipses. Yes

3D Objects Easily draw spheres, cubes, and more. Yes

(continued)
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Table 14-5 (continued)

D ro p B O G‘% What You Can Do Extensible?
urves

Easily draw curvy lines and even freeform. Yes

Lines and Arrows  Use a selection of connector lines and arrows.  Yes

Connector Use another set of connector symbols and lines.  Yes

Rotate Rotate a selected object on a specific axis. No

Alignment Shift the selected object to a specific alignment  Yes
on the page.

Arrange Move objects higher or lower in the stack. Yes

Insert Insert items, such as graphs. Yes

Effects Open the Special Effects dialog box. Yes

Interaction Set what should happen when you click with No
your mouse.

3D Controller Open the 3D Effects dialog box. No

Slide Show Begin a slide show with the existing slides. No

Menu bar

Along the top of the window is the Menu bar, a standard in the GUI world no
matter which operating system you’re using. OpenOffice.org Impress has all
the features you would expect from a modern presentation package. It has
too many menu options to cover in depth, so I give you instead a (nonexhaus-
tive) summary of what you find on each menu:

v File: The usual Open, Save, Save As, Print, and Print Preview commands,
along with a set of wizards (under the term AutoPilot) plus the ability to
send documents through e-mail and create templates

v Edit: The usual Select All and Find commands, along with the ability to
quickly duplicate a slide

v View: The usual Zoom functions and toolbars, along with the ability to
select whether you're looking at just slides, notes, or another section

v Insert: The usual new slide, along with charts, frames, graphics, and
spreadsheets

v Format: The usual text formatting features, along with layout, graphics,
and style formatting

v Tools: The usual spell-checking feature, in addition to hyphenation,
autocorrection, an image gallery, and a bibliography database
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These menus have more features than what is listed here. Go through and take
a look; you may find a new favorite feature in there somewhere.

DropBooks..

Directly below the Menu bar in a default setup is the Function bar, which you
can remove at any time by using the View menu. This series of icons allows
you single-click access to the most commonly used File and Edit features,
among others. Table 14-6 lays out, from left to right, what you find on the
default Function bar. The extensible items can all be expanded to show a
further set of options.

Table 14-6 The OpenOffice.org Writer Function Bar,
from Left to Right
Button or Item What You Can Do Extensible?
URL Entry drop-  After you type a full URL, including the opening No
down list box http://, open a new window with the Web
page’s contents displayed.
Stop Loading Tell OpenOffice.org to stop attempting to loadthe ~ No
specified Web page.
Edit File Edit the displayed Web page. No
New Open new documents of various types. Yes
Open File Open an existing file for reading or editing. No
Save Document  Save the current document, either with Save As  No
if you have never saved it or to save over the last
saved version if you have.
Edit File Set file as read-only or read-write. No
Export Directly Open a Save As dialog with the PDF file format No
as PDF selected.
Print File Directly ~ Send the file to the default printer. No
Cut Remove the selected text from the document No
and save itin memory.
Copy Make a copy of the selected documenttextand  No
save itin memory.
Paste Place the text from memory into the document No
atthe cursor's current location.
Undo Undo the last change you made to the document. ~ Yes

(continued)
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Table 14-6 (continued)

D ro p B O G_%or Item What You Can Do Extensible?
edo

Undo the last undone change to the document. Yes

Navigator On/Off ~ Open or close the Navigator window, which No
allows you to jump to specific features within
your document.

Stylist On/Off Open or close the Paragraph styles window, No
which allows you to select the particular style to
apply to selected text.

Hyperlink Dialog  Open or close a dialog box you can use to build ~ No
complex hyperlinks.

Gallery Open or close a dialog box, which provides No
access to divider bars, bullet types, and more.

Object bar

The Object bar is directly below the Function bar in a default OpenOffice.org
setup. As usual, you can remove the Object bar at any time by using the View
menu. This series of icons allows you to click buttons and expand drop-down
list boxes that represent standard presentation-software functions, such as
arrow styles, colors, line styles, and other formatting instructions. Most fea-
tures on this bar are identical to what you see in most modern presentation
programs.

Ruler

Directly below the Object bar in a default OpenOffice.org setup is the ruler.
This item marks out the margins and tabs, for example, of your document in
the measuring system of your choice. To change which system you want to
use, right-click the ruler to open the Measurements pop-up dialog box.

Your document

Oh, yeah — that big white space takes up most of the window. That’s where
you work on your slides! Just click in there and start typing. You can also
access a formatting pop-up menu by right-clicking in the document section.

OpenOffice.org Impress supports the following file formats (and more): its own
presentation format (.SXI), and Microsoft PowerPoint 97, 2000, and XP (.DOC).
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Using the Autolilot Presentation wizard

D ro p B O Qk(isussion of OpenOffice.org Impress gives me a good chance to introduce
0

e>AutoPilot. When working on any document in OpenOffice.org, you
can open this menu and select any of the options available — from Business
Cards to Presentation. In this case, select the latter to open the AutoPilot
Presentation dialog box shown in Figure 14-5.

(R AutoPilot Presentation

Type
& Empty presentation

 From template
I = QOpen existing presentation

Figure 14-5:
The Open-
Office.org
AutoPilot ¥ Preview
Presenta- [~ Do not show this dialog again
tion wizard. -
|

Help Cancel Back Create

To use this wizard, follow these steps:
1. Leave the Empty Presentation option selected (unless you have a
template you need to work from) and click Next.
The Select a Slide Design dialog box appears.

2. If you want your presentation ultimately to appear on something other
than a computer screen, adjust the Select an Output option to its
Medium setting.

Your choices are Screen, Overhead Sheet, Slide, and Paper.
3. After you have made your selection, click Next to continue.
The Slide Transition and Presentation Type dialog box appears.
4. Use the Effect drop-down list box to try the various transitions.

OpenOffice.org Impress animates these transitions for you as long as
the Preview box is checked.
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5. After you have selected an effect, use the Speed drop-down list box
to try the various transition speeds.

D ro p B O O KﬁnOfﬁce.org Impress animates the transitions again, at the requested
d.

6. After you have selected a speed, select whether you want to move
manually from one slide to the next (the Default option) or have the
presentation advance automatically (the Automatic option).

If you selected Default, proceed to Step 7. If you selected Automatic,
select both the Duration of Page (how long each slide should linger)
and Duration of Pause (how long OpenOffice.org Impress should pause
between showing slides) options.

7. After you have your settings selected, click Create to proceed.

OpenOffice.org Impress opens to its default layout, as shown in
Figure 14-4.

Fine Art with OpenQffice.Org Draw

Whether you’re an aspiring graphic artist or just need a tool that lets you gen-
erate simple graphics for use on their own, in a presentation, or elsewhere,
OpenOffice.org Draw provides a host of drawing functions. If nothing else, it’s
a whole lot of fun to play with! Not everything in life has to be practical.

Starting it up

To start OpenOffice.org Draw in the distributions I cover in this chapter, do
the following:

v In Fedora Core 1, select: Choose Main Menu=Officer>OpenOffice.org
Draw.

+ In Mandrake Linux 9.2, go to: Choose Main Menu=Officem>Graphs=
OpenOffice.org Draw.

v+ In SuSE Linux 9.0, go to: Choose Main Menur>Graphicsr>Vector Drawing.

Taking a tour of OpenOffice.org Draw

Before you proceed, take a look at the GUI layout shown in Figure 14-6.
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Along the left side of the window is the main toolbar, which you can remove
at any time by choosing Viewr>Toolbarst>Main Toolbar. Each icon in this series
represents a different functionality. If a button is extensible (has a little green
arrow on it), you can click and hold the mouse button on it to see the options
contained within. Each icon is described in Table 14-7. As you can see, this
main toolbar is significantly different from the other OpenOffice.org programs.

Table 14-7 The OpenOffice.org Draw Main Toolbar,
from Top to Bottom

Button What You Can Do Extensible?

Select Set the mouse pointer to select a particular No
element or section of a slide.

Zoom Use a set of options that let you zoom in and out ~ Yes
on the slide.

Text Use a variety of methods for entering textonto  Yes
a slide.

Rectangle Easily draw various forms of rectangles. Yes

Ellipse Easily draw various forms of ellipses. Yes

(continued)
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Table 14-7 (continued)

D ro B O Gﬁ What You Can Do Extensible?
p jects Easily draw spheres, cubes, and more. Yes
Curve Easily draw curvy lines and even freeform. Yes
Lines and Arrows  Use a selection of connector lines and arrows.  Yes
Connector Use another set of connector symbols and lines. ~ Yes
Effects Open the Special Effects dialog box. Yes
Alignment Shift the selected object to a specific alignment  Yes
on the page.
Arrange Move objects higher or lower in the stack. Yes
Insert Insert items, such as graphs. Yes
3D Controller Open the 3D Effects dialog box. No
Menu bar

Along the top of the window is the Menu bar, a standard in the GUI world no
matter which operating system you’re using. OpenOffice.org Draw has all the
features you would expect from a modern drawing package. It has too many
menu options to cover in depth, so I give you instead a (nonexhaustive) sum-

mary of what you find on each menu:

v~ File: The usual Open, Save, Save As, Print, and Export commands, along
with a set of wizards (under the term AutoPilot) plus the ability to send

documents through e-mail and create templates

v~ Edit: The usual Find and Replace, Image Map, and other such editing

commands

v View: The usual Zoom functions and toolbars, along with the ability to
select the display quality and place the program in Preview mode

v Insert: The usual charts, frames, graphics, and spreadsheets, along with

scanning functions

v Format: The usual brush and graphics formatting, along with layers and

style formatting

v Tools: The usual spell-checking, as well as hyphenation, autocorrection,

an image gallery, and an eyedropper for grabbing colors

These menus have more features than what is listed here. Go through and
take a look; you may find a new favorite feature in there somewhere.
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Function bar

Digjectly below the Menu bar in a default setup is the Function bar, which you
(& ve at any time by using the View menu. This series of icons allows you
*eHck access to the most commonly used File and Edit features, among
others. Table 14-8 lays out, from left to right, what you find on the default
Function bar. The extensible items can all be expanded to show a further set
of options.

Table 14-8 The OpenOffice.org Draw Function Bar,
from Left to Right
Button or Item What You Can Do Extensible?
URL Entry drop-  After you type a full URL, including the opening No
down list box http://, openanew window with the Web
page’s contents displayed.
Stop Loading Tell OpenOffice.org to stop attempting to load No
the specified Web page.
Edit File Edit the displayed Web page. No
New Open new documents of various types. Yes
Open File Open an existing file for reading or editing. No
Save Document  Save the current document, either with Save As  No
if you have never saved it or to save over the last
saved version if you have.
Edit File Set file as read-only or read-write. No
Export Directly Open a Save As dialog box with the PDF file type  No
as PDF selected.
Print File Directly ~ Send the file to the default printer. No
Cut Remove the selected text out of the document No
and save itin memory.
Copy Make a copy of the selected documenttextand No
save it in memory.
Paste Place the text from memory into the document No
at the cursor’s current location.
Undo Undo the last change you made to the document.  Yes
Redo Undo the last undone change to the document.  Yes

(continued)
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Table 14-8 (continued)
or Item What You Can Do Extensible?
avigator On/Off  Open or close the Navigator window, which No

allows you to jump to specific features within
your document.

Stylist On/Off Open or close the Paragraph Styles window, No
which allows you to select the particular style to
apply to selected text.

Hyperlink Dialog ~ Open or close a dialog box that you can use to No
build complex hyperlinks.

Gallery Open or close a dialog box that provides access  No
to divider bars, bullet types, and more.

Object bar

The Object bar is directly below the Function bar in a default OpenOffice.org
setup. As usual, you can remove the Object bar at any time by using the View
menu. This series of icons allows you to click buttons and expand drop-down
list boxes that represent standard presentation software functions, such as
arrow styles, colors, line styles, and other formatting instructions. Most fea-
tures on this bar are identical to what you see in most modern presentation
programs.

Ruler

Directly below the Object bar in a default OpenOffice.org setup is the ruler.
This item marks out the margins and tabs, for example, of your document in
the measuring system of your choice. To change which system you want to
use, right-click the ruler to open the Measurements pop-up dialog box.

Vour document

Click in that big white space and start doodling. You can also access a format-
ting pop-up menu by right-clicking in the document section.

OpenOffice.org Draw appears to have the most limited file type support
for saving when you use the Save As dialog, but in fact supports a wide
range of graphics formats. You can save images to a format other than the
OpenOffice.org Draw format (.SXD) by selecting Filec>Export.

Supported graphics formats are: BMP, EMF, EPS, GIF, JPEG, MET, PBM, PCT,
PGM, PNG, PPM, RAS, SVG, TIFF, WMF, and XPM.
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Calculations with OpenOffice.Org Math

DropBooks

othing like trying to type a math or science report and having to
either use multiple lines to show your equations or write them in by hand.
OpenOffice.org Math is a great solution to this problem. You can create your
equations and more in there and then insert them in any of your OpenOffice.org
documents. Whether you're a middle school student or a professional engineer,
OpenOffice.org Math just may thrill you.

Many OpenOffice.org Math functions are different from what you're used to if
you have looked at all the other OpenOffice.org programs. However, in many
ways this program is less complex than some, thanks to its special-purpose
nature. Keep in mind that it’s not a calculation program. It’s for laying out
complex formulas on paper. However, you can insert these formulas into
OpenOffice.org Calc for some interesting cross-program work.

Starting it up

To start OpenOffice.org Math in the distributions I cover in this chapter, do
the following:

v In Fedora Core 1, select: Choose Main Menu=>Officec>OpenOffice.org
Math.

» In Mandrake Linux 9.2, go to: Choose Main Menu= Office=>
Wordprocessor~>OpenOffice.org Math.

+ In SuSE Linux 9.0, go to: Choose Main Menu=Office=>Office Suite. When
the Templates and Documents — New Document window appears, double-
click on Formula to open a new OpenOffice.org Math document, or
browse to the file you want to edit.

Taking a tour of OpenOffice.org Math

Before you proceed, take a look at the GUI layout shown in Figure 14-7.

Close the Selection dialog box by clicking the small X in the upper-right
corner of its window. Keep things as uncluttered as possible. You can get it
back at any time by choosing Viewr>Selection.Main toolbar.
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Along the left side of the window is the main toolbar, which you can remove
at any time by choosing View=>Toolbars>Main Toolbar. Each icon in this series
represents a different functionality. You're likely to find this main toolbar quite
different from those in the other OpenOffice.org programs. Mostly, it’s just —
smaller. Each icon is described in Table 14-9.

Table 14-9 The OpenOffice.org Math Main Toolbar,
from Top to Bottom

Button What You Can Do

Zoom In Enlarge the contents of the document section.

Zoom Qut Shrink the contents of the document section.

Zoom 100%

Shrink or enlarge to the contents’ original size.

Entire Formula

Enlarge or shrink the formula so that it fits in the full screen.

Refresh

If you have View=>AutoUpdate Display enabled, update the docu-
ment area to match the Commands area.

Formula Cursor

Click within the formula in Document view so that your cursor
automatically moves to that position in the Commands area.

Symbols

Open the Symbols dialog box, which contains both Greek and
other special-purpose mathematical symbols.
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Menu bar
Algng the top of the window is the Menu bar, a standard in the GUI world no
D ro B O QK hich operating system you’re using. OpenOffice.org Math may be
nti y program you may have used already, so [ don’t say anything about
what you may expect to find there. I just give you a (nonexhaustive) summary
of what you find on each menu:

v File: The usual Open, Save, Save As, and Print commands that you find in
most GUI programs, along with a set of wizards (under the term AutoPilot)
and the ability to send documents through e-mail, create templates, and
create Web pages

v Edit: The usual Select All and Find commands, along with specialized
commands for moving within the formula

v View: The usual Zoom functions and toolbars, along with screen update
features and more

v Format: The usual font type, font size, spacing, and alignment features
and more

v Tools: The usual Configure and Options entries for customizing the pro-
gram’s setup and behaviors, in addition to formula importing and access
to the symbol catalog

Function bar

Directly below the Menu bar in a default setup is the Function bar, which you
can remove at any time by using the View menu. This series of icons allows you
single-click access to the most commonly used File and Edit features, among
others. Table 14-10 lays out, from left to right, what you find on the default
Function bar. If a button is extensible (has a little green arrow on it), you can
click and hold the mouse button on it to see the options contained within.

Table 14-10 The OpenOffice.org Math Function Bar,
from Left to Right

Item What You Can Do Extensible?

URL Entry drop-  After you type a full URL, including the opening No
down list box http://, open anew window with the Web
page’s contents displayed.

Stop Loading Tell OpenOffice.org to stop attempting to load No
the specified Web page.

Edit File Edit the displayed Web page. No

(continued)
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Table 14-10 (continued)

h‘ﬂ(\ What You Can Do Extensible?
DropBooks

Open new documents of various types. Yes

Open File Open an existing file for reading or editing. No

Save Document  Save the current document, either with Save As  No
if you have never saved it or to save over the last
saved version if you have.

Edit File Set file as read-only or read-write. No
Export Directly Open a Save As dialog with PDF selected asthe  No
as PDF file format.

Print File Directly ~ Send the file to the default printer. No
Cut Remove the selected text from the document No

and save itin memory.

Copy Make a copy of the selected document textand  No
save it in memory.

Paste Place the text from memory into the document No
atthe cursor's current location.

Undo Undo the last change you made to the document. Yes

Redo Undo the last undone change to the document. ~ Yes

Navigator On/Off  Open or close the Navigator window, which No

allows you to jump to specific features within
your document.

Stylist On/Off Open or close the Paragraph Styles window, No
which allows you to select the particular style to
apply to selected text.

Hyperlink Dialog ~ Open or close a dialog box that you can use to No
build complex hyperlinks.

Gallery Open or close a dialog box that provides access  No
to divider bars, bullet types, and more.

Document section

Things get tricky here if you have never used formula editing software. You
can’t type anything in the main document window in OpenOffice.org Math.
Instead, you type in the Commands window. Right-clicking in the Commands
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window opens a pop-up menu. To help you get used to working with the for-
mulas, [ suggest that you play around with this pop-up menu. For example, if

D r O p B O Ookg never used software like this, you might follow these steps:

Figure 14-8:
The
OpenOffice.
org Math
Commands
pop-up
menu.
|

Figure 14-9:
The
OpenOffice.
org Formats
submenu on
the Math
Commands
pop-up
menu,.
|

1. Open the right-click pop-up menu.

You can see this menu shown in Figure 14-8.

Unary/Binary Operators 3
Relations s
Set Operations r
Functions b
Operators v
Attributes v
Brackets v
Formats v
Others v

2. Select a submenu to open.

I chose Formats, which you can see in Figure 14-9.

X
X
Isup x
Isub x
csup x
csub x
New Line
5 Small Gay
Unary/Binary Operators v Eap o
Relations vl
i hinom x y
Set Operations v
: stack {...}
Functions v :
matrix {...}
Operators S
Attributes »  alignl x
Brackets v aligne x
alignr x
Others 5

3. Select a formula component within this submenu.

I'm a geek, and I fondly remember taking a class on matrices, so I chose
matrix {...}. Inmediately, the code that’s needed in order to add a matrix
to my formula appears in the Commands dialog box. A moment later,
because I'm letting the program refresh the rest of the screen as I work, I
see what the matrix looks like in the document window. The combination
is shown in Figure 14-10.
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4. Replace each of the <?> entries with the letters and numbers for your

formula.

When I change matrix{<?> # <?> jHF <2> # <?>} to matrix{A # B ##
C # D}, [ see the result shown in Figure 14-11.

. Continue adding components to the formula until you are finished.

Suppose that you want to multiply the matrix by 3. You press Enter to go
down to the next line, right-click to display the pop-up menu, and choose
Unary/Binary Operators=>a Times b. This choice adds the phrase <?>
times <?> beneath the matrix code. If you erase this phrase and use it
as a guideline, you end up with

3 times matrix{A # B 44 C # D}

This line gives the result shown in Figure 14-12. I could go on, but I hope
by now that you're eager to start with your own explorations!

OpenOffice.org Math supports (among others) its own format (.SXM) and
MathML 1.01 ((MML), which isn’t a program. MathML is a standard, similar to
HTML for working on the Web, and 1.01 is a specific version of this standard.
For this particular version of MathML, see www.w3.0rg/TR/REC-MathML/.
The main standard page is available at http://www.w3.0rg/Math/.If you
need to add formulas to Web pages, this site can be quite an interesting read!
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Chapter 15
Multimedia Wow!
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In This Chapter

Listening to music

Using, recording to, and ripping from CDs

Creating and modifying high-powered graphics with The GIMP
Watching movies

Using Windows tools and formats

The price of freedom is responsibility, but it’s a bargain, because freedom is
priceless.

—Hugh Downs

In these days of computing in noisy Technicolor, it just doesn’t feel like a
computer unless you can make it sing and dance. This used to be a weak
point for Linux, but these days there’s little that [ can’t do on my Linux desk-
top machine. From listening to CDs to watching QuickTime movies, you can
do just about anything. Sometimes it just takes a bit of elbow grease to get

things working.

Time to take a trip on the wild side and get your Linux box doing the
macarena.

Some Preliminavies

Because legal complications surround a number of multimedia programs and
their use in countries like the United States of America, some multimedia capa-
bilities had to be removed from Red Hat Linux. However, these capabilities are
still available if you know where to look — and if you're in a legal jurisdiction
that allows listening to MP3s, watching DVDs, or other touchy subjects under
patent laws and the DMCA.
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If you are in an area where it is legal to use these technologies in Linux and
open source, you need to enable the necessary features. Start by using the su
© to become the root user (type su - root). Then, use your favorite
Q r as discussed in Chapter 13 to open the file /etc/sysconfig/rhn/
sources for editing.

Go to the end of the file and add the following text (where this is all on a
single line):

yum Tivna-stable-fcl http://rpm.livna.org/fedora/1/i386/
yum/stable

Right click over the updater icon on the right hand side of your panel, and
click Exit. Then, select the main menu=>System Tools>Red Hat Network Alert
icon. When the updater icon is back in place, click it, and now when you navi-
gate to the point where you see “channels” for updates, the 1ivna archive is
included.

However, this action only makes it possible to update what’s already installed.
You also want to be able to add items you haven’t installed yet, so now open
the file /etc/yum.conf for editing in your favorite text editor. Add the follow-
ing lines at the bottom, where the URL is all on one line (rather than broken
up as it appears below):

[1ivna-stable]

name=Livna.org Fedora Compatible Packages (stable)

baseurl=http://rpm.livna.org/fedora/$releasever/$basearch/yum

/stable

[fedora-us]

name=Fedora.us The Non-Red Hat Fedora packages (stable)

baseurl= http://download.fedora.us/fedora/fedora/$releasever
/$basearch/yum/stable

After you have saved this file, you are ready to proceed through the rest of
this chapter.

Checking Your Sound Card

Before you can listen to those tunes, you have to make sure that your sound

card is working properly. After the configuration issues are dealt with, you can
move on to the fun stuff. These days, some people don’t bother buying stereos
because they can listen to CDs through their computer. There’s plenty of sup-
port for this under Linux. Internet radio and downloading tunes are also popu-
lar regardless of what operating system you’re using. Read on to find out more!
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Testing and configuring your sound

D ro p B O Q‘sttime that you booted Fedora Core, you were asked to listen to a test
olnd:

|
Figure 15-1:
The Fedora
Core Audio
Devices
dialog box.
|

you answered that you had, Linux and your sound card are getting
along just fine. If you don’t remember this step or it didn’t pass the first time,
I show you how to walk through the test again just to make sure. Then [ show
you where to find your audio mixer.

Testing your sound and making it work
To test your sound, select the appropriate tool for your distribution:

v In Fedora Core 1: Choose Main Menu=>System Settings=>Soundcard
Detection.

v+ In Mandrake Linux 9.2: Choose Main Menu=>Configuration=>Hardwarer>
HardDrake. Wait for the wizard to detect your hardware, and then select
the entry under the Sound Card item.

v+ In SuSE Linux 9.0: Select the SuSE menu, and then choose System>
Configuration=>YaST=>Hardwarer>Sound.

For Fedora Core, after you enter your root password, the Audio Devices dialog
box opens (see Figure 15-1). Click the Play Test Sound button, and you should
hear a series of guitar strums. If you hear nothing, click No; if you do hear
something, click Yes.

Audio Devices

The following audio device was detected.

Vendor: Ensonig
Model: ES1371 [AudioPCl-37]
Module: es1371

Play test sound,

If your sound isn’t working, your card may not be supported. The following
strategies can help you to track down a potential solution:

v Proceed to the manufacturer’s Web site and locate the page for the spe-
cific card that you have. This page often has a link to technical support,
drivers, and downloads. If it does, follow these links and see whether a
driver (the piece of software that tells your operating system how to talk

259



200 Partin: Getting Up to Speed with Linux

to each piece of hardware) is available for your card in Linux. If drivers
are listed by kernel version — the version of the Linux core that you're
Qg — type uname -r to see your version number and then choose the
D ro p B O O st driver that you can. You also might have to try the central tech
support page on that site if there isn’t one dedicated to the hardware in
question.

v Search on www.google.com for the make and model of your card, plus
the word Linux. For example, I might search for

Yamaha YMF-744B Linux

You might be lucky enough to find a nice, simple solution to your problem.
Or, you might find one that requires you to have a degree in Geekspeak.
If so, see the Web sites that [ mention in Chapter 1 for where to go for help
that you can understand.

v Two special sound-related projects in Linux also might be able to help
you. One is Advanced Linux Sound Architecture (ALSA), which you can
find at www.alsa-project.org/. The other is Open Sound System (OSS)
at www.opensound.com/. There’s also the Linux Sound & MIDI site at
http://1inux-sound.org/.

Finding your audio mixer

After you have your sound working, you might want to adjust the base volume
or mixer settings like you can in Microsoft Windows. These tools are available
at the following:

v Mandrake Linux 9.2: Choose Main Menu>Multimedia=>Sound=>KMix.

v Fedora Core 1: Choose the main menu and then choose Sound &
Videor>Volume Control to see the mixer shown in Figure 15-2.

v SuSE Linux 8.2: Choose the SuSE (lightning bolt) menu, and then choose
Administration=>YaST2 Modules~>Hardware=>Sound. Then click the
Volume button.

T

Volume Control

7Ei|e Settings Help )
I | o) Vol | Pcm cﬂSpkr‘uLine:ﬁMic ‘©cD | IGain §0.Line1 Phoneln PhoneOut| Video|

Fiaure 152 |LLILL| 1 | L 1| L |0 E[RLIL 0l & | & |0
e s ﬁ] F ﬁ‘
Core sound ‘ ‘ J H ‘ | | I J H H H | ‘ L

. Lock Lock | Lock Lock Lock Lock Lock|
mixer.
Rec. |[TRec. |[JRec. |[TRec [Rec. |[JRec |1 Rec.
I 4

CIMute |[JMute|(JMute  [IMule |(JMute [IMute |[[JMuwe (IMuse [IMue [IMue | []Mute|
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Listening to CDs

D ro p B O QK t Linux, many music CDs will start up on their own when you insert

ilrthe drive if you're in the GUI. If that CD is registered in the CD DataBase
(CDDB), the title and the song names load so that you can see what you're
listening to. (CD DataBase is one of the services that tells your media players
what the name of your CD is and what songs are on it; find more at www .
gracenote.com/.) What you'll see looks similar to Figure 15-3.

Figllre 15-3: #1 Crush - Various
The Red Hat

Linux CD
Player with \William Shakespeare's Romeo & Juliet Soundtrack

1
{ == }

an album
loaded and
playing.

35’” 1 -#1 Crush

\3
P If you close this application without clicking the Stop button, the CD will

actually continue playing. You can stop it by opening the program again and
clicking Stop.

If CDDB doesn’t recognize your CD, you can add it to the database by clicking
the Open Track Editor button (to the far left beneath the CD display) to
open the CDDB Track Editor dialog box shown in Figure 15-4.

& CDDE Track Editor. [

Artist. |Varicu5 |
|

Disc Title |Wi|ham Shakespeare's Romeo & Juliet Soundtrack

[> Show advanced disc options

‘ |Tme Length |E| |+ Show advanced track options
5 Kissing You 456
6 Whatever 4:08
7 Lovefool 317 I
I 8 Young Yearts Run Free 4:14
Figure 15-4: 9 Everybody's Free 1:42
The GNOME 10 To You | Bestow 357 2

, 11 Talk Show Host 416
CD Player’s 12 Litle Star 3:38

CDDB Track

Editor 14 Unknown 3:04

dialog box. | ®Canel | | Qsave |

[«]
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Notice the white, right-facing triangles pointing to Show Advanced Disc
Options and Show Advanced Track Options. You can click these to expand

nt of information displayed in the dialog box. After you're finished
ro p O inDthe information about your CD, click Save to store the data.

|
Figure 15-5:
The GNOME
CD Player
Preferences
dialog box.
|

The button to the right of the Track Editor is Open Preferences. Clicking this
brings up the dialog box shown in Figure 15-5. Here, you can tell the CD player
how to behave when you start and end the program. After you make your
changes, click Apply Change and then click Close.

CD Player Preferences.

CD Player Device:

i.fdew'cdrom\ ‘ Apply change |

CD Player Behaviour:
[[] Start playing CD when CD Player starts
[] Attempt to eject CD when CD Player exits

Available Themes:
None
led
media
red-lcd

Listening to Internet radio

Listening to Internet radio stations in Linux is not always the simplest thing
in the world, but thankfully, these days it’s not as hard as it used to be. Because
of various laws, patents, and licensing problems, some formats like MP3 are
not always supported out of the box. The best way to see what you’re set up
to support right now is to simply try and listen. After you’re sure that your
sound is set up properly, you can try many Web sites with the Mozilla browser:

» SHOUTcast for finding links to thousands of online stations, at www.
shoutcast.com/

v Radio-Locator for finding “regular” radio stations offering online versions,
atwww.radio-locator.com/

The first place to try is SHOUTcast. This site is the most likely to actually work
with a Linux system. When you find a station that you want to listen to, click
the Tune In! button. Because this is probably your first time doing this, you
receive a dialog box similar to that shown in Figure 15-6.
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h .sPButeast.com/sbin/
& ozilla do with this file?

drake 9.2
looks for
Mozilla's
Opening
dialog box.
|

|
Figure 15-7:
XMMS

in Fedora
Core 1.
|

Opening shoutcast-playlist.pls

The file "shoutcast-playlist.pls” is of type audio/x-scpls, and Mozilla does not
kfow how to handle this file type. This file is located at:

() Open it with

| Saveitto dlské

| Always show this dialog before handling files of this type

oK Cancel

Select the Open It With radio button. In the text box, type /usr/bin/xmms.
Click OK. The Mozilla download manager dialog box opens. Just minimize this:
If you close it, you lose the radio station. Next, XMMS (X MultiMedia System)
itself opens (as shown in Figure 15-7). The tool loads the radio station and
immediately starts playing (if the file type is supported)!

i 0D0:15 + HE CRAM'T DEFINE |T! =+ 3,
i 12GHEFE 44 EHZ ESTERED |

_@@@@_@E—E SHUFF [ REF

If the file type is based on MP3, which is a patented type of file format, then
you will receive a dialog box from Red Hat informing you that MP3 support
was removed due to legal issues. However, if you are in a location where the
MP3 functionality is legal to use, you can add this capability. First follow the
instructions in the previous section, “Some Preliminaries,” and then return
here to type:

yum install xmms-mp3

You may see a lot of information scrolling down your screen. That’s just the
yum tool grabbing the data it needs on the various files offered through the
repositories listed in your yum configuration file. When you see the words
Resolving Dependencies, that means this tool is about to get down to business.
Before the installation begins, you are asked whether you want to install the
package(s) required — you will need any dependencies that are recommended.
Press “y” and then Enter.
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Now try a trickier one, like Radio-Locator. Not only does this site offer stations
in formats that may not work under Linux, but it’s also a bit confusing. [ recom-

DropBodi

\\J

kgt you do the following:

. Under the Search By portion, select how you want to drill down to the
station that you want to listen to.

Choose from format, frequency, U.S. state, Canadian province, or
advanced search. I tend to pick format, so I'll use that for an example.

. Under Available Radio Station Formats, select which type of station

you’re looking for.

Stations are sorted by their content type.

. Under the section for your Format, look to the table beneath the fea-

tured stations.

It’s the left-most column that you're interested in. Many of the stations
here have blank entries, but some have lightning bolts.

. If there is a lightning bolt next to the station that you want, click it.

Stations played in a format that you have already told the browser is
handled by XMMS or another tool start playing automatically. If this is
the case, you're finished with this process.

. Otherwise, click the station’s call sign if it’s marked as a link.

This action brings you to the station’s own page. If the call sign isn’t
marked with a link, the station isn’t online.

. Look for a Listen online link and click it.

This action should open the station’s streaming feed. If your machine
supports this feed, it will play automatically.

If you keep running into stations that your media player won’t support, you
need to add some software. See the section “Watchin’ Movies!” later in this
chapter for how to add Mplayer.

Listening to downloaded music

Downloading music off the Internet is a fun activity. A lot of people like to pre-
tend that it’s both legal and ethical, when in fact it’s often theft. I leave that
ethical issue between you and your belief system of choice, but since my own
ethics say that it’s theft, 'm going to focus on showing you music that you're
welcome to download. Legally and ethically! Take a look at strategies for find-
ing such music, along with how to listen to it.
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One place to find such material is on a band’s own Web site. Many groups
today realize that offering free downloads of their work is a great PR move —

G € love the sample songs, they’re more likely to go out and buy the

r an example, [ use one of my own favorite bands, Evanescence
(www.evanescence.com/).

Evanescence, like many other bands, has its page done mostly with
Macromedia’s Flash tool. Mozilla will tell you that you can’t view the content
without the right plug-in, so Evanescence, like many other bands, has its page
done mostly with Macromedia’s Flash tool. Mozilla will tell you that you can’t
view the content without the right plug-in, so first you’ll have to get the plug-
in for Flash. To download and then install this plug-in, perform the following
steps:

1. Point your browser to http://macromedia.mplug.org.

2. Click the link that best represents your physical location.

This link takes you to the Macromedia site with the latest versions
of their Flash player, in the most friendly formats available.

3. Click the flash-plugin link next to Fedora Core 1.
A Save As dialog box opens.
4. Navigate to your preferred save location and then click Save.
The file downloads.
. Open a command line terminal.
. Use the cd command to go to the directory where you stored the file.

. Use the su command to gain root access.

@ N & O

. Type rpm -ivh filename.

If you receive an error, you may need to install an RPM from your DVD or
CD set called compat-libstdc++. You can install this library by typing yum
install compat-1ibstdc++ and pressing Enter.

9. Close your browser and then relaunch it.
10. Browse to www.evanescence.com.
If the plug-in still doesn’t load, choose the site version that doesn’t rely

on the particular plug-in in question (if there’s one available).

Now, to see whether you can listen to any music here, click the Music link.
The songs are in the Flash window on the left. You have the option of clicking
real for RealPlayer, windows for Windows Media Player, or Tyrics to see the
words for this song.
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Ripping music tracks from CDs

D ro p B O %ﬁother topic that’s impossible to cover without at least acknowledging
t

Figure 15-8:
Sound
Juicer

in Fedora

Core 1 with

a CD loaded.

ethics and legal issues are involved. I'm not going to get into legalities
here, but my personal ethics are that it’s fine to rip (copy) music off my own
CDs for my own use. If [ want to pull my favorite songs off CDs that I purchased
and set them up so I can listen to them collectively in a random playlist, [ don’t
see a problem with this. However, doing this and then taking the CD back for
arefund is theft.

So, with that said, a number of music ripping programs are available in Linux.
[ cover Sound Juicer, which is included on any machine with GNOME installed.
You open Sound Juicer by choosing Main Menu=>Sound & Video=>More Sound
& Video Applications=>Sound Juicer CD Ripper. Figure 15-8 shows this tool.

Sound Juicer

CD  Edit Help

Title: Brothers & Sisters, Are You Ready? j
Atist  [BgSugxr )
Duration: 49:53
Extract? |Tra(k |Tiﬂe |Artisl |Duraurm I~
1 Red Rover Big Sugar 4:57
2 MNashville Grass Big Sugar 3:49
3 She Left Ashes Big Sugar 4:04
4 Nicotina(She's All That) Big Sugar 4:02
5 So Not Over Big Sugar 3:33
6 Butterball Big Sugar 4:06
7 Bump on the Head Big Sugar 4:12
8 Lost and Found Big Sugar 3:55
9 Bad Old Days Big Sugar 3:36 L
= : b

%gﬂe-read | | ©) Extract

To rip songs from a CD that you already have inserted
1. For each song that you don’t want to rip, uncheck the Extract check
box, next to the song.
The check mark disappears for each song that you want to digitize.
2. Select Edit->Preferences.

The Preferences dialog appears, as shown in Figure 15-9.
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Preferences

DropBooks :

I @) Ogg Vorbis ) MP3
- FLAC Wi
Figure 15-9: | © (e
The SOUﬂd Output Quality
Juicer Smaller 192 Kbps Better
Files ‘i Quality
Preferences
il
|

fhome/dee
Output Name
Directory Hierarchy

File Name

Example Path:
["] Strip special characters

Output Format

‘ Album Artist, Album Title 2 |

‘ Number - Title z |
Album Artisy/Album Title/09 - Track Title

. Select your preferred sound format.

I highly suggest Ogg Vorbis because this format is easily handled on
Linux machines without any inherent legal problems, and is also better
compressed than MP3 for equivalent sound.

. Use the Browse button to select where you want your sound files

saved.

. In the Output Name section, select how you want Sound Juicer to

name and arrange the files in subdirectories.

6. Make any other configuration changes you want to make.

7. When finished making changes, click Close.

10.
11.

The dialog closes.

. Click Extract.

The Progress dialog appears, showing you what track you are on and
how far within that track you are.

. Select CD->Eject.

The CD tray opens.
Remove the CD and close the tray.

Close Sound Juicer.
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Want to listen to what you just ripped?
D r O B O O I@ose Main Menur>Sound & Videor>Audio Player.
p XMMS Media Player opens as shown in Figure 15-10.

Figure 15-10: |

The XMMS ||! -
Media |~ i G

Player. || [EI3]mIE][31] (=] oses o

2. Click PL.
This button opens the Playlist dialog box (see Figure 15-11).

|
Figure 15-11:
The XMMS
Playlist
dialog box. D mmAm [
900 | (][] (s o] W [e

|
|

3. Click Add.
This button opens the Load File(s) dialog box.
4. Navigate to the directory where your new OGGs are stored.
5. Click Add All Files in Directory.
This handy trick adds every file in that directory at once to the playlist.
6. Click Close.
The Load File(s) dialog box closes.
7. Close the Playlist dialog box.
8. Click the Play button in XMMS.

Isn’t that cool?!
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Burning CDs
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ner is a great way to make data backups (especially if it’s a rewrite-
e and share your digital photos, put together multimedia memento

scrapbooks, and more. Many tools are available that allow you to burn CDs
under Linux. I'll cover the one that comes with Fedora Core 1, which is

xcdroast.

This tool may not be installed by default. It’s

on your DVD (or CD 2 in the

Fedora Core 1 set). See Chapter 17 for how to install new software.

To start this program, use System Tools=>CD

Writer. A number of confusing

windows open. The best advice I can give here is to glance them over and keep
clicking okay until the tool itself opens. Then, click the Setup button; in the
resulting window, you should see your CD burner listed amongst the hardware.
Clicking the CD Settings tab brings you to one of the items you might want to
edit if you're a CD burning whiz (Figure 15-12).

Then, click the HD Settings tab to bring you to one of the few items that you
actually need to edit (check out Figure 15-13). In the Path text box, type /tmp.
Then click Add to place this directory in the list of temporary storage options.
Now, unless you are a wiz with CD burning and have a ton of things that you
want to configure, click Save Configuration. If you know what else you want to
do, take your time! After you're finished with all your setup tasks, click the Save
Configuration button again if you’ve made any changes, and then click OK.

v) X-CD-Roast 0.98alphald
Setup
Device-Scan | CD Setlings | HD Settings ‘M\scallananus ‘ Options ‘
CD/DVD Writer Configy
CD Writer Device: [ |
CD Witer Mode: | Autodetect -]
Default Write Mode ‘ Disk-At-Once (DAO) ~‘
CD Writer Speed ¥
CO Writer FIFO-Buffer-Size: | 1.0ME | (2}
Save configuration CD/DVD Reader Ci
Read Device: ‘ NECVMWar Viware IDE CORO0 [ATAPLD,00 v
Audio Read Speed: | 0x  |[_7 )=
Sectors per request | 75|
Sectors for overlap sampling: | 0 [}
Faranoia retries per sector. | 20 |
[] Use paranoia mode for audio
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Save configuration

X-CD-Roast 0.98alphal4

\7 Setup

Device-Scan | CD Settings \glj_D_S_e__tt_\r_vqu‘ Miscellaneous | Options ‘

[ Temporary Image Storage
Path

| Free space quBmin) | writeanle

Total space availahle: H Update |

Path: | Il Browse |

[ Add I Remove |

ffers you two options. You can duplicate an existing CD or create

one from scratch. Both of these choices offer you an attractive yet simple inter-
face for going through the steps of reading in the existing CD’s contents, edit-
ing them if desired, and then writing the results onto another CD.

|
Figure 15-13:

X CD Roast =
peachllll
Setings

dialog box.

|
X CD Roast o
\\3

The Tucows download site has a whole section for grabbing Linux multime-
dia tools. Check out http://1inux.tucows.com/mmedia.html.

Blocking pop-up ads

The Radio-Locator site gives me another topic
for discussion. Every time that you click a link
there, you have to deal with pop-up ads. Want to
get rid of them? In Mozilla, you can do so by
choosing Tools=>Popup Manager=>About Popup
Blocking. A dialog box opens asking whether
you want to block pop-ups and then configure
how this works. Click Yes, and the Preferences

dialog box opens to the Popup Windows tab.
The defaults here are fine, or you could explore
this area more thoroughly. Notice that you have
the ability to allow pop-ups from certain sites
because there are actually useful pop-ups out
there.

After you're finished setting this up, click OK.
Suddenly, no more pop-ups!
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Creating and modifying

Dro P Bo@kgiics with The GIMP

The GIMP is a graphics program that’s considered in many ways equivalent to
Adobe Photoshop. Many don’t consider The GIMP the friendliest program on
the planet, but at the very least, it has enough features to keep you busy for
weeks experimenting! To open The GIMP, access the main menu and then
choose Graphics=>The Gimp.

When you start The GIMP for the first time, you have to walk through its user
setup routine:

1.

In the Welcome dialog box, click Continue.

The Personal GIMP Directory dialog box opens.

. In the Personal GIMP Directory dialog box, click Continue.

Before you proceed, if you're curious, you can click on the various sub-

directories and files that will be created during The GIMP setup process.
Doing so gives you information about what each file and subdirectory is
for. After you click Continue, the User Installation Log dialog box opens.

. In the User Installation Log dialog box, click Continue.

The box instructs you to read through and look for installation errors.
It’s worth a quick scroll-through, but I've never run into problems,
especially on a package-managed system, such as RPM (see Chapter 17).
After you click Continue, the GIMP Performance Tuning dialog box
opens.

. Alter the value in the Tile Cache Size text box if you want to restrict

how much memory The GIMP lets your images take up.

The default is just fine for most people, but if you work with large, heavily
detailed images, you may need to raise the value. You can do this if you
have a lot of RAM on your system (128MB or more). On the other hand,
if you really work only with small items, you can lower the value.

. If your home directory is on a drive without approximately 500MB

of free space (a conservative value to be safe), change the value in
the Swap Directory text box to another location, such as /tmp/
username.
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Click the icon to open a window that enables you to browse to another
location. Again, most people won’t need to make any changes. If you're
ure how much room you have, open a terminal window by clicking
Jlerminal button on the lower button bar (or click the Main Menu
button and then choose System Tools=>Terminal) and type df -h to see
how much room you have on each of your partitions.

6. Click Continue to proceed.
The Monitor Resolution dialog box opens.
7. Select the Get Resolution from Windowing System check box.

Doing this allows The GIMP to figure your settings automatically instead
of forcing you to get down and dirty with the math.

8. Click Continue to start The GIMP.

The full startup is shown in Figure 15-14.

| EdThecine 7 =] ¥ Tool Options = B | ¥ Brush Selectio -
File  Xtns  Help |1 Rectangular Selection Circle (15) (19 %19)
= [JFeather 474 A 4 / e -

FRadiug: g —
7 Za
[*)

a0
[ ] Fized Size / Aspect Ratio [ ] .Iil .
it |1 2]
Height: [1 =

Unit: | e Y.
i BN Spacing;

)
<
% A

% Layers, Channels & Paths

Figure 15-14:
The

full GIMP
startup
includes a
collection of
dialog boxes

Image: | AGRE

Layers | Sharnels | 2t | Welcome to the GIMP |

I Gl [ teep Mearly all image operations are performed by right-clicking

Opaciy; = on the image. And don't worry, you can undo most mistakes...

Show tip next time GIMP starts Previous Tip H Mext Tip |

and more.

o[ The GIMP wLayers, Channels & |

‘%  Tool Options «  Brush Selection
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From now on, anytime that you start The GIMP, this is what you’ll see unless
you close some of the dialog boxes — which The GIMP kindly remembers

t closed the next time. The GIMP is an incredibly complex program,
i $e books written for the people who really want to use it heavily.

Great starter links for working with The GIMP are
v GIMP Tutorials Pointer Page: http://empyrean.lib.ndsu.nodak.edu/
~nem/gimp/tuts/
+* RRU GIMP Tutorial: www.rru.com/~meo/gimp/Tutorial/

1+~ The official GIMP.org site’s tutorials page: www.gimp.org/tutorials.
html

v The GIMP Savvy Web site (with a full book available for reading
online): http://gimp-savvy.com/

Watchin’ Movies

\\3

These days, you can watch many kinds of movies on your computer. Whether
it’s a Flash animation, a DVD, or a movie trailer, you've got the tools that you
need right at your fingertips (or just a click away). You might have even
installed some already while trying to access other multimedia features. Here
are some of the tools of the trade.

Watching a DVD in Linux is a bit of a legal quagmire if you live in the U.S. The
Digital Milennium Copyright Act (DMCA) and other issues make it tricky for
any open source program to navigate the licensing maze when it comes to
movies that are encoded or protected in various fashions. However, not all
DVDs have such countermeasures enabled: There are DVDs that Americans
can watch under Linux with no trouble. (Note that [ say watch, and not copy
or pirate.)

For more on the DMCA and the problems it causes, see anti-dmca.org.
Perhaps the best media player out there for the Linux community is mplayer.
You can fetch the latest version of this tool by doing the setup described in
the earlier section “Some Preliminaries” and then typing (as root) at the com-

mand line:

yum install mplayer
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After you have mplayer installed, you'll want to add some frills as well. Type:

DrOpBO Aftertstaﬂ e

is installation completes, go to the main menur>Sound and Videor>
Movie Player to run your new multimedia player (see Figure 15-15).

This program offers you a feature-rich experience, including the ability to load
subtitles and more! Not only that, but it will also come in handy if you want to
watch one of the many animations and movies available on the Web.

I—'_huIPIal,-'er - Video

-

M PIEAY ER

|
Figure 15-15:
The — /'y
MPlayer { A G
multimedia %ﬁ
tool. § b v [ 4
| -

Dealing with Windows-Only Media
Formats and Programs

There is little more maddening for the Linux user than to discover that no
Linux tool is available for working with a piece of multimedia, a document
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type, or a program feature that you know is available in Windows but you
can’t yet find an equivalent for in Linux. Fret not. You're not stuck!

D rop BO@K@thingto doisgoto linuxshop.ru/linuxbegin/win-lin-soft-en/

and see whether there really isn’t a Linux tool that can do the job. You might
be surprised. After this, you have two options. There are commercial packages
available that can help you to access these documents and features under
Linux, or you can wade in and try to get Wine working, which is the free base
beneath all these tools.

Available Software

A growing number of commercially available tools let you work with anything
from Microsoft Office to your Windows games. Ultimately, a Linux user’s goal
is to not have to use any of these extra program layers in order to do what we
want to do — but in the meantime, it’s nice not to be terribly inconvenienced.
I've reviewed or at least used every one of these products, so 'm not just going
by their Web sites.

CodeWeavers

CodeWeavers (www.codeweavers.com) provides two excellent products that
[ use from time to time: CrossOver Office and CrossOver Plugin. The Office
package allows you to use Microsoft Office (along with a growing number of
office applications) directly under Linux, and the Plugin tool helps you to

get past those last few hurdles that might be blocking you from accessing
various bits of content on the Web (and boy can the Plugin tool, shown in
Figure 15-16, help with lots of frustration). It’s a bit jarring to run Microsoft
Word and QuickTime under Linux at first — because there’s no native way to
do this for either — but it’s certainly handy.

What I most appreciate about CodeWeavers (and all these companies, really)
is that they are very upfront about what works really well, what works except
for a few features, and what works not so well. All you have to do is check
their Web site. You’ll have to have your Microsoft Office CDs on hand for
CrossOver Office and for the next item. These tools don’t come with all the
software that they support! They just allow you to run what you have.

CrossOver Office supports Office XP, 2000, and 97 products. See the Supported
Applications listing on the CodeWeavers site for more. CrossOver Plugin sup-
ports most major Windows multimedia clients along with the Trillian IM client
and other items some people just can’t do without.
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Install Software
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WinbLin

Another option is Win4Lin from NeTraverse (www.netraverse.com/). Although
CrossOver Office focuses mostly on serious office tools, Win4Lin extends far-
ther into the multimedia development direction by supporting a larger number
of Macromedia and Adobe products. Win4Lin supports Windows 95, 98 (see
Figure 15-17), and ME. It also requires you to have your Windows OS CDs

on hand.

WineX

More interested in games than office tools? There’s also TransGaming’s WineX
(www.transgaming.com). This version of Wine is specifically designed to
support Direct X, which is used in Windows to make programming for multi-
media and games easier. Subscribers have access to regular updates, allow-
ing them to make use of their favorite games and also add any games they
like to the growing list of games that are being tested with the system.

Selecting the Games link and then selecting the full listing at the bottom of the
resulting page allows you to see the full listing of what games are supported
and how well they’re supported. Figure 15-18 shows an example.
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UMware

D rO p B O Qkﬁyeu absolutely have to do something under Windows itself but only
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Figure 15-19:
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Windows
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in Linux.
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machine and it’s running Linux (or vice versa, for that matter),
there’s VMware (www.vmware.com). This is a popular tool in technical sup-
port offices where people need access to many different kinds of machines to
test things. It’s also popular with authors, like myself, because it allows us to
grab those tricky screenshots of the boot process and installer screens.

In VMware, you run a full session of another operating system (or even the
same one) within your desktop — see Figure 15-19. If your machine is power-
ful enough, you could have five different operating systems all running in
their own windows on a single computer.

All these tools require a bit of extra oomph in your system. Check out their
requirements and then try to go as farythem as you can. Each has a nice
graphical installer that walks you through the process, and in general can
make your life pretty nice if there are things you just can’t leave behind from
the Windows world.

b VMware Workstation,

_ File Edit Power Snapshot Yiew Window Help

winXPPro x

A\ You do not have Yiware Toals installed &
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Installing and Using Wine
D ro p B O Orklg there’s Wine (www.winehq.org), a complete rebuild of Microsoft

Windows 98 functionality that runs under Linux. Wine is in many ways the
mother of everything in the previous section. However, because it’s a free
and very complicated project, it’s not quite as friendly as the commercial

versions. It’s kind of like the others but with all the makeup and hairspray
removed.

Some Linux distributions offer Wine RPMs directly on their installation CDs. If
yours doesn’t, you can get an RPM from http://sourceforge.net/project/
showfiles.php?group_id=6241, which you can find by following the Wine
download links for the binary versions. Locate your distribution in the list and
then get the very latest RPM available for that distribution. It may take a while
for the download to complete. This is an entire re-implementation of Microsoft
Windows after all!

After you have the file downloaded, access a command line terminal and use
the su command to become the root user. Then, type rpm -ivh wine[TAB]
(where [TAB] means that you press the Tab key) to install the program.

\\3
You'll probably find it useful to return to the Web site soon, at www.winehq.
org/site/docs/wine-user/index. This is where the Wine documentation is.

The first thing that you must do before you are able to use Wine is, of course,
configure it. Fortunately, graphical tools are available to help you out. On the
same page where you downloaded the main package, go to the bottom and
find the winesetuptk RPM. Download this and install it as root. Then type
exit to return to being a normal user and type winesetuptk to start the tool
(see Figure 15-20).

Stick with the defaults until you reach the Look and Feel section. Then you’ll
probably want to choose Windows 98 so you don't feel like you've completely
returned to the Stone Age! Click Finish and the tool will do its thing, setting
up everything necessary for Wine to do its job.

Now comes the fun part — trying to run your old Windows software. You
don’t really run Wine, per se. Instead, you first install the Windows software
you want to run and then invoke Wine whenever you need to use something
from the Windows world. To install a Windows program for Wine, insert the
CD-ROM or floppy into the appropriate drive. Your distribution might open
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the file manager for you, or you might need to open the file manager manually.
Regardless, your goal is to run the installation routine, which is typically
XE. You can double-click this icon in the File Manager and, when

gat program you want to use to open this file, answer winelauncher.

Wine Configuration Wizard

Location of the Wine configuration file:
* “y winesconfig (new. writabled

~ Other

Cancel | Help | Next>>l

2000 Codail azere

As [ write this, I'm trying out the instructions with the set of National
Geographic CD-ROMs that I purchased years ago. Because it’s difficult to
describe a standard Wine session, I thought I'd walk you through how this
goes for me.

The installer loads just fine even though there’s a brief error message that I
have to close along the way. I stick with the defaults (because Wine is still a
work-in-progress and it’s best not to taunt it with getting fancy) and then wait
while the installer adds all of the files to my Mandrake system. After a while, I
wonder why nothing is happening, I minimize the installer’s background to
see what’s going on, and oops! Some dialog boxes are stuck behind it! Watch
out for that.

Every once in a while, the installation seems over, but it’s not. A Computer
icon hovers on the lower left of the screen while the installer continues run-
ning, with Setup underneath it. That makes viewing things clearer, especially
because it goes away after everything is installed. Oops, now there’s a big
blue screen that reads QuickTime 4 Setup and never, ever goes away. |
press Ctrl+Alt+Esc and can get rid of it.
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The main program should have installed just fine. To run a Wine program, I
first need to know what the path is to that program. I can find it by looking in
/1 ne directory. In this case, the program was installed into /home/
D ro p B O(i .Swe/fa ke_windows/Program Files/The Complete National
Geographic. The file NGMAGZ . exe looks like the one for launching the
program.

Wine sees the fake_windows directory as the main Windows hard drive base.
This means that [ need to type the following to start my program:

wine "c:\\Program Files\\The Complete National
Geographic\\NGMAG2.exe"

Believe it or not, it works (see Figure 15-21)!  now have access to the data-
base of the entire history of National Geographic that I bought a number of

years ago, back when Windows 98 was the standard.

Pull out those old Windows 95 and 98 CDs and give them a try!
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In this part . . .

Fis part is where you reach out with Linux beyond the
confines of the operating system in order to dig more
deeply into its daily care and feeding. [ introduce you to
the Linux file system, starting from its low-level layout and
partitioning schemes, then adding media and formatting
disks, and continuing with the ins and outs of managing a
file system and sharing files and printers. Next, you find
out how to add software to Linux while dealing with
archives, using the Red Hat Package Manager (RPM), and
locating and using new software for your system.

Finally, it’s time to batten down the Linux hatches as you
explore what'’s involved in securing a system and keeping
things secure. Here, you cover everything from picking
secure passwords to updating your system and other soft-
ware to learning the drill necessary to keep your system
safe from security threats and compromise.




Chapter 16

DFOPBOOﬁecking Out the Linux
File System

In This Chapter
Discovering the root directory and subdirectories
Discerning partitions from directories
Adding removable media to the file system
Caring for your file system
Accessing shared files on Windows computers

I have an existential map. It has “You are here” written all over it.

—Steven Wright

One of the most frustrating things about learning a new operating system
can be figuring out where it keeps files. Rather than keep all important
system files in a single directory, such as the C: \Windows directory in Microsoft
Windows, Linux follows the lead of its Unix cousins and spreads things out a bit
more. Although the Linux and Windows setups involve different methods, they
are both logical. They also both require that you understand where to look.

Another issue you come across is adding new media — hard drives, floppy
disks, CD-ROMs, DVD-ROMs, zip disks, USB keychain and thumb drives, and
more — to the existing file system. In this chapter, | focus on how the file
system is organized and other handy topics, such as how to access data on a
floppy disk.

Introducing the Linux File System

Linux may be all by itself on your hard drive, or maybe it’s sharing your hard
drive with another operating system, such as Microsoft Windows. All the
hard drive space you allocated for Linux during the installation process is
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your Linux file system. Because you're running your own Linux machine, you
must be familiar with how it’s put together — especially the sections that are

dakgs to mess with!

The Linux file system is deeply layered; it consists of lots of directories and
subdirectories. Most of the internal information in an operating system, such
as Microsoft Windows, is hidden away in the Windows directory. In Linux,
however, this information is scattered around a bit wider and for good
reason: Lots of files are involved! After you come to understand Linux, how-
ever, you see that it maintains a logical order to where it keeps things.

Meet the root directory

Everything in the Linux file system is relative to the root directory, which is
referred to as / and is the file-system base, a doorway into all your files. The
root directory contains a mostly predictable set of subdirectories. Each dis-
tribution varies slightly, but certain standards exist to which they all con-
form. The standards keep us all sane.

Rather than flood you with everything at once, I start by talking about just
the items that are directly off root. Table 16-1 lists the standards and some of
the more common extras. An asterisk (*) at the end of a description indicates
that you shouldn’t mess with this directory unless you have a specific reason
because it contains files that are very important to the functioning of your
system.

Table 16-1 Standard / Contents in Linux
Directory  Contains

/bin The commands that everyone needs to use at any time*

/boot The information that boots the machine, including your kernel*
/dev The device drivers for all the hardware that your system needs to

interface with*

/etc The configuration files that your system and many of its software
packages use*

/home The home directories for each of your users

/11ib The code that many programs (and the kernel) use*
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Directory  Contains

mnt The spot where you add temporary media, such as floppy disks and
DropBoO0KS e
LB S\ 4
/opt The location that many people decide to use for installing new soft
ware packages, such as word processors and office suites
/root The superuser's (root user’s) home directory
/sbin The commands the system administrator needs access to*
/tmp The place where everyone and everything store temporary files
/usr The programs that machines can share between them
/var The data that changes frequently, such as log files and your mail

Some of these directories have some equally important subdirectories, so |
dig a bit deeper now.

Meet the /etc subdirectories

Although the exact subdirectories that exist in /etc can change from distrib-
ution to distribution, the following two are fairly standard:

v The /etc/X11 directory contains configuration details for the X Window
System (X), which runs your Graphical User Interface (GUI). See Chapter
12 for more on the GUI.

v The /etc/opt directory contains configuration files for the programs
in the /opt directory, if you decide to use it.

Meet the /mnt subdirectories

You may or may not have any subdirectories in /mnt by default. Typically,
however, you at least have the following:

v The /mnt/floppy directory is used for adding a floppy disk to your file
system.

v The /mnt/cdrom directory is used for adding a CD-ROM to your file
system.

In the “Adding Media to Your File System” section, later in this chapter, |
show you how to add these items.
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Meet the /usr subdirectories
directory is often referred to as its own miniature file system hier-

DropBook
p % is directory has lots of important or interesting subdirectories, as

shown in Table 16-2. An asterisk (*) at the end of a description indicates that
you need to leave that directory alone unless you have good reason to mess
with it — after you gain lots of experience with Linux and know exactly what
changes you need to make — so that you don’t accidentally alter something
your system needs in order to function correctly. An important thing to
remember about this segment of the file system is that many Linux users
often use /usr to store programs that can be shared with other machines.

Table 16-2 Standard /usr Subdirectories
Subdirectory Contents

/usr/X11R6 The files that run the X Window System*

/usr/bin The commands that aren’t essential for users but are useful*
/usr/games The games that you install on your system, except for those

that you can choose to place in /opt

/usr/include

The files that the C programming language needs for the
system and its programs*

/usr/1ib

The code used by many of the programs in this /usr
subhierarchy®

/usr/local

The programs and other items that you want to keep locally,
even if you're sharing everything else in /usr

/usr/shin

The commands that aren’t essential for administrators but are
useful®

/usr/share

The information that you can use on any Linux machine, even if
it's running incredibly different hardware from what this one is
running*

/usr/src

The source code that you use to build the programs on your
system

Partitions versus Directories

One very important thing you must understand about the Linux file system is
that it may not all be on one single hard drive or hard drive partition. If you
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have dealt with this point during the installation, you probably already know
it. But maybe you have sidestepped this issue by using one of the installation

Ol that does things for you automatically.

What is really liable to confuse people is that partitions and directories tend
to blend together. In the Microsoft Windows world, if you use separate hard
drives or partitions, you have a specific letter designation for each one. The
primary hard drive is C, the next is D, and so on. Under Linux, each of these
drives and partitions quietly blends together.

If you partitioned your hard drives on your own, you know that you needed

to specify a mount point — which is like an empty spot in a puzzle, where the
outside partition or media can be plugged into the rest of the file system — for
each partition. In the case of a hard drive partition, the mount point isn’t in the
/mnt part of the file system. It’s an item in the root directory — maybe /boot
or / or /usr. You literally attach permanent items, such as hard drives and par-
titions, right into the file system. Linux doesn’t want to know or doesn’t care
about whether the directories or files are all on one drive or are on multiple
drives. It just wants to do its thing. Don’t worry: You do have reliable designa-
tions that are related to where in the scheme of hardware you can find your
drive. See Table 16-3 for a breakdown of popular designations.

Table 16-3 Common Drive Designations

Designation Description
/dev/cdrom CD-ROM drive
/dev/fd0 Floppy drive 1
/dev/fdl Floppy drive 2
/dev/hda First IDE hard drive

/dev/hdal First IDE hard drive, first primary or extended partition

/dev/hda? First IDE hard drive, second primary or extended partition

/dev/hdb Second IDE hard drive

/dev/hdbl Second IDE hard drive, first primary or extended partition

/dev/hdb? Second IDE hard drive, second primary or extended partition

/dev/sda First SCSI hard drive

/dev/sdal First SCSI hard drive, first primary or extended partition
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Linux see USB devices as SCSI devices. After you plug in your USB keychain or
thumb drive, you can add it to the filesystem with the designation /dev/sdal.

D ro p G)kgably see a pattern by now. A hard drive has a three-letter designation:

v An IDE drive’s designation starts with /dev/hd; the first drive of this
type is a, the second is b, and so on. The third IDE drive looks like this:
/dev/hdc.

v A SCSI drive’s designation starts with /dev/sd; the first drive of this
type is also a, the second is b, and so on. The third SCSI drive looks like
this: /dev/sdc.

The number that follows the three-letter designation represents your parti-
tions. I cover partitioning your hard drive in Chapter 2.

In Figure 16-1, I break down this concept, hopefully making it a bit more
accessible. In this case, the user created three partitions for Linux. The first
IDE drive is a single partition, allocated for the root partition. The second
IDE drive is broken into two partitions. The first was given /usr; and the
second, /var.

Windows Linux
A: Floppy /mnt/floppy | Floppy
B: CDROM /mnt/cdrom| CDROM
First IDE c: /dev/hdal First IDE
drive ' / drive
|
Figure 16-1:
Linux versus SﬁcDoEnd D: £ /dev/hdb1 | /dev/hdb2 S"lg"E”d
Windows in - ’ ’ Jusr /var .
. drive drive
handling
partitions First Second First Second
and hard partition partition partition partition
drives.
|

If you move around the file system, you can’t tell which of these directories is
on which drive. The prompt, for example, doesn’t change based on which
drive each directory is on; the commands used for moving around the file
system don’t care about the underlying hard drive or drives.
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gi(Media to Your File System

tss in /mnt, such as /mnt/floppy and /mnt/cdrom, are temporary
media — disks you must add to the file system if you want to work with them
and then remove them after you’re done. Although this task may sometimes
be done automatically (some distributions — including Fedora Core 1 —
have tools in the GUI that automatically mount a CD-ROM after you close the
drive), you often must mount a CD-ROM manually. But you can pretty easily
do it as outlined in the following section.

Adding media temporarily

Rarely do you want to keep removable media (floppy disks, CD-ROMs, and
even Zip disks) always in the drive. Even if you do, you probably don’t always
want the same disk, so you need a way to tell Linux that you have inserted
removable media and where. You can do so by using the mount command at
the command prompt or in a command-prompt window in the GUI by follow-
ing these steps:

1. Make note of whether you're trying to access a floppy or a CD-ROM.

The newest Linux distributions have a handy feature that automatically
mounts a CD-ROM after you place it in the drive — if you’re in the GUI.
Although not all distributions have this feature, the one I include with
this book does. When a CD-ROM, floppy disk, or hard drive is mounted,
the contents of the media are then accessible to Linux.

2. If the media is a floppy, type Is /mnt/floppy; if the media is a CD-ROM,
type Is /mnt/cdrom.

If the directory doesn’t exist, you need to create it. If you're not sure about
the existence of the directory, navigate to the /mnt directory and use the
1's command to display the contents. To create a directory, use the mkdir
command as follows: mkdir /mnt/Tocation (specifying the location).

3. If it’s a floppy disk, make note of the operating system the disk comes
from.

Table 16-4 shows which operating system corresponds to which type
label.

4. Put the command together in the following format, and at a command
prompt, type the command:

mount -t type /dev/device /mnt/location
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You need to replace italicized words with specific information. To mount
a floppy disk that you put together under Windows XP, for example, type

iq line:
DrOpBOO kSmt -t vfat /dev/fd0 /mnt/floppy

A\

\NG/
vg\\\

\\J

where fd0 is the type of device. (USB keychains and thumb drivers also
tend to come pre-formatted with vfat.) fd0 is the way Linux refers to
the floppy drive — sort of how Windows refers to the floppy drive as A:.
fd0 and A: are part of the operating system definitions.

Table 16-4  File System Types That Your Floppy Disk Can Contain

Type Description

ext2 Linux

msdos Windows 3.11 or earlier
vfat Windows 95 or later
hfs Macintosh

If you’re mounting a CD-ROM, try using the command as follows:
mount -t 1509660 /dev/cdrom /mnt/cdrom

You may be able to use just mount /mnt/cdrom in some distributions. For a
Linux floppy disk, you can skip the type stuff and just try mount /mnt/floppy
ormount /dev/fd0 /mnt/floppy.

To remove the CD-ROM or floppy disk from the file system, type this line:
umount /mnt/lTocation

Do not remove a floppy disk without correctly unmounting it, or else you may
wind up with missing data! Although you don’t need to worry about losing
data with CD-ROMs, you often can’t remove the disk until you unmount it. And
you can’t unmount an item if you're already in it, so make sure that you’re not
anywhere in its directories before you attempt to unmount the media.

If you have both Windows and Linux set up on your computer and can boot
from either operating system (a dual-boot setup), you can mount your
Windows partition while you're in Linux! This technique is a great way to
transfer files back and forth, if you need to. See your distribution’s documen-
tation for information about mounting a Windows partition.
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Formatting disks

D ro p B O QK‘ disk often comes as a blank slate or formatted for Windows or
@)

h use. If the disk is a blank slate, no computer can use it for any-

thing. No computer running any operating system can store data on a blank
floppy disk. A disk must have a file system on it to store information within
that file system’s format. That’s what formatting a disk is all about: building a
file system. You can either format a disk from the command prompt or use a
GUI tool to do it. [ cover both methods here in case you're not using GNOME,
KDE, or the graphical environment.

Formatting at the command prompt

To format a floppy at the command prompt so that Linux can recognize it as a
Linux disk, follow these steps:

1.

Place the floppy in the disk drive.

2. Type this line:

mke2fs /dev/fdO

Technical information about the information being written to the disk
scrolls past. After the light on the floppy drive turns off, you can either
eject the disk or mount it onto the file system (as I discuss in the section
“Adding media temporarily,” earlier in this chapter) and use it.

Formatting in GNOME

To format a floppy in GNOME so that Linux can recognize it as a Linux disk,
follow these steps:

1.

On the icon bar, click the Main Menu button.

In default GNOME and KDE setups, the Main Menu button in the lower-
left corner is a footprint in GNOME or a big K in KDE. If you installed
Fedora Core 1, the Main Menu button is the Red Hat fedora icon in both
GNOME and KDE.

. Choose System Tools~>Floppy Formatter.

The Floppy Formatter dialog box opens, as shown in Figure 16-2.

3. Place the floppy disk in the floppy drive.

4. Make sure that the File System Type drop-down list box is set to Linux

Native (ext2). (Refer to Figure 16-2.)

. Make sure that the Floppy Density drop-down list box is set to High

Density 3.5 (1.44 MB). (Refer to Figure 16-2.)
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File system type | Linux Native (ext2) -4 |

Volume name:

) Quick (only creates the filesystem)
(@) Standard (adds a low-level format to the quick mode)
() Thorough (adds a bad blocks check to the standard mode)

6. If you aren’t sure whether the disk is error free, make sure that the

Quick radio button is deselected.

Deselecting this option makes the formatting take longer. It may take a
minute or so to finish.

. Click the Format button to format the disk.

The Format Progress dialog box, with a progress bar, opens. After this
line fills in, the format is complete. Then the Floppy Formatted
Successfully dialog box opens.

. Click OK to close the Floppy Formatted Successfully dialog box.

Both this dialog box and the Format Progress dialog box close. Now the
Format Another Floppy dialog box opens.

. Click No if you’re done; click Yes if you want to format another floppy

disk and start the process all over again beginning with Step 3.

If you click No, the Format a Floppy dialog box closes along with the
Format Another Floppy dialog box.

Care and Feeding of Vour File System

Regardless of which operating system you’re using, you need to keep your
file system healthy and happy. Everything that you need to operate the
machine and do your work (or play) on it exists in that file system. Keep it in
good shape, and it’s sure to treat you well in return. Fortunately, Linux does
some of it automatically for you.
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Chectking the file system

D ro p B O q&gj’ you shut down your machine, you can use the - f option to skip

Figure 16-3:
Sample
output from
the df

command. |

stem check after the machine comes back up. Even if you do this
step every time, Linux enables you to get away with it only a set number of
times before it decides to take over and do a check anyway. However, I rec-
ommend not always using - f because you never know when a failure could
occur. Checking the file system costs you an extra minute or so in boot time,
although it can save you panicked hours of trying to revive a damaged
machine later.

You can also manually check file systems by using the e2fsck command:

1. Type df to see whether the item that you want to check is mounted.

The df command lists the mounted partitions and media in addition to
some statistics about them. You may, for example, see what’s shown in
Figure 16-3.

bl 1001@localhosi-

File Edit View Terminal Go Help

[root@ilocalhost root]# df

Tilesystem 1K-blocks Used Available Use’ Mounted on
/dev/hda2 5882276 2037908 3545560 37% /
/dev/hdal 101089 6222 80648 7% /boot
none 63078 0 63076 0% /dev/shm
[root@localhost rootl# I

2. If the item is mounted and not vital for using the system, such as a
CD-ROM full of pictures, type umount mount point (specifying a partic-
ular mount point) to remove it from the file system.

If you want to manually check a portion of the file system that’s vital for
the running of your Linux machine (/ and /bin, for example), you must
boot with rescue disks so that you can unmount these directories to
check them. (Rescue disks are special boot disks that you use in emer-
gencies, such as when your system isn’t booting correctly. Refer to
Chapter 5 for more information.) This task is a huge pain! Luckily, Linux
checks the directories that are crucial for the system while it’s booting
so that you don’t need to do so manually.

3. Type e2fsck /dev/device (specifying a particular device) to run the
check.

This step can take a while. Table 16-5 shows a few options you may be
interested in adding. If you decide to use an option, use the format e2fsck
options /dev/device (specifying any options and a particular device).
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4. Type mount /dev/device mount point (specifying a particular device
and mount point) to put the partition back in the file system if you

DrOpBOOkgtorneedtodoso.

Table 16-5 Commonly Used Options for e2fsck

Option Purpose

-f Convinces e2 fsck to check the file system, even if it tells you that
the file system has already been checked and declared clean

-n Answers No to all questions regarding whether things should be fixed

-p Repairs the file system without asking any questions; subsequently,

you can't see what has been done

-y Answers Yes to all questions regarding whether things should be fixed

Leaving spare room

One of the most insidious problems that all computer users run into from time
to time is a lack of disk space. The scope of this problem really depends on a
number of things. The primary issue is that, if your root partition becomes 99
or 100 percent full, you need to use emergency rescue techniques (refer to
Chapter 5) to boot the machine and clean it out. That’s no fun, is it?

In the beginning, you're probably not in danger of filling the drives, unless
you barely had enough room to install Linux in the first place. However, over
time, you may forget about watching the drives for remaining space. Even
experienced administrators run into this problem, so certainly you're for-
given if you do it too! Save yourself the worry and make sure that you know
how to get regular updates about how full all your partitions are. To access
the drive updates, follow these steps:

1. Log in to the account you tend to use the most.
2. On the icon bar, click the Main Menu button.
3. Choose Accessories->Text Editor.

The text editor displays the contents of your home directory.

4. Click the Open button. In the Selection field, type .bash_profile and
press Enter.

The contents of the .bash_profile are displayed in the text editor
window.

5. Use the mouse or the arrow keys to place the vertical insertion bar on
a blank line at the end of the file.
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6. Type df -h.

You really only need the df command by itself; the -h option refers to
D ro B O O an-readable, making the amount of space used and available easier
ou to read. For an example, see Figure 16-4.

Bo.6B& % ¢ =>bpdw

New Open Save Print Undo Redo Cut Copy Paste Find Replace

-bash_profile” x

# .bash_profile

# Get the aliases and functions
if [ -f ~/.bashrc ]; then

. ~/.bashrc
fi

I |4 User specific environment and startup programs

Figure 16-4: ||pars-spat: sHomE/bin
An example BASH_ENV=$HOME/ .bashrc

USERNAME="root"
of the
export USERNAME BASH_ENV PATH
.bash__ df -
profile
file in gedit.
[ .

Ln 15, Col. 6 NS

7. Click the Save button on the application’s toolbar.

8. To close gedit, click the X in the upper-right corner of the gedit
window.

The next time you log in to this account, and from then on, you get a list
of the space available and used on all mounted media.

Sharing Files by Using NFS

If you install multiple Linux computers on a network, you may want to share
a partition or section of the file system between two or more of them. You
can accomplish this by using the Network File System (NFS), which comes
with almost all Linux distributions by default. Fortunately, Red Hat Linux 10
comes with a GUI tool that helps you to set up this service.

Today, a common home use for NFS is sharing music files from CDs that you
purchased across multiple Linux computers. The rest of this section focuses
on this use as an illustrative example.
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NFS shared dirvectory

D ro p B O QK@eed to tell NFS to share the directory containing your music archive.
(o]

\\3

want to make this its own partition, or even a separate hard drive,

depending on how many users you actually have and how much space you
expect them to use. [ assume that the archive is in /home/bob/Music. Adjust
the directory accordingly for your needs.

Red Hat Linux offers a GUI NFS server configuration tool. See Chapter 17 for
how to use the software management system to add it.

To set up a shared directory, follow these steps:

1. Log in to the machine with the music archive as root.

2. Open the file /etc/exports in your preferred text editor.

This is the Network File System (NFS) central configuration file. By
default, it’s empty.

. Type this line:

/home/bob/Music networkaddress(rw,root_squash)

This line ensures that the /home/bob/Music directory and all its subdi-
rectories are sharable between all the computers in networkaddress. If
the outside computers access this share, they can both read and write
to their directories.

The format of networkaddress is important here. It can be any one of
the following:

¢ A single full IP address: You can have a copy of this line for each
individual machine if you want to allow it, rather than merge them
into one line.

¢ A single machine’s full name and domain information: This takes
the form host .domain.extension.

¢ All the machines in a domain: This takes the form *.domain.
extension.

¢ The entire network IP information: This takes the form network/
netmask.

Inside the parentheses, you set the rules for access. In this case, rw refers
to read-write access so that people can both play the music in this direc-
tory and save their own music files to it. The root_squash part means
that root can’t use this shared directory. Although you can remove this
item, you often should leave it alone. The root account has lots of high-
level permissions, and you want to limit its capability to move from one
machine to another as much as possible.

4. Save and exit the /etc/exports file.
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The exact method of exiting depends on which text editor you’re using.

. Reboot the machine.

D ro p B O O have other ways to apply the changes in the /etc/exports file, but

|
Figure 16-5:
An example
ofan /etc/
fstab
filein vi.
|

beginners — as do some lazy advanced users — often find rebooting
easiest. Doing so loads all the configuration changes you just made.

Permanently mounting a
remote NFS directory

In the preceding section, I tell you how to set up one of your Linux machines
so that your other Linux machines can access a directory by using NFS. In this
section, you tell the secondary machines where to find the shared directory.

Each Linux machine has a central file it uses to tell it what to mount on the
file system at boot time. This file also contains any shortcuts that may be on
your system for typing things, such as mount /mnt/cdrom rather than mount
-t 1509660 /dev/cdrom /mnt/cdrom. Within this file, you can tell your
machine to automatically mount the remote /home/bob/Music directory. To
accomplish this task, follow these steps on each secondary machine in turn:

1. Log in as root.

2. Open the file /etc/fstab in your favorite text editor.

This file may look something like what you see in Figure 16-5. Don’t let it
intimidate you, but don’t change anything unless you really understand
what it does.

3. Start a new, blank line at the end of the file.

[+

/boot
/dev/pts
/proc
/dev/shm defaults
/dev/hda3 swap swa defaults
/dev/cdrom /mnt/cdrom udf,is09660 noauto,owner,kudzu,r

cocopK
coconm

o
/dev/fd0 J/mnt/floppy auto noauto,owner,kudzu 0 0

/

Lat:/fstab" 8L, 621C 1;1 A1l

<
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4. Add the new line in the following format (and adjust for where your
music files are stored):

DrOpBOOK_ st :/home/bob/Music /Music nfs defaults 0 #

his line tells Linux to use NFS to go to the machine host (name or IP
address) and mount its /home/bob/Music directory as this machine’s
/Music directory with the same settings all the other drives have. The #
represents where in the mount order to mount the drive. Look in the last
column (with the padding spaces used in the file, the entries look like
they’re in columns) for the largest number and use one bigger. In Figure
16-5, for example, the largest number on the right is 2. You would use a 3
for # in this case.

5. Save and exit the /etc/fstab file.
6. Type mount -a to activate your new /etc/fstab entry.

Handle the boot process as you always do, making sure that you boot
into Linux. When you come back up, everyone should be able to change
to the /Music directory and enjoy its contents.

Accessing Shared Files on
a Windows Computer

If your Linux computer is on a network with Windows machines, you can
access files on the Windows computers across the network from your Linux
system. The only requirement on the Windows side is that file sharing is
turned on and at least one folder is shared. The user or administrator of the
Windows system determines which folders are shared, which enables their
contents to be accessed from another computer on the network.

To access a shared Windows directory from your Red Hat Linux 10 computer,
first create a user account on this machine for each person to whom you want
to allow access (refer to Chapter 6), and then follow these steps:

1. Choose Main Menu->System Settings—=>Server Settings.

If you can’t find an entry named Samba Server, you need add this pro-
gram (refer to Chapter 17) before you can proceed with these steps. If
you find an entry named Samba Server, continue to Step 2.

2. Select Samba Server.
The Samba Server Configuration program appears.
3. Click the Add button.
The Create Samba Share dialog box appears (see Figure 16-6).
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4. Click the Browse button, browse to the directory you want to share
with Windows users, and click OK after you have selected it.

5. In the Description text box, enter a brief description of what'’s in this
directory.

6. If you want Windows users to be able to make changes to this direc-
tory’s contents, select the Read/Write option.

7. Click OK to close this dialog box.
8. Choose Preferences~>Samba Users to open the Samba Users dialog box.
9. Click Add User.

The Create New Samba User dialog box appears (see Figure 16-7).

[ Create New Samba User

Unix Username:
Windows Username: ‘ |
Samba Password: ‘ |

Confirm Samba Password:

| 3¢ Cancel | ‘ & QK

L

10. In the Unix Username drop-down list box, select the login name for
the person you're giving access to.

11. In the Windows Username text box, enter the login name the person
uses to log in to their Windows box. If they don’t have one, leave this

text box blank.

12. In the Samba Password and Confirm Samba Password text boxes,
enter the password you want this person to use when accessing the

shared directory.

Chapter 16: Checking Out the Linux File System 30 1
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13. Click OK when finished.

his person’s Linux login is now listed in the user list.

T
D ro p B O OK u want to add another user, return to Step 9. Otherwise, click OK.

The Create New Samba User dialog box closes.

15. If you want to add a new directory to share, return to Step 3.
Otherwise, click the small X to in the upper-right corner to close the
Samba Server Configuration dialog box.

That’s it! The appropriate Windows users should now be able to access your
shared Linux directories. But what if you want your Linux users to view direc-
tories on your Windows boxes? Have I got a trick for you!

To browse the shared Windows folders on your network, open the Konqueror
Web Browser (see Chapter 9) and type smb:/ in the Location (URL) field.

The contents of the browser window display any devices found on your net-
work that are running the Windows file-sharing service.

To view the contents of the shared Windows folder, double-click the folder
icon in the Konqueror window.

If you want to copy any of the Windows files in the shared directory to your
Linux system, right-click the item in the browser window and choose Copy To
from the shortcut menu. Navigate through the locations displayed on the
menu to locate the destination. To cancel the Copy To selection, drag the
mouse off the menu and release the mouse button.
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In This Chapter

Recognizing tarballs, RPMs, and compressed files

Creating tarballs and archives
Compressing files
Opening tarballs, archives, and compressed files

Installing and removing RPMs

I will make you shorter by the head.
—Queen Elizabeth I

When you start using a new operating system, one of the most frustrating
things is trying to figure out all the goofy file extensions. The Windows

world has .exe and .zip. The Macintosh world has .bin and . hgx. What
about the Linux world? It certainly has its fair share of bizarre extensions; but,
really, they make a great deal of sense after you know the programs that make
them. In this chapter, you find out all about . tar, .gz, .tar.gz, .tgz, .bz2,
and . rpm. Anyone up for a game of Scrabble with alphabet soup?

Getting Tarved and Feathered

The Linux and Unix worlds are full of strange terms. If someone comes up to
you out of the blue and starts talking about tarballs, you probably get a mental
image of sticky, smelly balls of tar, maybe rolled in feathers. Yet a tarball is
something you run into regularly in the Linux world, especially when you're
looking for software or you need to save yourself some space. A tarball is a
bunch of files (and possibly directories) packaged together in a tar file and
then compressed by using the gzip utility.
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Thunder and tar-nation

D ro p B O Q gﬁne ago, in a galaxy far, far away, most data backups were done on
a

eS. Targe installations still use tapes, but this practice is getting more and
more rare among home users because users’ needs aren’t as complex as in a
corporate setting. The tar (Tape ARchive) program’s job is to grab a set of
directories and files and preserve everything about them, including their per-
missions, where they were in the file system, and more.

You have many more options these days for backups, but plenty of reasons
to use tar are still around. Trying to make a backup of your home directory
on CD? Want to have a single compressed file that contains all your word pro-
cessing documents? You use tar whenever you want to group a bunch of
files and directories into a single file.

More often than not, you need the tar command to open a file ending with
the . tar extension that you may have downloaded. To open a tar archive,
use the command in the format tar -xvf filename.For example, perhaps
you created the file mydocs . tar months ago and saved it to another drive so
that you could clear out space in your home directory. To restore these items
to your home directory, you must first type cd ~ (the ~ is a useful shortcut
for your home directory) to enter your home directory, and then type tar
-xvf mydocs.tar to see output similar to the following:

./docs/docl.txt
./docs/doc2.txt
./docs/doc3

Then, when you do a directory listing, you find that you now have a home
subdirectory named ~/docs that contains the files doc1.txt, doc2.txt, and
doc3. Some useful options to use with tar when dealing with existing tar
files are listed in Table 17-1.

Table 17-1 tar Extraction Options

Option Purpose

-f Operates on a specific archive file.

-k For a file that already exists in the same location, doesn't replace it
with the same filename from the archive.

-t Lists what is in the archive.

-V Gives verbose output, meaning that you see everything that's going on.

W Asks for confirmation before extracting each file.

-X Extracts files from an archive.
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Although you mostly need to open tarballs and tar files, from time to time
you want to create a tarball or a tar file. Usually, the format you use in this

i r -cvf filename.tar list_of_items,where filename isthe
he archive you want to create and /7st_of_items is a space-
separated list of the files and directories you want to package. For example,
if you want to archive only parts of your home directory, you can type tar
-cvf homefiles.tar docs data scripts, where docs (~/docs), data
(~/data),and scripts (~/scripts) are all directory names. Because you
include -v for verbose, you get a long list of every individual file that’s being
added. (I'm a bit paranoid and like to make sure that 'm adding what I really
want to add!) See Table 17-2 for a list of useful archive-creation options.

Table 17-2 tar Creation Options

Option  Purpose

=1 Operates on a specific archive file.

-k Doesn't overwrite the old versions of files if you're adding newer ones.

=P Doesn't just store relative path names (for example, ~/docs); stores
absolute path names (for example, /home/dee/docs).

=[F Adds files to an existing archive file.

-u Adds files to an existing archive file only if they're newer than their pre-
vious versions that are already in the archive; erases previous versions.

-V Gives verbose output, meaning that you want to see everything that's
going on.

W Asks for confirmation before adding each file.

-z Automatically gz1ips the archive to create a tarball.

If you want to check out an alternative to tar, type man pax to see another
powerful tool at your disposal.

qzip it up

Hard drives may be getting cheaper, but you always have to worry about run-
ning out of space. You're probably used to WinZip and all those . zip files out
there in the Windows world for compressing files for storage or sending

groups of files to other people. In the Linux world, you see lots of files that
end in .gz, for gzip.
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The gzip utility isn’t as tricky to use as tar. To compress a file, you type
gzip filename,and you end up with f77ename.gz. When you want to

ess a file, you use gzip’s cousin, gunzip, in the same manner. So, if
to open dogpic.gz, youtype gunzip dogpic.gz. The important

thing to know is that when you decompress a . gz file, the original file goes
away! So, you have no more dogpic.gz;just dogpic — though you also
could have named the file dogpic. jpg.gz so you could see which format the
image file was in. Be sure to make a copy of the compressed version if you
want to keep it around, although you can just make another one at any time.

Rolling the ball

Now that you know all about tar and gzip, what’s with all this talk about tar-
balls? As you may imagine, a . tar file can get pretty big with all those individ-
ual files and directories in it. Typically, after you archive something, you then
compress it. You may have even noticed an option in Table 17-2 (the -z option)
that allows you to compress your archive automatically after it’s created.

Red Hat Linux comes with a program named File Roller that enables you to
work with tarballs in a GUI. Click the Main Menu button to open the Main
Menu and then choose AccessoriestFile Roller.

In default GNOME and KDE setups, the Main Menu button in the lower-left
corner is a footprint in GNOME or a big K in KDE. If you installed Fedora Core 1,
the Main Menu button is the Red Hat fedora icon in GNOME.

To create a tarball, you first tar the items you want to archive, and after that
action is completed, gzip the resulting archive file. Suppose that you want to
save all configuration files in /etc, just in case something bad happens. Make
sure that you're logged in as root for this one; you need read permissions for
every file in /etc, and not all the files in /etc are accessible to general users.
(Aren’t you glad?) An alternative is to utilize tar’s -z option, as mentioned
earlier, in a format such as tar -cvfz etcbackup.tgz /etc. (Yes, that’s
.tgz —it’s shorthand for .tar.gz.)

WinZip can open tarballs with no problem on a Windows box!

When it’s time to open a tarball, you first gunzip it and then un-tar it —
oops, that can get confusing because there is no untar command. To open
etcbackup.tgz, you first type gunzip etcbackup.tgz, which leaves you
with the file etcbackup.tar. Then, you type tar -xvf etcbackup.tar.
You should be aware of one little issue, though. When you unpack a . tar file,
it typically creates all its subdirectories, starting wherever you are. So, if you
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have etcbackup.tgz in your home directory, when you unpack you end up
with the directory ~/etc, containing the entire archive’s contents.

O Sn’t sure about the file’s internal structure, you can check by typing

tar tvf filename.tar | more.

You can also use the shortcut tar -xvfz etcbackup.tgz and skip using
gunzip.

bzip2, the gzip alternative

There’s a new kid on the block when it comes to compressing files in the
Linux world. That kid is bzip2. You use this program exactly the same way
you use gzip, except that its files have the extension .bz2. To compress
mysong.mp3 using this (usually) more efficient program, you type bzip?2
mysong.mp3 and get the file mysong.mp3.bz2. To uncompress it, you use
bunzip?2, so you type bunzip2 mysong.mp3.bz?2.

You can also use this command in conjunction with tar to create files ending
in .tar.bz2.l haven’t seen any “B-Balls” with a . tbz2 extension yet, but I
suppose that it’s only a matter of time.

Revving Your RPMs

For a long time, keeping track of what was installed on your Linux machine
was a bit of a nightmare. Problems cropped up especially when the time
came to install new software. If a program relied on a specific version of
another tool to be installed and didn’t work because you didn’t have that
tool, you could spend ages trying to figure out what the problem was.

Red Hat to the rescue! The folks at Red Hat Linux wrote the Red Hat Package
Manager (RPM), and a number of other high-profile Linux distributions now
include this tool. You can tell a file that’s meant for use with the package man-
ager by its . rpm extension. What makes RPMs so special? An . rpm file con-
tains more than just the package itself: This type of file also holds information
about the package it contains, which other packages it depends on, and more.

When you install an RPM (or when the installer adds it during the installation
process), the additional package information is added to a central RPM data-
base. Your system knows exactly which software you have, which packages
are dependent on which other packages, and other information.
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Manually working with RPMs

D ro p B O QKSwith RPMs on the command line can seem daunting at first, espe-
idlly'1

A\

ou type man rpm and look at the help materials. So many options!
Don’t worry, though: You need to know only a short selection of the available
options. The remaining options are things you can experiment with later —
after you feel that you have the basics down.

Installing an RPM by hand

The most common RPM task is installing a new package, which you do by
typing rpm -ivh packagename (where i refers to Install, v means Verbose,
and h means Hash, or to show progress with  characters). If your system
doesn’t have the necessary items for this program to run properly, you see
an error message identifying the name of the package you need or the name
of the file. The important thing is usually the version number. The file gnome -
lTinuxconf-0.65-1.1386.rpmrefers to the program gnome-1inuxconf, ver-
sion .65-1 or maybe .65.1, for a personal computer.

If you type rpm -ivh gnome-1linuxconf-0.65-1.1386.rpm, it may go just
fine (in which case, you see a line of hash marks (#), and then you return to
the command prompt), or you may see the following error message:

Error: failed dependencies:
linuxconf >= 1.17 is needed by gnome-Tlinuxconf-0.65-1

This error message tells you the following information:

v The package gnome-Tinuxconf requires the 1inuxconf package to be
installed before it can properly be installed.

v The version of 1inuxconf that needs to be installed is 1inuxconf-1.17
Or newer.

Installing a new version of an RPM you already have? You type rpm -Uvh
instead. The U stands for Update, and the vh portion is identical to that of ivh.

Checking your RPMs by hand

Sometimes, you need a bit of information. Similar commands exist for getting
data about RPMs that are already installed and those that aren’t installed yet.
The main difference is the option -p — yes, p, which stands for package.
Think of it this way: If you don’t have the RPM installed yet, you have to open
its packaging first. If you do have it installed, you don’t have to deal with any
packaging.

To read the informational blurb about an RPM you haven’t installed yet, you
need to find out about yet another RPM option, -1i. This option enables you to
read the “about” information stored in the RPM. If you want to see this infor-
mation for a package that you haven’t installed yet, you type rpm -qip
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full_package_name from inside the directory where you have the file. For
example, you may type rpm -qgip gnome-Tinuxconf-0.65-1.7386.rpm. To

Ge i lgnation about a package that’s already installed, you don’t need the -
[

ntion earlier, so you use rpm -qi short_package_name (for exam-
ple, rpm -gi gnome-Tinuxconf).

Notice that if you already have the package installed, you don’t use the ver-
sion number, type of machine, or file extension.

You can also see which files a package installs in the same type of format. To
see a list of files that a package (that you haven'’t installed yet) will add, you
use rpm -qlp full_package_name. With an installed package, you type rpm
-ql short_package_name. So, youuse rpm -qlp gnome-Tinuxconf-0.
65-1.1386.rpm before installation and rpm -q1 gnome-Tinuxconf after. The
file-listing component is quite handy if you're looking for a configuration file!

You can see a list of every RPM you have installed by typing rpm -qa, where
the -a option stands for all (and tends to be used in conjunction with only a
few other options, such as -q for queries). A number of packages are out
there; type rpm -ga | more so that you can look at just one screen at a
time. On the other hand, if you're curious about whether you have a particu-
lar package installed, type rpm -q short_package_name.

Removing an RPM by hand

One of the best things about RPM is its ability to remove an application com-
pletely. When you remove an application RPM, you can be sure that you
removed all of the application files, except perhaps for configuration files it
may create backups of, just in case you need them later. To delete an RPM
from your file system and the RPM database, you type rpm -e short_
package_name.

Package point-and-click

Hate working on the command line? No problem! Red Hat provides a point-
and-click package-management tool for Fedora Core 1. Click the Main Menu
button, and then choose System Settings>Add/Remove Applications to open
the program shown in Figure 17-1.

If you're not using Red Hat Linux 8.0 or later (Fedora Core 1 is considered
“later”), you don’t have this tool. Instead, look for GnoRPM or Kpackage,
depending on whether you're using GNOME or KDE or your own distribu-
tion’s custom package manager.
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X Window System 32 of 34 installed Install

7| Install this group of packages to use the base graphical (X)
user interface.

GNOME Desktop Environment 35 of 35 Installed

e GNOME is a powerful, graphical user interface which
‘@ includes a panel, deskiop, system icons, and a graphical fle
manager.

KDE Desktop Environment 14 of 16 installed Install

5c’;< KDE is a powerful, graphical user interface which includes a
T panel, desktop, system icons, and a graphical file manager. ‘

| Applications
Figure 17-1: Editors Jofainstalled  Install
Sometimes called text editors, these are programs that
The Red Hat @ allow you to create and edit files. These incude Emacs and
Vi.
PaCkage Engineering and Scientific 0 of 7 installed Install
_ This group includes packages for performing mathematical
manage < and scientific computations and plotting, as well as unit
ment tOOI in conversion.
G NOM E Graphical Internet 8of 14 installed Install
* #__This aroun includes aranhical email Wah_and chat clients. ¥
Total install size: 1,983 MB
I

The Package Management tool is arranged in themed groups, as you can see
in Figure 17-1. Next to each group, you see a total, such as 32 of 34
installed. This line means that not all options in this particular group have
been installed. You can click the Install link to the right to take a look at
what’s left in this group (see Figure 17-2), and then check the boxes of any-
thing in that group that you want to add to your machine.

A package group can have both standard and extra package

I members. Standard packages are always available when the &

package group is installed.

Flgure 17-2' Select the extra packages to be installed:
The Red Hat Package Information Size |
Package > Installed Packages
manag e- redhat-config-printer-gui - A GUI frontend for nnrwtcunf. 512 KB
redhat-config-samba - Samba server configuration tool 484 KB
ment tOOl’S redhat-config-securitylevel - A graphical interface for modifying the system security level 156 KB
|nSta|| redhat-config-services - redhat-config-services is an initscript and xinetd configuration utility. 296 KB
¥  Packages not installed
Sel‘ver [redhat-config-bind - A Red Hat DNS configuration tool. 1MB
Configu_ [Iredhat-config-httpd - A araphical configuration tool for the httpd Web server. 1MB
[ redhat-config-nfs - NFS server configuration tool 288 KB
ration Tools [ redhat-switch-mail - The Mail Transport Agent Switcher for Red Hat Linux 120 KB
Packages [l redhat-switch-mail-gnome - A GUI interface for Mail Transport Agent Switcher. 5268 |
[ redhat-switch-printer - The Printing System Switcher for Red Hat Linux 132KB |[+]
dialog box.
3% Cancel | ‘ Install Packages
I
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To install or remove a package, follow these steps:

| n the package manager (if you haven’t already) by clicking the
ro p O O Menu button and then choosing System Settings=>Add/Remove
Packages.

Q&N\BEB
& In default GNOME and KDE setups, the Main Menu button in the lower-left

corner is a footprint in GNOME or a big K in KDE. If you installed Fedora
Core 1, the Main Menu button is the Red Hat fedora icon in GNOME.

2. Select Install Software if you want to add, or select Remove Software
if you want to delete.

3. Click the Install or Remove link to the right of the package group con-
taining the item you want to work with.

The Remove dialog box shows only one list of packages. In the Install
dialog box are two sections: Installed Packages and Packages Not
Installed. Use the check boxes to pick and choose the packages you
want to add or remove, depending on what you’re trying to do.

4. Click Install Packages or Remove Packages to close the dialog box and
begin the package installation or removal.

The program walks you through the addition or removal process. First,
the tool makes sure that either you’re not removing something another
program depends on, or that you have added anything this new program
depends on. Then, you’re directed to insert the DVD-ROM into the drive
as necessary.

5. Return to Step 2 if you're not finished removing and installing packages.

6. Click Update to proceed to the installations and removals you’ve
requested, and then click the X in the upper-right corner to close the
dialog box.

Updating YVour Machine

Red Hat Linux includes a tool called up2date, which allows you to see what
new versions of your software might be available, and can then automatically
get and install them for you. You can find this tool in you GUI on the right
side of the panel, next to the date. The icon is a round button that has three
different apppearances, as follows:

v Blue with a check mark — nothing new is available.

1 Red with an exclamation point — there are updates available.

v Green with aarows pointing left and right — the ool is in the process of
synchronizing with the update servers.
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More often than not, the updates include fixes for bugs or security issues.
Exploring this tool is highly recommended if you want to keep your Linux

DropBooks™
Finding New Software

\\J

One of the fun things about a new setup is hunting down software to add to
it. The best place to start is usually right there on your distribution medium
(DVDs, usually). You know that everything on there is compatible with your
system. From there, you're smart to go to the distribution’s Web site, such as
www.redhat.com, www.suse.com, or wiw.mandrake.com. There, you can
find updated versions of goodies you already have, security fixes, bug fixes,
and more.

Looking for a specific piece of software? Do a quick Web search to see
whether it has a home page. It’s the safest bet, and you get the latest version.

After you start venturing into the big, bad world, you need to be a bit more
careful. Although viruses, worms, and other nasties aren’t as prevalent in the
Linux world as they are in the Windows world, you still don’t want to be
sloppy. If you're not careful, you can download a tampered version of a pro-
gram, and then you may end up in a world of hurt! [ have compiled a list of
places to start when you’re looking for new software:

v www.rpmfind.net
¥ linux.tucows.com
¥ www.zdnet.com

This list isn’t as short as you think after you get started digging. Also check
out Chapter 2 for more options. Enjoy!
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DrOpBOOkE Secure Linux Box Is
a Happy Linux Box

In This Chapter

Implementing strong passwords

Keeping your system up to date

Plugging security holes

Using the System Logs Viewer

Securing your system by using best practices

I am Inspector Clouseau, and I am on official police business.

—Inspector Clouseau

Security is a buzzword that you can’t escape. Anywhere you read about
the Internet, you see reports of break-ins, threats by new viruses, and
dire warnings about the security of your systems. In some ways, this hype is
necessary to keep people on their toes. The biggest problems you get with
security — whether it’s in your home, at work, or on a computer somewhere —
happen when you get lazy.

You don’t leave the front door of your house open when you go to work, do
you? How about leaving it shut and locked but with a few nice, big windows
open? The problem is that many people do this every day with their comput-
ers, and they don’t even know it! In this chapter, I take a look at where your
open doors and windows are and what you can do to secure them.

Every user’s actions affect your overall system security. If your family mem-
bers or officemates need access to your Linux machine, take the time to sit
down and explain the facts of secure life to them. They can then apply this
information to the other computers they use, because these issues aren’t
specific to Linux.
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Choosing Secure Passwords
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'gline of defense from intruders is the collection of passwords used on
your system. For each account you have set up on your system, the passwords
must be strong and difficult to figure out. If even one of the accounts has a
weak password, you may be in for some trouble. Amazingly enough, in 70 per-
cent of the cases where unauthorized individuals gained access to systems,
the password for an account was the word password itselfl When choosing
good passwords, follow these rules:

» Don'’t use any part of your name.

v Don’t use the names of friends, loved ones, or pets.

v Don’t use birthdays, anniversaries, or other easily guessed dates.
v Don’t use dictionary words.

v Don’t keep your password written down near your computer, unless it’s
buried in something else, such as writing it into an address.

v Don’t tell anyone your password. If someone needs to access specific
files, give the person an account and set up permissions and groups
properly so that they can do so.

v Do use a mix of lowercase letters, capital letters, and numbers.
v Do ensure that your password contains a minimum of eight characters.

v Do use acronyms made from sentences, such as having the password
MB8yodniT to stand for “My eight year old dog’s name is Tabby.”

Every person on your system needs to follow these rules, including you!
Consider keeping a sheet of paper with these rules on it next to the machine.

[ can’t stress this advice enough: Never give out your password. Make sure
that the people using your machine understand this rule. You can always find
alternative methods to accomplish a task without giving out your password.
If someone wants to use your machine, make an account for that person. Then
they can have their own password!

Updating Software

All users can download and install new software. Of course, the programs

they install are limited to the user’s own permissions. The thing to be careful
of here — with any operating system — is that you don’t get a version of a
program that has been tampered with or is even an all-out fake trying to trick
folks into installing it.
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Most Linux applications and other Linux software programs are distributed
by way of the Internet. In fact, the development cycle of new (and updates to)
i tware revolves around the Internet for file exchange, e-mail, and

D ro p B O G newsgroup discussions. Make sure that you and other users of your
Linux system are comfortable with the Web sites that are used and visited.
You need to develop a list of trusted sites that provide you with the informa-
tion you need and are not misleading in their presentation. As a starting point,
you can frust all the Web sites referenced in this book because I have accessed
them all. If either you or a user of your Linux system is unsure whether you
can trust a particular Web site, do some research and perhaps ask others for
their opinions.

Plugging Security Holes

As the person in charge, your job is to make sure that this computer stays
intruder-free. In addition to making sure that you do all the same things a
user would do for both your user accounts and the superuser (root) account,
no matter which Linux distribution you’re running, you must keep up-to-date
with security problems.

Every operating system has security issues. You can’t escape them. The people
who manage to avoid break-in problems are those who stay informed and
apply fixes whenever they appear. Almost all Linux distributions offer the abil-
ity to find out about and grab fixes. If the instructions aren’t in their docu-
mentation, they’re on the distributors’ Web sites.

In the case of Fedora Core, you have the Red Hat Network (RHN) icon in the
lower-right corner of your panel as discussed in Chapter 17. One of the major
reasons your RHN icon turns red is for security updates. Be sure to install
these!

\\3

When you get a warning message — or find one on a Web site — about a par-
ticular piece of software, keep the following questions in mind:

v Are you using this program? You potentially can receive warnings
about everything that comes with the distribution. You can determine
whether the warning pertains to you in a number of ways, depending on
the distribution and the package. A quick way of telling whether you're
using a program is to type man program, where program is the name of
the application. If the package is installed, you see the help information
for it; the help information isn’t installed unless the program is.

1 Are you using the same version of the program you’re being warned
about? You may be using an older or newer version. You have to read the
warning message carefully to see what range of versions it covers. If it
doesn’t mention one, you should assume that the warning applies to
you too.
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v Consider the source. If your warning came directly from your distribu-
tion’s security mailing list or from a well-known, trusted security Web

i#, then this is something to heed. However, if it’s just a forward from a
ro p O O d, take it with a grain of salt.

\\J

Although you can’t plug some holes until you find them — such as the items
pointed out in security notifications — others come prepackaged. The nat-
ural thing to wonder when you’re reading about a known security hole in the
shrink-wrapped version of a Linux distribution is, “Why, if they’re known
holes, are they not plugged up in the first place?” It’s a good question. The
answer is that the people building the Linux distributions don’t know exactly
what you, in particular, want to do. They do their best to meet the security
needs of average users, which isn’t exactly right for everyone. But rest easy
because this issue is much easier to deal with than you may think.

Mandrake and SuSE also offer update e-mail lists and software update tools.
Check their Web sites and documentation to find out more!

Network holes

On a Linux server or workstation, you must not have any network services
running that you don’t intend to use. To understand why, you first need to
comprehend a bit about how these services work. Every network service lis-
tens to an assigned place leading to the outside world. For example, if you're
running a Web server, it’s listening to port 80. You can think of a port as an
apartment number. Whenever a person wants to look at one of your Web
pages, they point their browser toward your Web server, typically named
something like www.mywebserver.org. This name represents the street you
live on. Along with a name, this server also has an IP address, which is some-
thing like 172.16.3.9. This number represents the street address assigned
to your apartment building. The apartment building is full of doors leading to
various network services. Apartment (port) 80 always leads to the Web
server — unless you set yours up differently. (Don’t change the port unless
you want people to have a hard time getting to it.)

You can see in the /etc/services file which port corresponds to which net-
work service.

You can have a certain amount of security protecting each port, just like an
apartment door. You may have just a bit of security, like a normal key lock. Or,
you may have a deadbolt, a combination lock, and other gizmos protecting the
point of entry. This is where the metaphor begins to break down, though.
You're not likely to decide that a particular apartment can’t have anyone going
in or out. With a computer’s network services, however, this situation is
important to consider. If you don’t run an FTP server, for example, having
ports 20 and 21 functioning just provides more doors through which poten-
tial intruders can attack.
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Linux manages incoming connections in two different ways. The first involves
individual programs. You can control these by using the tools I describe in

in, “Software holes,” later in this chapter. The second method of
ro p O g incoming connections, however, involves a central program that

|
Figure 18-1:
The Red Hat
Linux
Security
Level tool.
|

NG/
&

watches many ports. This program then answers the door when a network
client — maybe an FTP client — comes knocking and starts the program that
handles the service.

Red Hat, Mandrake, and SuSE Linux all come with security settings you can
adjust both during and after installation. In Red Hat Linux 10, you can access
this tool by choosing Main Menu=>System Settings=>Security Level to open the
tool shown in Figure 18-1.

2 Security Level Configuration [=1=]=]

Bl
LE.L,JE'_ Please choose the security level for the system.

R

Security level: ‘ Enable firewall

|
1 WWW HTTP) |
O FpP
Trusted senvices: |[] SSH
[[] Telnet
[ Mail (SMTP)

[ ethd |

Trusted devices:

‘IganmlH o OK |

Your options are Enable Firewall and Disable Firewall. If you have your com-

puter directly connected to the Internet — and most computers are — make
sure to use Enable Firewall. The only time that you should not have this fire-
wall is place is when your machine(s) are behind a strong firewall already, or
you have a critical application that won’t work otherwise. For just one appli-
cation, though, that’s one huge risk!

These strategies work for any firewall, including the ones available in
Mandrake and SuSE.

To poke holes in the firewall, you need to work with the lower two sections

of the dialog. After you have done this, you have access to two different
boxes with options. Do not select as a trusted device the hardware that connects
you to the Internet! If you do, you may as well not bother using a firewall! On
the other hand, if you have a modem connecting you to the Internet and an
Ethernet card connecting you to other machines in your house, you can select
the Ethernet card and mark it as Trusted if you trust the folks in your house.

317
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If those people have sloppy security on their internal machines, however, you
may not want to make them trusted either.

Q tgapproach is to use the Allow Incoming check boxes. If you set up a

Web server on your machine and want to let people access it, select the check
box next to WWW (HTTP). The same advice applies if you have set up an FTP
server (in this case, you want to select the FTP check box) or if you're trying
to let someone connect securely via SSH (select the SSH check box) to your
computer. I talk more about SSH in a moment. If you want to receive e-mail,
you definitely need to select the Mail (SMTP) check box to allow it.

When you’re done fiddling with your security options, click OK to activate
them and close the dialog box.

The Secure Shell game (SSH)

One cool thing about Linux is that you can connect to your account from any-
where, as long as you have the right software (and the machine you're connect-
ing to isn’t behind some kind of corporate firewall). Most people tell you to use
the telnet program to do this, but I beg you not to. Do not open the Telnet
port in the security tool, and do not use the telnet program. It sends infor-
mation across the Internet in nice, raw text that anyone can snoop through.

Before you can connect either in or out using ssh, you have to set up your
keys. These keys are complex bundles of encrypted stuff built around pass-
word phrases. Think of them as the extra deadbolt on the door to each of your
accounts, where the normal password is the regular lock. First you install the
deadbolt (analogous to creating your SSH keys) and then you use it (analogous
to logging in using SSH).

The cool thing is that Fedora Core is set up to do this for you so that you
don’t have to worry about it. All you have to do in Fedora Core 1 to enable
ssh-ing into your Linux box is read the section, “Network holes,” earlier in
this chapter, and select the SSH check box. (Doing this tells the firewall to
open up that steel door it has blocking any access to the network port that
SSH needs to use.) Save the changes and that’s it!

In order for someone to SSH into this machine from the outside, you’ll need
to know its name or IP address. The IP address is pretty quick to get. Open up
a command line terminal window and type /sbin/ifconfig. Ignore the section
labeled with 1o; this refers back to your own machine and is only used for
internal networking purposes. What you’re looking for is the part labeled
ethO. In that section, find the inet addr entry. What follows is your machine’s
[P address, in the format xxx.xxx.xxx.xxx; for example, 192.168.1.90.



Chapter 18: A Secure Linux Box Is a Happy Linux Box

Installing a Windows SSH program

set up to accept SSH connections, not just a Linux one — from a
computer, goto http://www.siliconcircus.com/penguinet/

If you want to connect to your SSH-enabled Linux box — or, actually, to any
1I:§$
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and get the PenguiNet telnet and SSH client for Windows. A 30-day trial ver-
sion is available, and if you like it, the full version is only around $25.

To install PenguiNet under Windows after downloading PN2setup.exe, just
follow these steps:

1.

Open your file manager (such as Windows Explorer) and double-click
the PN2setup.exe program.

This action opens the PenguiNet Setup Wizard.

. Click Next to proceed.

The License Agreement dialog box opens.

. After you read the agreement (something you should always do), click

I Accept This Agreement and then click Next to proceed.

The Select Destination Directory dialog box opens. [ usually just stick
with the defaults.

. After you select the directory in which to install PenguiNet, click Next.

The Select Start Menu Folder dialog box appears.

. After you select the proper folder, click Next.

The Select Additional Tasks dialog box appears. If you want to create a
desktop icon or Quick Launch button, select the appropriate check boxes.

. After you have chosen your additional tasks, click Next.

The Ready to Install dialog box appears.

. Click Install to begin your PenguiNet installation.

An installation progress dialog box appears. When the installation is fin-
ished, the final installation screen appears.

. Select one or both of the final items.

[ recommend that you check at least Run PenguiNet. You may also want
to select View the PenguiNet Documentation if you like to get familiar
with programs by reading their manuals.

. Click Finish.

The PenguiNet window appears (if you checked Run PenguiNet), as
shown in Figure 18-2.

319
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Setting up and making your SSH connection in Windows
Either you have PenguiNet open from having installed it, or you need to open
it now from your desktop shortcut or the Start menu. After you have done
this, follow these steps:

1. Choose Session~>Connection Profiles.

The Connection Profiles dialog box opens, as shown in Figure 18-3.

§ Connection profiles - PenguiNet

W Login |SSH |Aﬂpea[ance|’50gnd|input |Qpbons| .

gré Profile name [Default
Hast

Protocol |SsH =

Port |22

Terminsl type | Linux x| T utFs

Username
Password

[~ Confirm on conneckion

Send commands... |
ﬂ Add | M Clone: | ¥. Delete |
B350 Close Cancel |

2. Click Add to open a new profile.
3. Enter the name for this profile in the Profile Name text box.

4. Enter your Linux box’s IP address in the Host text box.
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5. Enter your Linux login name in the Username text box.

You cannot use the root account here. Doing so is terribly bad for security.
D ro p B O O K&r your Linux login password in the Password text box.
7. Click Connect to make the connection to your Linux machine.

The Host Key Not Found dialog box opens the first time you connect this
way. Click Connect and save the host key. You don’t have to do this step
again from this Windows machine. Check out Figure 18-4 to see a Linux
command-line interface window on a Windows box!

RETE]

Session Edit View Format Tools ‘Window Help

- Mo Ry =nddhE | Ba0e

| %192.168.1.6:22(55H2,
z = 3

|
Figure 18-4:
Your Linux
command
linein

Windows!
J F- laptop

When you're finished, type logout at the command line, and your connection
closes.

Connecting to your Linux box from another Linux box with SSH

Yes, you can connect from another Linux box, too. This task is a bit less com-
plicated, unless the ssh program isn’t already installed (it’s already installed
if this is another Red Hat Linux 10 machine). Follow these steps:

1. Type ssh ipaddress username to open the connection.

For example, type ssh 192.168.1.6 dee. After you do this step, the follow-
ing text appears:

The authenticity of host '192.168.1.6 (192.168.1.6)"
can't be established.

RSA key fingerprint is
ed:68:0f:e3:78:56:c9:b3:d6:6e:25:86:77:52:a7:66.

Are you sure you want to continue connecting (yes/no)?
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2. Type yes and press Enter.

You now see these lines:

DrOpBOOk@m’ng: Permanently added '192.168.1.6' (RSA) to the

list of known hosts.
dee@192.168.1.6"'s password:

3. Enter your login password and press Enter. Now you’re in!

Close the connection by logging out of the account (type logout).

Connecting to your Linux box from a Macintosh
running 0S X with SSH

The process from a Macintosh is similar to that under Linux. Go to
Applications=>Utilities=>Terminal.app, which opens a command line
window for you. Then type

ssh IPaddress
to access the same user account on the remote machine, or type
ssh login@IPaddress

if you want to access the account login instead of the same account you're
using on the Mac.

Software holes

When someone is already in your system — whether or not they’re allowed
to be there — you have additional security concerns to keep in mind. One of
these involves what software you have on the machine. Believe it or not, each
piece of software is a potential security hole. If someone can get a program to
crash in just the right way, they can get greater access to your system than
they should. That’s a very bad thing!

One way to close software holes is to remove all programs you don’t need. You
can always add them later, if necessary. How exactly you do this task depends
on the package-management scheme your distribution runs. The following
steps work at the command prompt in Red Hat and all other distributions
that use RPM.

To remove all programs you don’t need, follow these steps:

1. Type rpm -qa | more to see every package you have installed, a screen
at a time.
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The list that appears is probably a bit daunting! [ suggest that you not try
to review and delete them all at one time. Do a group of packages, and

be come back the next day and do another. The beginning of the list
ro p O O look like this:

\\J

|
Figure 18-5:
Information
about the
glibc
RPM.

mailcap-2.1.11-1
basesystem-7.0-5
chkconfig-1.3.6-2

You can also use the GUI package manager. (Refer to Chapter 17 for more
information.)

2. In another virtual console, type rpm -qi packagename for the package
you want to investigate, without the version number.

Detailed information about this package is displayed. For example, see
Figure 18-5 to see the dataon gl1ibc-2.1.91-18.1 got this information

by typing rpm -qi glibc.

@localho

File Edit View Teminal Go Help

[dee@localhost deel$ rpm -gi glibc

Name : glibe Relocations: (not relocateable)
(Version 2 Vendor: Red Hat, Inc.

[Release 227! Build Date: Mon 07 Apr 2003 04:29:45
PM PDT

Tnstall Date: Sat 19 Apr 2003 01:59:24 PM PDT Build Host: porky.devel.redha
t.com

croup : System Environment/Libraries Source RPM: glibc-2.3.2-27.9.sre.rp
n

Size : 11436759 License: LGPL

Signature : DSA/SHA1, Wed 09 Apr 2003 09:13:52 AM PDT, Key ID 219180cddb42a60e
Packager : Red Hat, Inc. <http://bugzilla.redhat.com/bugzilla> I
Summary : The GNU libc libraries.

Description :

The glibe package contains standard libraries which are used by
multiple programs on the system. In order to save disk space and
memory, as well as to make upgrading easier, common system code is
kept in one place and shared between programs. This particular package
contains the most important sets of shared libraries: the standard C
library and the standard math library. Without these two libraries, a
Linux system will not function.

[dee@localhost deel$

3. Read the package information and determine whether you need this
program.

[ know — sometimes, this is easier said than done. You may want to
make several passes through the list. Get rid of the obviously unneces-
sary programs first. After that, go through again when you understand
the system better and get rid of some more. Remember that you can
put programs back if it turns out that you need them.

4. If you don’t want or need this package, type rpm -e packagename to get
rid of it, where you designate the package name without the version
number.
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Although you probably don’t want to get rid of g11ibc (which is required
to help some programs run), stick with this example. Type rpm -e glibc

D r O B O O k t rid of that package.
p Seu see an error message telling you that this package is required

in order to satisfy dependencies, it means that other packages use this
package to function. You have to decide whether you want to get rid of
all the packages that need this package before attempting to delete the
original package.

[ know that this is an intricate process. You get to know quite a bit about your
system along the way, however, and the more you know, the better off you are.

Keeping an Eye on Vour Log Files
with the System Log Uiewer

One other security issue you may want to configure concerns log files. Your
network programs, kernel, and other programs all run log files, which contain
records of what has been happening on your system. You may be amazed at
just how much information gets put in them! They’re mostly in /var/1og;
take a look sometime.

Fortunately, tools are available that can help us mere mortals sift through the
wheat to look for the chaff of bugs and intruders. The one I focus on in this
section is System Logs viewer, which is included with Red Hat Linux 10 and
installed by default.

To use the System Logs viewer, follow these steps:

1. Log in as root.

This step gives you access to the most log files. You would have less
access if you used another login account.

2. From the main toolbar, click the Main Menu button.
The main Red Hat Linux menu opens.

3. Choose System Tools~>System Logs.
The System Logs viewer opens, as shown in Figure 18-6.

4. Scroll through the boot log’s contents to examine normal system oper-
ation, and then select the next item from the list on the left, repeating
this technique until you have looked through them all.
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File Edit Help
Bofit Lo Security Log |
ropBoaks
GG og @ This log file contains security messages.
Mail Log
News Log Jun 28 23:41:13 localhost sshd[1459]: Server listening on 0.0.0.0 port 22. ||+
RPM Packages Jun 28 23:43:42 localhost xinetd[1473]: START: sgi_fam pid=1802 from=<nc
Jun 29 20:47:22 localhost sshd[1460]: Server listening on 0.0.0.0 port 22.
Jun 29 20:49:25 localhost xinetd[1474]: START: sgi_fam pid=1779 from=<n
System Log Jun 30 21:03:20 localhost xinetd[1474]: START: sgi_fam pid=14517 from==<i
XFree86 Log Jun 30 21:30:52 localhost sshd[1588]: Server listening on 0.0.0.0 port 22.
Jun 30 21:44:22 |ocalhost xinetd[1606]: START: sgi_fam pid=2166 from=<n
Jul 2 01:20:32 localhost sshd[1595]: Server listening on 0.0.0.0 port 22. |
I Jul 2 01:22:35 localhost xinetd[1609]; START: sgi_fam pid=1914 from=<no|| |
Jul 2 21:33:52 localhost sshd[3629]: Accepted password for dee from 192.]
Figure 18-6: !OJu\ 2 21:3352 localhost sshd[3631]: error: setlogin failed: Function not imple
A Sample Jul 2 21:35:15 localhost sshd[3631]: Received disconnect from 192.168.1.7 | |
| Jul 2 22:16:49 localhost sshd[3687]: Accepted password for dee from 192.7)| #|
GNOME <1 | [3]
SVStem Filter for: | | Filter | | & Reset |
Logs viewer. |
|
I

Give yourself a few weeks to get used to this process. If you look closely
at Figure 18-6, you notice an X next to one of the Security Log entries. This
program is set up to watch for common problems. Look more closely at
anything with a red X to see whether you remember causing that prob-
lem. If you don’t, and it shows up often, someone may be trying to break
into your machine. Double-check with the Red Hat Network (choose
Main Menu=System Tools=>Red Hat Network) to make sure that all

your software is up-to-date, and apply any updates, if needed.

Securing Vour System

You can find a plethora of information on the Internet about desktop, network,
and Linux security. Because of the massive volume of information available, I
have listed some Web sites I like for security issues (refer to Chapter 2 for this
list too):

v www.sans.org: One of the of the major security-related sites on the
Internet.

v http://grc.com/intro.htm: Provides some interesting tools, such as
tools to test which ports are open on a system. Also, this site features
many excellent articles dealing with system and network security.

v http://seifried.org/1asg/: Contains the Linux Administrator’s
Security Guide.
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v www.linux-firewall-tools.com/Tinux/: Offers tips for firewalls and
security on Linux systems.

D ro B O Ok .linuxsecurity.com/: Presents a plethora of information from
x Security.com.

»” www.securityspace.com/sspace: Has lots of information about secu-
rity issues and tools for different operating systems.
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befove. We're giving users additional {raining, betber
manvals, and a morphine drip.”
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In this part . . .

n this part of the book, I cover answers to the ques-

tions most frequently asked about Linux. I explain
some key Linux installation and setup points, as well as
share more routine troubleshooting tips and tricks. One
of the many strengths of Linux is its community, all those
people out there helping each other, so I also show you
where the good Linux stuff lives online and in print so that
you can continue to explore this fascinating computing
environment. [ only hope you enjoy reading this part of
the book as much as I enjoyed writing it!
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roR Oﬁeven Troubleshooting Tips

In This Chapter

Dealing with frozen installations

Changing your boot environment
Recovering when you see some black-and-white text screen!
Escaping a hung GUI

Using multiple resolutions

Troubleshooting is like reading a mystery novel. You have some facts,
symptoms, and details, but you don’t know whodunit. You have to take
whatever information you have, work with that data, weigh the various possi-
bilities, and then narrow them to a single suspect. Finally, you need to test
your theory and prove that your suspect is the guilty party.

Troubleshooting problems in Linux (or any operating system) can encompass
many hardware and software issues. Whether the operating system, the hard-
ware, or a service is giving you fits, you can use some basic troubleshooting
techniques to start your investigations:

* Document the problem. Write down any and all symptoms that the
system is showing, including actions you can and can’t do. Jot down
any information you see in error messages.

v+ Examine the Linux log files. You can find most of these in the /var/Tog
directory. Look for the word “error.”

1 Compare your problem system with a working system. Sometimes,
comparing configuration files and settings may uncover the problem
or narrow the possibilities.

v Check connections. Check to make sure that all the hardware is con-
nected properly and powered on. Verify that all cables and connections
are attached properly and are set at the correct specifications.
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+ Remove new hardware. Remove any hardware that you have changed
or added recently (before the problem started) and see whether the

lem disappears. If so, you can probably conclude that the new or
ro p O O ged hardware is the culprit.

A\

1 Reduce the number of active programs. Stop running unnecessary ser-
vices and applications that aren’t related to the problem at hand. You may
more easily figure out what’s happening if other services and applications
aren’t getting in the way.

1 Check to see whether the problem is reproducible. Does the same
sequence of events produce the same problem? Suppose that when
you try to print to a color printer, nothing happens. If nothing happens
every time you attempt to print, the problem is reproducible. If, instead,
sometimes your information is printed and at other times it isn’t, the
problem pattern isn’t the same and isn’t reproducible — or it’s caused
by something more complicated than just clicking one button. Unfortu-
nately, problems that are nonreproducible are more difficult to resolve
because no set pattern of events re-creates those problems.

After you have come up with a solution, take a few moments to document the
situation. Note the symptoms of the problem, its cause, and the solution you
implement. The next time you encounter the same problem, you can call on
your notes for a solution rather than reinvent the wheel.

If you don’t have any problems to troubleshoot (yet), document your environ-
ment before you do. You may want to print some of this information because
a future problem may prevent you from accessing your files. For a list of files
to document, see the section “Conquering Configuration Problems,” later in
this chapter. You should also back up your data files regularly (no matter
what!) and back up system files to tape or removable media if you have that
option.

In this chapter, I cover some points to ponder and tips to try whenever you
encounter problems with Linux.

“The Linux Installer Froze”

When you’re installing Linux, the installation may just freeze. If it does, wait a
bit and make sure that the installation program really froze. (Sometimes, the
software just takes a while to process information.) If the software looks like
it has frozen, there’s no harm in rebooting your computer and starting over —
just as you would do with any operating system installation. Sometimes, you
can reboot and never have that problem again. At other times, the problem
may happen twice in a row and then be fine the third time. Be sure to try sev-
eral times before giving up.
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If the installation still freezes, go to the distribution’s Web site and check
through the bugs and errata pages (Web pages where the distribution lists a
ofllectian of problems and solutions to them) in the technical support area.
D ro p B O ges may talk about some known problems and solutions that can
help you. Otherwise, diagnosing the problem can be tricky and may seem
more like voodoo than science. Here are some tips:

v~ If this problem happens repeatedly at exactly the same spot, you may
have a bad installation disk. If you're a Fedora Core user, see the follow-
ing section, “For Fedora Core Users.” If you're not using Fedora Core or
a version of Red Hat Enterprise Linux, try the disk in another machine
if possible, and see whether the installation fails in the same place there.
If you purchased this disk with a Linux distribution, contact the distribu-
tion’s technical support team. If you got the disk with a book, contact the
publisher’s technical support team. If you burned the disk yourself, try
burning a new copy at a slower speed.

v~ If this problem happens repeatedly at exactly the same spot and you
don’t have a bad installation disk, the trouble may be with one of your
machine’s hardware components. If you can, try trading hardware
between machines. If not, you may need to choose a different machine
on which to install Linux or try another distribution.

v~ If the problem seems to happen randomly, your particular Linux dis-
tribution may not be compatible with that particular machine. Again,
you can try trading some hardware around, installing Linux on another
machine, or using another distribution.

N If you're not sure whether your installer has frozen, try pressing various
combinations of Alt+F#, where # corresponds to one of the function keys.
The installer has not completely frozen if you can see different screens when
you try this technique. If nothing changes when you press these keys, the
installer has definitely frozen.

For Fedora Core Users

When installing Red Hat Linux 7.3 or later (Fedora Core 1 is considered “later”),
a special solution is available to people who run into problems that seem to
have absolutely no explanation, such as the installer freezing. If your installa-
tion keeps dying while Anaconda (the Red Hat Linux installer program) is
placing packages on your hard drive, follow these steps to try to fix it:

1. Place the DVD-ROM or the first Fedora Core CD-ROM into your drive.

2. Reboot the machine.
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3.

Wait until you reach the black-and-white screen where you select
which installer to use.

D ro B O O KS screen has a black background with text in a combination of white
colors. If you reach a graphical installation screen, you missed the

4.

screen. You need to reboot and repeat this step, and then proceed.
At the prompt, type 1inux mediacheck and then press Enter.

Text scrolls by, and then you see a screen with a bright blue background.
Then, the CD Found dialog box appears.

. Select OK and press Enter to proceed to the media examination.

This step opens the Media Check dialog box. If you have changed your
mind and just want to start the installation, use the Tab or arrow keys to
select Skip, and then press Enter.

6. If you want to test the first CD-ROM or the DVD-ROM, select Test.
7. If you want to test another installation CD-ROM, select Eject CD.

Remove the first CD-ROM from the CD-ROM drive and replace it with the
CD-ROM you want to test. Close the CD-ROM drive and make sure that
Test is selected.

. Press Enter to begin the media check.

The Media Check status box opens and shows you the name assigned to
the DVD-ROM or CD-ROM and how much progress has been made. At the
end of the inspection, the Media Check Result dialog box opens.

. Look at the text after and the result is.

If the result is PASS, nothing is wrong with the DVD-ROM or CD-ROM
itself. Your installation woes are caused by something else. Go to the
Fedora Core site (fedora.redhat.com), and then to the Errata page,
and look for a new boot disk image. The instructions on how to down-
load and make your boot disk are on the page relating to the update.

If the result is FATL, the DVD-ROM or CD-ROM you just tested is flawed.
If you purchased this CD-ROM or DVD-ROM, you need to talk to the com-
pany you purchased it from to see whether you can get a replacement.
On the other hand, if you burned your own DVD-ROM or CD-ROM, I rec-
ommend doing one of the following:

e Burn the DVD-ROM CD-ROM again, at a speed of 4x or lower.

¢ Burn the DVD-ROM CD-ROM again on a newer CD-ROM drive
with BurnProof technology (www.burnproof.com) or something
similar.
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If the DVD-ROM that came with this book is defective, contact the tech-
nical support address listed in this book, not Red Hat.

DropBooks
“My Graphics Fail the Installer Test”

You need to install the proper server software because the installation pro-
gram doesn’t do it for you. Here are a couple of places to find useful help with
this problem online:

¥ www. linuxnewbie.org/nhf/
v www.tldp.org/HOWTO/HOWTO-INDEX/apps.html#GUIXWIN

“The Installer Tested My Graphics
Fine, but My GUI Won't Start”

If your Linux installation program showed you a GUI test screen saying that
you were ready to proceed with the rest of the installation, you probably
expected that the GUI would start with no problem. Unfortunately, that doesn’t
always happen.

Each distribution has its own set of graphics configuration tools. If you boot

your machine for the first time and see error messages when you’re trying to
enter the GUI automatically or when you type startx to start the GUIl manu-
ally, use the following tools to fix the problem:

v For any Linux distribution, you should have a tool named XF86Setup. It
may not be installed by default, but it’s a good option if you can’t find
any fancier tools (such as the next four items in this list) to use.

v In Fedora Core, use Xconfigurator or redhat-config-xfree86.

v In Mandrake Linux, use XFdrake.

+ In SuSE Linux, use sax2 or sax.

v Your last resort is xf86config. This fully text-based tool should be
available with all distributions. It may be called xf86config4.

You may have to install these tools from your original distribution disks
before you can run them from the command line.

333
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“I Think I'm in Linux, but |
Dropleok&w What to Do!”

|
Figure 19-1:
A Linux
command-
line login
prompt.
|

s

Figure 19-2:
Logged in at
the Linux
command
line.
|

Two different screens tend to cause panic to folks new to Linux. The first of
these screens, shown in Figure 19-1, is in fact a sign that you installed the
software and booted the machine successfully! Jump for joy! It’s just that
you’re booting into the command-line environment rather than the GUI envi-
ronment. If you reach a screen similar to the one shown in Figure 19-1, the
computer is asking you to log in with the username for an account and a
password that you created during the installation process.

Fedora Core release 1 (Yarrow)
Kernel Z.4.22-1.2115.nptl on an i686

fcl login: _

If you created only the root account, you can log in there as root.

After you enter the username and password, you find yourself at the screen
shown in Figure 19-2, which just happens to be the second spot where people
get worried. If you see this screen, you have not only booted properly into
Linux, but you're also logged in and using the machine! Give yourself a good
pat on the back.

Fedora Core release 1 (Yarrow)
Kernel 2.4.22-1.2115.nptl on an i686

fc1 login: dee
Password :

Last login: Mom Nov 17 16:30:87 on ttyl
[deel@fcl deel$ _
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What do you do from here? Anything you want. Surf through this book for
commands you want to run. Type startx to start up the GUIL

DropBooks
“I Don’t Want to Boot into This!”

Are you booting into the command-line environment when you only want to
use the GUI? Or, are you finding that you’re already booting into the GUI and
you would rather boot to that nice, clean, black-and-white command-line
screen? You're not stuck with either of these options. You can change them
at any time.

Changing your boot environment
“vermanently”

The word permanently is in quotes in the heading because you can, of course,
go back and change this setting later, if you want. Permanently just refers to
the fact that after you have made this change, every time you boot the system,
it automatically goes into the preferred environment until you change it.

To make this change, you need to edit what’s called a runlevel. I can’t be cer-
tain which Linux distribution you’re using, so [ cover the most generic method
for accomplishing this task:

1. Log in as the root user.

2. If you’re in the GUI, open a terminal window.

The terminal window is typically offered as an icon on the Panel in both
KDE and GNOME. It usually looks like a little computer screen.

3. Type Is /etc/inittab and press Enter.

If this file exists, proceed to Step 4. If not, then it may be stored in a dif-
ferent location in your Linux distribution. Type find / -name inittab
to hunt down where it is in your file system. If you track down inittab
in a directory other than /etc, be sure that you change the directory
path appropriately in the rest of this sequence.

4. Type cp /etc/inittab /etc/inittab.old to make a backup.

Now, if something happens while you're editing the inittab file, you
can always restart fresh with the old version.
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5. Open the inittab file in your preferred text editor.

Some Linux text editors are covered in Chapter 13.
D ro p B O O kﬁgll down until you find a line similar to the following:

\\J

id:5:initdefault:

This line appears near the top of the file. What you're interested in here
is the number. In most mainstream Linux distributions, the number 5
tells Linux to boot into the GUI, and the number 3 tells Linux to boot
into the command line. In the preceding example, therefore, I boot into
the GUL

7. Change the number in this line.

If it’s a 5, change it to 3, and vice versa. Make sure that all colons and
other items are left properly in place, or else your machine will have
problems booting later.

8. Save and exit the file.

The changes go into effect the next time you reboot the system.

If you do end up having problems booting the system, in many current Linux
distributions (including the one that comes with this book) your installation
disk can be used as an emergency boot disk. Check your documentation for
information about the distribution you’re using if it’s not Red Hat 10.

Changing your boot environment
just for now

At any time, you can have your Linux box switch between full command-line
mode and full GUI mode. The instructions I give here assume that you're using
one of the mainstream Linux distributions that use a runlevel of 3 for the com-
mand line and 5 for the GUL Type runlevel on the command line: If you see
a 3 or a 5, you're fine, but if you see any other number, see your distribution’s
documentation to find out which runlevel corresponds to the full command-
line session with networking and which is for the full GUI session.

To switch between modes, do the following:

v To change from the GUI login to the command-line login, open a terminal
window and type (as root) init 3.

v To change from the command line login to the GUI login, type (as root)
init 5.
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“I Want to Use Multiple
Drop&BeakSsolutions”

Do you want or need to swap between resolutions in the GUI? Suppose that
you want to use 1024 x 768, but you work on Web pages and want to be able
to see how they look in a browser at 800 x 600 or even 640 x 480. You can set
up your Linux machine to do it, but you need to edit a text file. Type the fol-
lowing line at a command prompt to locate this file on your distribution:

find / -name "XF86Config*"

You may find multiple versions. For example, you may find XF86Config and
XF86Config-4.If you have both, you want to edit XF86Config-4. To change
your screen resolution settings now, follow these steps:

1.

Exit the GUI.

If you boot into the GUI by default, type init 3 at a command prompt
to leave the GUI for now. If you had to type startx to get into the GUI,
click the GNOME footprint or KDE K icon and choose Log Out.

. Log in as root.

If you're not logged in from the root account (and you normally shouldn’t
be), log in as root to edit this file.

. Change to the directory containing the file.

You probably type cd /etc/X11 for this step.

. Make a backup copy of the file.

You type either cp XF86Config XF86Config.oldor cp XF86Config-4
XF86Config-4.01d to make the backup.

5. Open the file in your favorite text editor.

6. Jump to the end of the file.

This file can be a long one, and the text you want is close to the end.

. Move up through the file until you see this text:

Section "Screen"

. Look beneath the section header for a line similar to this one:

Subsection "Display"

. Look beneath this section header for a line similar to this one:

Modes "1024x768"
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\\J

10. Add to the line the other modes you want to use, using the following
line as an example:

OOk es "1024x768" "800x600" "640x480"

Dropk

Be sure not to go beyond your monitor’s capabilities. Check your moni-
tor’s documentation to see what it can handle if you want to raise the
resolution.

11. After you finish making changes, save and close the file.

Now you can return to the GUIL Log out of root and back into the account you
usually use, and then type one of the following commands:

v startx: If you don’t normally boot into the GUI
v init b:If you normally boot into the GUI

You can change resolutions after they're set up (as shown in the preceding
section) by pressing the key combination Ctrl+Alt+Plus, where Plus is the big
plus (+) sign on your number pad — you can’t use the plus sign on the main
keyboard for this one. If you're using a keyboard without a number pad, you
have to edit the file as shown in the preceding section and move your pre-
ferred resolution to the beginning of the list. Then, if you're already in the
GUI, log out and log back in.

“My GUI Is Hung and I'm Stuck!”

One quick solution to this problem is the key combination Ctrl+Alt+Backspace.
If this doesn’t do the trick, your system is in really bad shape! Try to switch
to a virtual terminal by using Ctrl+Alt+F5. If this key combination also does
nothing, you need to reboot the machine.

“Help, my machine hangs during boot!”

When configuring a Linux machine, you may encounter problems with the
/etc/grub.conf file. This file indicates the operating system or systems to
which your system can boot, and the file also contains Linux startup settings.
Linux can boot from any of your hard drives — not just the master IDE drive
on the primary IDE channel. Consider this list of potential solutions if the
/etc/grub.conf file makes trouble:

v If you have altered or added hard drives, you may need to change the
boot line in the /etc/grub.conf file.

v If you haven’t made hardware changes, check to make sure that your
/etc/grub.conf file is referring to the correct location of the Linux
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image (the program code that loads and executes at runtime and is
located in the /boot directory).

D ro B O OkSe location under the /boot directory or the device for the root entry
#icorrect, your system can’t boot to Linux. In this situation, a rescue
or emergency disk is helpful. Refer to Chapter 5 for instructions on using
arescue disk.

v 1f you're working with a multiboot operating system environment, be
sure that your /etc/grub.conf file contains entries for each of your
operating systems. Each operating system or Linux installation needs
to be in separate entries.

v If your file contains entries to switch to a higher-resolution display and
you have boot problems, try reducing the video setting to simple VGA.

N Linux allows you to use spaces and other characters in filenames that you
may or may not be able to use in filenames on other operating systems.
However, some Linux applications may stumble when they encounter file
or directory names containing spaces. Usually, a safe bet is to stick with
alphanumeric characters and avoid spaces and odd characters, such as
question marks and exclamation points.

“How Do | Stop Scripting Screw-Ups?”

A script contains a series of commands designed to perform a task (usually
repeatedly) to save you from typing all those commands at a prompt, one
line at a time. If you have trouble with a script, follow this advice:

v Make sure that spelling or syntax errors aren’t causing the problems.
Remember that most things in Linux are case sensitive, so a simple slip
of the Shift key can make an entire script nonfunctional.

v~ If a script contains several sections to perform different tasks, try com-
menting out all lines except for one task. If the script works for the speci-
fied task, uncomment one line at a time and run the script between each
edit. When you encounter your first error, you probably have a good idea
of where the error occurred and how to make an appropriate correction.

v~ Start simple when you write any script from scratch. Make sure that the
script works before you start doing fancy stuff. If a recent addition causes
the script to fail, you know where the problem resides.

v Verify values for any variables on which your script may depend. Use
the echo statement in the script to display the contents of any variables
you use. You may need to use echo at several places in your script so
that you can watch what happens to the values of those variables. (Refer
to Chapter 11 for more information on variables.)

339
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”Aaar%t! 1 Forgot My Root
DropBeeka! What Do 1 Do>”

Fear not. You have a way around this problem! First, you need to reboot your
machine. While it’s rebooting, it reaches a boot loader, whether it’s a graphi-
cal boot loader or a command-line boot loader. This boot loader is either
GRUB or LILO. If you're using the DVD-ROM that came with this book, it’s
GRUB (unless you went out of your way during installation to specifically
choose LILO).

If you're not sure, don’t worry. Just try the GRUB option first, and then try
the LILO one:

+ GRUB: At the GRUB boot screen, press E, which takes you to a configu-
ration file. Use the arrow keys to go to the line starting with kernel, and
press E again to edit that line. At the end of the line, add the word single,
press Enter to put the change into place, and then press B to boot the
machine.

v LILO: At the LILO boot prompt, type 1inux single.

In both cases, the machine boots to a prompt. If it asks you for a login, type
root and press Enter. It doesn’t ask you for a password. Now’s your chance
to change the root password to one you can remember. Type passwd, and
then enter the new password twice as directed. When you’re done, type
reboot and then boot the machine normally.



Chapter 20

DrOpBOOkfen Superior Sources
of Linux Information

In This Chapter

Finding the best of the best at www. Tinux.com

Making the most of Linux security

Locating Linux applications

Learning from the online masters

Perusing peerless Linux publications

Obtaining support from Linuxcare.com

Nerding out at Slashdot.org

Tipping the iceberg — there’s more where these came from. . . .

Linux isn’t just an online phenomenon (in fact, it’s one of the few major-
league operating systems you can download from the Internet for free);
it’s also the stuff of which Internet infrastructure is made. For that reason, it’s
no surprise that more good information about Linux is available online than
you could ever absorb, even with an extra lifetime or two. That’s why I had
such a hard time coming up with the ten best Linux resources for this chap-
ter. That’s also why [ cheated — the last section is a grab bag that contains
more good Internet stuff than I could cover in the first nine entries!

The Best-Ever Linux Resource

[ had trouble picking only ten Linux resources, but if  had to pick only one,
www . Tinux.comwould be it. This site is the ideal general starting place for

any Linux-related investigation and includes a great search engine, plus a broad
range of useful Linux information, downloads, pointers, and documentation.
For example, when [ went looking for sources of Linux distributions, I quickly
figured out that it was easier to go through www. Tinux.com (via software.
Tinux.com, part of the same site) to get to all the key sites than to visit each
vendor or organization, one at a time!
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Keeping the Bad Guys at Bay

DropBo

Ol & plenty of security-related sites and information are available on the

Web, [ was initially hard-pressed to find a site that approached this important
topic from a Linux point of view. But Linuxsecurity.com fixes that problem in
a hurry. It’s a terrific clearinghouse for Linux security news, advisories, docu-
mentation, and resources. At www. 1inuxsecurity.comyou can find pointers
to security documentation, news sites, archives, mailing lists, discussion
groups, and much, much more.

Other good Linux security resources include

v System Administration Security Resources:
http://security.ucdavis.edu/sysadmin/linux.cfm

v The Linux Center: www.portalux.com/system/security

The Kernel’s at Linux Headquarters

Linux headquarters operates a kernel-focused (or should I say kernel-
obsessed?) Web site at www. Tinuxhg.com. In addition to providing pointers
to information, downloads, patches, change logs, and more for two versions
of the Linux stable kernel (what ordinary mortals use) and one version of the
developer’s kernel (what hackers and demigods use), this site has pointers to
all kinds of additional information. This info includes an extensive list of
Linux distributions, helpful information about kernel programming for those
who are so inclined, Linux vendors you can turn to, and a whole lot more.

Everything Linux

How can you go astray at a site named Everything Linux? It’s easy — you may
not exactly go astray, but you can find so much interesting stuff to distract
you from your task at hand that you may find yourself looking blearily up at
the clock at 3 a.m. and asking yourself “Where did the time go?” Visit
www.everythinglinux.org and start losing time.

At this site, you can find news, reviews, and opinions about Linux topics,
along with pointers to most of the good Linux stuff on the Web (including, not
coincidentally, all the other stuff that appears in this chapter).
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Looking for Linux Applications?
D ro p B O inapps site links to all kinds of Linux software and has more than 30

categories, from Audio/Sound to X Window. Click any category to see any-
where from a handful to more than a hundred Linux-ready applications, ready
for you to download. After you have Linux installed and are looking for things
to do with your system, you could do worse than go there looking for more
software. Visit www.1inuxapps.comto see what [ mean.

Lifelong Learning Includes Linux

A cornucopia of online tutorials and information about Linux is on the
Internet, and it’s just waiting for you to dig in. Although [ haven’t yet found a
clearinghouse for locating Linux training online, here are some strategies I
used to turn up thousands of free online training courses on everything from
basic Linux commands and operation to hacking the kernel yourself:

v Visit your favorite search engine and search for Linux tutorials.

v Visit a Linux-focused site and search for tutorials within the site. [ got
great results at www. Tinux.com, where my search turned up nearly 300
responses, many of them extremely interesting.

v An ultimate directory of information on learning Linux in the classroom
isat www.linux.org/vendors/training.html.

Peerless Linux Publications Online

As with everything else about Linux, you find no shortage of online newslet-
ters, magazines, and other periodical sources of information. Here’s my short
list of the best ones, purely for your perusal:

v The Linux Gazette (www . 1inuxgazette.com): This monthly online
Linux-focused publication is also part of the Linux Documentation
Project (LDP). This magazine includes lots of timely, useful information
and a plethora of pointers to other Linux information online.

v Linux Journal (Wwww.Tinuxjournal.com): This monthly Linux publica-
tion is available in print as well as online. Published by SSC (Specialized
System Consultants, Inc.), this magazine includes information about
Linux distributions, product reviews, industry news, and other cool stuff.

v LinuxWorld (www.1inuxworld.com): Industry news and technical cove-
rage round out this particular publication. I'd say more but 'm biased —
I'm one of the editors.
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v Linux Weekly News (www . Twn.net): This weekly Linux-oriented news
and information publication covers a broad range of topics. It’s probably

D ro p B O O kgﬂost timely of all the online (and print) journals I mention.

v LinuxToday (www.1inuxtoday . com): LinuxToday has worthwhile con-
tent from a number of sister sites, including LinuxPlanet (www . 1inux-
planet.com), revolving around many facets of Linux.

Supporting Linux Online

Linuxcare is a professional, for-profit organization devoted to Linux training,
technical support, and information sharing. If you need serious professional
Linux help, you need Linuxcare. You find, in addition to for-a-fee information
and services, plenty of free white papers and other good stuff on this site.
Visit this excellent outfit at www. Tinuxcare.com.

You can also visit the AnswerSquad (www.answersquad. com), where you can
pay a monthly fee to join a discussion mailing list. There, you can ask as many
computer questions as you want, and a team of computer book authors — who
know how to explain things to normal people — will help you out. The topics
here are not limited to Linux, either. You may even recognize a few
AnswerSquad member names from the Dummies author roster!

Slashdot: The Creme de la Nerd

The subtitle for this Web site, “News for Nerds,” says it all: Slashdot is a Web
site for Linux bigots by Linux bigots about deeply technical subjects of all
kinds, some more related to Linux than others, but all weirdly fascinating. I
had to include this site in my list, but [ can’t explain why. If you come up with
a good, inarguable reason, please tell me what it is. (My e-mail address is
listed in the author bio in the front matter of this book!) Visit the Slashdot
site at www.slashdot.org.

More Tips off the Linux Berg

[ have had a tough time closing in on only fen top Linux resources online.
That’s why I cheated and turned this last one into a grab bag of additional
Web sites, newsgroups, and even some information about updating Fedora
Core (otherwise, I would be neglecting this book’s poster child — Fedora
Core 1 — after all).
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Web sites

D ro p B O QK. wing list describes Web sites that didn’t quite fit into any other sec-
ons'i

is chapter, although their rich and useful content merits special
attention. Be sure to visit these sites while exploring Linux information online:

v www.t1ldp.org: The Linux Documentation Project is a great bookmark
for your browser. You may return often when trying to find specific
answers or even just to browse for topics of interest. The LDP contains
several types of documentation, including full-length books, HOWTO
documents, FAQs, and much, much more.

v www.redhat.com/apps/support/resources/: This site is the Red Hat
support resources center, where you find a wealth of Linux support
information, albeit with a strong Red Hat flavor. In addition to errata and
update information on specific versions of Red Hat, you find tutorials to
help you configure services on a Red Hat Linux computer.

v freshmeat.net: Do you ever feel left out while your cronies yak about
the newest Linux software or latest version releases? Now you can keep
up with a healthy daily serving of bug fixes, new software releases,
announcements, commentary, and a comprehensive index of all known
Linux software. Freshmeat is a staple for the release early, release often
hackers so prevalent in the open source community.

v fedora.redhat.com: The Fedora Core distribution site.

Newsgroups

Newsgroups are online discussion groups in which people read and post mes-
sages to one another on specific topics. The Internet now hosts more than
80,000 newsgroups, with more being introduced daily.

Google Groups (groups.google.com) provides access to Usenet postings and
archives and is the largest discussion archive on the Internet. You can search
and browse Usenet (newsgroup) discussions and other public online forums
with a single simple search. This site is a great place to look for technical sup-
port or information or to locate online groups that reflect your interests.

From the following list, see whether you can pick out the newsgroup that
appeals broadly to Linux lovers everywhere but has nothing to do with Linux
per se. (Hint: “Thank ya. Thank ya vurry much!”)

v comp.os.linux.advocacy: Updates you on what kinds of products and
services are new and interesting

v comp.os.linux.hardware: Keeps you informed on what’s going on
with Linux hardware and computers
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v comp.os.Tlinux.misc: Lets you know what’s happening with all kinds of
miscellaneous Linux topics

D ro B O O‘kzs .0s.Tinux.networking: Tells you what’s going on in the wonder-
orld of Linux networking
v alt.elvis.sighting: Keeps you up-to-date on the current and past
activities of that hunka hunka burnin’ love

Keeping your Fedora Core
system up-to-date

The Fedora Core 1 utility named Red Hat Update Agent enables you to install
new packages as they become available, directly from the Red Hat Web site. It
also enables you to refresh installed software with the latest enhancements
and bug fixes. To run the Red Hat Update Agent, click the main menu and
choose System Tools>Red Hat Network. You must be connected to the
Internet to successfully run the Update Agent.

When you register your Red Hat installation at http://rhn.redhat.com/,
you're issued a username and password that you must use to configure the
Red Hat Update Agent.
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In this part . . .

Flis part adds some extra material to support the rest
of this book. Starting with the ever-popular and useful
Appendix A, you'll find a reasonably comprehensive and
friendly compendium of common Linux commands, ready
for use as a desktop reference. Appendix B provides an
overview and information about the DVD included with this
book (and how to get a set of CDs if you don’t have a DVD-
ROM drive), including basic booting instructions when
installing Red Hat Linux and a list of what’s on the DVD.
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In This Appendix
Archiving and compression commands
Communication commands
File commands

System control commands

C omputing novices often marvel at the keyboard dance Linux experts typ-
ically perform. Sure, these experts know about modern advances, such
as the mouse and graphical interface, but these keyboard musicians prefer
the home keys and find that they can work faster with the keyboard. It takes
some time to reach this level of proficiency, but every expert was a novice at
one time, and any novice can become an expert by delving into the various
commands available and getting plenty of practice.

In this appendix, you will find the commands listed by themes, according to
what they can actually do for you.

So, read on — and dazzle your friends with your command-prompt finesse.
When they ask you how and where you figured out all those commands, just
smile and mumble something about the voices in your head — and of course,
keep this section dog-eared and within reach of your computer.

Linux Commands by Function

Because every command serves a specific purpose, organizing these tools
into groups according to their individual functions isn’t difficult. If you know
what you need to do but don’t know which command does the job, flip
through this section to start your search. From here, you can dig further by
referencing man pages and other help information (online sites and reference
books, for example) or by looking in this book’s index for further coverage.

To access a man page, type man command at a command prompt. For exam-
ple, man 1s shows you the help information for the file listing command.
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Archiving and compressing

D ro p B O QK disk space isn’t as much of a premium as it once was, bandwidth
n

\\J

up media still are. Subsequently, this group provides a potpourri of
tools for compacting and organizing data for storage:

ar, bzip2, compress, cpio, dump, gunzip, gzexe, gzip,
restore, tar, uncompress, unzip, zcat, zcmp, zip

Built-in bash commands

Some commands don’t even seem to exist if you try to look up their help
information in the man pages, and the commands don’t show up as files on
your system. Remember, as you type commands at the prompt, that you're
communicating with a type of program called a shell. (In my case, it’s bash,
the default Linux shell.) The shell has a set of commands, included in the fol-
lowing list, that you can use to communicate with it:

alias, bg, cd, export, fg, history, jobs, logout, set,
source, test, umask, unalias, unset

If you try to view the man page entry for some of these commands, you’ll find
instead that the help information for BASH BUILTINS loads. To search
through this massive manual, press the forward slash (/) key to open the man
search interface, and then type the name of the command you want to search
for. Press Enter to start the search. The interface stops in the first spot where
the term is found. If you want to try again, press the N key to proceed to the
next occurrence of the word.

When you’re digging around for help on a command, you can call on an inter-
esting range of shell commands for assistance:

apropos, info, man, manpath, type, whatis, whereis, which
Locating details about the command-prompt options of a command is a

never-ending pursuit. The man page system provides some helpful guides at
your fingertips for rapidly finding this detailed information.

Communication

As a system administrator, you find these utilities useful for providing infor-
mation about your users and communicating with them:

finger, wall, write, who
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Files and file system

D ro p B O Q(lgﬁr which operating system you’re using, it’s hard to do anything with-
u

g able to find your way through and work with the file system. The
following utilities help you find your way:

File organization

Boxing, packing, sorting, shipping — I'm always shuffling files around on my
system. File organization commands provide tools for moving files and file
system units around:

cp, dir, In, mkdir, mv, pwd, rename, rm, rmdir, shred

File attributes

Files are much like candy bars. The wrappers provide information about the
ingredients, size, and package date — all descriptive of the tasty nugget
inside. (Perhaps the wrapper is even childproof.) Files keep all this wrapper
information in an inode. Along with the capability to change file inode infor-
mation, these commands can return data about the content of the file:

chage, chattr, chgrp, chmod, chown, file, stat, sum,
touch, wc

File filters

A file filter enables you to take the contents of one file and process them for a
new result. To sort the contents of the password file alphabetically, for exam-
ple, you can type the command sort /etc/passwd. Listed here are a few of
the tools available for mulching data into something meaningful:

cmp, colrm, column, comm, csplit, cut, iff, diff3, expand,
fmt, fold, join, look, merge, paste, rev, sort, split,
strings, tac, tr, unexpand, unig, uuencode, uudecode

File locators

Where, oh, where can my file be? These commands help you locate files in
Linux’s monster tree-structure file system:

find, Tocate, which

File utilities that deserve their own category

Although some may argue that these utilities are just commands, others can
argue that the ceiling of the Sistine Chapel is just a painting. These commands
sport short names, even though nothing about them is simple or powerless.
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These commands are industrial-strength data-manipulation tools. You need just
a few minutes to get the basics, and a lifetime to master the tools. If you manage

D r O p B O GAI{)é! to wrangle these beauties, you achieve respected geek status:

convert, gawk, grep, sed

File viewers

File browsing is a favorite pastime of many a system user. These tools pro-
vide a variety of utilities for viewing the contents of readable files of all sizes.
Unlike using a full-screen editor, you cannot damage the contents of a file
with these commands because they’re read-only tools:

cat, head, less, more, tail

Miscellaneous file commands
These file commands don’t seem to fit into any other category:

basename, dircolors, hexdump, newer, nl, od, patch, test, xxd

Wholesale file system commands

These commands provide information or perform actions on the entire file
system, from creation and tuning to repair and recovery. Some of these com-
mands return data only, whereas others also provide you with surgical instru-
ments for serious file-system hacking:

badblocks, debugfs, dumpe2fs, e2fsck, e2label, fdformat,
fsck, mkfs, df, du, 1s, Tsattr, mount, quota, quotacheck,
quotaon, resize2fs, sync, tuneZfs, umount

Miscellaneous

The leftovers are in this group — I can’t classify these commands
anywhere else:

bc, cal, clear, date, dc, echo, eject, expr, oclock, openvt,
resize, script, tee, toe, unbuffer

mtools

The mtools suite of utilities provides a nice way to transfer information to
your Microsoft friends. Although Linux has native support for Microsoft
Windows and DOS file systems, your Microsoft cohorts don’t have access to
Linux (ext?2 and ext3) file systems. To keep everyone happy, you can buy
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preformatted MS-DOS disks and use them with the mtools commands so that
you can swap them back and forth with your friends who are using Windows:

DrOpBOOVK‘Sncd mcopy, mdel, mdeltree, mdir, mdu, mformat, mlabel,
mm

, mmount, mmove

Printing

The printing system is the combination of programs that handles the routing
of data from you to the printer. These commands enable you to add, verify,
and remove print jobs from the queue:

cancel, 1p, 1pg, lpr, Iprm, lpstat, Iptest, pr

System control

These commands provide system-wide information and control. Normal
users can run many commands to obtain system information; however, com-
mands that actively change the configuration of the system need to run while
you're logged in as root — or have utilized the su command to temporarily
become the superuser.

Kernel module handling

You may sometimes need to add kernel support for an additional device
(software or hardware). If this need arises, you have a limited number of
choices: You can either rebuild the kernel or install a loadable kernel module.
Although rebuilding a kernel doesn’t exactly require a Ph.D. in nuclear sci-
ence, consider it a time-consuming nuisance that’s best to avoid. The follow-
ing commands enable you to include the kernel support you need while the
system is running, without having to rebuild the entire thing from scratch:

depmod, insmod, Tsmod, modprobe, rmmod

Processes

Most of your system activity requires processes. Even when your system
appears idle, a dozen or so processes are running in the background. These
commands enable you to check under the hood to make sure that everything
that needs to be running is running and that you’re not overheating or over-
taxing resources:

at, atqg, batch, crontab, env, fuser, kill, killall, nice,
pidof, pkill, ps, pstree, renice, sleep, top, usleep, watch

353
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System action commands
Sygtem action commands provide tools for controlling your host. Rather than
D ro B O @k&information your host may need, these commands incite your
t action:

dhcpcp, halt, kbdrate, logger, mesg, mkbootdisk, poweroff,
reboot, sash, setleds, setterm, shutdown, stty, tset,
tzselect

System information

System information command tools are for setting and checking your host
configuration. These few doctor tools are for probing and prodding your
system for vital statistics (the command uptime, for example, tells you how
long your system has been running since the last time you booted it):

arch, date, ddate, fgconsole, free, hostid, hostname, hdparm,
hwclock, ifconfig, kernelversion, netstat printenv, route,
runlevel, top, tty, uname, uptime, vmstat

Users and groups

Who are the people in your neighborhood, and what are they doing? These
commands enable you to change user profiles and provide specific informa-
tion about your system users:

checkalias, chfn, chsh, faillog, gpasswd, groups, id, last,
lastlog, Tistalias, mkpasswd, mktemp, newalias, newaliases,
newgrp, passwd, su, users, uuidgen, w, who, whoami
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Fe DVD-ROM included with this book contains everything you need to
install and run Fedora Core 1. This is the equivalent of the six CD-ROMs
you would have to download from Red Hat’s Fedora Project Web site (http://
fedora.redhat.com), and includes the following:

v~ Fedora Core 1: A complete copy of the latest and greatest version of the
consumer-level Red Hat Linux, for your computing pleasure.

+ RPM (Red Hat Package Manager): The Red Hat software distribution
and installation management environment, wherein Linux updates and
new facilities are packaged for easy installation on your Linux machine.

v KDE (the K Desktop Environment) and GNOME (GNU Network Object
Model Environment): The two leading graphical user interfaces for
Linux. You can pick the one you like best!

v Mozilla: The best-of-breed Web browser for your Linux machine, just
waiting for your surfing pleasure.

v Samba: The best way to integrate Linux servers with Windows users.
Samba lets your Linux machine masquerade as a Windows server so
that Windows users can grab files and print documents hassle-free.

1+ Apache Web Server: The world’s most popular (or at least, most fre-
quently used) Web server software.

v Games!: Tons of games; enough to help you procrastinate for weeks!

v OpenOffice.org: A full-featured and popular office suite.
\\J
If you don’t have a DVD-ROM drive, send the coupon in the back of this book
to us to receive the CD set. (See coupon for details.)

System Requirements

Make sure that your computer meets the following minimum system require-
ments. If your computer doesn’t match up to most of these requirements, you
may have problems using the contents of the DVD-ROMs:
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v A PC with an Intel-compatible Pentium-class processor: | recommend a
400MHz Pentium II or better for using Graphical mode, and a 133MHz

D r O B O OKS)ium or better for Text mode.
p 0S 6.02 or Microsoft Windows 3.1 or later: These systems conve-

niently help you set up your system, but you can install from a Linux
bootable floppy disk without needing DOS or Windows, if you prefer.

1 At least 64MB of total RAM installed on your computer for text mode:
You need at least 64MB of RAM for Text mode, and at least 128MB is rec-
ommended for Graphical mode. (Linux can handle as much RAM as you
can fit into a typical PC, and more is almost always better than less.)

v~ At least 650MB (the barest minimum) of hard drive space: | recom-
mend 2.5GB and as much as 5GB if you want to install all the software
from the DVD-ROM. You need less space if you don’t install every pro-
gram, but you should go ahead and make 5GB of space available, to give
yourself more options.

v A DVD-ROM drive — double-speed (2x) or faster: The faster the DVD-
ROM drive, the faster your installation experience.

v Just about any VGA monitor: Just about any monitor does the trick, but
you want one that’s capable of displaying at least 256 colors or grayscale.

v A keyboard and a mouse: You need both items so that you have a way
to communicate with your Linux system and tell it what to do!

v A 3Y>-inch floppy drive: You have to create an emergency boot disk for
your Linux system. (And although I hope that you never need one, you
may thank your lucky stars that you have one, if you ever do need one.)
With this tool in your PC, you can also use it to boot from a floppy disk,
if you ever need to do that.

+* A modem with a speed of at least 56,000 bps (optional): Again, the faster
your Internet connection, the less time it takes to update your installation
to the most recent versions. I use a cable modem for my Internet connec-
tion, and I like the increased speed when it comes to dealing with the
many and varied sources of Linux software and updates online.

If you need more information on PC basics, check out PCs For Dummies, 9th
Edition, by Dan Gookin (published by Wiley Publishing, Inc.).

Using the DUD-ROM

You can take either of two basic approaches to using the Fedora Core installa-
tion DVD-ROM. I cover each one in separate step-by-step lists. I tell you in
this section how to pick which set of instructions to follow. The two ways to
use this DVD-ROM are shown in this list:
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v If you can boot from your DVD-ROM drive (which probably means that
you have a newer PC), follow the instructions in the following section.

D ro B O OKSU can’t boot from your DVD-ROM drive, for whatever reason, follow
nstructions in the section “Booting from a Linux floppy disk,” a little
later in this chapter. Choosing this option means that you boot from a
Linux boot floppy disk, with the DVD that came with this book already
inserted into your DVD-ROM drive. (To create a Linux boot floppy disk
to enable this approach, please check out the instructions in Chapter 2.)

The floppy disk handles the beginning of the process and then turns the
rest of the installation over to the DVD-ROM.

Booting from the DUD-ROM

To install items from the DVD-ROM to your hard drive, follow these steps:

1. Insert the DVD-ROM into your computer’s DVD-ROM drive.

2. Reboot your PC.
As long as your PC is configured to boot from the DVD-ROM, this step
starts the Linux installation process for you automatically.

Congratulations! The Linux installation process is now under way. For the
rest of the gory details on this fascinating task, please consult Chapter 3. If
you had to order the CD-ROMs, then boot with the first CD for the same effect
as booting with the DVD.

Booting from a Linux floppy disk

To install the items from the DVD-ROM to your hard drive with a boot disk
(I show you how to make one in Chapter 2), follow these steps:

1. Insert the DVD-ROM into your computer’s DVD-ROM drive and insert a
bootable Linux floppy disk into your computer’s floppy drive. See the
instructions in Chapter 2 for creating a bootable Linux floppy disk.

2. Reboot your PC.
This step starts the Linux installation process for you automatically.

Congratulations! The Linux installation process is now under way. For the
rest of the gory details on this fascinating task, please consult Chapter 3.

And some people say that installing Linux is hard! What could be easier than
this? On the other hand, if all you want to do is investigate the contents of
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the Linux installation DVD-ROM, simply insert it into your machine’s CD-ROM
drive. After that, you can browse through the DVD-ROM’s contents right

D ro p B O d“ngindows. The contents are described in the following section.
What You Find in Fedora Core 1

Here’s a summary of the software on the DVD-ROM, arranged by directory
organization. If you use Windows, the DVD-ROM interface helps you navigate
the DVD-ROM easily; you can use most of its contents only if you already
have Linux installed.

The contents of the DVD consist of all six CD-ROMs’ worth of material for
Fedora Core 1. Not all of the software is installed automatically. You find out
in Chapter 3 how to customize what’s added. Aside from that, the DVD has
useful install utilities and a handy-dandy README file that explains precisely
what you find. The directory structure may look similar to the following
(except for lacking my handy annotations, of course):

/mnt/redhat
----> RedHat
| SRS REMS -- binary packages, incl:
0S, GUIs, Apache, etc.
|----> base -- info on release 10
| used by install process
| -- source code for the packages
in RPMS
----> images -- boot & ramdisk images
----> dosutils -- DOS install utilities
----> isolinux -- boot files
----> README -- general read me file
----> RELEASE-NOTES -- current info about release 10
====2 RPM-GPE=KEY -- GPG sigs for Red Hat pkgs

Both CDs include GPG signatures, allowing the installer to check the contents
of the files against the stored security data to make sure that the files haven’t
been changed. (The assumption is that all changes would be for the worse,
such as Trojan horses or viruses.) Thus, signatures provide a way to make
sure that everything is safe and wholesome for your computer!

If You've Got Problems (Of
the DUD-ROM Kind)

[ tried my best to locate programs that work on most computers with the
minimum system requirements, as Red Hat did for its operating system. Alas,
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your computer may differ, and some programs may not work properly for
some reason.

\@ikeliest problems are that you don’t have enough memory (RAM)
for the programs you want to use or that you have other programs running
that are affecting the installation or running of a program. If you see error
messages like Not enough memory or Setup cannot continue, try one or
more of the following methods and then try using the software again:

v Close all running programs. The more programs you’re running, the
less memory is available to other programs. Installers also typically
update files and programs; if you keep other programs running, the
installation may not work properly.

v+ In Linux, close your GUI environment and run demos or installations
directly from a shell. The interface itself can tie up system memory or
even conflict with certain kinds of interactive demos. Use the command
prompt to browse files on the DVD-ROM and launch installers or demos.

+* Have your local computer store add more RAM to your computer. This
step is, admittedly, a drastic and potentially expensive one, depending
on the price of RAM at the time. If you have a modern PC with less than
64MB of RAM, however, adding more memory can really help the speed
of your computer and enable more programs to run at the same time.

If you still have trouble with the DVD-ROM, please call the Wiley Product
Technical Support phone number: (800) 762-2974. Outside the United States,
call 1(317) 572-3994. You can also contact Wiley Product Technical Support
through the Internet at: http://www.wiley.com/techsupport. Wiley
Publishing provides technical support only for installation and other general
quality control items; for technical support on the applications themselves,
consult the program’s vendor or author.

To place additional orders or to request information about other Wiley prod-
ucts, please call (800) 225-5945.
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Symbols and Numerics

* (asterisk) character, 172, 186-187

\ (backslash) character, 191-192, 193
$ (dollar sign character), 182, 191-192
.. (double period) characters, 160

= (equals) character, 191

> (greater than) character, 194-195

# (hatch mark) characters, 81, 216, 217
- (minus sign) character, 127

| (pipe) symbol, 80

+ (plus) sign, 127

? (question mark) character, 172, 186

‘ (single quote) character, 192-193

[ ] (square brackets), 172

~ (tilde) symbol, 93, 185

_ (underscore) character, 217

3D Controller button (OpenOffice.org)

Additional Language Support screen, 53
Administrative Tools folder (Windows
XP/2000), 21-23
Adobe products, Linux support for, 276
Advanced Linux Sound Architecture
(ALSA), 260
aliases, for commands, 188-189
ATignment button (OpenOffice.org)
Draw, 246
Impress, 240
Allow Incoming check boxes, 318
ALSA (Advanced Linux Sound
Architecture), 260
Amusements applets (GNOME), 93
Appearance Preferences window
(Mozilla), 127
applets
Actions, 93

Draw, 246
Impress, 240
3D Objects (OpenOffice.org)
Draw, 246
Impress, 239
4 x 4 Matrix (OpenOffice.org Math), 255

o/ o

A command (vi text editor), 216
access permissions, 157

Accessories applets (GNOME), 93
Accessories menus (desktops), 88, 96
Account Wizard (Mozilla), 133-135
accounts, user. See user accounts
Accounts window (Gaim), 145
Actions applets (GNOME), 93

Add Account window (Gaim), 145-146

adding to desktops, 200, 203-204

Amusements, 93

clock, 92

configuring, 200-201, 204

Dialer, 118

Java, enabling, 130

Launcher, 93

Modem Lights, 118-119

removing, 201, 204

viewing, 92

Workspace Switcher, 91
Applets menu (GNOME), 93

applications. See programs, software

archiving files, 350
arguments, for commands, 186
Arrange button (OpenOffice.org)
Draw, 246
Impress, 240
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arrow keys, with text commands, 85-86
asterisk (*) character 172, 186-187
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audlo and audio files

mixers, 260

ripping tracks from CDs, 266-268

sound cards, 60-61
Audio Devices dialog box, 259
autocomplete feature, 85-86
AutoFilter On/0ff button, 235
AutoFormat button, 235
Automatic Partitioning screen, 49-50
AutoSpellcheck On/Off button,

230, 235

¥ X

b file type, 158
backslash (\) character, 191-192, 193
bash shell
activating, 182
altering shell environment, 196
autocompletion feature, 172, 187-188
backslash (\) character, 191-193
built-in commands, 350
cleaning screen, 198
command aliases, 189
command history, 188-189
command structure, 184-186
customizing file settings, 196
documentation for, 182
dollar sign ($) prompt, 182-183
features, 181
flags and arguments, 185
handling malfunctioning programs, 198
login prompt, 183-184
pwd command, 197
redirection of output, 194-195
restoring, 198
starting programs from, 186
system snapshots, 198
uname command, 197
variables, 189-193
who, whoami commands, 196-197

/bin directory, 286
BIOS (Basic Input/Output System), 33, 38
Bluecurve desktops. See GNOME
desktop environment; KDE
(K Desktop Environment)
/boot directory, 286, 289
boot disk
creating, 37-38, 57
emergency boot disks, 79
boot environment settings, 335-336
boot information directory, 286
boot loader programs, 50-51, 75-76, 79
boot: prompt, 42
booting (boot process)
bootable media, 35
from CD- or DVD-ROMs, 36-37, 357
first time setup screens, 58-61
from floppy disks, 37, 357
loading init program, 77
loading kernel, 76-77
POST (power-on-self-test), 74-75
rescue mode boots, 43, 78-80
troubleshooting, 32, 338-339
broadband, defined, 111
browsers, Web. See Mozilla Web browser;
Web browsers
browsing files
in file managers, 174, 177-178
in shared Windows folder, 300-302
burning CDs, 269-270
buttons, extensible, 234
buying distributions, pros and cons, 64
bzip2 compression utility, 307

o e

c file type, 158

C programming language, 12, 288

cable modems, 110

cache settings (Mozilla), 130-131

Calc (OpenOffice.org) spreadsheet
program, 91, 234-238

case sensitivity of commands, 85

cat command, 194, 213

cd command, 160
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CD Player, 88, 261-262
CD Settings dialog box (X CD Roast), 270
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booting from, 35-37
burning, 269-270
configuration files, 287
damaged, identifying, 41, 44
directory for, 289
installing Fedora from, 39-40
listening to, 261-262
mounting, unmounting, 291-292
ripping tracks, 266-268
chmod (change mode) command, 167-169
Choose Themes button (OpenOffice.org
Calc), 235
chown (change owner) command, 166
clear command, 198
clock applet, 92
CMOS (Complementary Metal-Oxide
Semiconductor), 33
CodeWeavers programs, 275
COM 1/COM 2 connections, 115
command completion feature (bash
shell), 172
Command mode (Vi text editor), 215
command-line interface
accessing interface, 38, 85
accessing text editors, 214
adding users, 99-100
advantages, disadvantages, 84, 181
autocomplete feature, 85-86
bash shell command structure, 184-186
booting into, 334
checking file system, 295
formatting disks, 293-294
history list, 85, 188-189
logging in from, 334
navigation tools, 85
commands. See also command-line
interface; specific utilities
and commands
aliases for, 188
case sensitivity, 85
flags and arguments for, 185

long, completing, 187-188
pipe (1) symbol in, 80
recently used, viewing, 85
Commands menu (OpenOffice.org
Math), 253
comma-separated values files (.CSV), Linux
support for, 238
communications utilities, 350
Composer Preferences window (Mozilla),
128-129
compressing files, 303-307, 350
Computer Management tool (Windows
XP/2000), 21-23
configuration files, tools, 88, 104, 210-213
configuring
applets, 200-201, 204
dial-up connections, 115-119
KMail e-mail client, 149-150
Konquerer Web browser, 147-148
Mozilla Web browser, 126-132
NFS (Network File System) server,
298-299
Samba Server, 300-301
connection speeds, 110-112
Connector button (OpenOffice.org)
Draw, 246
Impress, 240
Control Center menu (KDE), 96
Control Panel (Windows), 21-23
Copy button (OpenOffice.org)
Calc, 237
Draw, 247
Impress, 241
Math, 252
Writer, 232
copying files, 174-175, 178
copyleft software, 14
copyrights, 15
core dump files, 188
CrossOver Office, CrossOver plug-in
(CodeWeavers), 275-276
.CSV (comma-separated value) file format,
Linux support for, 238
Ctrl+Alt+Backspace keystrokes, 338
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Ctrl+Alt+F2 keystrokes, 183
Ctrl+Alt+F5 keystrokes, 338
kes, 338
Office.org)
Draw, 246
Impress, 240
Custom installation, 48
Cut button (OpenOffice.org)
Calc, 237
Draw, 247
Impress, 241
Math, 252
Writer, 232

oo

d file type, 159
Data Interchange Format (.DIF), Linux
support for, 238
Data menu (OpenOffice.org Calc), 236
Data Sources button (OpenOffice.org)
Calc, 235
Writer, 230
data-manipulation commands, 352
Date and Time Screen, 60
.DBF (dBase) file format, Linux support
for, 238
Debian GNU/Linux distribution, 16
debugging core dump files, 188
deleting
files, 175, 179
text, 217-218
dependencies, defined, 324
desktop environments
customizing, 199-205
defined, 86
display themes, 205-210
GNOME, 86-94
KDE, 94-96
starting bash sessions from, 182-183
variations in, 93

/dev directory
/cdrom subdirectory, 289
contents of, 286
/fd0, /fdl subdirectories, 289
/hda, /hdal, /hdaZ2 subdirectories, 289
/hdb, /hdb1l, /hdb?2 subdirectories, 289
/sda, /sdal subdirectories, 289
device drivers, viewing, 286, 295
Device Manager (Windows), 32, 34
df command, 197
DHCP (Dynamic Host Configuration
Protocol), 51-52, 120
diagnostic tools, 32
Dialer applet (GNOME), 118
dial-up connections, 111, 113-119
.DIF. See Data Interchange Format (.DIF)
Digital Millennium Copyright Act
(DMCA), 273
Digital Subscriber Line (DSL), connecting
to, 110-111
Direct Cursor On/0ff button (Writer
main toolbar), 230
directories. See also specific directories
accessing, 172
creating new, 162
listing of, 286-287
moving and renaming, 162-163
navigating, 160
opening, 174, 177
parent directories, 157
removing, 163-164
root (/) directory, 156
sharing, 300-302
versus partitions, 288
viewing contents, 156-158
working, identifying, 196
Disk Druid (Red Hat), 58
disk images file, 37
Disk Management information (Windows),
22-23
Disk Partitioning Setup screen, 49-50
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disk space
checking in Windows, 21-25
FeQuijkag i installation, 23, 26
DropBogks
disk usage, viewing, 197
disks, formatting, 293-294
displays, desktop
resolutions, 337-338
themes for, 205-210
distributions
beginner versus advanced, 18
buying, 64
core components, 63
Debian GNU/Linux, 16
defined, 63
installation programs, 17-18
Knoppix, 70
Mandrake, 16, 66-68
number of, 64
package managers, 17
Red Hat/Fedora Core, 16
similarities among, 17
Slackware, 17
software versions, 17
SuSE, 17, 68-72
Xandros, 16
DMCA (Digital Millennium Copyright
Act), 273
dmesg | Tess command, 80
dmseg command, 80
DNS (Domain Name System), 120-121
.DOC file format, Linux support for,
233, 238, 242
document section (OpenOffice.org)
Calc, 238
Draw, 248
Impress, 242
Math, 252-255
Writer, 233
documentation. See also help and support
for FIPS partition resizing tool, 27
importance of reading, 31
using during installation, 36

dollar sign ($) character (bash),
182, 191-192
Domain Name System (DNS),
120-121
domain registrars, 121
/dosutils directory, 37-38
double period (..) characters, 160
downloading
desktop themes, 206
distributions, 65
documentation, 36
mp1ayer media player, 274
music from Internet, 264-265
OpenOffice.org office suite,
224-225
Real Audio for Linux, 264-265
security risks, 316-318
Wine, 279-281
drakx X configuration tool
(Mandrake), 210
Draw (OpenOffice.org) drawing
program, 248
Drawer applet (GNOME), 93
drivers, locating, 31
drives, list of, 289
DSL (Digital Subscriber Line), connecting
to, 110-111
du (disk usage) command, 197
dual boot systems
creating partitions for, 27
mounting Windows partition, 292
preparing computer for, 20
startup screen, 30
DVD-ROMs
booting from, 35-37
identifying damaged discs, 44
installing Fedora Core from,
39-40, 65
Dynamic Host Configuration Protocol
(DHCP), 51-52, 120
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Edit File button (OpenOffice.org)
Calc, 236
Draw, 247
Impress, 241
Math, 251
Writer, 231
Edit menu (Mozilla), 126
Edit menu (OpenOffice.org)
Calc, 236
Draw, 246
Impress, 240
Math, 251
Writer, 230
editing text (vi text editor), 216-218
Effects button (OpenOffice.org)
Draw, 246
Impress, 240
efficiency of Linux, 12
e2fsck (file system check) command, 295
E111pse button (OpenOffice.org)
Draw, 245
Impress, 239
e-mail
attaching files to, 150
configuring, 128-130
Evolution mail manager, 135-139
KMail client, 149-150
sending and receiving, 97, 140-141
Empty Trash button, 175
Entire Formula button (OpenOffice.org
Math), 250
env command, 192
environment variables, 190-191
equals (=) character, 191
errata pages, defined, 331
error messages. See also troubleshooting
BAD PASSWORD, 100
[FATLED] status, 77
operating system not found, 76

rpm installations, 308

viewing log of, 80

when removing packages, 324
/etc directory

contents, 286

/exports subdirectory, 298-299

/fstab subdirectory, 299-300

/grub.conf file, 79, 338-339

/opt subdirectory, 287

/profile file, 196

/services file, 316

/X11 subdirectory, 287

/X11/XF86config file, 210-211
ethical issues

root user access, 97

software as intellectual property, 14
Everything Linux Web site, 342
Evolution e-mail program (Ximian)

accessing, 88, 125

launching, 90

sending and receiving e-mail, 140-141

setting up, 135-139
.exe (executable) files, 104
execute (X) permissions, 166
expansion, wildcard, 186-187
Ext mode (vi text editor), 215
ext? file system type, 292
extensible buttons, 234
external modems, 113

oF e

[FATLED] status (init program), 77
FDISK utility (Windows 98), 23-25
Fedora Core 1 distribution
accessing XMMS, 263
configuration tools, 104-105
desktop environments, 84-96
error log locations, 80
finding audio mixers, 259
FIPS partition resizing tool, 27
FirstBoot screens, 58-61
gFTP utility, 151
installation options, 39-41
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KMail e-mail client, 149-150
Konquerer Web browser, 147-148
DDk fi ice suite, 224
D ro p l@@ stallation, 40
reasons for choosing, 16, 40
Red Hat Network screen, 61
registering, 61
security tools, 317
setting up user accounts, 97-100
starting bash sessions, 183-183
supported hardware, 31
testing sound cards, 258
troubleshooting, 41, 331-333
updating, 346
versus Fedora Core in RHEL, 40-41
viewing contents of, 358
Ximian Evolution e-mail program, 125
file command, 159
file filter commands, 351
file formats (OpenOffice.org)
Calc, 238
Draw, 248
Impress, 242
Math, 254
Writer, 233
file information, long format, decoding,
164-167, 170-171
file locator commands, 351
file managers, 173-180
File menu, 93-94 (OpenOffice.org)
Calc, 236
Draw, 246
Impress, 240
Math, 251
Writer, 230
file organization commands, 351
File Roller utility, 225-227, 306
file services, 150-151
file sharing tools, 166-167
file system
adding temporary media, 291-292
changing permissions, 167-169
checking during boot process, 81
commands for, 351-352

creating new files, 161-162
directories, 160, 286-287
disk space requirements, 296-297
Linux versus Windows structures, 290
navigating, 160
root (/) directory, 286-287
viewing, checking, 295-296
File Transfer Protocol (FTP) services,
150-152
file types
defined, 104, 151-152
summary of, 158-159, 292
filename autocompletion, 172, 188
files
accessing, 172
commands for, 351-352
compressing, 303
copying, 174-175, 178
deleting, 175, 179
filters for, 351
moving, 162, 174-175, 179
new, creating, 161-162
opening, 177-178
owners and groups, 158
permissions, permission sets, 157
removing, 163-164
renaming, 162
sending output to, 194-195
sharing, 297-302
uncompressing, unzipping, 308
viewing file information, 158-159,
177-178
wrappers for, 351
find command, 188
Find Files menu (KDE), 96
Find On/0ff button
Calc Main toolbar, 235
Writer Main toolbar, 230
FIPS partition resizing tool, 27-30
firewalls
configuring, 52-53
effect on traceroute command, 124
enabling/disabling, 317-318
FirstBoot screens, 58-61
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flags (command options)
e2fsck command, 295
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rm command, 163

tar command, 304

using, 185

viewing, 186
Flash Player (Macromedia) plug-in, 265
flexibility of Linux, 12
floppy disks

booting from, 35, 37-38

configuration files, 287

directories for, 289

formatting, 293-294

mounting, unmounting, 291-292
Floppy Formatter tool (GNOME), 293-294
Form button

Calc Main toolbar, 235

Writer Main toolbar, 229
Format menu (OpenOffice.org)

Calc, 236

Draw, 246

Impress, 240

Math, 251

Writer, 231
formatting Mozilla display, 127
Formula bar (OpenOffice.org Calc), 237
Formula Cursor button (OpenOffice.org

Math), 250
formulas (OpenOffice.org Math), 252-255
4 x 4 Matrix (OpenOffice.org Math), 255
frame buffering, enabling/disabling, 43
Frankensteined computers, 80
Free Software Foundation (FSF), 14
freedom software, 13-14, 112
freeware, 11
freezing of system, troubleshooting, 76
Freshmeat Web site, 345
FTP (File Transfer Protocol) services,
150-152

Function bar (OpenOffice.org)
Calc, 237
Draw, 247-248
Impress, 241-242
Math, 251-252
Writer, 231-232
function keys, 42-43, 133
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Gaim instant messenger, 88, 144
Gallery button (OpenOffice.org)
Calc, 237
Draw, 248
Impress, 241
Math, 252
Writer, 232
games, directory for, 288
Games menu (desktops), 88, 96
gedit text editor, 218-221
General Public License (GNU GPL), 9-10,
14-15
The GIMP graphics program, 88, 271-272
GNOME desktop environment
accessing, 84
activating bash sessions, 182-183
applets, 200-201
CD Player Preferences dialog box, 262
CDDB Track Editor, 261
components, 86
desktop window, 86
Dialer applet, 118
formatting disks from, 293-294
icons on, 93
installing, removing packages, 309-311
installing desktop, 56
Lock Screen tool, 89
Log Out tool, 90
main menu, 87
menus, 86-90
Nautilus file manager, 173-176
the Panel, 90-94
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program management, 202-203
Red Hat version (Bluecurve), 84
jogs from, 89
frO), 219
themes, 209-210
trashcan, 93-94
variations among distributions, 93
viewing system logs, 324-325
GNU (GNU'’s Not Unix) project
development of, 14
GPL (General Public License, 9-11, 14, 15
tools, utilities, 17, 64
GNU Network Object Model Environment.
See GNOME desktop environment
Grace Note Web site, 261
GRand Unified Boot loader. See GRUB
boot loader
graphical installations, 42, 58
graphical user interface. See GUI (graphical
user interface)
graphics file formats, supported, 248
Graphics menu (desktops), 88, 96
Graphics On/0ff button
(OpenOffice.org Writer), 230
greater than (>) character, 194-195
groupadd command, 167
groups (file permissions)
adding, removing permissions, 168
commands related to, 354
creating new, 167
defined, 158
settings for, 165-167
GRUB boot loader
accessing, 75
configuration file, 79
handling lost root password from, 340
identifying kernel path for, 77
GUI (graphical user interface)
benefits of using, 84
gedit text editor, 218-221
for gFTP, 147-148
install screen, 41
logging in from, 335-336

readability, 84
troubleshooting, 333, 338
user account setup, 97
X Window System, 199
GUI session, versus virtual terminal
session, 89
gunzip command, 306
. gz file format, 305-306
gzip utility, 303, 305-306

oMo

hacker ethic, 14
Hackers (Levy), 13
halt command, 81
hard drives
directories for, 289-290
partitioning, for dual boot system, 27
removable, installing Linux on, 21
hard links, 157-158
hardware requirements, 31-33
hash mark (#) characters, 81, 216, 217
HD Settings dialog box (X CD Roast),
269-270
help and support. See also Web sites
accessing from bash shell, 186
accessing from desktops, 88, 96
-help option, 197
Linux reference Web sites, 36
man pages, 182, 197
for Mozilla Web browser, 126
in vi text editor, 215
Helper Applications window (Mozilla), 132
Hewlett-Packard, support for Linux, 10
hfs file system type, 292
history command, 188
history of Linux, 11
history list (command-line interface), 85
HISTSIZE environment variable, 190
holes, security
network holes, 316-318
risks from, 315-316
software holes, 322-324
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Home menu (KDE

Holin Datentechnik Web site, 32
/home directory, 160, 286

rlable 190
NOME) 88

hops, defined, 122- 124
.HTML (Web Page) file format, 233, 238
Hyperlink Dialog button
(OpenOffice.org)

Calc, 237

Draw, 248

Impress, 241

Math, 252

Writer, 232

o]e

IBM Linux support, 10
Icon view (Konquerer), 178
icons
adding to, removing from desktops,
93-94, 202-205
on the Panel, 90-91
IDE hard drive directories, 289-290
IM (Instant Messaging), 88, 14-147
images, installing and updating, 40
Impress (OpenOffice.org) presentation
program, 91, 238-244
Inbox window (Evolution), 140-141
init command, 77, 336, 338
inode (wrapper) information, 351
Insert button (OpenOffice.org)
Calc, 234
Draw, 246
Impress, 240
Writer, 229
Insert Cells button (OpenOffice.org
Calc), 234
Insert Fields button (OpenOffice.org
Writer), 229
Insert Group button (OpenOffice.org
Calc), 235

Insert menu (OpenOffice.org)
Calc, 236
Draw, 246
Impress, 240
Writer, 231
Insert mode (vi text editor), 215

Insert Objects button (OpenOffice.org)

Calc, 235
Writer, 229
installation programs, differences
among, 17
installation screen options, 42-45
Installation Type screen, 47-49
installing Fedora Core 1
Additional Language Support
screen, 53
automatic permission assignments, 167
Boot Loader Configuration screen,
50-51
from CD- or DVD-ROM, 39—40
creating boot disk, 57
Disk Partitioning Setup screen, 49-50
Firewall Configuration screen, 52-53
halting installation, 41, 57
Installation Type screen, 47-49
Keyboard Configuration screen,
45-46
Language Selection screen, 44-45
Monitor Configuration screen, 46-47
Mouse Configuration screen, 45-46
Network Configuration screen, 51-52
options for, 42-43
Package Defaults screen, 54-56
Package Group Selection screen,
55-57
Personal Desktop installation, 40
Root Password screen, 54-55
text-based installation, 41, 42
Time Zone Selection screen, 53-54
troubleshooting installation problems,
41, 330-331
Welcome screen, 44
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reading documentation, 36
on removable hard drives, 21
required disk space, 23, 26
on system with Windows
installed, 21
installing Mandrake, 66-67
installing OpenOffice.org suite,
224-227
installing SuSE, 69-70
instant messaging. See IM
(Instant Messaging)
Integrated Services Digital Network
(ISDN), 110
intellectual property, 14
Interaction button (OpenOffice.org
Impress), 240
interfaces, 194. See also command-line
interface; GUI (graphical
user interface)
internal modems, 113
Internet applets (GNOME), 93
Internet browsers. See Web browsers
Internet connections, 65, 110-119
Internet menu (desktops), 88, 96
Internet radio, 262-264
interoperability, of Linux, 12
interpolated values, 193
IP addresses, 120, 122
IP Settings dialog box (Network
configuration tool), 117
ISDN (Integrated Services Digital
Network), 110
ISPs (Internet Service Providers),
113-114

o]o

Java applets, 130

oK o

KDE (K Desktop Environment)
applet management, 203-204
customizing settings in, 203
desktop window, 94
features, 84
installing, 56
installing, removing packages
using, 309-311
Konquerer file manager, 176-180
program management, 205
themes, 207-208
kernel, Linux
stability of, 12
troubleshooting problems with, 76, 77
use of, in all distributions, 17, 64
kernel panic message, 76
Keyboard Configuration screen, 45, 46
keys (SSH), setting up, 318
keystroke sequences
for accessing BIOS information, 33
for switching to text environment, 183
kill,killall commands, 198
KMail e-mail client, 149-150
Knoppix distribution, 70
Konquerer file manager (KDE desktop),
148, 176-180

of o

1 file type, 159

LAN (Local Area Network) proxy
servers, 131

Language Selection screen, 44-45

laptop computers, installing Linux
on, 35

latency, defined, 121

Launcher applet (GNOME), 93

less command, 80, 214

Levy, Steven (Hackers), 13

Index 3 7 1
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/11D directory, 286
licensing, 9-10, 14

pLB@“cj(kgboot loader,

Lines and Arrows button, 240, 245
links, tracing with fi1e command, 159
LinModem project, 112
The Linux Center Web site, 342
Linux distributions. See distributions
Linux Documentation Project, 119, 345
Linux kernel. See kernel, Linux
LInux LOader (LILO) boot loader, 75, 340
Linux operating system. See also
kernel, Linux
advantages of using, 12
appeal of, 10
applications for, finding online, 343
bash (Bourne again shell), 182
dual boot systems, 30, 278
history of, 11
home Web site, 341
images, 39-40
links in, 157-158
partitions and hard drives, 290
shutting down, logging off, 81
tools in, 13
versus other operating systems, 11
Linux Shop Web site, 275,
Linux Sound & MIDI Web site, 260
1inux text command, 42
Linux Users Groups (LUGs) Web site, 65
Linuxcare Web site, 344
literal text strings, 193
Local Area Network (LAN) proxy
servers, 131
Lock Screen command (desktops),
89, 96
log files, viewing, 324-325
logging in, 335-336
logging out, 81, 89, 90, 96
logical drive information (FDISK), 25
10gin prompt (bash shell), 183-184

long format file listings, 170-171
lowres commands, 43

1s command, 156-158

LUGs (Linux Users Groups), 65

oM o

Macromedia products
Flash Player plug-in, 265
Linux support for, 276
Mail & Newsgroups window (Mozilla),
128-130, 133-134
MAILCHECK environment variable, 190
Main menu
GNOME desktop, 87, 93
KDE desktop, 95-96
Main toolbar (OpenOffice.org)
Calc, 234
Draw, 245-246
Impress, 239-240
Math, 250
Writer, 228-229
man pages
accessing documentation using, 197, 349
for bash shell, 182
for command flags and arguments, 186
managing files. See file managers
managing packages. See Red Hat Package
Manager (RPM, rpm)
Mandrake distribution
audio mixers, 260
configuration tools, 105-106, 210
custom boot disk tool, 79
error log locations, 80
features, 16, 18, 66—-68
installing Mandrake, 66-67
installing OpenOffice.org, 224
Mozilla Web browser, 262-263
security tools, 317
software update tools, 316
testing sound cards, 258
User’s Club, 65



373

Index

Math (OpenOffice.org) calculation
program, 249-255

D ro lbi@%gfﬁce.org Math), 254

media, installing
mounting, unmounting, 291-292
testing installations, 44
Media Player (XMMS), 268-269
mediacheck option, 44
Menu Bar applet (GNOME), 93
Menu bar (OpenOffice.org programs)
235, 240, 246, 251
menus
GNOME desktop, 87-89
KDE desktop, 95-96
messages. See also error
messages; troubleshooting
e-mail, 140-141, 150
instant, 143-144
methods in Linux, common, 194
Microsoft Office, using from Linux, 275
Minix operating system, 11
MIT (Massachusetts Institute of
Technology), 13
mkbootdisk command, 79
mkdir command, 162
mke2fs command, 293-294
/mnt directory, subdirectories, 287,
291-292
Modem Lights applet, 118-119
modems
cable, 110
connecting to system, 113
dial-up, 110
viewing on GNOME desktop, 118-119
WinModems, cautions about, 112
Monitor Configuration screen, 46
more command, 195, 214
Motorola, support for Linux, 10
mount command, 291-292
mount point, 58, 289
mounting NFS (Network File System)
directory, 299-300

Mouse Configuration screen, 45-46
move (Mv) command, 162-163
movie files, viewing, 273-274
moving files and directories, 163, 174-175
Mozilla Web browser
accessing, installing, 88, 128-130
appearance settings, 127
cache settings, 130-132
configuring, 126
e-mail and newsgroup settings, 128-130
enabling Java applets, XSLT, 130
Evolution setup, 135-139
FTP services, 151
Internet radio services, 262
launching from the Panel, 90
navigating, 128, 133
newsgroups, 133-135
playing audio files, 264
plug-ins, 131-132
pop-up blocker, 131-132, 270
Preferences Window, 126
privacy and security settings, 130
sending and receiving e-mail, 140-141
Sidebar feature, 133
MPlayer (mp1ayer) media player, 273-274
msdos file system type, 292
MS-DOS window, accessing, 38
mtools utilities, command, 352-353
multimedia
audio mixers, 259
burning CDs, 269-270
The GIMP graphics program, 271-272
Internet radio, 262-264
movie files, 273-274
music downloads, 264-265
playing CDs, 261-262
programs for, 88, 276
ripping audio tracks from CDs, 266-268
sound cards, 258-259
tools for accessing, 270
Multimedia applets (GNOME), 93
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multiple desktops, launching, 91, 95
multlple instant messages, 143-144
197
RS
creatlng user accounts 96-100
Linux support for, 12
multiprocessing, Linux support
for, 12
music downloads, 264-265
music ripping programs, 266—-268
mv (move) command, 162-163
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Nautilus file manager (GNOME), 88,
173-176
navigating
command-line interface, 85
file system, 160
Mozilla Web browser, 127, 128, 133
Navigator On/0ff button
(OpenOffice.org)
Calc, 237
Draw, 248
Impress, 241
Math, 252
Writer, 232
NeTraverse Win4Lin program, 276

Network Configuration window, 51-52,

115-119

Network File System (NFES), 297-300
network services, unused, 316-317
networks, networking

booting using, 35

configuration tools for, 104, 105

Red Hat tools for, 111-112

TCP/IP networks, 119-124
New button (OpenOffice.org)

Calc, 236

Draw, 247

Impress, 241

Math, 252

Writer, 231

newsgroups
accessing messages, 135
configuring display preferences, 128-130
Linux-related, listing of, 345-346
sending messages, 97
subscribing to, 133-135
NFS (Network File System), 297-300
nontext files, creating, 161-162
notebook computers, Linux on, 35
NTES partitions, resizing, 27
number sign (#) character. See hash mark
(#) character
numeric permission sets, 169
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Object bar (OpenOffice.org)
Calc, 237
Draw, 248
Impress, 242
Writer, 232
Office menu
GNOME desktop, 88
KDE desktop, 96
Office (Microsoft), using from Linux, 275
offices suites See OpenOffice.org
office suite
Online Layout button (OpenOffice.org
Writer), 230
Open File button (OpenOffice.org)
Calc, 236
Draw, 247
Impress, 241
Math, 252
Writer, 231
open programs, viewing, 91
Open Recent menu (GNOME), 89
Open Sound System (OSS) Web site, 260
open source projects, 12-15
OpenOffice.org office suite
accessing, 88
Calc program, 91, 233-238
components, 223-224
Draw program, 244-248
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installing, 224-227
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Writer program, 228-233
open-source software, 9-10
operating system not found
message, 76
operating systems, 10, 278. See also dual
boot systems; Linux operating system,;
Windows operating system
/opt directory, 287
options. See flags (command options)
O’Reilly & Associates (PC Hardware in a
Nutshell), 21
0SS (Open Sound System), 260
other file users, permission settings,
165-166, 168
output redirection, 194-195
ownership
of files, 158, 165-166, 179-180
of sessions, 196

oepPoe

P command (Vi text editor), 216
Package Defaults screen, 54, 55-56
Package Group Selection screen, 55-57
Package Management tool, 309-310
package managers, 17
packages, software
adding after installation, 56
choosing, 55-56
installing, removing, 308-311
unneeded, removing, 322-324
pager utilities, 195
the Panel (GNOME desktop)
accessing Main Menu, 90
adding applets, 93, 200-201
customizing display, 92
launching Mozilla setup, 126
Panel menu contents, 92
status/task section, 91
tool and program icons, 90-91

parent directories, 157
Partition Magic (PowerQuest), 25, 26
partitions
creating manually, 58
for dual boot systems, 27
mounting, viewing, 197
resizing, 25-30
versus directories, 288
viewing in Windows XP/2000, 22-23
passwd command, 99
passwords
assigning, 98-100
guidelines for selecting, 314
root, changing, 340
Paste button (OpenOffice.org)
Calc, 237
Draw, 247
Impress, 241
Math, 252
Writer, 232
PATH environment variable, 191
PC Hardware in a Nutshell (O’Reilly &
Associates), 21
PC-CONFIG hardware detection tool, 32
penguin mascot, 10
performance, 84
permissions, permission sets
automatic assignment, 167
changing, 167-169, 175-176, 179-180
defined, 157
numeric representation, 169
reading, 164-167, 170-171
Personal Desktop installation, 40, 48-50
ping command, 121-122
pipe (I) symbol, 80
pipes, pipelines, 193, 195
platforms, multiple, Linux support for, 12
Playlist dialog box (XMMS), 268-269
plug-ins
CrossOver (CodeWeavers), 275-276
directory for, 132
gedit text editor, 220
Macromedia Flash Player, 265-266
for Web browsers, 131-132, 165
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plus (+) sign, minus (-) sign
characters, 126

D 'O pB@ﬁk{igo 1’3111-?32, 270

Popup Windows Preferences window
(Mozilla), 131-132
POST (power-on-self-test), 74-75
poweroff commands, 81
power-on-self-test (POST), 74-75
PowerPoint (Microsoft), Linux support
for, 242
PowerQuest Partition Magic
program, 25
ppp0 device, 118
Preferences menu
gedit plug-ins, 220
GNOME desktop, 88
KDE desktop, 96
presentation software. See Impress

(OpenOffice.org) presentation program

Print File Directly button
(OpenOffice.org)
Calc, 237
Draw, 247
Impress, 241
Math, 252
Writer, 232
printing
commands for, 353
configuration settings, 101-103
Print Manager tool, 91
privacy tools (Mozilla), 130
program status, changing, 92
Programming menu (desktops),
88, 96
programs, software
adding/removing, 201-203, 205
code directories, 286
defined, 103
malfunctioning, closing, 198
open source, versus commercial, 9-10
open, viewing, 91
packages, tarballs, 303
removing, 309-310, 323-324

reusing programming components, 12
running from bash shell, 186
running from desktops, 88, 89, 96
running from file managers, 174, 177
security risks, 322-324
versions, differences among, 17
Windows, running from Linux, 278

protocols, TCP/IP networks, 119

proxy settings (Mozilla), 131

ps command, 198

PSI environment variable, 191

pwd command, 160, 197

QQQ

:q command, 215
question mark (?) character, 172, 186
quotes, single (), 192-193
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r (read) permissions, 166
Radio-Locator radio stations (Internet
radio), 264
.-ram (Real Audio) files, 265
RAWRITE utility, 37-38, 40
Real Audio for Linux, 265
reboot command, 81
receiving e-mail, 140-141
Rectangle button, 239, 245
Red Hat Linux. See also Fedora
Core 1 distribution
CD Player, 261-262
configuration tools, 104-105
Disk Druid, 58
Fedora Core, 18
File Roller utility, 306
networking tools, 111-112, 120-121
Printer Configuration tool, 101-103
Red Hat Enterprise Linux, 18, 40-41
Security Level tool, 317
support center, 345
User Manager window, 98-100
X Window System, 210
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Red Hat Network
accessing on System Tools menu, 88
ore, 61
5-316

updating Fedora Core, 346
Red Hat Package Manager (RPM, rpm)
installing packages manually, 308
installing Wine using, 279-280
removing applications using, 309
uses for, 307
viewing configuration tools, 104
redhat-config-network tool, 104, 105
redhat-config-xfree86 tool, 210, 333
redirection, 193-195
Redo button (OpenOffice.org)
Calc, 237
Draw, 247
Impress, 241
Math, 252
Writer, 232
Refresh button (OpenOffice.org
Math), 250
registering
Fedora Core, 61, 346
OpenOffice.org, 228
regular file type, 158
reinstalling Linux, 80
relative locations, 160
remote directories, 299
removable rack hard drives, 21
removing
applets, 201, 204
files and directories, 163-164
program icons, 203
programs, 201, 205, 309
temporary media, 291-292
unneeded software, 322-324
Required Install Media dialog box, 57
rescue mode, booting into, 43, 78-80
reset command, 198
resizing partitions, 25-30
resolution, screen, 43, 337-338
Restart the Computer option, 90

RHEL (Red Hat Enterprise Linux). See
Red Hat Linux
ripping audio tracks, 166-169
rm (remove) command, 163-164
rmdir (remove directory) command, 164
/root directory, 156, 286-287
Root Password screen, 54-55
root user
defined, 97
home directory, 286
Lock Screen option, 89
ownership changes by, 166
responsibilities, 97
user account for, 97
Rotate button (OpenOffice.org), 240
routers, 119, 122-124
RPM (Red Hat Package Manager, rpm)
installing, 264, 308-309
removing applications using, 309
using, 307-309
rpm-qa | grep redhat-config
command, 104
RRU GIMP Tutorial Web site, 273
.RTF (Rich Text Format), Linux support
for, 233
ruler (OpenOffice.org), 233, 242, 248
runlevel command, 335-336
running programs
from bash shell, 186
from GNOME desktop, 88, 89
from KDE desktop, 96
from Konquerer file manager, 177
from Nautilus file manager, 174

oSeo

Samba Server, 300-301
Save Document button (OpenOffice.org)
Calc, 237
Draw, 247
Impress, 241
Math, 252
Writer, 231
saving files, 218, 220-221
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sax, sax2 tool (SuSE), 210, 333
/sbin directory, 287
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configuring, 43
switching between, 337-338
scripts, troubleshooting problems
with, 339
SCSI hard drive directories, 289-290
Search for Files menu (GNOME), 89
Security Administration Security
Resources Web site, 342
security risks
downloading software, 314-315
online information about, 36
software holes, 322-324
Telnet port, 318
unused network services, 316-317
Web sites about, 325-326
security tools
Allow Incoming check boxes, 318
Mozilla Web browser settings, 130
passwords, 98-100, 314
Red Hat Network security tools, 315-317
Web sites about, 325-326
Select button (OpenOffice.org), 239, 245
sending e-mail, 140-141
Server installation, 48
service types, for IM (instant messaging),
144-146
sharing files
directory for, 287-288
NFS shared directory, 297-300
using Windows computers, 300-302
shell scripts, 193, 213
shells, defined, 182
shortcut menus, Empty Trash button, 175
SHOUTcast radio stations, 262
Show Draw Functions button
(OpenOffice.org)
Calc, 235
Writer, 229
shutting down Linux, 81, 90

Sidebar feature (Mozilla), 133
single quote () character, 192-193
Slackware distribution, 16
Slashdot Web site, 344
S1ide Show button (OpenOffice.org
Impress), 240
slides, creating, 243-244
. so file extension, 132
soft links, 157
software. See programs, software
software modems (Winmodems), 112, 113
Sort Ascending/Descending buttons
(Calc toolbar), 235
sound cards, testing and configuring,
60-61, 259-260
Sound Juicer CD Ripper, 266-268
sound mixers, 260
Sound & Video menu, 88, 96
source code directory, 288
spell checking, 150, 230, 235
spreadsheet program. See Calc
(OpenOffice.org) spreadsheet program
square brackets ([ ]), 172
SSH (Secure Shell)
enabling, using, 318
Linux-to-Linux connections, 321-322
Linux-to-Windows connections, 319-321
stability of Linux, 12
Stallman, Richard (GNU project), 13-14
startup screen, for dual boot systems, 30
startx command, 218, 335, 337-338
static I[P numbers, 120
status of programs, changing, 92
status/task section (GNOME panel), 91
stderr (standard error), stdin (standard
in), stdout (standard out)
methods, 194
Stop Loading button (OpenOffice.org)
Calc, 236
Draw, 247
Impress, 241
Math, 251
Writer, 231
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stopping installations, 41, 57
storage devices (drives), viewing, 37
values, 193
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Draw, 248
Impress, 241
Math, 252
Writer, 232
su command, 99, 265
subdirectories, 288. See also
specific directories
subscribing to newsgroups, 133-134
superuser, defined, 97
supported hardware, listings of, 31
SuSE distribution
audio mixers, 260
configuration tools, 105-106
custom boot disk tool, 79
error log locations, 80
evaluation version, 70-71
features, 16, 18, 68—69
installing, 69-70
9.0 Professional version, 71-72
security tools, 317
software update tools, 316
testing sound cards, 258
X Window configuration tools, 210
swap partitions, defining in Linux, 58
SXC file format, 238
.SXD file format, 248
SXI file format, 242
.SXM file format, 254
SXW file format, 233
Symbols button (OpenOffice.org
Math), 250
system control tools, 353-354
system information, accessing, 32-34, 197
System Logs viewer, 324-325
system requirements, 65
system resource allocations, 197-198
System Settings menu
configuring dial-up services, 115-119
GNOME desktop, 88
KDE desktop, 96, 97

tton (OpenOffice.org)

System Tools menu
configuration tools, 105
GNOME desktop, 88
KDE desktop, 96

o e

Tab key, with commands, 85, 188
tar (Tape ARchive) utility, 303-307
tarballs, 303, 306
TCP/IP networks, 119-124
Telnet port, security risks, 318
temporary files, 162, 287
temporary media, 291-292
terminal window, opening, 85
Text button (OpenOffice.org)
Draw Main toolbar, 245
Impress Main toolbar, 239
text editors
creating files using, 161
gedit text editor, 219
vi text editor, 214-218
versus word processors, 219
text files, 213-214, 233
text strings, literal text strings, 193
text-based Linux installations, 41, 42, 58
themes (desktop displays), 205-210
3D Controller button (OpenOffice.org)
Draw, 246
Impress, 240
3D Objects button (OpenOffice.org)
Draw, 246
Impress, 239
tilde (~) symbol, 93, 185
Time Zone Selection screen, 53-54
/tmp directory, 162, 287
Tom’s hardware information Web site, 31
Tools menu (OpenOffice.org)
Calc, 236
Draw, 246
Impress, 240
Math, 251
Writer, 231
top command, 197-198
top-level domains, 121
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Torvalds, Linus (creator of Linux), Undo button (OpenOffice.org)

10-11, 15 Calc, 237
PT) >IN Draw, 247
D ro @L‘@ \ i@lZl, 122-124 Impress, 241
TransGaming WineX, 276-277 Math, 252
Transmission Control Protocol/Internet Writer, 232
Protocol. See TCP/IP networks Ungroup button (OpenOffice.org
trash container, 93-94, 175, 179 Calc), 235

Universal Time, enabling, 53
Unix operating system
Bourne shell, 182

Tree View (Konquerer), 178
troubleshooting
audio problems, 61

bash-related problems, 186

boot-related problems, 78-80, 338-339

corrupt boot loaders, 76

corrupt system kernels, 76

dial-up connection problems, 119

GUI hangups, 333, 338

installation problems, 41, 330-333,
358-359

instant messaging problems, 146-147

Internet connections, 121-124

lost root password, 340

machine hangups, 338-339

package installation problems, 308

package removal problems, 324

script-related problems, 339

techniques for, 329-330

unlisted (unsupported) devices, 47

and creation of Linux, 11
links in, 157-158
unmounting temporary media,
291-292
unpacking . tar files, 306-307
up command, 188
URL Entry list box (OpenOffice.org)
Calc, 236
Draw, 247
Impress, 241
Math, 251
Writer, 231
user accounts. See also root users
adding in Samba, 301
creating and adding, 97-100,
145-146
home directories for, 286

trusted devices, 317-318

ttyS0/ttyS1 connections, 115

Tucows download site, 270

turning off computer, 81

Tux (penguin mascot), 10

.TXT file format, Linux support for, 233

olf o

u command (Vi text editor), 216

ugo option (chmod command), 168
umount command, 292, 295

unallocated partitions, identifying, 22-25
uname command, 197

underscore (_) character, 217

user interfaces, graphical. See GUI
(graphical user interface)
useradd command, 99
usermod command, 167
users, of files. See also user accounts
Users and Groups dialog box, 97-98
users, system
commands for, 354
identifying from bash shell, 196
permission settings for, 165-166, 168
/usr directory, subdirectories, 263,
287-288
UTC (Universal Time, Coordinated), 53
Utility applets (GNOME), 93
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/1049 subdirectory, 80
variables (bash shell), 189-193
vfat file system type, 292
vi text editor, 214-218
View menu (OpenOffice.org)

Calc, 236

Draw, 246

Impress, 240

Math, 251

Writer, 231
views, file (Konquerer), 178
virtual terminal (VT) sessions, 89, 184
VMware Web site, 278
volunteers, quality of work, 15

ol o

w (write) permissions, 166
Web browsers. See also Mozilla
Web browser
accessing FTP services, 151
caches, 130
graphical, impact of, 125
in Konquerer, 147-148
plug-ins for, 131-132
Web sites
Advanced Linux Sound Architecture
project, 260
anti-DMCA Web site, 273
audio-related, 61
CodeWeavers programs, 275

connecting Linux to cable modems, 110

Digital Subscriber Lines, 110-111
Everything Linux, 342

Fedora Core distribution, 345
Fedora-supported hardware, 31
Freshmeat, 345

The GIMP tutorials, 273

GNOME desktop environment, 86

Grace Note, 261

GRUB manual, 77

help resources, 333

K Desktop Environment, 95

LinModem project, 112

The Linux Center, 342

Linux Documentation Project, 119, 345

Linux downloads, 64, 312, 343

Linux for Laptops, 35

Linux home site, 16-17, 341

Linux kernel information, 342

Linux publications, 343-344

Linux reference sites, 36

Linux Shop, 275

Linux Sound & MIDI, 260

Linux Users Groups (LUGs), 65

Linuxcare, 344

Mandrake distribution, 66

MathML standard, 254

MPlayer media player, 273-274

online tutorials, 343

OpenOffice.org, 224

Open Sound System, 260

Partition Magic (PowerQuest), 25

PC-CONFIG hardware detection tool, 32

Radio-Locator, 262

Real Audio for Linux, 263-264

Red Hat support center, 345

Security Administration Security
Resources, 342

security tools, 325-326

SHOUTcast Web site, 262

Slashdot, 344

SuSE distribution, 69

Tom’s hardware information, 31

TransGaming products, 276-277

Tucows download site, 270

VMware, 278

Wiley Product Technical Support, 359

Win4Lin (NeTraverse), 276

X Window System tools, 211

who, whoami commands, 196-197
wildcard characters, 172, 186-187
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Wiley Product Technical Support, 359 P y PY
“Wm hardware cautions about, 33
D rop ) 276 YaST2 Control Center (SuSE), 105-106

.' YStem YaST2 installation tool (SuSE), 70-71
accessing Dev1ce Manager, 32-34 Young, Robert (Red Hat), 16
disk space, viewing from, 21-25 ’ '
dual boot systems, 20, 21-25, 30, 278
partitions and hard drives, 290 ® z ®

sharing files using, 300-302

with SSH-enabled systems, 319-321 Zoom buttons (OpenOffice.org)

Wine Windows functionality, 279-281 Draw, 245
Wine program, 279-281 Impress, 239
; Math, 250

winelauncher command, 279

winesetuptk configuration tool, 279-280

WineX (TransGaming) tools, 276-277

WinModems, cautions about, 33, 112

WinZip utility, using in Linux, 306

word processors, versus text editors, 219.
See also Writer (OpenOffice.org)
word processor

working directory, identifying, 197

Workspace Switcher applet, 91

Workstation installation, 48

wrappers, for files, 351

write (W) permissions, 166

Writer (OpenOffice.org) word processor,
90, 228-233

oo

X (execute) permissions, 166

X CD Roast CD burner, 269-270

X MultiMedia System (XMMS), 263, 268

X Window System (X), 199, 210-211, 287

Xandros distribution, 16

xcdroast CD burner program, 269-270

Xconfigurator tool (Red Hat),
210-211, 333

XFdrake tool (Mandrake), 333

XF86Setup file, 211

Ximian Evolution e-mail program, 125

XMMS (X MultiMedia System), 263, 268

XSLT Web pages, enabling in Mozilla, 130
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GNU GENERAL PUBLIC LICENSE

| 3% e
Jop) 1 Free Software Foundation, Inc.

59 Temple Place - Suite 330, Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it.
By contrast, the GNU General Public License is intended to guarantee your freedom to share and
change free software—to make sure the software is free for all its users. This General Public
License applies to most of the Free Software Foundation’s software and to any other program
whose authors commit to using it. (Some other Free Software Foundation software is covered by
the GNU Library General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public
Licenses are designed to make sure that you have the freedom to distribute copies of free soft-
ware (and charge for this service if you wish), that you receive source code or can get it if you
want it, that you can change the software or use pieces of it in new free programs; and that you
know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights
or to ask you to surrender the rights. These restrictions translate to certain responsibilities for
you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give
the recipients all the rights that you have. You must make sure that they, too, receive or can get
the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license
which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands
that there is no warranty for this free software. If the software is modified by someone else and
passed on, we want its recipients to know that what they have is not the original, so that any
problems introduced by others will not reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the
danger that redistributors of a free program will individually obtain patent licenses, in effect
making the program proprietary. To prevent this, we have made it clear that any patent must be
licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.



TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION, AND MODIFICATION

his Licerfls lies to any program or other work which contains a notice placed by the
D ro p Bt gsaying it may be distributed under the terms of this General Public License.
€ “Program & below, refers to any such program or work, and a “work based on the
Program” means either the Program or any derivative work under copyright law: that is to
say, a work containing the Program or a portion of it, either verbatim or with modifications
and/or translated into another language. (Hereinafter, translation is included without limita-
tion in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License;
they are outside its scope. The act of running the Program is not restricted, and the output
from the Program is covered only if its contents constitute a work based on the Program
(independent of having been made by running the Program). Whether that is true depends
on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it,
in any medium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that
refer to this License and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option
offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work
based on the Program, and copy and distribute such modifications or work under the terms
of Section 1 above, provided that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices stating that you changed
the files and the date of any change.

b) You must cause any work that you distribute or publish, that in whole or in part contains
or is derived from the Program or any part thereof, to be licensed as a whole at no
charge to all third parties under the terms of this License.

c) If the modified program normally reads commands interactively when run, you must
cause it, when started running for such interactive use in the most ordinary way, to print
or display an announcement including an appropriate copyright notice and a notice that
there is no warranty (or else, saying that you provide a warranty) and that users may
redistribute the program under these conditions, and telling the user how to view a copy
of this License. (Exception: if the Program itself is interactive but does not normally print
such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that
work are not derived from the Program, and can be reasonably considered independent and
separate works in themselves, then this License, and its terms, do not apply to those sections
when you distribute them as separate works. But when you distribute the same sections as
part of a whole which is a work based on the Program, the distribution of the whole must be
on the terms of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.
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Thus, it is not the intent of this section to claim rights or contest your rights to work written
entirely by you; rather, the intent is to exercise the right to control the distribution of deriva-

tiye orcofectiye works based on the Program.

élé) ! aggregation of another work not based on the Program with the Program
(or with a work based on the Program) on a volume of a storage or distribution medium
does not bring the other work under the scope of this License.

You may copy and distribute the Program (or a work based on it, under Section 2) in object
code or executable form under the terms of Sections 1 and 2 above provided that you also
do one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which
must be distributed under the terms of Sections 1 and 2 above on a medium customarily
used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third party,
for a charge no more than your cost of physically performing source distribution, a com-
plete machine-readable copy of the corresponding source code, to be distributed under
the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

¢) Accompany it with the information you received as to the offer to distribute correspond-
ing source code. (This alternative is allowed only for noncommercial distribution and
only if you received the program in object code or executable form with such an offer, in
accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications
to it. For an executable work, complete source code means all the source code for all mod-
ules it contains, plus any associated interface definition files, plus the scripts used to control
compilation and installation of the executable. However, as a special exception, the source
code distributed need not include anything that is normally distributed (in either source

or binary form) with the major components (compiler, kernel, and so on) of the operating
system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a desig-
nated place, then offering equivalent access to copy the source code from the same place
counts as distribution of the source code, even though third parties are not compelled to
copy the source along with the object code.

You may not copy, modify, sublicense, or distribute the Program except as expressly pro-
vided under this License. Any attempt otherwise to copy, modify, sublicense or distribute
the Program is void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under this License will
not have their licenses terminated so long as such parties remain in full compliance.

You are not required to accept this License, since you have not signed it. However, nothing
else grants you permission to modify or distribute the Program or its derivative works. These
actions are prohibited by law if you do not accept this License. Therefore, by modifying or
distributing the Program (or any work based on the Program), you indicate your acceptance
of this License to do so, and all its terms and conditions for copying, distributing or modify-
ing the Program or works based on it.
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10.

Each time you redistribute the Program (or any work based on the Program), the recipient

automatically receives a license from the original licensor to copy, distribute or modify the

Progr ject to these terms and conditions. You may not impose any further restrictions

mﬁg’ exercise of the rights granted herein. You are not responsible for enforcing
P e ird parties to this License.

If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this License, they do not excuse
you from the conditions of this License. If you cannot distribute so as to satisfy simultane-
ously your obligations under this License and any other pertinent obligations, then as a
consequence you may not distribute the Program at all. For example, if a patent license
would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this
License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circum-
stance, the balance of the section is intended to apply and the section as a whole is intended
to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property
right claims or to contest validity of any such claims; this section has the sole purpose of
protecting the integrity of the free software distribution system, which is implemented by
public license practices. Many people have made generous contributions to the wide range
of software distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to distribute software
through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of
the rest of this License.

If the distribution and/or use of the Program is restricted in certain countries either by
patents or by copyrighted interfaces, the original copyright holder who places the Program
under this License may add an explicit geographical distribution limitation excluding those
countries, so that distribution is permitted only in or among countries not thus excluded. In
such case, this License incorporates the limitation as if written in the body of this License.

The Free Software Foundation may publish revised and/or new versions of the General
Public License from time to time. Such new versions will be similar in spirit to the present
version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version
number of this License which applies to it and “any later version”, you have the option of
following the terms and conditions either of that version or of any later version published
by the Free Software Foundation. If the Program does not specify a version number of this
License, you may choose any version ever published by the Free Software Foundation.

If you wish to incorporate parts of the Program into other free programs whose distribution
conditions are different, write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we
sometimes make exceptions for this. Our decision will be guided by the two goals of preserv-
ing the free status of all derivatives of our free software and of promoting the sharing and
reuse of software generally.
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B E OGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
ro p @ 4 E EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE
: |

12.

NG THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFOR-
MANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIB-
UTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE
USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA
OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES
OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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Limited Warranty

(ay WPI warrants that the Software and Software Media are free from defects

D ro p B O Q als and workmanship under normal use for a period of sixty (60) days

date of purchase of this Book. If WPI receives notifications within the

warranty period of defects in materials or workmanship, WPI will replace the
defective Software Media. (b) WPI AND THE AUTHOR OF THE BOOK DISCLAIM
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCUDING WITHOUT LIMITA-
TION IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PAR-
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COURCE CODE CONTAINED THEREIN, AND/OR THE TECHNIQUES DESCRIBED
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